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Introduction

1

Welcome, and congratulations! You’ve just bought a ticket to the world of Autodesk® 3ds
Max®. Hang on and get ready for the ride of a lifetime! With 3ds Max, you can create 3D
places and characters, objects and subjects of any type. You can arrange them in settings and
environments to build the scenes for your movie or game or visualization. You can animate
the characters, set them in motion, make them speak, sing and dance, or kick and fight. And
then you can shoot movies of the whole virtual thing.

1

The Sky Fisherman
Akin Bilgic
cggallery.com

You can use 3ds Max to visualize designs of real things that will actually be built, such as
buildings and machines. The File Link feature of 3ds Max lets you base visualizations on
designs created in AutoCAD® or Autodesk Revit® Architecture: When the design changes
in these other applications, the revisions can be automatically updated in your 3ds Max
scene. Add lighting and materials, then render to still image or movie formats.
These tutorials teach 3ds Max through a series of hands-on exercises. Prepare to be entertained
and fascinated by the awesome power at your fingertips.

Acknowledgements
Special thanks are due to a number of hardworking and talented individuals who helped
create this volume of tutorials. A tip of the virtual hat to:
■

All those customers and users who have allowed us to showcase their artwork, whether
in the User Showcase on page 5 section or elsewhere in the help and tutorials.

■

All those who have contributed models and methods used in these tutorials, including
Jean-Marc Belloncik (skinning and quadruped animation), Michele Bousquet (two-legged
Biped animation), Mark Gerhard (Set Key animation and the character studio
introduction), and Amer Yassine (models, methods, and artwork too numerous to list).
There are other contributors whose names aren’t available: We apologize for omitting
them, and thank you for your help as well.

Where to Find the Tutorials
The Tutorials link on the Help menu takes you to the HTML tutorials. These
are located on the Web at www.autodesk.com/3dsmax-tutorials-v2011.

Where to Find Tutorial Files
To access the scenes and other resource files you need to complete the 3ds
Max tutorials, go to www.autodesk.com/3dsmax-tutorials-scene-files-v2011.

2 | Chapter 1 Introduction

How to Learn 3ds Max
Besides the tutorials found in this collection, a number of other resources are
available to help you learn 3ds Max. In particular, consider the online Help
file an important adjunct to the tutorials; if you encounter a feature you'd like
to learn more about, look it up in the 3ds Max Help. There you'll find general
descriptions, detailed descriptions of all the controls, usage notes and tips,
and procedures for accomplishing various tasks.

Yesterday, The Lost Time
Zhelong Xu

Autodesk 3ds Max 2011 Documentation Set
■

Autodesk 3ds Max 2011 Help: The online help covers fundamental concepts
and strategies for using the product, as well as details about the features
of 3ds Max.
Access the reference online by choosing Help > Autodesk 3ds Max Help.

■

Additional Resources: A number of additional help files are installed with
the software and are available from the Help > Additional Help menu.

3ds Max on the Web
Links to the following Web sites are available from the Help menu within 3ds
Max. These pages provide access to a wide range of product information and
support resources: searchable Knowledgebase, FAQs, technical bulletins, tested
hardware information, and product downloads.
■

Online Support

■

Updates

How to Learn 3ds Max | 3

■

Resources

■

Partners

■

Training

Autodesk Training Information and Resources
■

Learning Path: Autodesk provides you with a single access point to an
interface overview, discussion groups, essential skills movies, technical
support, training resources and more. To access the this site, go to:
http://www.autodesk.com/3dsmax-learningpath.

■

Training Resources on the Web: You’ll find additional training resources
for 3ds Max at http://www.autodesk.com/3dsmax-training.

■

Other Resources: There is a wealth of information written about using 3ds
Max. There are third-party books that specialize in teaching the software
for various industries. There are magazines devoted to 3D design and
animation, as well as user groups and mail lists. Communities of users
trade secrets daily, and if you ask a question, you're likely to get answers
from experts all around the world.

Some of the above programs or contact details might not be available or
applicable in your country. Please check with your local Autodesk Authorized
Reseller or Autodesk office for details.

Browsing the HTML Tutorials
The title bar of each tutorial page contains both browse buttons and contextual
links.
You can use the three buttons in the upper-right corner of the page to browse
the tutorials. The button with the left arrow goes to the previous page, and
the button with the right arrow goes to the next page. The upward-pointing
arrow goes to the parent page; if there is no parent, this button is blank.

When you move your cursor over one of these buttons, the browser displays
the name of the page that the button points to.

4 | Chapter 1 Introduction

The other three buttons at the upper right of the title bar provide additional
controls:

■

Show in ContentsUpdates the Contents panel at the left to show
the page you are reading.

■

Add to FavoritesCreates a bookmark to this page on the Favorites
panel at the left.

Home: Autodesk 3ds Max TutorialsGoes to the graphic Welcome

■

page.
In addition, a series of links appear above the topic title. These show the path
of the topic within the 3ds Max tutorials.

The first link on the left is the chapter (top-level page) that contains the page
you are reading. If there are additional container pages, these appear in order
after the chapter link. Click any one of these links to go directly to the topic
it names.

User Showcase
In the 3ds Max tutorials, we teach you the tools to use the software. Put those
tools in the hands of talented artists and magic happens.
Here is a gallery of images by creative individuals from around the world using
this software. We hope you find these images inspiring before you set out on
your journey of learning 3ds Max.
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Le Rabbit
José Alves da Silva
josealvessilva.daportfolio.com

Composition: Childhood Toys
Vincent Dany
Copyright © 2008
ermite.net
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Gull and Me
Dejan Kober
berko.3dhr.net

Office Floor
Jamie Cardoso, GMJ Design Ltd
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Chinese Opera
James Ku
www.3dartisan.net/~kuman/
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The Ancient Indian Crown
Kameswaran Ramachandran Iyer, India
www.kameswaran.com
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Ice Cubes
José Manuel Elizardo, Autodesk, Inc.
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Apples
José Manuel Elizardo, Autodesk, Inc.
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Pete Draper
xenomorphic.co.uk
Deconstructing the Elements with 3ds Max, Third edition
Elsevier (Focal Press), © 2009
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Only Human
Jacques Pena
www.9dkid.com

Unpleasant Company
Metin Seven
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A Living Room
Frances Gainer Davey

Guardian of the Enchanted Forest
Marc Tan, Insane Polygons
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Old Courtyard
Pradipta Seth
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by Tommy Hjalmarsson
home.swipnet.se/~w-19339/GALLERY/frame.htm
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by Tommy Hjalmarsson
home.swipnet.se/~w-19339/GALLERY/frame.htm
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Student Breakfast
Jean-Yves Arboit, Belgium
www.cgitrainer.com
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Electric Water
Johannes Schlörb
www.schloerb.com
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The Sky Fisherman
Akin Bilgic
cggallery.com

Ripples of Spring
Casey McGovern
molerocket@hotmail.com
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Indian Beauty
Jaykar Arudra, AMM Studio, India
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by Ben Paine

Environment
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Thilan Harshadhamma

Old Sunflowers
Joana Garrido (Caixa D'Imagens), Portugal

Pistol Pete
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Martin Coven

Sommar Torp: "Summer House"
Sören Larsson, Sweden
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Anibal
Daniel Martínez Lara (Pepeland)

Yesterday, The Lost Time
Zhelong Xu

All images are copyright. Reproduction and distribution is not permitted
without the owner's permission.
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Getting Started: Animated
Battle Scene

2

This tutorial, intended for those new to 3ds Max, offers a quick introduction to the world of
3D.
Using basic features of the program, you’ll create a simple battlefield scene made up of a
cannon, a rock, a tree, and a windmill. You’ll also add a camera and use it to view the scene
from different angles.
The final steps show you how to add some basic animation, then turn the results into a
multimedia file.

The battlefield

27

In this tutorial, you will learn how to:
■

Open a scene

■

View a scene from different angles and perspectives

■

Model objects and apply realistic materials

■

Move and animate objects

■

Render the scene and save it as a multimedia file

Skill level: Beginner
Time to complete: 1 hour

Navigating a Scene
In this lesson, you'll open a partially-completed scene of a battlefield and learn
how to adjust the view and navigate the viewports.
Set up the lesson:

1 On the Quick Access toolbar, click

(Open File).

2 In the \scenes\startup folder, highlight battlefield_start.max, then click
Open.
NOTE If a dialog asks whether you want to use the scene’s Gamma And LUT
settings, accept the scene Gamma settings, and click OK. If a dialog asks
whether to use the scene’s units, accept the scene units, and click OK.
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Perspective viewport

The Perspective viewport should be active, indicated by a yellow border.
If no border is visible, click anywhere within the viewport to activate it.
Navigating the scene:
1 Depending on how your system is currently being used, you might have
up to two navigation tools displayed in the viewport. The ViewCube™
displays in the top right corner and the SteeringWheels™ 3D navigation
controls display in the lower left.
2 You will first take a look at the ViewCube. If the SteeringWheels is visible,
hide it by clicking the X at the top right of the corner of the wheel.
NOTE If this is the first time you are using SteeringWheels, you will need to
click on its icon to activate it.
3 In the Views menu ➤ Viewport Configuration ➤ ViewCube panel ➤
Display Options group, turn on Show The ViewCube if it is not already
on.
In the When Clicking On The ViewCube group, make sure Fit-To-View
On View Change and Keep Scene Upright are on, and click OK.
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4 In the Perspective viewport, right-click the ViewCube and choose Set
Current View As Home.
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5 Click the Left face of the ViewCube to view the scene from the left.
As you can see, the ViewCube lets you view the scene from alternative
viewpoints with a simple click of a mouse.
Notice how the viewport zooms in to a default scene magnification as it
switches to the left perspective. The change in zoom factor is not
something we want in this tutorial however, so you’ll change it.
6 Right-click the ViewCube and choose Configure from the menu.
The ViewCube tab is automatically selected.
7 In the When Clicking On The ViewCube group, turn off Fit-To-View On
View Change and click OK.
It is important to keep this setting off if you want to maintain the same
zoom factor when switching between viewpoints.
8 In the Perspective viewport, click the Home icon to the upper left of the
ViewCube.
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The Perspective viewport returns to its initial viewpoint.
NOTE You can reset the Home viewpoint to the current view at any time by
right-clicking the ViewCube and choosing Set Current View As Home.

9 Click
(Zoom) in the viewport navigation controls at the lower-right
corner of the 3ds Max window.
To show that this control is now active, the button is highlighted.

10 With the mouse, drag downward in the Perspective viewport.
Your view zooms out so you can see the scene from a distance.
NOTE You can also zoom in or out by rotating the mouse wheel forward or
backward.

11 In the viewport navigation controls click
(Orbit), which is below
and to the right of the Zoom button. The button highlights when active.
A yellow navigation circle appears in the viewport.
12 Position the cursor inside the yellow circle. Click and hold the left mouse
button and move the mouse. This action is called dragging.
The point of view orbits around the scene.
TIP Avoid dragging outside the yellow navigation circle, unless you want to
roll the entire viewport.
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13 Use a combination of the Orbit and mouse wheel to zoom in on the
windmill.

14 Orbit your view by dragging to the left or right until you can see the
cannon in the opposite direction.
15 Right-click the viewport to exit Orbit mode.

16 Click
(Pan) in the viewport navigation controls and move the
mouse in the viewport.
The viewport view now follows the movement of your mouse.
NOTE You can also start a pan operation by holding down the mouse button
or wheel as you pan.
17 Return the viewport to its original orientation by clicking the Home icon.
18 Press Shift+W to display the SteeringWheels controls, if they are not
already visible.
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NOTE In this instruction, “Shift+W” is outlined with a rectangle to indicate
that you must press this key combination on the computer keyboard. We use
this style consistently in the help and tutorials for both single key presses and
key combinations, so that it's always clear when an instruction involves using
the physical keyboard as opposed to using the mouse with the software
interface on the screen.
The SteeringWheels controls offer an alternative way to navigate a scene.

19 Click and drag each of the Zoom, Pan and Orbit controls in turn, and
experiment with how they can be used to navigate the scene.
20 When you’re done, click the Rewind button and drag to the left.
21 The Rewind tool passes over a strip of thumbnails, each of which
represents a previously selected navigation point. Release the mouse on
any thumbnail. The viewport rewinds to that point.
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22 Experiment with the Center, Walk, Look. and Up/Down controls in the
center of the SteerWheels icon. When you are done, click the arrow at
the bottom right of the wheel and from the menu, choose Go Home.
This repositions the viewport view to the Home viewpoint.
23 Click the small “X” in the top right of the wheel to hide the
SteeringWheels control.
TIP You can press Shift + W to redisplay the SteeringWheels controls.

Next, you'll create a camera and a Camera viewport. The Camera viewport is
similar to the Perspective viewport but with different functionality. You can
animate it, and add effects to it.
Creating a camera:
1 Right-click the Top viewport to activate it.
The viewport is outlined in yellow.

2 On the

Create panel, click

(Cameras), then click Target.

3 In the Top viewport, click behind and slightly to the right of the cannon,
then drag down to a point just left of the windmill (as shown in the
following illustration). Don’t worry about the exact camera placement
yet: You will adjust this later.
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To see what the camera sees, you now need to display one of the viewports
as a Camera viewport.
4 Right-click the Perspective viewport to activate it, then press C.
Right-clicking a viewport activates it and keeps any objects in other
viewports in a selected state (in this case, our camera object). Left-clicking
a viewport deselects previously selected objects.

5 On the main toolbar, click

(Select And Move).

A tripod of red, blue, and green arrows appears in the Top viewport. This
is the transform gizmo. As you move your cursor over the arrows, each
axis label and arrow stem turn yellow. When one is yellow, you can click
and drag to move the object in a single direction. If you move your cursor
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over the inner corners of the transform gizmo, the plane turns yellow.
This lets you move in a single plane.
6 Right-click the Left viewport, click the camera’s Y axis manipulator, and
drag it slightly upward so you can see more of the horizon in the
Camera001 viewport.

7 If the cannon is not visible in the Camera001 viewport, then in the Top
viewport drag the camera until the front of the cannon comes into view
in the Camera001 viewport, as shown in the next illustration.
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Next, you'll create a rock and a tree, then add them to the scene.

Creating a Rock and a Tree
In this lesson, you'll create two primitive objects, then modify their parameters
so they take on the appearance of a rock and a tree.
Set up the scene:
■

Continue from the previous lesson.

Create a rock:

1 On the
Create panel, click
Type rollout, click Sphere.

(Geometry), then in the Object

The button highlights to show that it is active and ready to use.
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2 Create a sphere in the Top viewport by holding down the left mouse
button anywhere to the front and left of the cannon (see the next
illustration) and dragging away from where you started. As long as you
hold the mouse button down, you can adjust the size of the sphere. When
you release the mouse button, the sphere is complete.
TIP Your sphere might be a different color from the one in the illustration.
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Create a sphere.
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The sphere in the camera viewport

3 On the
Modify panel ➤ Parameters rollout, change the Radius
setting to 25 and press Enter.

The sphere changes size in the viewport. In 3ds Max, it’s typical practice
to rough out an object with the mouse, then refine it on a rollout.
4 Click the Modifier List drop-down menu and choose the Noise modifier.
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5 In the Noise group, turn on Fractal, and in the Strength group, set X, Y,
and Z to 30.0.

The rock is taking shape, but it could be flatter.

6 On the main toolbar, click

(Select and Uniform Scale).

7 In the Camera001 view, drag the gizmo Z axis downward until the rock
object is about two-thirds its original height.
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Change the name of the sphere:
1 In the Modify panel object name field, double-click the name Sphere001
to highlight it.

2 Type in rock to change the name of the sphere. Press Enter to set the new
name.
NOTE Pressing Enter is an explicit way to change a parameter. 3ds Max also
accepts a parameter change as soon as you click anywhere else in the 3ds
Max window.
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Create a tree:

1 On the
Create panel, click
(Geometry), then from the
drop-down list (at present, it shows “Standard Primitives”), choose AEC
Extended.

AEC Extended objects are pre-built geometry, including railings, fences,
and plants. They are a fast way to add realistic details to a scene.
2 On the Object Type rollout, click Foliage.
3 On the Favorite Plants rollout, choose Generic Oak as the species of tree.
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4 Right-click the Top viewport to activate it, and add the tree to the scene
by clicking a point slightly below and to the right of the rock.
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Create a tree

To give the scene some atmosphere, we’ll make the tree appear stunted
and battle-scarred.
5 With the tree still selected, on the Modify panel ➤ Parameters rollout,
set Height to 150.
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6 In the Show group, turn off Leaves, and in the Level-Of-Detail group,
turn on Low to reduce the number of branches.
7 If you are not yet satisfied with the appearance of the tree, on the
Parameters rollout click New.
Each time you click this button, the Seed value is changed, causing the
tree to undergo a random reconfiguration.
8 When you are satisfied with the appearance of the tree, re-name the
Foliage001 object in the Name field using the same procedure you followed
for the rock. Call this object oak_tree.
9 If the tree is obscuring your view of the windmill, feel free to move it

aside using

(Select And Move) on the main toolbar.
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Next, you'll apply a material to your rock using the Material Editor.

Adding Materials to Objects In the Scene
You add realism to scene objects by adding materials to their surfaces. Material
texture can include information from bitmap images, as well as bump maps
for a 3D effect. In this tutorial the battlefield terrain, as well as the tree, rock,
cannon, and windmill, all get their appearance from bitmap texture mapping.

Cannon texture
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Rock texture

Set up the scene:
■

Continue from the previous lesson.

Add a battlefield material:

1 On the main toolbar, choose
(Material Editor) from the Material
Editor flyout to open the Compact Material Editor.
The Material Editor opens as a floating window.
The Compact Material Editor is usually more convenient when you want
simply to assign materials that have already been designed. The Slate
Material Editor, which takes up more screen space, is more convenient
and versatile for designing materials.
NOTE If you open the large Slate Material Editor by mistake, then from the
Material Editor toolbar choose Modes ➤ Compact Material Editor.
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By default, the Compact Material Editor shows six sample slots, each of
which is capable of holding a material. Typically, you would have multiple
materials to choose from, so you might prefer to expand the number of
sample slots selectable from the editor.
2 Click any sample slot to select it. A white outline shows the slot is active.
Right-click and from the list, choose 5 x 3 Sample Windows. You now
have 15 sample slots for future use.
3 Locate the Battlefield material sample slot and click it.
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Notice that the name Battlefield appears in the Material Name field below
the sample slots.
This material has already been constructed for you. It uses a bitmap as a
texture and includes a bump map.
4 Drag the Battlefield material from its sample slot and drop it onto the Field
object in the Camera001 viewport.
The viewport now displays a landscape covered by grass and dirt.
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5 Drag the Stone material from its sample slot onto the rock object in the
viewport. The stone surface updates to a realistic texture.
Next, you will apply a material to the cannon.
All parts of the cannon were previously grouped together into a single
entity, called a selection set. This way, when you choose a material, it is
applied to all components in the selection set in a single action.
6 From the main menu Named Selection Sets drop-down list, choose
Cannon.

7 On the Material Editor, click the Cannon sample slot and then click
(Assign Material To Selection).
This method is another way to apply materials to selected objects.
The oak tree and windmill already have materials applied to them, so
now you’re ready to begin animating the scene.
8 Save your scene to your local folder as my_battlefield_scene.max.
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Animating the Scene
In this lesson, you'll bring the battlefield scene to life by animating scene
objects.
You'll do this with keyframe animation. The Auto Key tool in 3ds Max lets
you record the physical characteristics of an object at any given point in time.
This state in time is called a keyframe. 3ds Max then figures out all the
in-between states from one keyframe to the next, for a smooth transition of
the object.
The following procedure consists of two animations. Between frames 0 to 120,
you will advance the cannon to its firing position, next to the rock. Between
frames 120 and frame 160, you will raise the cannon barrel in preparation for
the first shot.
3ds Max gives you three different ways to create keyframes. One is to turn on
the Auto Key button, move to any point in time, and transform (move, rotate,
or scale) the object. A second method is to right-click the time slider and then
set keys using the Create Key dialog. There is also a Set Key animation mode,
designed for professional character animators.
In this exercise, you’ll use the Auto Key button.
Set up the scene:

■

Continue with your own scene, or

open battlefield_scene.max.

Animate the position of the cannon:

1 Right-click the Top viewport, then
zoom in and
scene so that the cannon and rock are clearly in view.

pan the

2 On the main toolbar, click
(Select And Move), then hover your
mouse over the rear portion of the cannon.
After a moment, a tooltip appears that says frame.
The tooltip indicates your selection tool is hovering over the frame object.
In this scene, frame is the parent object of the cannon, meaning that if
it moves, the rest of the cannon assembly moves with it.
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3 Click the frame object to select it.
4 The time slider is the wide button located directly above the time scale
display below the viewports. Drag the time slider to frame 120 (to create
a 4-second animation when played back at 30 frames a second).

5 Click

(Auto Key) to turn it on.

The button turns red. You are now in automatic animation mode.

TIP The time slider bar also turns red, and the active viewport is outlined in
red to remind you that you are in Auto Key mode.
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6 In the Top viewport,
select the frame object and drag it on its
Y axis until the cannon is lined up next to the rock.
Autokey interpolates, or averages out, the cannon position at each frame
from its start position at frame 0 to its final resting place at frame 120.

7 Turn off

(Auto Key).

TIP To avoid accidentally creating unwanted animation, develop the habit
of turning Auto Key off after animating each movement.
8 Move the time slider back and forth from frame 0 to frame 120, and
watch the cannon move forward.
Notice how animation has already been applied to the windmill in the
background.
Add a second animated movement:

1 Turn on

(Auto Key) and advance to frame 160.

2 Press H on the keyboard.
3ds Max opens the Select From Scene dialog.
3 Choose the barrel object from the list, and click OK.
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You might have to scroll, or resize the Select From Scene dialog, in order
to find the barrel entry.

4 On the main toolbar, click

(Select And Rotate).

5 In the Camera viewport, rotate the barrel on its X axis by –10 degrees.
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As you modify the barrel rotation, the axis values update in yellow.
6 Drag the start keyframe at frame 0 to frame 130.

7 Turn off

(Auto Key).

8 In the animation playback controls, click

(Go To Start), then click

(Play Animation).
Watch the animated cannon prepare its deadly attack on the windmill.

9 Click
(Stop, in the same location as the Play button) when you
are done watching the animation.
10 Save your scene to your local folder, this time as
my_battlefield_attack.max.

Animating the Scene | 57

Rendering the Animation
Rendering multiple frames for a complete animation can be time consuming,
even on a fast machine, because each frame is individually processed. Realistic
materials, shadow casting, and other factors can slow the process as well. This
scene is relatively simple however, so it shouldn’t take that long to render.
Set up the scene:

■

On the Quick Access toolbar, click
(Open File) and open your saved
animation, my_battlefield attack.max. Or, open battlefield_attack.max, located
in the \scenes\startup folder.
NOTE If you saved your completed files to a folder other than \scenes\startup,
when you open one of your files you might encounter messages about missing
files. If you run into this problem, click the Browse button on the Missing
External Files dialog. This opens the Configure External File Paths dialog. Click
the Add button. Use the Choose New External Files Path dialog to navigate to
the folder where you loaded the original file, and then click Use Path. Click
OK, and then click Continue.

Render your animation:
To complete this tutorial, render the animation you made earlier. The rendering
time is probably under 15 minutes, depending on the speed of your machine.

1 On the main toolbar, click

(Render Setup).

3ds Max opens the Render Setup dialog.
2 In the Time Output group, choose Active Time Segment. (If you left the
setting at Single, just the currently displayed frame would render.)
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TIP If your computer is fast, you may skip the next step.
3 In the Output Size group, change the default (640 x 480) to 320 x 240.

This smaller size has only one-quarter the area of the default, making it
much faster to render.
4 In the Render Output group, click the Files button. (You might have to
scroll down in order to see this control.)
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5 On the Render Output File dialog, name your animation
mybattlefield_attack.avi. Click Save to save the animation to the default
folder (usually \renderoutput).
WARNING You must either add the extension .avi in the file name, or else
select AVI as the file type. If you don't tell the program what type of animation
format to save in, the rendering won't work.
6 On the AVI File Compression Setup dialog, do the following:
■

If necessary, change the compressor to Cinepak Codec. There are
many different codecs to choose from. Cinepak generally gives
satisfactory results and is commonly installed on Windows machines,
meaning your compressed AVI file can be read by wide audience.

■

Set Quality to high, between 90 and 100.

■

When you’re finished, click OK.

On the Render Setup dialog, Save File is now on and the output field
shows the location of mybattlefield_attack.avi.
7 At the bottom of the Render Setup dialog ➤ View list, choose Camera01.

Always check to be sure you’re rendering the right viewport.
TIP In most cases, you will render the camera viewport.
8 Click Render to begin the rendering process.
Watch a few frames to make sure that the rendering gets off to a good
start. The Time Remaining estimate gives you an idea of how long the
rendering will take.
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Play the rendered animation:
1 When your animation is finished rendering, choose Rendering menu ➤
View Image File.
By default, the View File dialog opens in the \renderoutput subfolder.
2 Highlight mybattlefield_scene.avi and click Open to display the Media
Player.
3 In the Media Player, play your animation.

Summary
You have learned how to find your way around the 3ds Max user interface
while creating an animated scene. You now know how to navigate the
viewports, create simple objects using primitives, and assign materials to them.
You've also learned how to move objects as well as animate and render your
animation.
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Modeling Tutorials

3

Modeling in 3D is similar to sculpting. Many different techniques can be used to create the
objects in your scene. The techniques you learn in these tutorials can be adapted to any style
of modeling you need to perform. For instance, if you're building models that will be
incorporated into a game, you'll be most interested in low polygon modeling techniques. The
same techniques will be equally beneficial when building highly detailed models for
architectural presentations or motion pictures.

Beyond modeling techniques, the Façade tutorial also exposes you to the Material Editor and
shows you how to apply materials to objects in your scene. That familiarity will help when
you do the materials and mapping tutorials on page 1057 (or you might want to go through
the Materials tutorials first, then return to the Façades section).
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Features Covered in This Section
■

Creating primitive objects

■

Using a modifier to alter an object's shape.

■

Creating and editing spline objects

■

Converting splines into geometry

■

Using images to assist your modeling

■

Editing a model at sub-object levels

■

Using the Graphite Modeling Tools ribbon to edit Editable Polygon objects

Modeling a Helmet Using the Ribbon
The Graphite Modeling Tools ribbon, referred to in this tutorial simply as “the
ribbon,” is a customizable toolbar that provides you with all the tools you
need to edit Editable Poly surfaces.

64 | Chapter 3 Modeling Tutorials

In this tutorial, you will use the ribbon modeling tools to create a Viking
helmet.
In this tutorial, you will learn how to:
■

Use the Symmetry modifier to mirror edits to one side of a model.

■

Create loops by connecting polygon edges.

■

Extend polygons using various extrusion techniques.

■

Create beveled and inset shapes.
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Skill level: Beginner to Intermediate
Time to complete: 1 hour

Using Basic Polygon Editing to Create a Helmet
When you model rounded objects, such as the helmet in this tutorial, we
recommend that you avoid using a sphere as a starting point.
The next illustration shows the polygons that make up a sphere. The top of
the sphere is composed of triangular polygons whose vertices tend to pinch
together at the pole. This can lead to problems later on.

Top of sphere with vertices pinched together at its pole

It is therefore best to model a rounded object, other than an actual sphere,
using rectangular polygons only. You will use this technique in this lesson.
Create the basic helmet shape:
1 Start 3ds Max.
By default, a minimized version of the Graphite Modeling Tools ribbon
displays directly below the main toolbar.
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NOTE The ribbon on your workstation might display differently if you
customized the ribbon in a previous 3ds Max work session. This tutorial
assumes you are using the default configuration.

2 Click the
displays.

expand/minimize icon a few times until the full ribbon

The tools in the Polygon Modeling tab are inactive, since no polygon
model exists in the scene.
3 From the Customize menu, choose Units Setup, and in the Units Setup
dialog ➤ Display Unit Scale group, make sure Generic Units is chosen.
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4 Activate the Perspective viewport, and press Alt+W to maximize it.

5 On the
Create panel, activate
Object Type rollout, click Box.

(Geometry), then on the

6 Drag to create a box of any size.

7 On the
Modify panel ➤ Parameters rollout, set Length, Width,
and Height to 50.0.
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Currently, the pivot point is at the base of the object. You need to set
this point to the center of the box so you can manipulate the object more
easily.

8 In the
Hierarchy panel ➤ Adjust Pivot rollout ➤
Move/Rotate/Scale group, click Affect Pivot Only to turn it on.

9 In the Alignment group, click Center To Object, then click Affect Pivot
Only again to turn it off.
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10 On the main toolbar, click
box.

(Select And Rotate) and rotate the

The box now rotates around the object’s center of mass.

11

Undo the rotation.

12 Right-click the box, and choose

Transform ➤ Move.

13 Right-click the X, Y, and Z transform spinners to set each of them to 0.0.

The center of the box is now at the center of the world coordinates.

14 Click

(Select Object) to turn off the Move tool.

Turn the box into a sphere:

1 On the
Modify panel ➤ Parameters rollout, set Length Segs,
Width Segs, and Height Segs to 4.
2 Press F4 to turn on Edged Faces, so you can see the segment divisions in
the viewport.

70 | Chapter 3 Modeling Tutorials

After you press F4, the Shading viewport label should show
“Smooth+Highlights+Edged Faces.”
3 From the Modifier list, choose Spherify.
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Box with Spherify modifier applied

The object is deformed into a spherical shape, but retains its geometric
composition of easily editable quadrilateral polygons.
You only need a hemisphere to create the helmet, so next you will delete
the lower half of the box and deform the remaining polygons into a
conical shape.
Refine the shape:
1 In the viewport, right-click the sphere and choose Convert To ➤ Convert
To Editable Poly.
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The ribbon updates to display a range of polygon-editing tools.
2 Click the Point-Of-View (POV) viewport menu (at present, it reads “[
Perspective ]” and choose Front as the view to display.

3 On the ribbon ➤ Polygon Modeling panel, click

(Vertex) to go

to the Vertex sub-object level.
Region-select all the vertices in
the lower half of the object (but not the equator), then press Delete.
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You now have a hemispherical dome for the helmet. Next, you will give
the object a slightly conical shape.
4 Click the POV viewport label again, and return to the Perspective view.

5

Select the vertex at the top of the helmet and move it upward
along the Z axis.

74 | Chapter 3 Modeling Tutorials

Top vertex after transformation in Z

Notice that only the polygons that share the vertex are deformed. You
need to use Soft Selection to involve the adjacent vertices and polygons
as well.

6

Undo the vertex move.

Use Soft Selection to shape the helmet:

1 On the ribbon ➤ Polygon Modeling panel, click
Selection) to turn it on.

(Soft
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At the end of the ribbon, on the right, 3ds Max displays a Soft Selection
panel, which provides options that control how the soft selection is
carried out.
2 On the Soft Selection panel, set Falloff to 30.0.

3

Move the top vertex of the helmet upward along the Z axis
again, until the object appears similar to that in the next illustration.
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4 On the ribbon ➤ Polygon Modeling panel, click
Selection) again to turn it off.

(Soft

Next, you will use the MeshSmooth tools to smooth out the helmet
surface.
5 In the viewport, drag to select all the object vertices (or press Ctrl+A), and
then on the ribbon ➤ Subdivision panel, click MSmooth.
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This option takes each polygon and divides it into four, making a
smoother, more detailed geometry.

6 On the ribbon ➤ Polygon Modeling panel, click
this sub-object level.
Save your work:
■

Save your scene as my_helmet_01.max.

78 | Chapter 3 Modeling Tutorials

(Vertex) to exit

Working in Symmetry Mode to Add Detail to the Helmet
In this lesson, you will work in symmetry mode on half the helmet. This way,
any changes you make will be perfectly mirrored for the other half.
Set up the lesson:

1 Continue from the previous lesson, or
open helmet_01.max. This
scene is in the folder \scenes\modeling\helmet\.
NOTE If a dialog asks whether you want to use the scene’s Gamma And LUT
settings, accept the scene Gamma settings, and click OK. If a dialog asks
whether to use the scene’s units, accept the scene units, and click OK.

2 If you open the new file, then
select the helmet object, and on
the ribbon ➤ Polygon Modeling panel, click Modify Mode.

When active, Modify Mode makes the entire array of Graphite Modeling
Tools available.
Add the Symmetry modifier:

1 On the Polygon Modeling panel, activate
Polygon sub-object level.

(Polygon) to go to the
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2 Click the ribbon’s Selection tab.

3 On the By Half panel, click

80 | Chapter 3 Modeling Tutorials

(Y), then click

(Select).

This selects half the object based on its Y axis orientation.
4 On the By Half panel, click Invert Axis.

The polygon selection is inverted. The new selection contains the
polygons we want to remove.
5 Press Delete.
You will now add a Symmetry modifier to these polygons so that their
geometry can be mirrored.
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6 On the ribbon, click the Graphite Modeling Tools tab. With the helmet

object still selected, go to the
List choose Symmetry.

Modify panel and from the Modifier

7 On the Parameters rollout ➤ Mirror Axis group, choose the Y option
and turn on Flip.

This properly orients the mirrored half of the helmet.
Notice how the ribbon displays a limited set of modeling tools. This is
because the Symmetry modifier is active.

8 On the ribbon ➤ Polygon Modeling panel, click
Modifier).

(Previous

Now the Editable Poly object is active again, and the ribbon displays an
expanded set of tools for polygon editing.
The mirrored half of the helmet is hidden in the viewport because with
the polygon editing controls displayed, you are editing the source
polygons only.

9 On the Polygon Modeling panel, click
(Show End Result) to see
the mirrored side of the helmet controlled by the Symmetry modifier.
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10 Click

(Show End Result) again to turn it off.

Preview mesh smoothing:

1 On the Edit panel, click

(Use NURMS).

The Use NURMS panel displays at the right of the ribbon. (NURMS is
short for Non-Uniform Rational MeshSmooth.)
2 On the Use NURMS panel, set Iterations to 2.
This smooths out the object by adding more polygons to the geometry.
It is best to specify an Iterations value of no more than 3, because each
time you increase iterations by one, the number of vertices and polygon
faces can increase by a factor of four. This can result in a lengthy
calculation time.
3 If the Show Cage button is already on, turn it off to better see the
geometry added by the NURMS iterations.
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4 On the ribbon ➤ Edit panel click

(Use NURMS) to turn it off.

Next, you will add two extrusions that will form the rim of the helmet
and its vertical ridge.
Select the seam and rim faces to extrude:

1 On the Polygon Modeling panel, activate
Edge sub-object level.

2 In the viewport,

(Edge) to go to the

select a polygon edge as shown in the next

illustration, then on the Modify Selection panel, click
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(Ring).

3ds Max selects all edges parallel to the first one, in a ring around the
object.
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3 On the Loops panel, Shift+click

(Connect).

3ds Max draws a single loop of edges around the selected edges. It also
displays the “caddy” controls for the Connect tool.
(When you Shift+click a tool on the ribbon, 3ds Max displays the caddy
controls for that tool.)
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By default, the loop is placed in the center of the selected edges, but the
negative Slide value you will specify in the next step will position it to
the left of center.
4 On the third control of the caddy, Slide, drag to the left until the value

equals –50, and then click

(OK).
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Edge slides to the left

5 In the viewport,
click to select a vertical edge on any polygon
at the bottom row of the helmet, then on the ribbon ➤ Modify Selection
panel, click

(Ring).

The Ring tool automatically selects all the vertical edges.
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6 On the Loops panel, Shift+click

(Connect).

Once again, 3ds Max displays the caddy controls for the Connect tool.

7 Change the value of the Slide control to –25, then click

(OK).
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8 On the Polygon Modeling panel, turn on
(Show End Result) to
see how the Symmetry modifier has added a mirrored portion to the
helmet.

9 Right-click the helmet and choose Transform ➤ Convert To ➤ Convert
To Editable Poly.
The Symmetry modifier is removed and all the mirrored polygons are
integrated into the model.

90 | Chapter 3 Modeling Tutorials

Select the helmet seam and rim:

1 On the ribbon ➤ Polygon Modeling panel, activate

(Edge).

2 On the Modify Selection panel, click Loop Mode to turn it on.

3

Click to select one of the edges along the center edge of the
helmet.

Working in Symmetry Mode to Add Detail to the Helmet | 91

Because Loop Mode is on, 3ds Max selects the entire loop of edges along
the helmet ridge.
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4 With Loop Mode still active, hold down the Ctrl key, then click an edge
along the rim of the helmet.
3ds Max selects the rim edges as well as the ridgeline.
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5 Hold down the Ctrl key again, and on the ribbon ➤ Polygon Modeling
panel, activate

Polygon.

3ds Max selects all the polygons adjacent to the edge selection.
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Extrude the helmet seam and rim:

1 On the Polygons panel, Shift+click

(Extrude).

3ds Max displays the caddy controls for the Extrude tool.
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2 On the first control, Group, choose Local Normal from the drop-down
list.
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3 On the third control, Height, change the value to 1.0 , then click
(OK).
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4 On the ribbon ➤ Polygon Modeling panel, click
selection to exit the sub-object level.

5 On the Edit panel, click

(Polygon)

(Use NURMS) and on the Use NURMS

panel, click
(Show Cage) to hide the cage, then press F4 so you
can see the end result without edged faces.
6 On the Use NURMS panel, set iterations to 2 to further smooth out the
helmet.
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Helmet with middle seam and rim extrusions

In the next procedure, you will add more edges to create a less rounded
extrusion to the rim and ridge.

7 On the ribbon ➤ Edit panel, click
NURMS mode.

(Use NURMS) to turn off

8 Save your scene as my_helmet_02.max.
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Set up the scene:

1 Continue working on your scene, or

2 If you opened the new file,

the

open the scene helmet_02.max

select the helmet, and make sure

Modify panel is active.

Refine the extrusions:
1 In the viewport, switch to a Left view. If the viewport is shaded, press F3
to turn off shading and see the helmet in Wireframe view.
Notice the slight wave to the extruded rim of the helmet.

2 On the ribbon ➤ Polygon Modeling panel, activate

then
bottom.

(Vertex),

region-select the row of vertices that is second from the
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3 On the ribbon ➤ Align panel, click
(Align Z) to align all the
vertices along their average orientation on the Z axis.

4 Switch to a Top view and
of the ridge extrusion.

region-select the vertices on one side
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5 On the ribbon ➤ Align panel, click
(Align Y) to align all the
vertices along their average orientation on the Y axis.
6 Region-select the vertices on the opposite side of the ridge extrusion, and

click

(Align Y) again.

Now the edges of the extruded ridge are also straight.

7 Change the viewport to a Perspective view once again.
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8 On the ribbon ➤ Polygon Modeling panel, activate

9 On the Modify Selection panel, click to turn on

10

(Edge).

(Ring Mode).

Click to select one of the horizontal edges just on the near side
of the ridge of the helmet.

Working in Symmetry Mode to Add Detail to the Helmet | 103

Ring Mode selects all edges parallel to the one you clicked.

11 On the Loops panel, Shift+click

(Connect).

3ds Max displays the caddy controls for the Connect tool.
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12 Set the value of the third control, Slide, to 83, so the new edge loop is

very close to the base of the ridge, and then click

(OK).
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Loop slides to the left

13

Orbit the viewport so you can see the other side of the ridge of
the helmet.
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14 On the Edit panel, turn on

(Swift Loop).

15 Drag the mouse over the surface of the helmet. A green virtual loop
appears as you drag the mouse. It lets you visualize where to place the
loop.
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Click to place a new, vertical edge loop on the near side of the helmet.
Like the loop you placed on the opposite side, it should be close to the
base of the extruded ridge.

SwiftLoop provides a fast way to create and position a loop on a model.
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16 Use Swiftloop again to place a horizontal edge loop, this one just above
the helmet’s extruded rim.
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Click to create the loop.

Adding these parallel edge loops reinforces the existing edges, so they
won’t be smoothed as much as you saw in the previous lesson.

17 Click

18 Click

(Swift Loop) to turn it off.

(Edge) to exit the Edge sub-object level.

View the helmet with smoothing:

1 On the ribbon ➤ Edit panel, click
(Use NURMS) to turn it on,
then press F4 to turn off edged faces and see how the added edge loops
give the base of the extrusions a sharper angle.
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Helmet showing sharper extrusions

2 Press F4 to display Edged Faces again, and click
turn it off and redisplay the underlying model.

(Use NURMS) to

Save your work:
■

Save your scene file as my_helmet_03.
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Using Extrusions to Add Horns to the Helmet
This lesson shows you how to create a pair of twisting horns. It uses extrusions
and transforms; it also demonstrates spline extrusion as a simple alternative
to multiple extrusions.
Once again, apply a Symmetry modifier to mirror the edits you make to one
half of the helmet.
Set up the lesson:

1 Continue working from the previous lesson, or
helmet_03.max.

2 If you opened the new file,

the
it off.

open

select the helmet, and make sure

Modify panel is active. Click

(Use NURMS) to turn

Split the model in half and apply a Symmetry modifier:

1 On the ribbon ➤ Polygon Modeling panel, activate

(Polygon).

Select the polygons on the left half of the helmet (from your
point of view), and then press Delete.
2 Apply a Symmetry Modifier, and adjust its settings as described in the
previous lesson:
■

Axis = Y

■

Flip = on

On the Modify panel, you can toggle
sure the helmet is mirrored correctly.
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(Show End Result) to make

3 On the ribbon ➤ Polygon Modeling panel, click
Modifier) to go to the Editable Poly level.

(Previous

Adjust vertices at the base of the horn:

1 On the ribbon ➤ Polygon Modeling panel, activate

(Vertex).

2 On the ribbon ➤ Edit panel ➤ Constraints group, activate
(Constrain To Edge).

This ensures that the transform of any vertex will slide along the edges
of the polygon to which it belongs.

3 Change the viewport to a Left view. If you need to, click
Extents) to get a good view of the helmet.

(Zoom

4 On the main toolbar, activate
(Select And Move), then select a
vertex in the upper region of the helmet and move it as shown in the
next illustration.
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5 Select the vertex that is opposite the central vertex, and
move
it as well. Also move the vertices above and below the central vertex. The
goal is to create a symmetrical shape that is roughly circular.

6 On the ribbon ➤ Edit panel, activate
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(Constrain To None).

IMPORTANT When you forget that a constraint is on, surprising things can
happen when you transform sub-objects. Because of this, it is a good idea to
deactivate a constraint as soon as you have finished using it. Also, the buttons
in this set behave like radio buttons. You can’t turn a constraint off by clicking
its button a second time: You must activate Constrain To None to deactivate
the currently active constraint.

Create the base of the horn:

1

Select the vertex at the center of the circular group of polygons.

2 On the ribbon ➤ Polygon Modeling panel, Ctrl+click

(Polygon).

This automatically selects all the polygons that share the vertex.
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3 Switch the viewport back to a Perspective view, and
can see all of the base of the horn.
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Orbit so you

4 On the Polygons panel, Shift+click

(Inset).

5 On the Inset caddy, drag the Amount spinner (the second control) to a

value of approximately 0.25, and then click

(OK).
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This creates an inset edge for the selected polygons.
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Use extrusion and bevel to create the socket for the horn:

1 On the Polygons panel, Shift+click

(Extrude).

2 On the first control of the caddy (extrusion type), choose Group from
the drop-down menu.

3 Set Extrusion Height to approximately 3.0, and then click

(OK).
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4 On the Polygons panel, Shift+click

(Bevel).

5 On the Bevel tool caddy, set the Height value (second control) to 0.25

and the Outline value (third control) to –0.5. Click
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(OK).

Helmet horn socket after first extrusion and bevel

6 On the Polygons panel, Shift+click

(Inset).

7 On the Inset tool caddy, set Amount (the second control) to 0.35, then

click

(OK).
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8 On the Polygons panel, click

(Bevel).

9 Drag the selected polygons slightly toward the inside of the helmet, then
release the mouse and drag slightly down to bevel the extrusion slightly
in toward its center. Click once to end the operation.
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Horn socket after second inset and bevel

10 Click
(Extrude) again, and drag away from the helmet until the
polygons extend slightly beyond the socket. Click to end the extrude
operation.
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Helmet horn ready for spline-based extrusion

At this point, you could continue to create the horn by using the Move,
Rotate, and Scale tools, coupled with the Extrude, Bevel, and Inset polygon
tools. Instead, you will guide the extrusion by means of a path.
Draw a spline for extruding the horn:

1 On the
Create panel, click
Type rollout, click Line.

(Shapes), then on the Object

2 On the Creation Method rollout, choose Smooth for both Initial Type
and Drag Type.
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3 Press Alt+W to view all four viewports, and in the Top view draw a line
extending from the horn socket. Click, drag, and click again, until you
have created a line of four or five vertices. Right-click to end Line creation.

4 In the Front view,
move the line along its Y axis until it is
centered on the horn socket. Move it along the X axis too, if you need
to.
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5 Go to the
(Vertex).

6

Modify panel ➤ Selection rollout, and activate

Maximize the Perspective view and
move the line’s
vertices until they form the shape of the horn you want to create.
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7

Double-check and refine your Line edits in the other viewports.
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Left view

8 Click

(Vertex) once more to turn it off.

Extrude the horn:

Select the helmet, then on the ribbon ➤ Polygon Modeling

1

panel, click

2 Activate
it on.

(Previous Modifier) to go to the Editable Poly level.

(Polygon), then click
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(Show End Result) to turn

3 On the Polygons panel ➤ drop-down panel, Shift+click Extrude On
Spline.

The caddy controls for spline extrusion are more numerous than for most
caddies.
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4 Click the last of the controls, Pick Spline, and then click the spline you
drew earlier.

After you click the spline, 3ds Max grows horns, but these have no taper,
yet.
5 (Optional.) On the caddy, click Extrude Along Spline Align to turn it on.
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3ds Max aligns the spline to the normals of the original faces, making
the horns more perpendicular to the rest of the helmet. This might or
might not be a good effect, depending on the spline you drew.
NOTE You can also try adjusting the values of Twist and Rotation (available
only when Align is turned on).

6 Change the value of Taper Amount to about –0.5, then click
And Continue).

(Apply

3ds Max extrudes the horns still further. This is easier to see in other
viewports, but you can also navigate the Perspective view, as shown in
this illustration.
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7 Change the Taper Amount so the horns come to a point (for the illustrated

helmet, the value was –0.955). Click
and finish creating the horns.
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(OK) to finalize these changes

By extruding the horns along a path, you saved yourself a great deal of
back-and-forth between the transform and polygon modeling tools.

8 On the ribbon ➤ Polygon Modeling panel, click
to turn it off.

(Polygon) again

Make the helmet a single object once again:

1 On the Edit panel, make sure
(Use NURMS) is off. NURMS
smoothing needs to be off before you transform the helmet into an
Editable Poly: Otherwise, you wind up with a model that has far too many
faces.
2 In a viewport, right-click the helmet, choose Transform ➤ Convert To
➤ Convert To Editable Poly, then press F4 to turn off edged faces.
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The Symmetry modifier is removed and all the mirrored polygons are
integrated into the model.
3 Press F4 again to turn edged faces back on.
Save your work:
■

Save your scene as my_helmet_04.
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Using Freeform Tools to Add Spikes to the Helmet
In this lesson, you will use a variety of freeform tools to create a ridge of
irregular spikes for the Viking helmet.
Set up the lesson:

1 Continue working from the previous lesson, or
helmet_04.max.

2 If you opened the new file,

the

open

select the helmet, and make sure

Modify panel is active.

Remove the middle seam from the helmet ridge:

1 On the ribbon ➤ Polygon Modeling panel, activate

2 On the Modify Selection panel, click

(Edge).

(Loop Mode) to turn it on.

You will use this tool to remove the edge loop in the middle of the helmet
ridge.

3

Click a vertical edge along the middle seam of the helmet ridge.
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Loop mode selects the entire edge loop that forms the middle seam.
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4 On the Edges panel, click

5 Activate the

(Remove).

(Vertex) sub-object level.

Notice that while the loop edges have been deleted, their vertices remain.
You want to remove the vertices as well.
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Unwanted vertices left over from edge removal

6

Undo the Remove operation so that the loop redisplays.

7 Activate

(Edge) again, then on the Edges panel, Ctrl+click
(Remove).

Ctrl+Remove removes the vertices as well as the edges.
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Both edges and vertices removed

Subdivide the ridge into rectangular faces:

1

Click and Ctrl+click to select two of the longer vertical edges on
either side of the helmet ridge, as shown in the next illustration.
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2 On the Loops panel, Shift+click

(Connect).

3 On the caddy controls for Connect, make sure Segments is set to 1 and

Pinch and Slide are set to 0, then click
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(OK).

These values ensure you are connecting the edges just once, with no
offset.
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4

Select the next pair of edges above the ones you just connected,
and click

(Connect) to add horizontal edge to the ridge.

5 Repeat the previous step for each pair of edges along the ridge, except
for the shorter edges just above the rim of the helmet. Stop when you
have connected edges on the rear side of the helmet as well as along the
front.
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Create irregular spikes using the Freeform tools:

1 On the ribbon ➤ Polygon Modeling panel, activate

2

(Polygon).

Select the polygon at the base of the ridge.
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3 Adjust the Perspective view to make sure you are looking at the helmet
from an oblique angle.
NOTE If you start extruding the polygon while looking at the model head
on, the extrusion will take on a 2D appearance.
4 On the ribbon, click the Freeform tab, and on the PolyDraw panel, click
(Branches).

5 Shift+drag the selected polygon outward, away from the helmet, then
release the mouse.
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Helmet after first Branch extrusion

6 Ctrl+click to select the polygon two above the one you just branched,
then Shift+drag it to create another branch.
7 Continue extruding every second polygon until the entire ridge is
complete.
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As you progress along the helmet, make sure you maintain an oblique
view of the polygons. If you don’t like the shape of an extrusion, or you
extrude the wrong polygon, press Ctrl+Z to undo the operation.
8 Click the ribbon ➤ Graphic Modeling Tools tab again.

9 On the ribbon ➤ Polygon Modeling panel, click
to turn it off, then press F4 to turn off edged faces.
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(Polygon) again

10 On the Edit panel, click

(Use NURMS) to turn it on.

The helmet geometry is smoothed out and ready to accept materials.

Summary
Throughout this tutorial, you used a number of modeling tools on the Graphite
Modeling Tools ribbon to create a Viking helmet. While these tools are also
available from the Command panel, the ribbon gives you faster access, in
context, as you need them.
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This tutorial only scratched the surface of the many ways in which you can
use the ribbon for editing mesh and polymesh objects. For a full description
of the ribbon tools, consult the 3ds Max help. For more extensive exercises
in polygon modeling, see Using Photos to Model Façades on page 148 and
Modeling an Airplane on page 283.

Using Photos to Model Façades
With a photo of a building, you can create a remarkably realistic model. This
tutorial shows you how to do so.

Model of house fronts on a plaza

In this tutorial, you will model two house fronts, based on photos of buildings
in the plaza of Monpazier, a 13th-century bastide (fortified town) in Dordogne.
The illlustration shows these houses, along with two others (in the actual
plaza, the houses occupy different positions).
You use each photo both to construct the façade and to texture it. In a way,
you are “reverse engineering” the original architecture. Each house is
constructed as an Editable Poly object: You will use various polygon-editing
tools to give the façade depth so it can cast realistic shadows, and then use
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the Unwrap UVW modifier to adjust the texture and improve the model’s
appearance.
TIP If you are not familiar with using the Material Editor and texture-mapping
modifiers, you might want to go through the Materials And Mapping tutorials on
page 1057 first, then return to this tutorial.
WARNING The techniques used in this tutorial are suitable for modeling
architecture and other stationary objects. They aren’t suitable for modeling organic
meshes, especially ones that you want to animate by using a feature such as the
Skin modifier or Physique. In this tutorial, we create irregular meshes that include
multisided polygons. A deformable mesh, by contrast, should contain only square
or triangular polygons of fairly uniform size (if you plan to turn the mesh into a
subdivision surface by using the HSDS modifier, then it should contain only square
polygons before you apply HSDS).
See Modeling an Airplane on page 283 for an example of mesh modeling with
more-or-less regular polygons.
Skill level: Intermediate
Time to complete: 3 hours

Some Pointers: Preparing a Photo Before You Use It to Build a Model
This section explains how to prepare photos for use in the kind of façade
modeling the tutorial demonstrates. You might want to read it if you plan to
take your own photos (or scans) to use in a similar way. Or you might want
to skip this section, do the tutorial itself, and then read this material later.
In a photograph, as in the human eye, parallel lines appear to converge. But
to create a façade in 3ds Max, horizontal lines should be horizontal, and
vertical lines should be vertical. So you will almost always need to use a graphic
editing program, such as Photoshop, to adjust the photo before you use it as
a texture.
For example, here is the original photo used to create “Façade 4,” the second
building you construct in the tutorial:

Using Photos to Model Façades | 149

Superimposing guidelines on the house, shows that the groundline is
horizontal, and the left side is close to vertical, but that the right side needs
adjusting:
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Using a perspective-correction or “distortion” tool, lets you align the sides of
the house to the guides:
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NOTE Perspective-correction or “perspective-control” lenses are available to
eliminate the vertical, or “third” vanishing point, and make the vertical sides of a
building appear parallel. But such a lens is a specialized, expensive piece of
equipment.
A view camera, which uses a bellows for the body, can be set to accomplish
perspective correction, too. But view cameras are not in widespread use, these
days.
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A photo editor has other uses. In this example, we wanted to remove the little
girl standing in the archway:

... Which is easy to do with most such programs:
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The final step is to crop the image to the dimensions of the house itself:
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This final image becomes the bitmap used to construct and to texture the
house in Modeling the Second House on page 233.

Creating the First House
The first house, which we will call Facade1, is based on a single photograph,
adjusted in the way described in Some Pointers: Preparing a Photo Before You
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Use It to Build a Model on page 149. In this lesson, you take several steps to
set up the scene and the modifier stack, so that modeling will go more easily
when you add detail to the façade.

Begin Building the Model
The house begins as a simple plane.
Set up the scene:

■

On the Quick Access toolbar, click
(Open File), navigate to the
\scenes\modeling\facades folder, and open facade_modeling_start.max.
NOTE If a dialog asks whether you want to use the scene’s Gamma And LUT
settings, accept the scene Gamma settings, and click OK. If a dialog asks
whether to use the scene’s units, accept the scene units, and click OK.
The scene contains a plane to model the pavement, a Daylight system with
a sky dome, and a few cameras that are hidden.

Optimize bitmap display in viewports:
1 On the main toolbar, choose Customize ➤ Preferences.
2 Go to the Viewports tab, then click Display Drivers ➤ Configure Driver.
3ds Max opens the configuration dialog for the graphics driver you are
using (Software, OpenGL, or Direct3D).
3 Depending on the driver, there are either one or two check boxes labeled
Match Bitmap Size As Closely As Possible. If there is one, turn it on. If
there are two, turn on both of them.

156 | Chapter 3 Modeling Tutorials

Creating the First House | 157

Configuration dialog for the Direct3D driver

4 Click OK to close the driver configuration dialog, and OK again to close
the Preferences dialog.
5 If you had to turn on Match Bitmap Size As Closely As Possible, then exit
3ds Max. Restart 3ds Max before you continue with this tutorial.
Bitmap configuration changes do not take effect immediately: You always
have to restart 3ds Max.
If you did not have to change the Match Bitmap Size setting, you can
continue without restarting 3ds Max.
Make sure Use Real-World Texture Coordinates is turned off:
1 From the main toolbar, choose Customize ➤ Preferences.
2 On the Preference Settings dialog, go to the General tab.
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3 In the Texture Coordinates group, make sure Use Real-World Texture
Coordinates is off, then click OK.

The dimensions of the scene will actually be close to the real-world
dimensions, but 3ds Max doesn’t need to enforce that: This option would
just add complications to your work.
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View the reference/texture bitmap, and note its dimensions:
1 On the main menu, choose Rendering ➤ View Image File. In the View
File dialog, navigate to the \sceneassets\images folder, and highlight
fac1.jpg.
In the lower-left corner of the View File dialog, a status line shows the
dimensions of the image, which are 1200 x 1533 pixels. This will become
the aspect ratio of the façade.

2 Click Open to view the image at full size.
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3

Close the image window after you have looked at the photo.

Creating the First House | 161

Construct the plane that will become the façade:

1 On the
Create panel, click
the Object Type rollout, click Plane.

(Geometry) active, then on

2 Near the center of the Front viewport, drag to create a plane.
3 On the Parameters rollout, enter 8.7m for the Length (the height), and
6.8m for the Width.
These dimensions roughly correspond to the aspect ratio of the photo:
1533:1200 pixels, or 0.78.
4 Also on the Parameters rollout, change Length Segs and Width Segs to
1.
(After you convert the plane to an Editable Poly surface, you will subdivide
it by using the polygon tools.)
5 Change the name of the plane to Facade1.

6 Go to the

Hierarchy panel. On the Adjust Pivot rollout, turn on

Affect Pivot Only, then
base of the Facade1 plane.
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move the pivot vertically so it is at the

Pivot moved to the base of the plane

7 Turn off Affect Pivot Only. With
(Select And Move) still active,
on the status bar, right-click the X, Y, and Z spinner arrows so the pivot
of the plane is now located at the origin (0,0,0).
Setting the Z axis to 0.0 aligns the façade with the Ground object. Setting
X and Y to 0.0 simply makes navigation easier, while you are editing the
plane.
8 Right-click the Facade1 plane, and from the Transform (lower-right)
quadrant of the quad menu, choose Convert To ➤ Convert To Editable
Poly.
Texture the plane:

1

Open the Slate Material Editor.
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2 On the Material/Map Browser panel, locate Materials ➤ mental ray, then
drag the Arch & Design entry to the active View (the large panel labeled
View1 in the center of the Editor).

3ds Max displays the Arch & Design material node in the active View.
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3 Double-click the Arch & Design material node to display the material
parameters in the Parameter Editor panel on the right.
4 Name the material Facade 1.

5 On the Templates rollout, choose Matte Finish from the drop-down list
of templates.

6 On the Material/Map Browser panel, locate Maps ➤ Standard, and drag
the Bitmap entry into the active View.
3ds Max opens a file dialog.
7 On the file dialog, choose fac1.jpg, turn off Sequence, and then click
Open.
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IMPORTANT In the Select Bitmap Image File dialog, be sure to turn off the
Sequence toggle.

When Sequence is on, 3ds Max attempts to create an IFL animation, and we
want to open only the single image.
3ds Max adds a Bitmap node to the active View.
8 Drag from the Bitmap node’s output socket (the small circle at the right).
A wire appears in the View. Drop the end of the wire on the Arch & Design
material’s Diffuse Color Map input socket (the small circle at the left).
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9 Drag from the Bitmap node’s output socket again, and this time connect
the wire to the Arch & Design material’s Bump Map component.
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10 Click the Facade 1 material node again to make it active, then on the Slate

Material Editor toolbar, click

then turn on
11

(Assign Material To Selection), and

(Show Map In Viewport).

Close the Slate Material Editor.

12 Activate the Front viewport, and press F3 to turn on shading.
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Shaded plane in Front viewport

Save your work:
■

Save the scene as facade1_begin.max.

Set Up the Stack so 3ds Max Preserves the Photo Projection
You are almost ready to add detail to the façade. But first, you need to set up
3ds Max so it displays the façade texture consistently, without distortion, and
so it clearly highlights selected polygons.
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Set up the scene:

■

Continue working on your scene from the previous section, or
open \modeling\facades\facade_modeling_01.max.

The goal of the steps in this section is to be able to edit the Facade1 poly surface
without distorting the texture projected onto it. Editable Poly objects have a
toggle, Edit Geometry rollout ➤ Preserve UVs, that does a good job of
preserving the projection in most cases.

Moving an edge while Preserve UVs is off
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Moving an edge while Preserve UVs is on

The stack setup used in this section is an alternative method that works for
surfaces other than Editable Poly.
Add a UVW Map modifier:

1

Select Facade1, then go to the

Modify panel.

2 From the Modifier List, choose UVW Map.
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The UVW Map modifier has no visible effect: It merely provides more
explicit mapping control than the implicit mapping provided by the
Facade1 object’s texture coordinates.

3 In the modifier stack controls, make sure that
On/Off Toggle) is on.

(Show End Result

Add a Poly Select modifier:
1 In the modifier stack, go down one level to the Editable Poly object
(Facade1).
2 From the Modifier List, choose Poly Select.
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3 In the modifier stack controls, make sure that
is on for Poly Select as well.

(Show End Result)

4 In the modifier stack, go to the Editable Poly level. Make sure that
(Show End Result On/Off Toggle) is on for the Editable Poly object
(Facade1) as well as for the modifiers.
Turning on Show End Result for all three levels of the stack causes the
viewports to always display the full bitmap in its final placement, even
while you edit the underlying geometry.
NOTE Depending on your 3ds Max configuration, when you go to the
Editable Poly level, you might see this warning:

For the edits you are doing in this tutorial, it is safe to click Yes and proceed
with your work. You also have the choice of turning on Do Not Show This
Message Again before you click Yes: That disables display of this warning,
but it does so not only for this tutorial, but for all future 3ds Max sessions.
The choice is up to you, but for the remainder of this tutorial, we won’t
mention the warning dialog again.
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Now you have set up the stack so you can see the undistorted bitmap
projection, even while you edit the geometry of Facade1.

Stack setup for editing a poly surface
with a bitmap
Show End Result must be on for all
three levels.

One further adjustment corrects for the situation that highlighted polys are
hard to see with the default color scheme.
Change the color of selected faces:

1 On the
Modify panel, with the Editable Poly level active in the
stack, scroll down to the Subdivision Surface rollout, and open it if it isn’t
already open.
2 On the Subdivision Surface rollout, make sure Show Cage is on.
3 Click the second of the color swatches that follow Show Cage.

This color is the color of highlighted polygons.
4 On the Color Selector, choose a bright red as the highlight color, and
then click OK.
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In the next lesson, you will turn Facade1 into a three-dimensional façade.
Save your work:
■

Save the scene as facade1_stack.max.

Next
Begin Adding Detail to the Façade: Modeling the Windows on page 175

Begin Adding Detail to the Façade: Modeling the
Windows
Now that you have set up the stack and the color of selected polygons, you
are ready to turn the plane of the façade into a three-dimensional model.
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Set up the lesson:

Continue working on your scene from the previous lesson, or
\modeling\facades\facade_modeling_02.max.

■

If you open the file,

select the façade, go to the

panel, and make sure that
levels of the stack.
■

open

Modify

(Show End Result) is on for all three

If you continue from the previous lesson, do the following:
1 Activate the Front viewport.

2 Click
(Maximize Viewport Toggle) (or click Alt+W) to maximize
the Front viewport.
3 Press F4 to make sure Edged Faces are displayed.

Adjust the line of the eaves:

1 Go to the
Modify panel. In the modifier stack, click to activate
the Editable Poly level.
TIP You will use the Graphite Modeling Tools ribbon, but the ribbon doesn’t
display all options unless the Modify panel is active, and the geometry is
chosen in the stack.
2 If the Graphite Modeling Tools ribbon is not displayed, then on the main

toolbar, click
click the ribbon’s
panels display.
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(Graphite Modeling Tools (Open)). If you need to,
expand/collapse icon until the full-size ribbon

3 On the Graphite Modeling tools tab, click
Edge sub-object level.

4 Select the top edge of Facade1, then
the roof.

(Edge) to turn on the

move it downward to hide

You will restore the roof later, in a following lesson.
Add edges for the windows:

1

Zoom the viewport so you have a good view of the three windows
in the upper portion of the wall.

2 On the Graphite Modeling tools tab ➤ Edit panel, click to turn on
(SwiftLoop).
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The SwiftLoop tool adds edges to the Editable Poly surface by drawing a
“loop” from one edge to another.
NOTE In this tutorial, you use only a handful of tools to create the façade
geometry. The ribbon has many other options that aren’t demonstrated here.
See Modeling a Helmet Using the Ribbon on page 64 for further uses of the
ribbon.
3 Drag over the façade near the top edge. 3ds Max constructs a vertical
edge, which you can move.

4 Click to set a vertical loop at the left edge of the small window in the
upper left of the façade.
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5 Add additional vertical loops for the other window edges.

6 Add horizontal loops to define the tops and bottoms of the windows.
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Add edges for the lintel beam and the doorways:

1

Pan down to get a good view of the doorway area.

2 Add loops to outline the lintel.

NOTE The lintel beam is not perfectly rectangular. You will adjust its outline
in a later procedure.
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3 Add a vertical loop for the edge of the right-hand doorway. (The other
vertical door edges match edges you already created for the windows.)

4 Also add vertical loops to the left of each dark area, where the wall angles
into the doorway.

Loop for the angle of the left doorway’s left-hand doorjamb
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Loop for the angle of the right doorway’s left-hand doorjamb

5 Finally, add a horizontal loop to define the elevation of the doorstep.

6 Right-click to turn off the SwiftLoop tool.
Now you have most of the edges you need to add 3D detail to the façade.
Add depth to the top center window:

1 Turn off

Edge to return to the top, object level.
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2 Drag the left edge of the ViewCube to get a view of the façade that shows
some depth.

3 In the viewport,
click to select the Ground object in the
background, then right-click and from the quad menu, choose Hide
Selection.

4

Zoom and
pan to get a good view of the windows in the
upper portion of the wall.
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5

Select Facade1 again.

6 Go to the Editable Poly level.
TIP On the Graphic Modeling Tools ribbon, you can navigate the stack by

using the buttons
(Next Modifier) and
(Previous Modifier).
These move to the geometry level as well as to modifiers.

7 On the ribbon, click
level.

8

Polygon to go to the Polygon sub-object

Click and Ctrl+click to select the three faces of the top center
window.
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9 On the ribbon ➤ Polygons panel, click the drop-down arrow next to

the

Extrude button, and choose Extrude Settings.

3ds Max displays an interactive manipulator called a “caddy.”
10 Drag the arrows by the Height control, and extrude the window back by
about –0.05m.

TIP You can also simply type –0.05 in the Height field, and then press Enter.

11 Click
(OK: the check-mark icon at the bottom of the caddy) to
complete the extrusion.

Begin Adding Detail to the Façade: Modeling the Windows | 185

Add depth to the other two windows:

1

Click and Ctrl+click to select the two polygons of the small
window at the upper left.

2 On the ribbon, Shift+click

(Extrude).

Shift+click is a shortcut way to display the caddy for a modeling tool.
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3 The caddy defaults to the previous value you used for Extrude Polygons,

so just click

4

(OK) so the small window matches its larger neighbor.

Click and Ctrl+click to select the four polygons of the main
window in the center of the wall.
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5 On the ribbon, Shift+click

(Extrude).

6 This window should have more depth than the smaller windows, so in
the Height field, enter –0.1m, then press Enter.
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7 On the caddy, click

(OK).

Now the windows for Facade1 are done.
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This completes the modeling of the upper portion of the wall.

Next
Detailing the Doorways on page 190

Detailing the Doorways
Modeling the lintel is a bit more complicated than modeling the windows.
On the other hand, the doorways themselves are a simple extrusion as the
windows are.
Set up the lesson:
■

Continue working from the previous lesson.
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Correct the outline of the lintel beam:
1 Click the Front face of the ViewCube to return to a Front view.

2

Pan and
the lintel beam.

Zoom to get a good view of the faces that show

As you can see in the bitmap, the lintel has an irregular outline. You will
edit the faces so they correspond to the outline of the wooden beam.

3 On the ribbon, click

(Vertex) to go to the Vertex sub-object level.

4 At the left end of the lintel,
move the three lower vertices so
they follow the outline of the beam.
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TIP To do these edits and the ones that follow, it might help to

in more closely, then

zoom

pan as you work on other parts of the lintel.

5 Where the lintel passes over the central pillar between the two doorways,

click to turn on
(SwiftLoop), then add a new vertical loop where
the stones of the pillar form an angle into the beam.
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This new loop of edges is so you can add a vertex at the angle point
without creating a free-standing vertex. Free-standing vertices are never
a good idea.
6 Right-click to close the SwiftLoop tool.

7 On the ribbon ➤ Edit panel, click to turn on

(Cut).

8 Use the Cut tool to draw new edges that follow the top of the pillar and
the bottom of the beam.

TIP The cursor for the Cut tool has three different forms:

■

■

■

when the cursor is at a vertex

when the cursor is on an edge

when the cursor is on a face

To avoid creating free-standing vertices, do not click the mouse while the

cursor shows that it is

on a face.
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9 Right-click to close the Cut tool.

10 At the right end of the lintel, click to turn on
(SwiftLoop), then
add two new vertical loops where the stones rise into the beam.

11 Right-click to close the SwiftLoop tool.

12 Click to turn on

(Cut).

13 Cut new edges to follow the outline of the beam.

14 Right-click to close the Cut tool.
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15

Move the two upper vertices at the right end of the beam, to
better follow the beam contour.

16 Click to turn on

(Select Object) and turn off Move.

Now the faces over the lintel are a fair approximation of the shape of the
beam.
Add depth to the lintel:

1 If you zoomed in to perform the edits in the previous procedure,

zoom out and

2 On the ribbon, click
level.

pan so you can see the entire lintel.

(Polygon) to go to the Polygon sub-object
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3

Click and Ctrl+click to select all of the lintel faces.

4 Drag the left side of the ViewCube to get a view that shows some depth,
again.

5 Do the extrusion interactively this time: On the ribbon, click
(Extrude) to turn it on, then drag in the viewport so the lintel extends
above the doorways.

6 Right-click, and from the quad menu, choose Scale.
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7 Use the scale gizmo to scale the size of the front faces of the lintel down
a bit along the X and Z axes.

NOTE In the original building, the lintel doesn’t appear to extrude this far;
but for our model, we want to have geometry that casts a decent shadow.

Add depth to the doors:

1

Zoom,
pan, and
get a better view of the doorways.

orbit (or use the ViewCube) to

2

Click and Ctrl+click to select the doorway faces. Include the
portion with stone to the left of each door. (The left-hand doorway has
an extra sliver of face that the right-hand doorway does not have.)
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3 On the ribbon, Shift+click
(Extrude), then use the caddy’s Weight
field to extrude the doorways inward by a value of –0.6m.
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4 Click

5

(OK) to accept the extrusion.

Orbit (or use the ViewCube) to see the doorways from the other
side.
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6 On the ribbon, click

7

(Edge) to turn on the Edge sub-object level.

Click and Ctrl+click to select the four vertical edges that are part
of the doorways, but whose faces show stonework.
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8

Move these edges to the right along the X-axis until the faces
show only the shadows beyond the door.

Detailing the Doorways | 201

Incidentally, the perspective captured by the camera helps with the texture
projection onto the left-hand doorjambs: These now look good. The
right-hand doorjambs don’t look as good. This is a problem that you will
fix in a later lesson.

9 Click

(Edge) to exit the Edge sub-object level.

Next
Completing the Façade: Detailing the Roof on page 202

Completing the Façade: Detailing the Roof
The last step in modeling Facade1 is to add the roof.
Set up the lesson:
■

Continue working from the previous lesson.
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Begin to model the roof:

1 Click

(Zoom Extents Selected) to see the entire façade.

2 On the ViewCube, click Front to return to a Front view.

3 On the ribbon, click
once more.

(Edge) to turn on the Edge sub-object level

4 On the ribbon ➤ Modify Selection panel, click
to turn it on.

(Loop Mode)

5 With
(Select Object) active, click one of the edges along the top
of the façade.
Loop Mode selects all edges along the top of the façade.

6 Drag the left edge of the ViewCube to see the façade in depth once more.
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7 Turn on

8

(Select And Move).

Shift+move the top of the façade forward a bit along the Y-axis.

Reminder: Holding down Shift while you move, clones the edges to create
new edges.

9

Shift+move the top of the façade upward a bit along the Z-axis,
until you can see the ends of the roofing tiles.

204 | Chapter 3 Modeling Tutorials

Before you finish the roof, you will add depth to the entire façade.
Add depth to the entire façade:

1 Click

(Select Object) to turn it on and turn off Move.

2 On the ribbon, click
level.

3

(Border) to turn on the Border sub-object

Click an edge along the top of the façade.
3ds Max selects the entire border.
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4 Turn on

5

(Select And Move).

Shift+move the border back about 0.75m along the Y-axis.
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Now that the façade, including its roof area, has some depth to it, you can
complete the roof.
Finish the roof:
1 Click the Front portion of the ViewCube to return to a Front view.
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2 Drag the top edge of the ViewCube to tilt the view a little, so you can see
the rear edge of the roof.

3

Zoom to get a better view of the roof area.

4 On the ribbon, click

then
the roof.

5 Turn on

6

(Edge) to go to the Edge sub-object level,

drag a selection box to select all the edges at the rear of

(Select And Move).

Move the selected edges up along the Z-axis until you can see
the peak of the roof.
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If you
orbit the view, you can see that raising the rear edge also
gives a slope to the roof.

7 Return to a Front view.
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On the ribbon, click

(Vertex) to turn on Vertex sub-object mode.

8 One at a time,
move vertices at the rear roofline down vertically
to match the bitmap of the roof.
TIP At the extreme left and right of the roof, you might also want to move
the front roofline vertices slightly downward.

After moving all existing vertices, you can see there are two areas on
either side of the peak, where the sagging of the medieval roof still shows
some sky.

9 On the ribbon ➤ Edit panel, turn on
(SwiftLoop), then in the
viewport, add two vertical edge loops. Each loop should be near the
middle of the sky area, on either side of the peak of the roof.
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10 Right-click to close SwiftLoop.

11

Move the new vertices at the rear roofline down vertically to
hide the sky-blue (or cloudy) areas of the façade texture.

12 Turn off

(Vertex) to exit the Vertex sub-object level.

Save your work:
■

Save the scene as facade1_modeled.max.

Now you’ve completed the modeling of the façade: You have a convincingly
three-dimensional house front with a realistic texture.

Completing the Façade: Detailing the Roof | 211

The only flaw, is that there is a good deal of streaking on those faces that are
perpendicular to the projection of fac1.jpg. The next lesson shows how to
correct the texture in these portions of the model.

Next
Correcting the Texture on page 212

Correcting the Texture
To correct the texture on selected faces, you add additional mapping
information for those faces. There are a number of ways to do this, but the
Unwrap UVW modifier is the most versatile and interactive way: This lesson
shows how to use Unwrap UVW.
Adding texture detail is a matter of how much time you want to spend, and
how you plan to use the model. If the model will appear only in a long shot,
you might be able to dispense with texture correction. If the model will appear
in a medium shot or a close-up, you might have to go through these steps.
For the purposes of this lesson, we use the final rendering as a guide:
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This is a medium shot. Facade1, on the left, is in shadow: But at another time
of day, you would be able to see the right sides of the doorways. So we will
show how to correct the sides of the doorway, and the doorstep.
The windows are too far away to see detail; the roof is seen only from below;
and the sides of the house are obscured by other houses. So we won’t go
through the steps for correcting these details, but at the end of this lesson, we
show how the details might be corrected. (The completed model,
facade_modeling_completed.max, has many texture corrections that these lessons
don’t describe.)
Set up the lesson:

1 Continue working on your scene from the previous lesson, or
open \modeling\facades\facade_modeling_03.max.
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2 If you open the file,

panel, and make sure that
levels of the stack.

select the façade, go to the

Modify

(Show End Result) is on for all three

Add an Unwrap UVW modifier:

1

Select Facade1.

2 Go to the
Modify panel. In the modifier stack, click the UVW
Mapping entry to make this modifier active.
3 From the Modifier List, choose Unwrap UVW.

4 In the modifier stack, click
(the plus-sign icon) by the Unwrap
UVW entry to expand the Unwrap UVW sub-levels, then click the Face
sub-object level to make it active.
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Correct the texture on the left-hand doorjamb:

1

Orbit (or use the ViewCube),
zoom, and
pan the
viewport so you have a good view of the right side of the doorways.

Correcting the Texture | 215

The sides appear streaked, because they are at right angles to the texture
projection of the UVW Map modifier.

2

Click and Ctrl+click to select both doorjamb faces.

NOTE You can adjust some settings for both doorjambs at once, because
they are parallel to each other.

3 On the
Modify panel ➤ Map Parameters rollout, click to turn
on Planar, then click Align X.
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Now the doorjambs are correctly aligned with the fac1.jpg texture.
However, they show the entire façade, which is not quite what we want.

4 Click Planar again to turn it off.
IMPORTANT If you forget to turn off Planar, later you won’t be able to use
controls in the Edit UVWs dialog.
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5

Click to select only the left-hand doorjamb.

6 On the

Modify panel ➤ Parameters rollout, click Edit.

3ds Max opens the Edit UVWs dialog.
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7 On the Edit UVWs dialog toolbar, choose “Map #11 (fac1.jpg)” from the
background pattern drop-down list.
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Now the main window of the dialog displays fac1.jpg.

8 On the lower toolbar, click to turn on

(Filter Selected Faces).

Now the geometry shown in the Edit UVWs dialog (the red mesh)
represents only the left-hand doorjamb face.

9 On the Edit UVWs dialog toolbar, click to turn on
Mode).

(Freeform

The face mesh now shows handles at its edges and corners. With Freeform
Mode, you can scale the face by dragging a corner handle, rotate the face
by dragging a side handle, and move the face by dragging from the interior
of the face.
10 Drag a corner to scale the face so it is roughly the size of a doorjamb in
the bitmap.
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TIP Move the Edit UVWs dialog so you can also see the left doorjamb in the
viewport. That way, you can see your texture-mapping changes interactively,
as you make changes in the dialog.
11 In the Edit UVWs dialog, drag the face to the right, so it covers the right
side of the central pillar.

12 On the Edit UVWs dialog toolbar, click

(Mirror Horizontal).

In the viewport, you can see how the correction looks.

Correcting the Texture | 221

This is the pattern for using Unwrap UVW to correct textures on faces with
poor texture projection: Essentially, you “fake” the texture by choosing some
part of the original texture that looks well when applied to the surface that
needs correcting.
Correct the texture for the right-hand doorjamb:

1 With the Edit UVWs dialog still open,
right-hand doorjamb.
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click to select the

2 On the Edit UVWs dialog ➤ lower toolbar, click to turn Filter Selected

Faces

off and then

on.

IMPORTANT Toggling Filter Selected Faces ensures that the Edit UVWs dialog
display is updated correctly.

3 On the Edit UVWs dialog toolbar, turn on
(Freeform Mode), then
drag the upper-right corner of the doorjamb face to scale it so it is roughly
the size of a doorjamb in the bitmap.
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4 Drag the face a bit to the right, so you can see the edge of the shrub.

5 On the Edit UVWs dialog toolbar, click

(Mirror Horizontal).

Once again, you can see the correction in the viewport.
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6

Close the Edit UVWs dialog.

7 Deselecting the faces makes it easier to see the corrections you made.

Correcting the Texture | 225

Correct the texture on the doorsteps:
The doorsteps are a little tricky, because the photo has no information about
that portion of the building. To compensate, we use the lintel texture:
Although the lintel is wood, when scaled up in size it can pass for stone.

1

Click and Ctrl+click to select the doorstep faces (there are four
faces on the left, and three on the right).
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2 On the
Modify panel ➤ Map Parameters rollout, click to turn
on Planar, then click Align Z.

Now the doorsteps are correctly aligned with the fac1.jpg texture.
3 Click Planar again to turn it off.

4 On the
Modify panel ➤ Parameters rollout, click Edit to open
the Edit UVWs dialog.
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5 In the Edit UVWs dialog, scale and move the doorstep faces so they are
on top of the lintel beam in the bitmap.

6

Close the Edit UVWs dialog.

A close-up rendering of the doorways shows your texture corrections better
than the viewport can.
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Save your work:
■

Save the scene as facade1_textured.max.

Extra Credit: Mapping the Windowsills, Window Jambs, and Sides of the
House
As we mentioned at the beginning of this lesson, it isn’t necessary to correct
the texture for the windows or the sides of the house. But if you want to try
using Unwrap UVW to do so, or if you are simply curious how it was done
for the completed model, here are the mappings used.
NOTE The completed model has some additional mapping corrections not shown
here: the bottom of the lintel and the bottom of the eaves. You can investigate
these, if you wish, by looking at facade_modeling_04.max or
facade_modeling_completed.max.
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Windows

Mapping for the windowsills
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Mapping for the window jambs
(The same texture is used for both sides of the windows.)
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House Sides

Left side
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Right side

Next
Modeling the Second House on page 233

Modeling the Second House
The second house front has a peaked roofline and an arched entry. We will
concentrate on modeling these, as you already know how to model windows.
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Set up the lesson:

■

Continue working on your scene from the previous lesson, or
\modeling\facades\facade_modeling_04.max.

open

View the bitmap for the second house, and note its dimensions:
1 On the main menu, choose Rendering ➤ View Image File. In the View
File dialog, navigate to the \sceneassets\images folder, and highlight
fac4.jpg.
In the lower-left corner of the View File dialog, a status line shows the
dimensions of the image, which are 1200 x 1740 pixels.

2 Click Open to view the image at full size.
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3

Close the image window after you have looked at the photo.
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Create the plane for the house:

1 Click
layout.

(Maximize Viewport Toggle) to display a four-viewport

2 Change the upper-right viewport to a Front viewport, and activate it.

3

4

Select Facade1, and then click

(Zoom Extents Selected).

Pan the viewport so Facade1 is at the left.

5 On the
Create panel, click
Type rollout, click Plane.

(Geometry), then on the Object

6 In the Front viewport, drag to create a plane. Change the Length (height)
value to 10.0m and the Width value to 6.8m. Change Length Segs = Width
Segs = 1.

NOTE The aspect ratio of the new house is 1200:1740, which equals 0.69,
so the dimensions of 10m x 6.8m are close to the real-world dimensions.
(Most of the houses in Monpazier are 6.8m wide.)

7

Move the new plane so it is level with Facade1, then move it to
the right so it is to the right of the previous house, with bit of distance
between them.
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8 Name the new plane Facade4.

9 Go to the

Hierarchy panel. On the Adjust Pivot rollout, turn on

Affect Pivot Only, then
base of the Facade4 plane.

move the pivot vertically so it is at the

10 Right-click the Facade4 plane, and from the Transform (lower-right)
quadrant of the quad menu, choose Convert To ➤ Convert To Editable
Poly.
Texture the plane:

1

Open the Slate Material Editor.
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2 In the Material/Map Browser panel, locate Materials ➤ mental ray, and
drag the Arch & Design entry to the active View.
3 Double-click the Arch & Design material node to display its parameters.
4 Name the material Facade 4.
5 On the Templates rollout, choose Matte Finish from the drop-down list
of templates.
6 On the Material/Map Browser panel, locate Maps ➤ Standard, and drag
the Bitmap entry to the active View.
7 In the file dialog that opens, choose fac4.jpg as the bitmap, turn off
Sequence, and then click Open.
IMPORTANT In the Select Bitmap Image File dialog, be sure to turn off the
Sequence toggle.

When Sequence is on, 3ds Max attempts to create an IFL animation, and we
want to open only the single image.

8 Wire the Bitmap to the Arch & Design material’s Diffuse Color Map and
Bump Map components.
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9 Click the Facade 4 material node to make it active, then turn on
(Show Map In Viewport).
10 Drag from the Arch & Design material node’s output socket (the small
circle on the right), and drop the material on the Facade 4 plane in a
viewport.
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Dragging and dropping is another way to apply a material.
NOTE You won’t see the wire as it crosses the panel at the right of the Slate
Material Editor, or in the viewport.
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Shaded plane in Front viewport

11

Close the Slate Material Editor.

Set up the stack and face-selection color:

1 Go to the

Modify panel.
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2 From the Modifier List, add a UVW Map modifier. Click the Editable Poly
entry again, then add a Poly Select modifier.

3 Make sure that
(Show End Result) is on for all three levels of the
stack (the two modifiers and the Editable Poly object itself).
4 Click the Editable Poly level again to make it active. Scroll down to the
Subdivision Surface rollout, and open it if it isn’t already open.
5 On the Subdivision Surface rollout, make sure Show Cage is on.
6 Click the second of the color swatches that follow Show Cage.

This color is the color of highlighted polygons.
7 On the Color Selector, choose a bright red as the highlight color, and
then click OK.
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Adjust the roofline:

1 On the ribbon, click

On the Edit panel, click

(Edge) to go to the Edge sub-object level.

(SwiftLoop) to turn it on.

2 Make sure the viewport displays Edged Faces (F4).
3 Create a vertical edge that is centered on the peak of the roof.
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4 On the ribbon, click

(Vertex) to go to the Vertex sub-object level.

Move the upper-left and upper-right vertices down to match
the roofline.

5 On the ribbon, click

(Edge) to go to the Edge sub-object level.

Click and Ctrl+click to select the two roof edges, then
move them down vertically a bit to hide the cornice.

As you did for Facade1, you will add detail for the roof later in this tutorial.
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Add edges for the windows:
Although we won’t go into detail about creating the windows, you will add
their construction edges, as these can help you construct the arch.

1 On the ribbon ➤ Edit panel, click

(SwiftLoop) to turn it on again.

2 Add vertical edges for the two windows.

3 Also add vertical cuts for the center dividers of the two windows.
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As you work with SwiftLoop, you will notice that the “horizontal” loops
are now chevron-shaped, because of the peaked roof. To get true
horizontal edges, you need to use a different tool at first.

4 On the ribbon ➤ Edit panel, turn on

(QuickSlice).

5 Position the cursor at the horizontal top of the upper window, then click
the mouse once.
3ds Max creates a single horizontal slice.
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6 Click the mouse a second time to “set” the quick slice. (If you drag the
mouse, 3ds Max rotates the slice, which we don’t need here.)

7 Use
window.

(QuickSlice) again to create the lower edge of the upper

8 Once you’ve used QuickSlice to finish creating horizontal edges for the

upper window, you can use
(SwiftLoop) again to create the
horizontal edges for the lower window.
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NOTE Although we don’t go through the steps in this tutorial, we use three
horizontal loops for the lower windowsill, because in the final model it has
two levels of extrusion. You can see this in facade_modeling_completed.max.

Now you have some of the grid on which you will base the actual arch contour.

Next
Add Detail to the Arch on page 248

Add Detail to the Arch
The arch is the distinctive feature of Facade4. It calls for more complex
modeling than the doorways of the previous façade.
Set up the lesson:
■

Continue working from the previous lesson.
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Add edges for the arch:
The window edges give you a starting point, but to model the arch well, you
need to add some further edges for reference and for making cuts.

1

Pan and

zoom so you have a good view of the arch.

2 On the ribbon ➤ Edit panel, turn on

(SwiftLoop) again.

3 Add a horizontal loop at the top of the arch.

4 Add a vertical loop at each side of the arch.
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5 Subdivide the arch area with four horizontal loops. Make them a little
closer together at the top, and more widely spaced toward the bottom.

6 Add one more horizontal loop for the doorstep or sidewalk.

7 Subdivide the arch area further with vertical loops: Add two on the left,
and three on the right.
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Outline the arch:

1 On the ribbon ➤ Edit panel, turn on

(Cut).

2 Cut edges to define the archway.
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Reminder: Don’t click the mouse when the cursor shows it’s
a face. The cuts should always join edges or vertices.

on

3 Right-click to close the Cut tool.

4 If you want to adjust the cuts, turn on
(Vertex), then
move the new vertices in X or Y (try not to deform the horizontal and
vertical lines of the grid).
When the cuts for the archway are done, you’re ready to extrude the arch.
Extrude the arch:

1 On the ribbon, click
level.
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(Polygon) to go to the Polygon sub-object

2

Click and Ctrl+click to select the faces in the archway. Don’t
neglect the small triangular faces that you might have created along the
upper edge of the arch.

3 Drag the left edge of the ViewCube so the view shows some depth.

4 On the ribbon ➤ Polygons panel, Shift+click
the extrusion caddy.

(Extrude) to display
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You will extrude the arch in two stages: The first stage gives depth to the
wall, and the second represents part of the interior of the arcade behind
the arch.
5 In the caddy’s Height field, enter –0.3m for the first extrusion (the width
of the wall).
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6 Instead of clicking OK, click

(Apply And Continue).
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3ds Max creates the extrusion and begins another.
7 In the Height field, enter –0.4 for the second extrusion (the arcade
interior).
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8 Click

(OK) to accept the value and close the caddy.

Next
Add Detail to the Cornice on page 257

Add Detail to the Cornice
The cornice, with its peak, is slightly different from the roof for Facade1.
Set up the lesson:
■

Continue working from the previous lesson.
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Model the cornice:

1

Pan so you can see the roofline.

2 On the ribbon, click

3

(Edge) to turn on the Edge sub-object level.

Select the edges along the top of the façade.

TIP It can be hard to select the very small edges near the peak: Make sure

the Window/Crossing toggle is set to
(Window), and drag a box
around them. Ctrl+click to add the longer edges to the selection.

4

Shift+move the edges forward a bit along the Y-axis.

258 | Chapter 3 Modeling Tutorials

5

Shift+move the edges up a bit along the Z-axis.
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6

Shift+move the edges forward along the Y-axis, and then
Shift+move them up along the Z-axis once again, to complete the cornice.

7 Click

(Edge) to exit the Edge sub-object level.

At this point, if you wish, you can add depth to the windows and to the façade
as a whole, as we did for Facade1. But that work has been done for you in the
sample file for the next lesson. This completes the modeling work on Facade4.
What remains is to correct the texture mapping with Unwrap UVW. Because
the arch is curved, you will use a new method to map its inner faces.
Save your work:
■

Save the scene as facade4_modeled.max.

Next
Texturing the Arch on page 261
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Texturing the Arch
As for Facade1, you use Unwrap UVW to texture the entryway faces of Facade4.
Because of the arrangement of these faces, you use different Unwrap UVW
techniques.
Set up the lesson:

1 Continue working on your scene from the previous lesson, or
open \modeling\facades\facade_modeling_05.max.

2 If you open the file,

panel, and make sure that
levels of the stack.

select the façade, go to the

Modify

(Show End Result) is on for all three

Texture the pavement:

1

Select Facade4.

2 Make sure the viewport displays Edged Faces (F4).

3

Orbit (or use the ViewCube),
get a good view of the arch geometry.

zoom, and

pan to
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4 Go to the
Modify panel. In the modifier stack, make sure UVW
Mapping is the active level.
5 From the Modifier List, choose Unwrap UVW.

6 In the modifier stack, click
(the plus-sign icon) by the Unwrap
UVW entry to expand the Unwrap UVW sub-levels, then click the Face
sub-object level to make it active.
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7

Click and Ctrl+click to select the upper faces of the doorstep or
sidewalk.

8 On the
Modify panel ➤ Map Parameters rollout, click to turn
on Planar, then click Align Z.
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Now the pavement is correctly aligned with the fac4.jpg texture.

9 Click Planar again to turn it off.

10 On the
Modify panel ➤ Parameters rollout, click Edit to open
the Edit UVWs dialog.
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11 On the Edit UVWs dialog, choose “Map #13 (fac4.jpg)” from the
background pattern drop-down list.

12 On the Edit UVWs dialog lower toolbar, click to turn on
Selected Faces).

13 On the Edit UVWs dialog main toolbar, click to turn on
Mode).

(Filter

(Freeform

14 Use the handles to move and scale the pavement faces so they are on top
of the larger window’s windowsill.

The idea is to map the pavement to a dark area of stone.
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TIP Move the Edit UVWs dialog so you can also see the texture display in the
viewport.

15

Close the Edit UVWs dialog.

Set up texturing for the wall portion of the arch:
1 Use the ViewCube to orbit the scene so you can see all the interior faces
of the archway.
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2

Click and Ctrl+click to select the outer faces along the inside of
the archway: These are the faces that correspond to the width of the stone
wall.

TIP You can press F2 to toggle the shading of selected faces. Turning on face
shading makes it easier to see your selection.
3 Press Shift+Z to return to your previous view of the archway, looking at
it from the side and slightly downward.

4 On the
Modify panel ➤ Map Parameters rollout, click Cylindrical
to turn it on, then click Align Y.
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3ds Max displays a cylindrical gizmo for the Unwrap UVW projection.

5

Move the cylinder gizmo forward a bit, so you can see all of it,
and it is not hidden by the wall.
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TIP As the illustration shows, you might want to
orbit (or use the
ViewCube) to see the wall and the cylinder gizmo more obliquely.
The cylinder gizmo has one height segment displayed in green. This
indicates where the seam of the cylindrical mapping will be. At present,
the green segment is near the right side of the arch.

6 Turn on

7

(Select And Rotate).

Rotate the cylinder gizmo about the Y-axis until the seam
segment is at the bottom of the scene.
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Since the arch isn’t a full circle, putting the seam at the bottom ensures
there won’t be a seam on the façade geometry.
8 On the Map Parameters rollout, click Fit.

270 | Chapter 3 Modeling Tutorials

3ds Max fits the cylinder gizmo to the geometry of the arch.

9 Click Cylindrical again to turn it off.
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IMPORTANT Like the Planar button, the Cylindrical button enters a mode:
If you forget to turn it off, later you won’t be able to use controls in the Edit
UVWs dialog.

Use the Edit UVWs dialog to position the wall texture:

1 On the
Modify panel ➤ Parameters rollout, click Edit to display
the Edit UVWs dialog.

2 If you need to, on the Edit UVWs dialog, choose “Map #13 (fac4.jpg)”
from the background pattern drop-down list, and on the lower toolbar,

turn on

(Filter Selected Faces).

3 On the Edit UVWs dialog main toolbar, turn on

(Freeform Mode).

4 Use the handles to scale the wall faces so they cover a strip of stone above
the arch. The placement doesn’t matter much, as you will be changing
it soon.
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5 On the Edit UVWs dialog main toolbar, click

(Mirror Horizontal).

6 On the options panel below the main Edit UVWs dialog, click to turn on

(Vertex Sub-Object Mode).

7 On the Edit UVWs dialog menu bar, choose Tools ➤ Sketch Vertices.
3ds Max opens a Sketch Tool dialog.
8 On the Sketch Tool dialog, choose Free Form from the Align To drop-down
list.
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Also in the Sketch Tool dialog, click to turn on Interactive Mode, and
then click OK.

After you have set up the Sketch Tool to use Free Form drawing, you work
in a two-step manner: First, drag to select the vertices you want to
reposition; Second, draw a freehand stroke to show Edit UVWs where to
place the selected vertices.
9 In one continuous motion, drag to select vertices along the lower-left edge
of the arch faces: Begin at the center of the lower edge, and move the
cursor to the left.
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NOTE If your grid of edges matches the grid shown in the previous lesson,
there are 11 vertices on each side of the arch. 3ds Max numbers these from
0 to 10.
10 With the pencil cursor, sketch along the lower-left edge of the arch that
the bitmap shows.
3ds Max moves the vertices you selected to follow the line as you draw.

You don’t have to worry about being too precise: You can adjust your
work later.
11 Repeat the previous two steps for the upper edge of the arch faces.
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12 And then repeat the same steps for the right side of the arch.
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13 After you have used Sketch Vertices to rough out the arch faces in this

way, on the Edit UVWs dialog toolbar, turn on
move vertices to arrange them more regularly.
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(Move), and then

Map the inner, arcade faces:
We’ll let you decide whether you want to go through the steps for mapping
the inner, arcade faces. The steps to follow are the just same as the steps you
followed for the stone wall faces, with these changes:
■

Select the inner faces instead of the outer ones.

■

Map the faces to the dark, arcade area of the bitmap. Avoid lighter areas
of the bitmap (except the reflected lights, which will look OK); and of
course, avoid the bicyclist.

A close-up rendering of the façade shows the result of mapping the arch.
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Save your work:
■

Save the scene as facade4_textured.max.

The completed scene is facade_modeling_completed.max. This scene contains
two other façades. If you want to try modeling them, you should now know
the tools you can use to do so.
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Façade 2
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Façade3

Summary
With a photograph of a building’s façade, you can create a convincing model
of that façade. The overall steps are as follows:
1 Use a photo-editing program to correct the photograph’s perspective, so
that vertical and horizontal lines are parallel.
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2 In 3ds Max, create a plane that has the same aspect ratio as the
photograph, and the same dimensions as the original building.
3 Create a material that uses the photo as both a Diffuse and a Bump map,
and apply it to the plane.
4 Make the plane an Editable Poly object.
5 Set up the stack with UVW Map and Poly Select, so you can see the end
result while you edit the geometry.
6 Use Editable Poly tools to create edges that correspond to features of the
façade.
7 Use the Extrude tool to make features three dimensional, having them
recess or protude so the building will cast realistic shadows.
8 Use Unwrap UVW to correct the mapping of faces that aren’t parallel to
the main UVW Map projection.

Modeling an Airplane
In this tutorial, you explore Editable Poly surfaces further by building a model
of a fighter airplane.
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The aircraft is a Republic Aviation P-47 Thunderbolt, a heavy-duty fighter
used extensively by the Allied forces in World War II. For information about
the history and technical details of this aircraft, do a Web search for “P-47”.
NOTE Unlike the irregular meshes used in the tutorial Using Photos to Model
Façades on page 148, the mesh you create in this tutorial has consistent
quadrangular faces. Although the airplane is not meant to be deformed, this is
the kind of mesh you should create when you model a deformable character.
Skill level: Advanced
Time to complete: 5 to 6 hours

Pointers on Setting Up a “Virtual Studio”
When you build a 3D model from scratch, often it helps to set up reference
or “blueprint” images to use as a guide to the 3D geometry. Typically these
images are plans that show the side, front, and top of the object to model.
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Virtual studio for the P-47 model

You might find such plans on the Web, you might scan them from a book or
the instructions for a scale model, or you might draw them yourself. Here are
some pointers for how to set them up so you can use them in 3ds Max:
■

If you need to resize the images, resize them as a set, so the dimensions
match in all three images.
Many image-processing programs have guidelines or rulers that can help
you align the images to a common center, and make sure their dimensions
match.

■

Make the images square.
Square images are easier to align when you apply them to 3ds Max
geometry.

■

Use color for the images.
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For this tutorial, we chose shades of blue: This nostalgically recalls paper
blueprints, but more importantly, in 3ds Max it is impossible to see white
selection boxes against a white background.
In 3ds Max itself, you can set up three planes in the virtual studio arrangement.
For this tutorial, we used Generic units (1 generic unit equals 1 inch), and set
the reference planes to the pixel dimensions of the blueprint images: 800 x
800.
Map the images to the planes, using these guidelines:
■

Set Self-Illumination to 100 percent.
If your scene uses lights, the blueprint images will always be visible.

■

Select all the planes, right-click, and choose Object Properties. On the
Object Properties dialog, turn on Backface Cull.
This way, when you look at the model through one of the planes, the image
doesn’t get in the way.

■

Also on the Object Properties dialog, turn off Show Frozen In Gray.
Freezing the planes lets you work on the model without worrying about
selecting the planes by accident. By default, frozen objects are gray: Turning
off this option lets you freeze the planes and still see their blueprint images.

■

Freeze the planes.

■

Set all four viewports to Smooth + Highlights display (F3).

Now you are ready to begin modeling.

Creating the Fuselage
The fuselage begins as a geometric primitive. You modify the shape of the
primitive, and then convert it to an Editable Poly object. For most of this
section, and the remainder of the tutorial, you will use Edit Poly tools to shape
the airplane.

Model the Engine Cowl
You build the P-47 Thunderbolt from scratch, but use planes with “blueprint”
images to guide your work. The airplane will consist of just two objects: The
fuselage with its wings and other details, and the canopy that goes over the
cockpit.
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Set up the scene:

■

On the Quick Access toolbar, click
(Open File), navigate to the
\scenes\modeling\p47 folder, and open p47_start.max.
NOTE If a dialog asks whether you want to use the scene’s Gamma And LUT
settings, accept the scene Gamma settings, and click OK. If a dialog asks
whether to use the scene’s units, accept the scene units, and click OK.
The scene contains three planes that show side, front, and top elevations
of the airplane: a “virtual studio” as described in Pointers on Setting Up a
“Virtual Studio” on page 284.

Optimize bitmap display in viewports:
1 On the main toolbar, choose Customize ➤ Preferences.
2 Go to the Viewports tab, then click Display Drivers ➤ Configure Driver.
3ds Max opens the configuration dialog for the graphics driver you are
using (Software, OpenGL, or Direct3D).
3 Depending on the driver, there are either one or two check boxes labeled
Match Bitmap Size As Closely As Possible (for the OpenGL driver, the
label is Match Bitmap As Close As Possible). If there is one, turn it on. If
there are two, turn on both of them.
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Configuration dialog for the Direct3D driver

4 Click OK to close the driver configuration dialog, and OK again to close
the Preferences dialog.
5 If you had to turn on Match Bitmap Size As Closely As Possible, then exit
3ds Max. Restart 3ds Max before you continue with this tutorial.
Bitmap configuration changes do not take effect immediately: You always
have to restart 3ds Max.
If you did not have to change the Match Bitmap Size setting, you can
continue without restarting 3ds Max.
Set up the viewports:

1 Click

(Maximize Viewport Toggle) to display all four viewports.

2 For each of the orthographic viewports (Top, Front, and Left), turn on
Smooth + Highlights (keyboard shortcut: F3), turn off grid display

(keyboard shortcut: G), and click

3 In the Left viewport, use
the front of the airplane.

(Zoom Extents).

(Region Zoom) to get a better view of
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Create a cylinder to begin the engine cowl:

1 On the
Create panel, activate
Object Type rollout, click Cylinder.

(Geometry), then on the

2 In the Left viewport, drag from the center of the propellor hub to create
a cylinder that is about as wide as the airplane. Give it a height of about
60 (the exact value is not important). Set Height Segments to 1, Sides to
10, and turn off Smooth.
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NOTE With 10 sides, the top and bottom segments are flat: This will come
in handy when you add some details such as the tail.
3 Change the name of the cylinder to P-47.

4 Turn on
(Select And Move). In the Left viewport, move the
cylinder so it is well centered on the image of the airplane. In the Top
viewport, move it forward so its rear edge coincides with the rear edge of
the engine cowl.
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NOTE As you create the model, it can help to

zoom and

pan a particular viewport to get a better view of the geometry and
the blueprint image. In general, we mention view changes when they are
particularly important or useful, but you might want to change the view more
often than we indicate. This is quite all right.
5 If you need to, reduce the height of the cylinder so its front edge matches
the edge where the air-intake cover meets the cowl.

NOTE In this step, as in much of this tutorial, you are using the “blueprint”
images as a guide, and the exact values don’t matter much. Use your eye
and your judgement.

6 Go to the
the cylinder.

Modify panel, and apply an FFD 3x3x3 modifier to
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FFD stands for “free-form deformation.” This modifier lets you adjust the
shape of the cylinder, using a 3x3x3 array of control points.

7 On the modifier stack, click
(the plus-sign icon) to open the FFD
3x3x3 modifier hierachy. Click Control Points to highlight that sub-object
level.

8 In the Left viewport, drag to select the bottom row of FFD control points
(this actually selects all nine control points at the bottom of the lattice),

then

fuselage.
together.

move them down so they coincide with the bottom of the

Scale them along the X axis so they are a bit closer
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9 Drag to select the upper row and plane of control points.

them out a bit along the X axis, then
the Y axis.

294 | Chapter 3 Modeling Tutorials

Scale

move them up a bit along

You now have a good cross-section of the cowl at the front of the fuselage.
In the next procedure, you refine its shape along the length of the
airplane.
Taper the profile of the cowl:
1 On the modifier stack, click the FFD 3x3x3 entry to exit the Control
Points level. Then choose Modifier List ➤ FFD 2x2x2.
You will use this additional free-form deformation modifier to give some
taper to the nose of the airplane.

2 On the modifier stack, click
(the plus-sign icon) to open the FFD
2x2x2 modifier hierachy. Click Control Points to highlight that sub-object
level.
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3 In the Front viewport, drag a selection box to select the row of control

points at the lower leading edge of the cowl, then
move the
points to follow the taper of the image. Do the same for the lower trailing
edge of the cowl.

4 Do a similar adjustment for the upper profile of the cowl.
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5 In the Top viewport, drag to select the leading plane of control points,

then
scale them down a bit along the Y axis to taper the cowl
in that dimension as well. so it matches the blueprint image.
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The changes you make in the Front and Top viewports also appear in the
Left viewport.
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Extend the cowl forward:
1 Right-click the P-47 cylinder, then from the quad menu, choose Convert
To ➤ Convert To Editable Poly.
By converting the cylinder to an Editable Poly object, you lose the specific
Cylinder and FFD modifier controls, but you gain access to the rich set
of Editable Poly sub-object controls.
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2 If the Graphite Modeling Tools ribbon is not displayed, then on the main

toolbar, click

(Graphite Modeling Tools (Open)).

3 If the ribbon is displayed but not fully expanded, click the
expand/minimize icon until the full ribbon is visible.
4 On the ribbon ➤ Graphite Modeling Tools tab ➤ Polygon Modeling
panel, click

5 In the Left viewport,
of the cowl.
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(Polygon) to go to the Polygon sub-object level.

click to select the large polygon at the front

6 Activate the Perspective viewport.

7 On the ribbon ➤ Polygons panel, click

(Bevel).

The Bevel tool does two things: It extrudes a selection, and then lets you
scale the size of the extrusion.
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8 Do this step in the Perspective viewport, but watch your work in the Front
viewport: Drag upward to extrude the selected polygon as far as the front
of the airplane.

Release the mouse, then drag downward to scale the polygon so it tapers
as the blueprint image shows.

302 | Chapter 3 Modeling Tutorials

The curve of the cowl is subtler than the model we have so far, but you
will fix that later on.

Next
Complete the Air Intake on page 303

Complete the Air Intake
At the front of the cowl, the cover of the air intake is recessed, and has a
rounded shape. You don’t need to make the model as detailed as an actual
airplane would be, but these steps give the general look of the front of the
plane.
Set up the lesson:
■

Continue working from the previous lesson.
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Add detail to the air intake:
1 In each of the four viewports, press F4 to turn on Edged Faces.
This makes it easier to see the polygons with which you’re working.
2 With the front polygon still selected, on the ribbon ➤ Polygons panel,
click
(Inset). In the Perspective viewport, drag downward to reduce
the size of the front polygon, and add polygons around it.

You can also see this change in the Left viewport.
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3 On the ribbon ➤ Polygons panel, click
(Bevel). In the Perspective
viewport, drag downward to recess the central polygon.
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Release the mouse, then drag it downward again a little bit, to taper the
inside of the recess. This change is easier to see in the Left viewport.
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As for most of the P-47 model, exact distances don’t matter here: The
important thing is the overall look.
4 Activate the Left viewport, and press Alt+X to turn on X-Ray (See-Through)
display mode. Click away from the geometry to deselect the front face.
Even with X-Ray display, it is a little hard to see details of the blueprint
image.
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Here is the image without the geometry in front of it:
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(If you like, you can also choose Rendering ➤ View Image File, and then
open \sceneassets\images\p47_front.jpg to see the full-size version of this
image.)
As the blueprint image shows, there is a circular area within the recess:
This is the intake for air to help cool the engine. The air intake for the
engine’s combustion is a pipe located below the circular area.

5 On the ribbon ➤ Polygon Modeling panel, click

to the Edge sub-object level.
the bottom of the recess.

(Edge) to go

Click to select the center edge at
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6

Move the edge up until it is just below the circular border.
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7

Scale the edge out a bit along the X axis so the outline of the
intake becomes a bit rounder.
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8 On the ribbon ➤ Polygon Modeling panel, click

(Vertex) to go

to the Vertex sub-object level.
Click and Ctrl+click to select the
four vertices at the lower edge of the inner portion of the recess.
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TIP If you select a vertex you don’t want, Alt+click to deselect it.

9

Move the vertices up along the Y axis to make the cooling intake
even more rounded.
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If you activate the Perspective viewport and press Alt+X to turn off X-Ray
display, you can get a better view of the work you’ve just done.
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Subdivide the intake faces:
The front of the airplane is nearly done, for the time being. But because of
the way 3ds Max constructed the cylinder that was the origin of this model,
the intake face is a 10-sided polygon. As we mentioned earlier, it is best if the
mesh consists of consistently quadrangular polygons: These work much better
with smoothing and (if you are creating a character) with skin deformation.
So to complete the air intake, you divide the large 10-sided polygon into
smaller quadrangular polygons.

1 Activate the Left viewport again.
is easier to see.

Zoom in a bit so the geometry

2 Click and Ctrl+click to select the two vertices at either side of the intake
polygon.
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3 On the ribbon ➤ Loops panel, click

(Connect).

It is hard to see the connecting edge until you click elsewhere in the
viewport to deselect the initial vertices.
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4 Use the method from the previous two steps to add two more horizontal
edges: one above the center edge, and one below it.
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Now the original 10-sided polygon is divided into four polygons, and
each of the new polygons has only four sides.

Next
Finish the Engine Cowl on page 319
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Finish the Engine Cowl
In this lesson, you add some detail to the rear of the cowl, and then adjust its
shape to better fit the blueprint image.
Set up the lesson:
Continue working from the previous lesson.

■

Shape the rear of the cowl:
The engine cowl fits over the front of the main fuselage, a bit like a bottle cap
on top of a glass bottle. So the rear of the cowl also has a recessed area, though
not as pronounced as the air intake.

1 On the ribbon ➤ Polygon Modeling panel, click

2

(Polygon).

Orbit the Perspective viewport so you can see the back of the
cowl.
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3

Click to select the polygon at the rear of the cowl.

4 On the ribbon ➤ Polygons panel, click
(Inset). In the Perspective
viewport, drag the mouse down to inset the rear of the cowl.
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5 On the ribbon ➤ Polygons panel, click
(Bevel). In the Perspective
viewport, drag downward to create a shallow recess at the rear of the
cowl.
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Release the mouse, then drag it downward a bit more to reduce the size
of the recessed polygon.
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You can check your work by pressing Alt+X to turn on X-Ray display once
again, and looking at the Front viewport.
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Adjust the curvature of the cowl:
The engine cowl is almost done: To complete it, you adjust its curvature to
better match the blueprint.
1 Activate the Front viewport.

2 On the ribbon ➤ Polygon Modeling panel, click

3

(Edge).

Click to select one of the longer edges along the length of the
cowl.
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4 On the ribbon ➤ Modify Selection panel, click

(Ring).

The Ring tool selects a ring of comparable edges, about the circumference
of the cowl.
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5 On the ribbon ➤ Loops panel, Shift+click

(Connect).

Shift+clicking Connect displays the caddy controls for the Connect tool.
These let you adjust the edge connection interactively.
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6 On the caddy, drag the value of the lower spinner, Slide, to slide the new
vertical edge to the left, so it is beneath the bulge in the cowl.
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7 When the edge is in the right place, click

8

(OK).

Scale the new edge up along the Y axis so the cowl has a bulge
that better matches the blueprint image.
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9 Click

(Edge) again to exit the Edge sub-object level.

Now the P-47 engine cowl is essentially complete, as far as polygon shapes
go. (You will add some detail later, to improve the way 3ds Max smooths this
part of the model.)
Save your work:
■

Save the scene as p47_engine_cowl.max.

Next
Add the Fuselage on page 330
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Add the Fuselage
The main fuselage is an extension of the cowl geometry.
Set up the lesson:
■

Continue working from the previous lesson.

Build the forward part of the fuselage from the rear of the cowl:

1 On the ribbon ➤ Polygon Modeling panel, click

the Perspective viewport,
cowl to select it.
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(Polygon). In

click the polygon at the rear of the

2 On the ribbon ➤ Polygons panel, click
(Inset). In the Perspective
viewport, drag downward to create an inset with very narrow border
polygons.

3 On the ribbon ➤ Polygons panel, click
(Bevel). In the Perspective
viewport, drag upward this time to extrude the polygon toward the rear
of the airplane. Watch the Front viewport while youre doing so, and
extrude the polygon just beyond the area of the cowl.
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Front view

Release the mouse, then drag upward again to scale the bevel so it is
almost the same diameter as the cowl itself. Again, watch the Front
viewport while you work.
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Front view

Continue modeling the fuselage:

1 Use
(Bevel) again to extend the fuselage up to the leading edge of
the rectangular panel in front of the cockpit, then scale it up so that in
the Front view, it follows the contour of the blueprint image.
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Front view

This looks good, but if you look at the Top viewport, you can see that
the new bevel is a bit too wide.
2 Activate the Top viewport, then scale the polygon down along the Y axis
to align it with the blueprint image.
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From here on, Extrude is the main tool for creating the fuselage. Along
the way, you will use Scale and vertex adjustments to refine its shape.

3 If you need to,

pan the Front viewport so you can see the cockpit.

NOTE We won’t always mention when you need to pan the viewports, as
this can vary depending on your 3ds Max window setup.

4 On the ribbon ➤ Polygons panel, click
(Extrude). In the
Perspective view, extrude the fuselage up to the leading edge of the
cockpit. As usual, watch the Front viewport while you work.
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Front view

5 On the ribbon ➤ Polygon Modeling panel, click

(Vertex).
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6 In the Front viewport,

drag a box to select the vertices at the

lower edge of the rear of the fuselage. Then
move these vertices
downward along the Y axis to match the lower contour of the airplane.

7 On the ribbon ➤ Polygon Modeling panel, click
return to the Polygon sub-object level.

8 Activate the Top viewport, then
slightly along the Y axis.
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(Polygon) to

scale the polygon down very

9 On the ribbon ➤ Polygons panel, click
(Extrude) once more.
Working in the Perspective viewport, but watching the Front viewport,
extrude the fuselage as far as the seam at the rear of the cockpit.
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Front view

TIP Sometimes the size of the 3ds Max window prevents you from extruding

as far as you want. If this happens, extrude as far as you can, then
move the polygon horizontally to the desired location.

10 In the Front viewport,
move the polygon up a bit along the Y
axis so the bottom is closer to the contour of the airplane.
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11 Also in the Front viewport,
scale the polygon down along the
Y axis so it better matches the blueprint.
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NOTE At this point, the match to the airplane contour is only approximate.
Also, the polygons along the length of the fuselage are too long: In later
procedures, you will add edge segments to refine the mesh, and move vertices
to improve the contour of the fuselage.

At this point, you might also want to go to the

(Vertex) sub-object

level and
move the middle and lower vertices so they better
match the contours of the airplane. Remember to use region selection so
you select the vertices on both sides of the fuselage.
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After you adjust vertices, return to the

(Polygon) sub-object level.

12 In the Top viewport,
scale the polygon down some more along
the Y axis, to match the blueprint image.
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Complete the cylindrical part of the fuselage:

1 On the ribbon ➤ Polygons panel, click
(Extrude) once more.
Then extrude the fuselage as far as the leading edge of the tail.
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Front view

2 In the Top viewport,
contour of the airplane.

scale the polygon down to match the
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3 In the Front viewport,
contour.

4 Also in the Front viewport,
the blueprint image.
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scale the polygon down to the size of the

move the polygon to better match

Next
Complete the Lower Part of the Tail on page 349

Complete the Lower Part of the Tail
The lower part of the tail extends the fuseelage, but it becomes much more
narrow.
Set up the lesson:
Continue working from the previous lesson.

■

Finish extruding the fuselage:

1

Extrude the fuselage once more, this time to the very tip.
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Front view

2 In the Top viewport,
blueprint image.
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scale the polygon down to match the

3 In the Front viewport,
size of the blueprint image.

scale the polygon down to match the
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4 Also in the Front viewport,
contour of the fuselage.

352 | Chapter 3 Modeling Tutorials

move the polygon up to match the

Subdivide the rear polygon:

1 From the Orbit flyout, choose

(Orbit SubObject). Then

orbit,
pan, and
zoom the Perspective viewport to get a
good view of the rear polygon.
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2 On the ribbon ➤ Polygon Modeling panel, click

(Vertex).

3 As you did for the large polygon in the air intake,
click and
Ctrl+click to select horizontal pairs of vertices, then click ribbon ➤ Loops
panel ➤
(Connect) to add three horizontal edges and subdivide
the large polygon into four quadrangular polygons.
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Begin modeling the tail:

1 On the ribbon ➤ Polygon Modeling panel, click

(Polygon).

If all four rear faces aren’t selected when you switch to the Polygon

sub-object level, then

2

click and Ctrl+click to select them.

Extrude the faces to the end of the tail.
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Front view

3 In the Top viewport,
scale the faces down to narrow the
bottom-rear portion of the tail.
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Perspective view

4 On the ribbon ➤ Polygon Modeling panel, click

(Vertex).
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5 In the Front viewport, region-select vertices to be sure you are adjusting

both sides of the tail, then
move the vertex pairs to follow the
contour along the lower part of the tail.
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Save your work:
■

Save the scene as p47_fuselage.max.

Next
Add the Vertical Stabilizer on page 363

Add the Vertical Stabilizer
The portion of the tail that rises above the fuselage is technically known as
the “vertical stabilizer.”
Set up the lesson:
■

Continue working from the previous lesson.
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Begin extruding the vertical stabilizer:

1 Go to the

(Polygon) sub-object level.

2 In the Top viewport,
click and Ctrl+click to select the two faces
on the top of the fuselage, from which you will “grow” the upper part of
the tail.

3

Extrude these faces upward as far as the first hinge of the rudder.
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Front view
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4 On the ribbon ➤ Align panel, click

(Align Y).

3ds Max aligns the two polygons so they are level.
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Front view

NOTE The axis in which you need to align faces depends on how you created
your geometry. In this case, the fuselage began as a cylinder built in the Left
viewport, so aligning to the Y axis makes the faces horizontal. In a different
model, you might have to experiment to find the axis that works.

5 In the Front viewport,
scale and
move the faces along
the X axis to match the outline of the tail to the blueprint image.
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6 On the ribbon ➤ Polygon Modeling panel, click

(Vertex).

7 In the Front viewport,
region-select the two vertices at the
leading edge of the top of the tail.
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8 Activate the Top viewport, and then
scale these two vertices
along the Y axis to bring them closer together and narrow the width of
the tail.
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Complete the vertical stabilizer:

1 In the Front viewport,

region-select the vertices at the center of

the top edge of the tail, and
move them along the X axis to
align them with the leading edge of the rudder.
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2 On the ribbon ➤ Polygon Modeling panel, click

(Polygon).

The two faces on top of the tail should become the active selection again.

If they don’t, then in the Top or Perspective viewport,
Ctrl+click to select them.

3

click and

Extrude the faces on the top of the tail as far as the top of the
upper hinge of the rudder.
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Front view

4 In the Front viewport,
scale and
move the faces in the
X axis to fit the tail outline to the blueprint image.
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5

Extrude the tail polygons a final time, stopping just shy of the
top of the tail as shown in the blueprint images.
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Front view

As you did for the bottom portion of the tail, you will move vertices to
round the outline of the top of the tail. But to get enough vertices to
model the curvature well, first you add another set of edges,

6 On the ribbon ➤ Polygon Modeling panel, click

7

(Edge).

In the Front viewport, click to select one of the horizontal edges
on the forward, stationary portion of the tail.
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8 On the ribbon ➤ Modify Selection panel, click

(Ring).

3ds Max selects a ring of parallel edges around the forward part of the
tail and the corresponding portion of the fuselage.
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9 On the ribbon ➤ Loops panel, Shift+click

(Connect).

3ds Max displays the caddy for the Connect tool.
10 Use the third control, Slide, to position the new edges roughly in the
middle of the forward, stationary part of the tail.
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11 Click

12 Go to the

(OK).

(Vertex) sub-object level, then use region-select to

select pairs of vertices, and
move them to follow the outline of
the tail, as shown in the blueprint image. At this stage, you might also
want to move the vertex pairs in the middle of the tail, to improve their
alignment.
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13 Click

(Vertex) again to exit the Vertex sub-object level.

Save your work:
■

Save the scene as p47_fuselage_and_tail.max.

Next
Refine the Fuselage on page 387

Refine the Fuselage
In this lesson, you add more edges to improve the regularity of the fuselage
and refine its profile.
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Set up the lesson:
Continue working from the previous lesson.

■

Add vertical edges to the fuselage:

1 Activate the Front viewport and click
you can see all of the fuselage.

(Zoom Extents Selected) so

2 On the ribbon ➤ Polygon Modeling panel, click

3

(Edge).

Select one of the edges in the portion of the fuselage between
the cockpit and the tail.
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4 On the ribbon ➤ Modify Selection panel, click

(Ring).

3ds Max selects all parallel edges around the circumference of the fuselage.

5 On the ribbon ➤ Loops rollout, Shift+click

(Connect).

3ds Max displays the caddy for the Connect tool. For the third setting,
Slide, right-click the spinner arrows to reset the value to 0. Then change

the first setting, Segments, to 2, and then click

(OK).

3ds Max adds two vertical sets of edges, evenly spaced, along the length
of the rear of the fuselage. (Setting the Slide value to zero guarantees that
the new edge loops are evenly spaced.)
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6

Select one of the horizontal edges below the cockpit. Click
(Ring) again, and then click Loops panel ➤

(Connect).

NOTE For this step, since you aren’t changing the Connect tool settings,
you can just click the button.

7

Select one of the horizontal edges in the section of the fuselage
in front of the cockpit. Click

390 | Chapter 3 Modeling Tutorials

(Ring) again, and then Shift+click

(Connect). Use the Connect tool caddy to reduce the number

of Segments to 1, and then click

(OK).

3ds Max adds a single set of vertical edges between the front of the cockpit
and the rear of the engine cowl.

Adjust the curve of the lower part of the fuselage:

1 On the ribbon ➤ Polygon Modeling panel, click

(Vertex).

2 Using region selection to select pairs of vertices along the bottom of the

fuselage,
move them along the Y axis so the bottom outline of
the fuselage better follows the curve that the blueprint image shows.

Creating the Fuselage | 391

3 Click

(Vertex) again to exit the Vertex sub-object level.

Save your work:
■

Save the scene as p47_fuselage_detailed.max.

Next
Completing the Tail on page 392

Completing the Tail
To complete the tail, you add horizontal stabilizers on either side of the vertical
stabilizer.

Begin Adding the Horizontal Stabilizers
The horizontal stabilizers are shaped like small wings, and you use similar
methods to model both these airplane parts. Because the horizontal stabilizers
and the wings are symmetrical, it helps to split the model in half and use a
Symmetry modifier to restore the mesh: This way, you have to model only
one stabilizer and one wing; the modifier takes care of the other side of the
airplane.
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Set up the lesson:

1 Continue working on your scene from the previous lesson, or
open \modeling\p47\p47_01.max.

2 If you opened the file,

select the P-47 fuselage and go to the

Modify panel.
Split the model in half and add a Symmetry modifier:
1 Press Alt+X to turn off X-Ray display.
2 If you need to, adjust the Perspective view so you can see the P-47 fuselage
from the front.

Select the fuselage. Then on the ribbon ➤ Polygon Modeling

3

panel, click

4

(Edge).

Click to select one of the lateral edges at the very top of the
fuselage.
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5 On the ribbon ➤ Modify Selection panel, click
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(Ring).

6 On the ribbon ➤ Loops panel, Shift+click

(Connect).

3ds Max displays the Connect tool caddy. On the caddy, be sure to set
Slide (the third control) to 0 so the new set of edges is perfectly centered,

and then click

(OK).
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TIP You can right-click the spinner arrows to set the Slide value to zero.
Now you are ready to split the fuselage model.

7 On the ribbon ➤ Polygon Modeling panel, click

(Polygon).

8 On the ribbon, go to the Selection tab.

9

Click the viewport at a distance from the fuselage, to make sure
no polygons are selected.
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10 On the ribbon ➤ Selection tab ➤ By Half panel, make sure that X is

the chosen axis, and then click

(Select).

This selects the right half of the P-47 (from the airplane’s point of view).

11 Press Delete.
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12 On the ribbon, return to the Graphite Modeling Tools tab, and on the
Polygon Modeling panel, click
sub-object level.

(Polygon) to exit the Polygon

13 On the Modify panel ➤ Modifier List, choose Symmetry.
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Now the model appears complete again. But the right side is generated
by the Symmetry modifier, and changes you make to the left side will be
reflected on the other side.
NOTE The symmetry must be about the X axis: This is the default for the
Symmetry modifier.

Create the edges from which you will build the stabilizers:
1 Press Alt+X to turn on X-Ray display again.

2 Activate the Front viewport, and
stabilizers will be.

zoom in to the region where the
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3 On the ribbon ➤ Polygon Modeling panel, click
Modifier), then click

(Previous

(Polygon).

Also on the ribbon ➤ Polygon Modeling panel, click to turn off
(Show End Result). This makes it a bit easier to see the blueprint image.

4 On the
Show Cage.

Modify panel ➤ Subdivision Surface rollout, turn off
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The cage display can be useful when you work with smoothing, but for
the time being, it just makes it harder to see the plain geometry.

5 On the ribbon ➤ Edit panel, turn on

(Cut).

6 Cut edges that follow the outline of the stabilizer that appears in the
blueprint image. Right-click to exit the Cut tool.
TIP The cursor for the Cut tool has three different forms:

■

■

■

when the cursor is at a vertex

when the cursor is on an edge

when the cursor is on a face

In this step, you create free-standing vertices to round the leading and trailing
edges of the stabilizer: In general, a model should not have free-standing
vertices, and in a moment you will add edges to connect these vertices to
other vertices.
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TIP If the fuselage vertices overlap the stabilizer area, you can
move
them so their locations are more like those shown in this illustration.
7 Right-click to close the Cut tool.

8 Use the
Cut tool again to create edges that join the free-standing
vertices to the corner vertices of the neighboring faces. This ensures that
the mesh still has all quadrangular faces.
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Begin to extrude the stabilizers:

1

Click and Ctrl+click to select the faces at the base of the stabilizer.
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2 If you aren’t already working with a four-viewport layout, click
(Maximize Viewport Toggle) to display all four viewports.

3 On the ribbon ➤ Polygons rollout, Shift+click
(Extrude). Use the
caddys Height control to extrude the faces by a value of about 20.0. Watch
your work in the Perspective and Top viewports.
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Top view

4 Click

(OK).

5 On the ribbon ➤ Align panel, click

(Align X).
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Top view

As you can see, there is a discrepancy between the side and top blueprint
images. This is not unusual, especially when one of the drawings is
foreshortened as the side image is. In the next couple of steps, you will
adjust vertices to better match the top image, which is the more accurate
one.
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6 Go to the
(Vertex) sub-object level.
Select the three
vertices where the trailing edge of the stabilizer joins the fuselage, and
move them forward along the X axis to better match the top blueprint
drawing. In the Top viewport, move them down along Y so they follow
the fuselage contour (check this in the Perspective viewport).

Adjusting the trailing edge of the stabilizer
Front view
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Adjusting the trailing edge of the stabilizer
Top view

7 Do the same for the three vertices at the leading edge of the stabilizer
(probably you won’t have to move them very much in the Top viewport).

Adjusting the leading edge of the stabilizer
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Front view

Adjusting the leading edge of the stabilizer
Top view

8 Click

(Polygon) again.

9 In the Top viewport,
rotate the stabilizer faces on the Z axis to
better follow the direction of the stabilizer. About 5 degrees is enough.
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10 Activate
(Select And Move), then choose Local as the transform
coordinate system (after you rotate the faces, you can’t rely on View
coordinates).

In the Top viewport, move the faces to better match the blueprint image.
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11 Activate
(Select And Uniform Scale), choose Local as the
coordinate system once more, then scale the faces up slightly in the Y
axis so they match the blueprint image.
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12 In the Front viewport,
move the faces vertically in local Y axis
to make them horizontal. Watch your work in the Left and Perspective
viewports.
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Left view
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Perspective view

Next
Complete the Horizontal Stabilizers on page 414

Complete the Horizontal Stabilizers
To complete the horizontal stabilizers, you continue extruding and shaping
them as you did the vertical stabilizer.
Set up the lesson:
■

Continue working from the previous lesson.
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Continue extruding the stabilizers:

1 Click
(Extrude), and then drag to extrude the stabilizer as far as
the rectangular flap. Work in the Front viewport but watch the Top
viewport.

2 In the Top viewport,
move and
local Y axis so they match the blueprint image.

scale the faces in their
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3 Click
(Vertex), then in the Top viewport,
move the
vertices at the leading edge of the stabilizer to better match the blueprint
image.
TIP This step is easiest if you switch the transform coordinate system back
to View.
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4 Go back to the
(Polygon) level, then
again, this time almost to the tip.

extrude the stabilizer
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5 On the ribbon ➤ Align panel, click
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(Align X).

6 In the Top viewport,
move and
local Y axis so they match the blueprint image.

scale the faces in their

7 To shape the tip of the stabilizer, you need a bit more detail in the
geometry.

Go to the
(Edge) sub-object level.
Click to select one of
the longitudinal edges in the widest faces of the stabilizer.
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8 On the ribbon ➤ Modify Selection panel, click

420 | Chapter 3 Modeling Tutorials

(Ring).

9 On the ribbon ➤ Loops panel, click

(Connect).
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Now the tip of the stabilizer has seven pairs of vertices, which will help
you give it shape.
Complete the stabilizers:

1 In the Top viewport,
zoom in on the tip and
pan so you
have a good view of both the geometry and the blueprint image.
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2 Return to the
(Polygon) sub-object level, and
extrude the
faces again, almost to the end of the stabilizer in the blueprint image.
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3 Go to the

(Vertex) sub-object level, then use region selection to

move vertices so they match the curve of the tip of the stabilizer.
TIP Move the closely spaced vertices at the leading and trailing edges as
pairs (actually four vertices, counting top and bottom), then adjust them
further in the next step.
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4 For the closely spaced vertices at the leading and trailing edges of the

stabilizer tip, use region selection to
they follow the contour of the curve.

rotate the vertex pairs so
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5 Click

(Vertex) again to exit the Vertex sub-object level.

Save your work:
■

Save the scene as p47_stabilizers.max.

Next
Check the Airplane Geometry on page 426

Check the Airplane Geometry
In this lesson, you make one adjustment to correct an artifact that occurred
when you created the horizontal stabilizers, and then you use NURMS
smoothing to check the overall model.
Set up the lesson:
■

Continue working from the previous lesson.

Adjust the join between the stabilizers and the fuselage:
1 Press Alt+X to turn off X-Ray display.
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2 On the ribbon ➤ Polygon Modeling panel, click to turn on
End Result).

(Show

3 In the Perspective viewport,
zoom in (and otherwise adjust the
view as necessary) to get a good view of the area where the left-side
stabilizer joins the fuselage. Press F4 to turn off Edged Faces display.

The horizontal stabilizers look good, but where they join the fuselage,
there are two faces that are awkwardly narrow. You can fix this by moving
a single vertex.

4 Go to the

(Vertex) sub-object level.

5 In the Perspective viewport,
zoom in still further to get a good
view of the vertices that surround the narrow faces.
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6 On the ribbon ➤ Edit panel, activate

(Constrain To Edge).

7 Turn on
(Select And Move), then select the forward vertex where
the narrow faces join.
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8 Move the vertex forward along the edge so the fuselage faces have more
area.

The wider faces will smooth more easily.

9 On the ribbon ➤ Edit panel, activate

(Constrain To None).
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IMPORTANT When you forget that a constraint is on, surprising things can
happen when you transform sub-objects. Because of this, it is a good idea to
deactivate a constraint as soon as you have finished using it. Also, the buttons
in this set behave like radio buttons. You can’t turn a constraint off by clicking
its button a second time: You must activate Constrain To None to deactivate
the currently active constraint.

10 Exit the

(Vertex) sub-object level.

Use NURMS to check the appearance of the P-47:

1 In the Perspective view,
the entire airplane again.

zoom out and

2 On the ribbon ➤ Edit panel, click
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pan so you can see

(Use NURMS).

The NURMS option (it stands for Non-Uniform Rational Mesh Smooth, an
industry-standard method) is provided for smoothing editable polygon
surfaces.
3 On the ribbon ➤ Use NURMS panel, increase the number of iterations
to 2.
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The airplane model, with its stabilizers, is looking good. Some faces,
especially those at the air intake, are being smoothed more than they
ought to be: You will fix this in a later lesson.

4 Click

(Use NURMS) again to turn it off.

5 Click

(Polygon) again to exit the Polygon sub-object level.

Next
Adding the Wings on page 432

Adding the Wings
The wings are shaped extrusions as are the horizontal stabilizers. Once more,
the wing on the right side is provided by the Symmetry modifier.

432 | Chapter 3 Modeling Tutorials

Begin Adding the Wings
To create the wings, first you make some adjustments to the contours of the
fuselage.
NOTE If you feel comfortable with the techniques shown in the previous lessons,
and don’t feel like going through all the steps to build a wing, you can skip ahead
to Creating the Cockpit on page 468.
Set up the lesson:

1 Continue working on your scene from the previous lesson, or
open \modeling\p47\p47_02.max,

2 If you open the file,

select the P-47. On the ribbon ➤ Polygon

Modeling panel, click Modify Mode, and then click
Modifier) to go to the Editable Poly level of the stack.

3 On the ribbon ➤ Polygon Modeling panel, click
Result) to turn it on.

(Previous

(Show End

Create the “foundation” for the left-hand wing:

1 On the ribbon ➤ Edit panel, click

(SwiftLoop).

2 In the Front viewport, use SwiftLoop to create a longitudinal loop of
edges near the bottom of the fuselage.
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3 Right-click to exit the SwiftLoop tool.

4 Go to the

(Vertex) sub-object level.

5 On the ribbon ➤ Edit panel, activate

(Constrain To Edge).

6 In the Front viewport, along the edge above the new edge loop,
move vertices vertically to make a contour that will surround the wing
faces.

7 On the ribbon ➤ Edit panel, activate
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(Constrain To None).

8 Click

(Vertex) again to exit the Vertex sub-object level.

9 On the ribbon ➤ Edit panel, click

(Cut).

10 In the Front viewport, use the Cut tool to creae edges around the outline
of the wing. You can use some of the blueprint image to help locate these
cuts, but for the forward part of the wing, use the contour above it and
the following illustration.

11 Right-click to exit the Cut tool.

12 Turn on
(Cut) once again, and as you did for the stabilizer, add
edges from the free-standing vertices at the leading and trailing edges of
the wing to the nearby corner vertices, to make sure all polygons are
quadrangular.
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13 Right-click to exit the Cut tool.
Begin to extrude the wing:

1 Go to the

2

(Polygon) sub-object level.

Click and Ctrl+click to select the faces that make up the base of
the wing.
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3 On the ribbon ➤ Polygons panel, click
extrude the faces a short distance.

(Extrude). Then drag to

TIP As you did for the stabilizer, drag in the Front viewport but watch your
work in other viewports, especially the Top view.
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Top view

4 On the ribbon ➤ Align panel, click

5

(Align X).

Scale the faces along their X axis and
move them in
both X and Y so the wing extrusion matches the blueprint image in the
Top viewport.
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TIP This step won’t work if constraints are active: Make sure that
(Constrain To None) is active.

6 In the Left view,
scale and
move the faces along their
Y axis so the wing matches the blueprint image.
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TIP At this point, if the upper surface of the wing seems too low, you can

go to the

(Vertex) sub-object level, activate

(Constrain To

Edge), and
move the vertices along the base of the wing’s upper
edge upward along the fuselage (it’s easiest to select these vertices in the

Perspective viewport). Be sure to activate
you’re done.

7 At the
(Polygon) sub-object level,
as the seam at its middle.
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(Constrain To None) when

extrude the wing as far

Top view

8

Scale the faces along their X axis and
move them in
both X and Y so the wing extrusion matches the blueprint image in the
Top viewport.
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Top view

9 Also
scale and
move the wing in the Left viewport, so
it matches the blueprint image.

Finish extruding and shaping the wings:

1

Extrude the wing as far as the last seam.
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Top view

2 Once again,
scale and
move the faces so the wing
matches the blueprint image in the Top viewport.
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Top view

3 Do the same in the Left viewport.
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4

Extrude the wing again, this time to the very tip.

Top view
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NOTE The long edge segments don’t do justice to the curvature of the wings,
especially at their trailing edges. In the next lesson, you will refine these the
way you refined the curvature of the fuselage.

5 In the Left viewport,
scale and
the wing to the blueprint image.

6 Go to the

move the faces to match

(Vertex) sub-object level.

7 In the Top viewport, use region selection to select pairs of vertices (top

and bottom), and
move them so the curve of the wing tip
matches the blueprint image.
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Next
Complete the Wings on page 451

Complete the Wings
To complete the wings, you adjust some details and improve the curvature of
the trailing edges.
Set up the lesson:
■

Continue working from the previous lesson.

Check your work:

1 In the Perspective viewport,
the wings are even.

orbit around the model to make sure

Adding the Wings | 451

If any vertices seem out of place, especially along the vertical axis, move

them

2 Activate

to improve the wing’s appearance.

(Select Object) to turn off Orbit.

3 Press Shift+Z to undo changes to the Perspective view.
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4 In the Left viewport,
select the wingtip vertices, and
scale them down a bit vertically.

5 Do the same for the vertices at the wingtip seam.
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These adjustments are more intuitive than quantitative: Aim for a result
that is visually pleasing to you.

6 Click

(Vertex) again to exit the Vertex sub-object level.

Refine the curvature of the wings:

1

Zoom and
left-hand wing.
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pan the Top viewport so you can see all of the

2 On the ribbon ➤ Edit rollout, turn on
(SwiftLoop). Then in the
Top viewport, use SwiftLoop to add two new edge loops that subdivide
the long faces on the wing.
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3 Right-click to turn off the SwiftLoop tool.

4 Go to the

(Vertex) sub-object level again, region-select vertices

at the trailing edge of the wing, then
move them to better match
the curvature of the wing, as shown in the blueprint image.
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5 Click

(Vertex) again to exit the Vertex sub-object level.

Save your work:
■

Save the scene as p47_wings.max.

Next
Correct the Air Intake on page 460
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Correct the Air Intake
As you will see, adding an edge loop for the wing geometry created a problem
with the air intake. In this lesson, you correct that problem and further refine
the shape of the intake.
Set up the lesson:
Continue working from the previous lesson.

■

Use NURMS again to check your work:
1 Press Alt+X to turn off X-Ray display, then on the ribbon ➤ Edit rollout,
turn on
(NURMS). On the Use NURMS panel, increase the
number of iterations to 2.
2 Activate the Perspective viewport, and press F4 to turn off Edged Faces.

The smoothed model shows that the wings are successful.

3

Zoom and
pan the Left viewport so you have a good view
of the air intake. Press F4 to turn off Edged Faces.
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Two edges at the lower edge of the intake are sharper than they should
be: These come from the additional contour you created with SwiftLoop
when you were preparing to extrude the wings. You will correct these in
the next procedure.

4 Click

(NURMS) again to turn it off.

Correct the air-intake edges:
1 In the Front viewport, press F4 to turn on Edged Faces again.
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2 Go to the

cowl,
viewport.

(Edge) sub-object level. On the very front of the engine

select the new edge that is to the lower right of the
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3 On the ribbon ➤ Edit rollout, activate

(Constrain To Edge), then

move the edge upward to about the center of the face it is on.
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4 On the ribbon ➤ Edit rollout, activate

(Constrain To None),

then
move the edge again, outward this time, so the intake
portion of the engine cowl is a bit more rounded.
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5 Select the center edge at the bottom of the front of the intake, and

move it down along the Y axis.

Adding the Wings | 465

6 Select the corresponding edge at the top of the intake, and
it up slightly along the Y axis.

466 | Chapter 3 Modeling Tutorials

move

7 Deselect all edges.

8 Turn on

(NURMS) again, and press F4 to turn off Edged Faces.
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Now the intake portion of the cowl looks a good deal better.

9 Click

(NURMS) again to turn off smoothing.

Save your work:
■

Save the scene as p47_wings_intake_fixed.max.

Next
Creating the Cockpit on page 468

Creating the Cockpit
The cockpit includes a canopy, which becomes a separate object. It also
includes part of the hollow interior of the aircraft.
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Begin Modeling the Cockpit Canopy
To model the cockpit, you begin by shaping the fuselage in the cockpit region,
then extruding polygons in that same region. This is the basis for the cockpit
canopy, which becomes a separate object.
Set up the lesson:

1 Continue working on your scene from the previous lesson, or
open \modeling\p47\p47_03.max,

2 If you open the file,
select the P-47. On the ribbon ➤ Polygon
Modeling panel, click Modify Mode.
Collapse the stack:
Now that you’ve created the horizontal stabilizers and the wings, the Symmetry
modifier has done its work, so you can collapse the airplane model back into
a unified object once again.
■

Right-click the P-47, and from the Tools (lower-right) quadrant of the quad
menu, choose Convert To ➤ Convert To Editable Poly.

Outline the cockpit:

1 On the ribbon ➤ Polygon Modeling panel, click

(Vertex).

2 Press Alt+X to turn on X-Ray display again.
3 In the Front viewport, region-select the top vertices just behind those at

the front of the cockpit, and
outline in the blueprint image.

move them to match the cockpit
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NOTE Now that the model is collapsed, when you region-select the top row,
you are selecting three vertices: both sides and the middle of the fuselage.
4 Region-select the vertices immediately below these along the lateral edge,

and

move them forward so the mesh is a bit more regular.
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5 Region-select the top vertices behind the ones you moved in step 2, and

move them to match the blueprint outline as well.
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6 Region-select the vertices immediately below these along the lateral edge,

and
move them forward to adjust the mesh as you did for the
more forward edge.
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7 In the Top viewport,
view of the cockpit area.

pan and

zoom in so you have a good
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8 In the Front viewport, region-select the row of vertices at the leading

edge of the cockpit, and then in the Top viewport,
scale them
along the Y axis so they match the shape of the cockpit (the dark-blue
area) in the blueprint image.

9 Repeat the preceding step for the other three rows that define the area
of the cockpit. Use the Front viewport to region-select the vertices, and
then use the Top viewport to watch how you scale them.
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Extrude the cockpit canopy:

1 On the ribbon ➤ Polygon Modeling panel, click

2 On the
Backfacing.

(Polygon).

Modify panel ➤ Selection rollout, turn on Ignore

3 In the Top viewport,
click and Ctrl+click to select the polygons
that make up the cockpit area.
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4 On the ribbon ➤ Polygons panel, click
(Extrude). In the
Perspective viewport, extrude the polygons: Watch your work in the Front
viewport, so you can make the extrusion about the height of the cockpit
canopy in the blueprint image.
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Front view

5 On the ribbon ➤ Align panel, click
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(Align Y).

Front view

If you need to,
move the polygons so that in the Front viewport,
they are the same height as the canopy in the blueprint image.

6 On the
Backfacing.

Modify panel ➤ Selection rollout, turn off Ignore

Next
Block Out the Shape of the Canopy on page 479

Block Out the Shape of the Canopy
Now you give the cockpit canopy its overall shape. You will add more detail
to the geometry in a later lesson.
Set up the lesson:
■

Continue working from the previous lesson.
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Block out the shape of the canopy:

1 On the ribbon ➤ Polygon Modeling panel, click

(Vertex).

2 As you did for the top of the cockpit (which is now the bottom of the

canopy), in the Front viewport region-select vertex groups, and
move them to follow the shape of the canopy in the blueprint image.

3 In the Front viewport, region-select the leading edge of vertices in the
glass part of the canopy (the upper part, above the fuselage), then in the

Top viewport,
scale the vertices along the Y axis. This time, use
the Left viewport to monitor your work and match the model to the
blueprint image.
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Left view
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4 Repeat the preceding step for the row of vertices immediately behind the
row you just scaled.
NOTE For this row and the next one, you won’t be able to duplicate the
extreme round shape shown in the Left viewport’s blueprint image. This isn’t
a problem: Later on, you will increase the curvature. For this step, approximate
the metal struts of the canopy, which in the blueprint image are shown in
the lighter color.
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Left view

5 And repeat the step once more for the third row of vertices, at the top of
the canopy before it narrows again.
For this step, approximate the outer edge of the canopy, shown in dark
blue.
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Left view
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6 In the Top viewport,
click and Ctrl+click to select the three
vertices along the “ridgeline” of the canopy.

TIP If you select a vertex you don’t want to move, use Alt+click to deselect
it.

7 In the Front viewport,
move these vertices up along the Y axis
while watching the outcome in the Left viewport.
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8 In the Front viewport,
click to select only the most forward of
the three vertices you just moved.
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9

Move the vertex down a bit in the Y axis to make the outline
of the canopy look smoother.
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Left view

Detach the canopy and hide it:
The canopy will become a separate object from the fuselage. In this procedure,
first you detach the canopy from the fuselage, and then hide it: The next
lesson will concentrate on modeling the interior of the cockpit.
You finish adding detail to the canopy object in a lesson that follows.

1 On the ribbon ➤ Polygon Modeling panel, click

(Polygon).

2 On the main toolbar, make sure the Window/Crossing toggle is in its

Crossing state; on the

Modify panel ➤ Selection rollout,
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make sure that Ignore Backfacing is turned off; then in the Front viewport,

drag a selection box to select all the polygons in the canopy.

3 On the ribbon ➤ Geometry (All) rollout, click

(Detach).

4 On the Detach dialog, name the new object Canopy. Make sure both
options are turned off (they should be off by default), and then click OK.
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5 On the ribbon ➤ Polygon Modeling panel, click
to exit the Polygon sub-object level.

6

(Polygon) again

Click to select the new Canopy object.

7 Right-click, and from the Display (upper-right) quadrant of the quad
menu, choose Hide Selection.
You will unhide the cockpit, and finish it, after you finish modeling the
fuselage.
Save your work:
■

Save the scene as p47_cockpit_and_canopy.max.

Next
Create the Cockpit Interior on page 492
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Create the Cockpit Interior
The cockpit interior doesn’t require extensive detail, but adding it restores the
fuselage model to being a single continuous surface.
Set up the lesson:
■

Continue working from the previous lesson.

Begin modeling the interior of the cockpit:
1 Select the P-47 fuselage.
2 Press Alt+X to turn off X-Ray display.

3 In the Perspective viewport,
view of the top of the cockpit.

zoom and

pan to get a better

The P-47 fuselage now has a cockpit-shaped hole in it. To make the model
a continuous surface again, you will add faces to form the interior of the
hole.
4 On the ribbon ➤ Polygon Modeling panel, click
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(Border).

5

Click the edge of the cockpit to select all of the border edges.

6

Shift+move the border downward to clone it and create a rim
for the cockpit.
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7 Press Alt+X to turn on X-Ray display again.

8 In the Top viewport,
Shift+scale the new border uniformly, to
make the cockpit interior wider than its rim.
Watch all four viewports when you do this step: You don’t want the sides
of the cockpit interior to extend beyond the outside of the fuselage!
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9 In the Front viewport,
Shift+move the cockpit border down,
until the new border is just above the level of the wings.
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10 On the ribbon ➤ Align panel, click
border horizontal.

(Align Y) to make the new

Add a floor to the cockpit:
1 Press Alt+X to turn off X-Ray display.

2 In the Perspective viewport,
zoom and
most of the opening at the bottom of the cockpit.
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pan so you can see

The bottom of the cockpit is still an open hole.

3 On the ribbon ➤ Geometry (All) panel, click

(Cap Poly).

3ds Max creates a polygon to cap the open border.
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4

Zoom,
pan, and
orbit the Perspective viewport so
you can see all of the floor of the cockpit.
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The polygon you just created is large and multisided, so you need to
subdivide it into quadrangular polygons.

5 On the ribbon ➤ Polygon Modeling panel, click

(Vertex).

6 Two lateral edge loops were interrupted by the cockpit hole, and now
they are interrupted by the large polygon that forms the cockpit floor.

To fix this,
click and Ctrl+click to select the two vertices where
the forward edge loop stops at the cockpit floor, then on the ribbon ➤
Loops rollout, click

(Connect).

7 Do the same for the trailing pair of edge loop vertices.
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8 On the ribbon ➤ Polygon Modeling panel, click

9

(Edge).

Click an empty part of the viewport to deselect any edges that
are automatically selected, then click and Ctrl+click to select the two edges
you just created.
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NOTE Even if the two edges are selected by default when you switch to the
Edge sub-object level, deselect them and then select them explicitly:
Otherwise, the default edges created in the next step, when you click Connect,
will form too complex a web of edges.

10 On the ribbon ➤ Loops rollout, click

(Connect).

Creating the Cockpit | 501

11 To complete the “quadrification” of the cockpit floor, use the ribbon ➤
Edit panel ➤
(Cut) tool to connect the vertex at the front floor
level of the cockpit to the one at the middle of the leading floor-level
loop. Use the Cut tool again to connect the vertex at the middle of the
trailing flor-level loop to the one in the middle of the back floor level of
the cockpit.
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Now the polygons that form the interior of the cockpit are all
quadrangular, and follow the overall pattern of the polygons that form
the exterior of the fuselage.
Add leg room to the cockpit:

1

Zoom,
pan, and
orbit the Perspective viewport so
you have a more edge-on view of the cockpit.

2

Click to select one of the vertical edges along the side of the
cockpit interior.
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3 On the ribbon ➤ Modify Selection panel, click

(Ring).

3ds Max selects all the vertical edges, in a ring around the inside of the
cockpit.

4 On the ribbon ➤ Loops panel, click

(Connect).

3ds Max connects the edges with a new horizontal loop of edges.
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5 On the ribbon ➤ Edit panel, activate

6

(Constrain To Edge).

Move the new edge loop up a bit.
TIP Change the coordinate system to Local before you move the edge loop.

7 On the ribbon ➤ Edit panel, activate

8

(Constrain To None).

Zoom and
orbit the Perspective viewport so you can see
the polygons at the front of the cockpit interior.
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9 Go to the

10

(Polygon) sub-object level.

Click and Ctrl+click to select the two polygons at the bottom of
the front wall of the cockpit interior.
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11 On the ribbon ➤ Polygons panel, turn on
(Extrude). Drag to
extrude the polygons forward, providing leg room for a pilot. (The two
polygons above the leg room but below the cockpit rim would be the
location of the instrument panel.)

12 Exit the

(Polygon) sub-object level.

Next
Refine the Cockpit on page 507

Refine the Cockpit
Although the cockpit is essentially done, you need to add edges and adjust
their position so the cockpit still looks good when you smooth the model.
Set up the lesson:
■

Continue working from the previous lesson.
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Use smoothing to preview the model and help you refine the geometry:

1

Zoom,
pan, and
orbit the Perspective viewport so
you have a more conventional view of the whole airplane, or most of it.
Angle the view so you are looking down on the cockpit area.

2 On the ribbon ➤ Edit panel, turn on
(NURMS), and then on
the ribbon ➤ Use NURMS panel, increase the number of iterations to
the usual value (for the P-47) of 2.
The model is smoothed nicely, and the cockpit is smoothed all the way
around. This is easiest to see in the Top viewport.
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However, the blueprint image shows that the leading edge of the cockpit
should be straight. You can fix this by adding some edges (as you saw
when you refined the air-intake portion of the engine cowl, placing edges
close together reduces the effect of NURMS smoothing).

3 Turn off

4 Go to the

(NURMS).

(Edge) sub-object level.

5 On the ribbon ➤ Edit panel, turn on
(SwiftLoop). Add a new
lateral loop of edges, about halfway between the leading edge of the
cockpit and the loop of edges that is now in front of it.
TIP For this step and the ones that follow, you might want to use the

Perspective viewport and

zoom in before you make the changes.
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6 Right-click to turn off SwiftLoop.

7

Click and Ctrl+click to select the two edges on top of the fuselage,
in the new loop you just created.
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8 On the ribbon ➤ Edit panel, activate

9

(Constrain To Edge).

Move the two edges so they are close to the leading edge of the
cockpit.
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10 Turn on
(SwiftLoop) again, and add another lateral loop of edges
behind the leading edge of the cockpit, about halfway to the edges that
trail it.
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11 Right-click to turn off SwiftLoop.

12

Click and Ctrl+click to select the two small edges along the rim
of the cockpit, in the new loop you just created.

To select both edges, you have to

orbit the Perspective view.
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13

Move the two rim edges forward so they too are close to the
leading edge of the cockpit.

14 On the ribbon ➤ Edit panel, activate
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(Constrain To None).

15 Click

(Select Object) to exit Move.

16 Press Shift+Z several times to undo Perspective view changes, and return
to an overhead view of the P-47.

17 On the ribbon ➤ Edit panel, turn on

(NURMS).

The leading edge of the cockpit is now straight, as it is in the blueprint
images.
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18 Turn off

(NURMS).

Next
Refining the Aircraft on page 516

Refining the Aircraft
To complete the aircraft, you make various adjustments to both the fuselage
and the cockpit canopy.

Refine the Curvature of the Nose
The nose of the fuselage is flat on top. Making it a bit more rounded improves
the airplane’s appearance.
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Set up the lesson:
Continue working from the previous lesson.

■

Improve the curvature of the top front portion of the fuselage:

1

Click and Ctrl+click to select the three ridgeline edges in front
of the cockpit, and the ridgeline edge immediately behind it.
TIP Use region selection for the small edge where you reinforced the front
of the cockpit. If you select an edge by mistake, use Alt+click to deselect it.

2

Move these edges up vertically a bit, to make the fuselage more
rounded.
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Front view
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Increase the curvature at the top of the engine cowl:

1 Switch to the

2

3

(Vertex) sub-object level.

Click and Ctrl+click to select the three vertices along the top of
the engine cowl.

Move these vertices up a bit, as well.
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Front view

4 Click

(Vertex) to turn it off and exit the Vertex sub-object level.

5 In the Perspective viewport,
Edged Faces.

zoom out and press F4 to turn off

6 On the ribbon ➤ Edit panel, turn on

(NURMS) once again.

Now the fuselage is convincingly rounded.
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7 Turn off

(NURMS).

Save your work:
■

Save the scene as p47_fuselage_finished.max.

Next
Set Up Smoothing for the Fuselage on page 522

Set Up Smoothing for the Fuselage
NURMS smoothing does its job a little too well. There should be clear joins
between some parts of the airplane; for example, between the wings and the
fuselage. You can fix this by using smoothing groups. Smoothing groups
change the appearance of the model without changing its geometry. Unlike
NURMS, smoothing groups don’t increase the face count: This can be an
important consideration if you are preparing your model for use in a game.
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Set up the lesson:
■

Continue working from the previous lesson.

Set up the viewports:

1 With the P-47 selected, choose

(Zoom Extents All Selected).

2 Activate the Left viewport, and
of the air intake.

region zoom to get a good view

Smooth the engine cowl:

1 Go to the

(Polygon) sub-object level.

2 Press Ctrl+A to select all polygons in the airplane.
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3 On the ribbon ➤ Properties panel ➤ drop-down portion, click
(SmGroups).
3ds Max opens the Smoothing Groups dialog.

4 On the Smoothing Groups dialog, click Clear All.
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This removes any default smoothing-group values that the faces might
have.
Leave the Smoothing Groups dialog open: You will be using it throughout
this lesson.
5 On the main toolbar, make sure the Window/Crossing toggle is in its

Crossing state, then in the Front viewport,
to select the faces at the very front of the engine cowl.

drag a region
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6 On the ribbon ➤ Modify Selection panel, click
of times, until all of the engine cowl is selected.

(Grow) a couple

7 On the Smoothing Groups dialog, turn on 32.

3ds Max smooths the faces of the engine cowl.
The basic idea of the smoothing-group values is simple: If two faces share
the same value, 3ds Max smooths between them. If they have distinct
values, there is no smoothing. (A face can have more than one
smoothing-group value, which complicates matters, but we won’t use
that feature in this tutorial.)
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Remove smoothing from the air intake:
In this procedure, you don’t really remove smoothing from these faces: You
just assign them to a different group from the rest of the cowl.

1 In the Left viewport,
the air intake.

click and Ctrl+click to select the faces of

2 On the Smoothing Groups dialog, click to turn off 32, then turn on 31.

Refining the Aircraft | 527

Now the air-intake faces look flat.
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Smooth the wings:

1 In the Top viewport,
wings.

drag and Ctrl+drag to select the tips of the

2 On the ribbon ➤ Modify Selection panel, click
times, until all of the wings are selected.

(Grow) several
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Perspective view

3 On the Smoothing Groups dialog, turn on 24.
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Smooth the horizontal stabilizers:
The steps for the horizontal stabilizers are almost the same as those for the
wings.

1 In the Top viewport,
stabilizers.

drag and Ctrl+drag to select the tips of the

2 On the ribbon ➤ Modify Selection panel, click
times, until all of the stabilizers are selected.

532 | Chapter 3 Modeling Tutorials

(Grow) a few

3 On the Smoothing Groups dialog, turn on 23.
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Smooth the remainder of the fuselage:
Now all of the model is smoothed correctly, except for the main fuselage. You
can use the smoothing groups you’ve already created to help select it.
1 On the Smoothing Groups dialog, click Select By SG.

3ds Max opens a Select By Smooth Groups dialog. The buttons show only
those smoothing groups that you’ve assigned so far.

2 On the Select By Smooth Groups dialog, turn on all four buttons, then
click OK.
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3ds Max selects those faces that already have a smoothing-group value
assigned.

3 Press Ctrl+I to invert the selection.
Now only the fuselage and tail are selected.
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4 On the Smoothing Groups dialog, turn on 16.

Smoothing the fuselage has an unexpeted effect: The faces around the
cockpit are indented too deeply. You can use the Smoothing Groups
dialog to fix this.
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Unwanted indentation around the cockpit
(This is easier to see when the polygons are not selected, but you don’t
need to deselect the polygons in your scene.)

5 Make sure the fuselage polygons (smoothing group 16) are selected, then
on the Smoothing Groups dialog, change the Auto Smooth threshold
value to 80.0, and then click Auto Smooth.
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3ds Max corrects the indentation around the cockpit.

Increasing the threshold value increases the chance of two faces to be
smoothed together.
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NOTE Auto Smooth changes the smoothing value (16) that you originally
assigned to these faces. After you click AutoSmooth, the faces share values
of 1, 2, and 3.

Use smoothing groups with NURMS smoothing:

1 Exit the

(Polygon) sub-object level.

2 On the ribbon ➤ Edit panel, turn on

(NURMS).

3 On the ribbon ➤ Use NURMS panel, increase the number of iterations
to 2.
The default NURMS smoothing ignores the smoothing groups, and blends
all faces of the P-47 together.

4 On the ribbon ➤ Use NURMS panel ➤ drop-down portion, open the
Separate By drop-down list, and turn on Smoothing Groups.
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With smoothing groups taken into account, NURMS correctly shows
seams between the air intake and the rest of the engine cowl, and between
the wings and stabilizers and the main fuselage.

5 Turn off

(NURMS).
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Although the smoothing provided by smoothing groups alone is not as
good as NURMS smoothing, it could work for a low-polygon environment
such as a game engine, or for viewing the model in a medium or long
shot.

Save your work:
■

Save the scene as p47_smoothed.max.

Next
Add Detail to the Cockpit Canopy on page 541

Add Detail to the Cockpit Canopy
The cockpit canopy in this particular model is a bubble canopy, one of the
canopy options for the P-47. The pilot sits in a glass bubble. The forward
windshield is flanked by two side windshields, and the three windshields are
backed by a metal strut like a rollbar.
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NOTE On the Web you can find good photos of P-47s with the bubble canopy,
as well as with an earlier style of canopy that featured more metal.
Set up the lesson:

1 Continue working on your scene from the previous lesson, or
open \modeling\p47\p47_04.max,

2 If you open the file,
select the P-47. On the ribbon ➤ Polygon
Modeling panel, click Modify Mode.

3 On the ribbon ➤ Edit panel, turn off

(NURMS).

Adjust the shape of the front windshield:
1 Right-click a viewport and from the quad menu, choose Unhide All.
Now you can see the canopy again.
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2

Orbit,
pan, and
get a closer view of the canopy.

zoom the Perspective viewport to
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3

Select the canopy and if you need to, press F4 to display Edged
Faces.

4 Go to the
(Vertex) sub-object level.
the top center of the front windshield.
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Select the vertex at

5 On the ribbon ➤ Edit panel, activate

(Constrain To Edge). Then

move the vertex upward to give the front windshield more of
a peak.
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6 Activate

(Select Object) to deactivate Move.

7 On the ribbon ➤ Edit panel, activate

(Constrain To None).

Add edges to reinforce the metal parts:

1 On the ribbon ➤ Edit panel, turn on

(SwiftLoop).

2 Add edge loops to reinforce the metal parts of the canopy, as follows:
■

Horizontally, at the base of the canopy.
TIP Use the Front viewport for this one, so you can match the loop to
the blueprint image.
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■

Vertically, just behind the edges that define the front windshield.

■

Vertically, just in front of the edges that define the “rollbar” strut.
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3 Right-click to exit the SwiftLoop tool.

4 Go to the

5

(Edge) sub-object level.

Click and Ctrl+click to select the two edges at the top front of
the “rollbar” strut.

548 | Chapter 3 Modeling Tutorials

6 On the ribbon ➤ Edit panel, activate

(Constrain To Edge). Then

move the edges forward a bit to give the strut a more even width.
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7 Make a similar adjustment to the two top edges that define the rear of

the windshield frame,
of the frame is more even.
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moving them back slightly so the width

8 Activate

(Select Object) to deactivate Move.

9 On the ribbon ➤ Edit panel, activate

(Constrain To None).

Add width to the metal parts:

1 Go to the

2 Click

(Polygon) sub-object level.

(Zoom Extents All Selected).
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NOTE When you change to the Polygon sub-object level, you might see all
the polygons selected, as the illustration shows.

3

Click away from the canopy to deselect all polygons. Then click
and Ctrl+click the polygons that correspond to the glass parts of the
canopy. You will need to use the Top viewport to select polygons that
aren’t visible in the Perspective view.
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Top view

Perspective view

4 Press Ctrl+I to invert the selection.
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5 On the ribbon ➤ Polygons panel, Shift+click

(Extrude).

3ds Max displays the Extrude Polygons caddy.
6 Click the first control in the caddy, then from the drop-down list, choose
Local Normal.

7 Use the second control on the caddy to extrude the polygons by about
1.7 units.
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8 Click

(OK) to accept the extrusion.

9 On the ribbon ➤ Modify Selection panel, click

(Grow).

This selects the side faces that were created when you extruded the metal
parts. These faces should be metal, too.
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IMPORTANT You will use this selection in the following lesson.

Next
Use Smoothing Groups to Distinguish the Glass and Metal Canopy Parts on
page 556

Use Smoothing Groups to Distinguish the Glass and Metal
Canopy Parts
Just as you used smoothing groups to distinguish different parts of the fuselage,
you can use smoothing groups to distinguish the different materials in the
canopy.
Set up the lesson:
■

Continue working from the previous lesson.

Use smoothing groups to distinguish the metal parts from the glass parts:

1 On the ribbon ➤ Properties panel ➤ drop-down portion, click
(SmGroups).
3ds Max opens the Smoothing Groups dialog.
2 In the Smoothing Groups dialog, assign the metal polygons a value of
32.
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NOTE You used this value for the engine cowl as well, but remember that
the P-47 fuselage and the Canopy are two different objects, so the
smoothing-group values don’t overlap.

3 Press Ctrl+I to invert the selection again, and then assign the glass faces
a smoothing-group value of 24.

4

Close the Smoothing Groups dialog.
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Use NURMS smoothing to preview the canopy:

1 Exit the

(Polygon) sub-object level.

2 Press Alt+X to turn off X-Ray display.

3 On the ribbon ➤ Edit panel, turn on
(NURMS). On the ribbon
➤ Use NURMS panel, increase the value of Iterations to 2.
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This is far too much smoothing. As with the fuselage, you now need to
take smoothing groups into account.
4 On the ribbon ➤ Use NURMS panel ➤ drop-down portion ➤ Separate
By drop-down list, turn on Smoothing Groups.

Now the metal and glass portions of the canopy appear more distinct.
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With smoothing groups taken into account, there are well-defined edges
between the glass and the metal parts of the canopy. On the other hand,
the shape of the windshields is far too rounded. You will fix that in the
next procedure.

5 Turn off

(NURMS).

Next
Refine the Canopy on page 560

Refine the Canopy
As with the air intake or the front edge of the cockpit interior, the way to
reduce the amount of NURMS smoothing is to reinforce an edge by adding
nearby edge loops. You will do this to the front windshields of the cockpit
canopy.
Set up the lesson:
■

Continue working from the previous lesson.
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Fine-tune the bubble canopy:

1 On the ribbon ➤ Edit panel, turn on

(SwiftLoop).

2 Add edge loops to reinforce the windshields, as follows:
■

Near the front of the side windshields, just behind the metal strut.

■

On the front windshield, just on the other side of the left-hand strut.
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■

Also on the front windshield, but on the right side, opposite the
previous loop.
TIP This one is easiest to do in the Top viewport.

■

Immediately in front of the “rollbar” strut.
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■

And immediately behind the “rollbar” strut, as well.

■

Finally, add an edge loop just above the rim of the cockpit canopy.
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3 Right-click to exit the SwiftLoop tool.
Check the smoothing once again:

1 On the ribbon ➤ Edit panel, turn on
off Edged Faces.

(NURMS). Press F4 to turn

Now the windshields have their proper shape, and the edges between
the metal and glass parts are crisp.
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2 Turn

(NURMS) off again.

Next
Refine the Shape of the Bubble on page 565

Refine the Shape of the Bubble
The final step in modeling the P-47 is to improve the curvature of the glass
bubble.
Set up the lesson:
■

Continue working from the previous lesson.

Refine the shape of the bubble:
1 Press F4 to turn Edged Faces back on.
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2 Turn on
(SwiftLoop) again, and add a loop in front of the vertical
loop that is already present, midway along the bubble portion of the
canopy.

3 Right-click to exit the SwiftLoop tool.

4 Go to the

(Edge) sub-object level.

5 In the Top viewport,
click and Ctrl+click to select the four edges
at the top of the original bubble loop.
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Perspective view
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6 On the ribbon ➤ Edit panel, activate

then in the Front viewport,
tail of the airplane.

(Constrain To Edge), and

move the edges back, toward the

7 With Move still active, in the Top viewport, click and Ctrl+click to select
the two edges just above the sides of the middle of the bubble.

568 | Chapter 3 Modeling Tutorials

8 In the Front viewport,
the side of the bubble.

move these edges down to the middle of

Refining the Aircraft | 569

9 Go to the

(Vertex) sub-object level.

10 On the ribbon ➤ Edit panel, activate

(Constrain To Face).

11 With Move still active, in the Top viewport, click and Ctrl+click to select
the two vertices where the side of the bubble meets the top, behind the
vertical loops.

12 In the Front viewport,
move these vertices down and forward
so the bubble has a smoother contour.
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13 On the ribbon ➤ Edit panel, activate

(Constrain To None).

Expand the width of the bubble:
The last step in finishing the canopy, is to refine the bubble so the glass bulges
a bit more, as shown in the blueprint images.

1 In the Front viewport,
Ctrl+drag to select the vertices you just
moved, as well as the vertices immediately above them on the same
segment.
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Look at the Top view to make sure you have selected four vertices: two
on each side of the bubble.

2 Activate

(Select And Uniform Scale), then from the Use Center

flyout, choose
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(Use Selection Center).

3 In the Top viewport,
scale the vertices out along the Y axis to
give the rear part of the bubble more of a bulge.

4 In the Front viewport,
region-select the four vertices that are in
front of the ones you just scaled, at the sides of the bubble along the
contour.
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5 In the Top viewport,
scale these vertices out along the Y axis,
as you did for the rear vertices.
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Observe your work:

1 Exit the

(Vertex) sub-object level.

2 Turn on

(NURMS) for the Canopy.

3

Select the fuselage, and turn on

(NURMS) for it as well.

NOTE Use NURMS ➤ drop-down portion ➤ Separate By ➤ Smoothing
Groups should be turned on for the fuselage as well as for the canopy. You
might want to verify this.
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4 In the Perspective viewport, press F4 to turn off Edged Faces, and then

zoom out so you can see the entire airplane.

Save your work:
■

Save the scene as p47_canopy_finished.max.
To see a finished version of the P-47 model, you can open
p47_completed_no_texture.max. This version of the model includes some
additional geometry adjustments that didn’t seem important enough to
include in this tutorial.
You can also see a finished and textured version of the P-47 model by
opening p47_completed_textured.max..

Summary
The P-47 Thunderbolt model contains only two objects, but each object has
a lot of subtle detailing. Among the features and methods covered in this
tutorial were:
■

Setting up a “virtual studio” with “blueprint images” to use as references.

■

Turning on See-Through (“X-Ray”) display to use the reference images
more easily.
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■

Using free-form deformation (FFD) modifiers to change the shape of a
primitive object.

■

Turning a geometry primitive into an Editable Poly surface so you can
change it into a streamlined or organic shape.

■

Using the Symmetry modifier to ensure that a model is symmetrical.

■

Using the Extrude, Inset, and Bevel tools to add polygonal faces.

■

Using the Align buttons to align polygon sub-objects.

■

Using the SwiftLoop, Connect, and Cut tools to add edges or loops of
edges.

■

Using the Ring tool to select a ring of edges.

■

Using transforms, especially Move and Scale, to adjust the shape of the
model by changing the position of sub-objects, especially vertices and
edges.

■

Using the Constrain tools to limit sub-object movement.

■

Using the Border sub-object level to select the edge of a hole in the surface,
and the Cap Poly tool to cover that hole.

■

Using NURMS to smooth the model and increase the detail of its geometry.

■

Adding edge loops to “reinforce” edges and reduce the amount of
smoothing.

■

Assigning smoothing groups to differentiate components of the model,
and to provide fairly good smoothing even when the model has a low
polygon count.

Learning to Use Containers
This tutorial introduces methods for working with the Container feature. The
container provides various project-management functions, including
organizing scene components and sharing tasks among team members, along
with locking files and restricting access to specific scene components.
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Use containers to organize scene contents and build scenes.

In this tutorial, you will learn how to:
■

Use containers to organize and share scene contents.

■

Inherit a container.

■

Restrict access to specific object parameters from other users.

■

Use the locking feature so that only one person can edit a container’s
contents at a time.

■

Build a complex scene using nested containers.

Skill level: Beginner
Time to complete: 2 to 3 hours

Getting Started
Set up the scene:

■

On the Quick Access toolbar, click
(Open File), navigate to the
\scenes\modeling\container folder, and open container_start.max.
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NOTE If a dialog asks whether you want to use the scene’s Gamma And LUT
settings, accept the scene Gamma settings, and click OK. If a dialog asks
whether to use the scene’s units, accept the scene units, and click OK.
The scene contains a table, a chair, and two place settings: one for eating
a meal and another for attending a meeting at work.

Get acquainted with container tools:
1 Each scene component has a named selection set. From the Named
Selection Sets drop-down list on the main toolbar, choose the dinner setting
item.
This selects all the objects in the dinnerware set.
2 Right-click in the active viewport, choose Hide Unselected, and then click

(Zoom Extents All).
The dinnerware set is maximized in all viewports.
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3ds Max provides various ways of accessing container-related commands,
but one of the handiest is the Containers toolbar.
3 Right-click an empty area on the main toolbar and, from the context
menu that opens, choose Containers. Then right-click the Containers
toolbar title bar, and choose Dock ➤ Right.
The toolbar docks on the right side of the interface, next to the command
panel.

4 On the toolbar, click

(Create Container From Selection).

This command adds a new container to the scene and then places the
selected objects in the container. The container appears in the viewports
as a wireframe box with the lid flaps open. The box’s position is calculated
from the average of the selected objects’ locations.
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Alternatively, you could create a new container and then add objects to
it, but if you already know which objects you want in the container,
using Create Container From Selection is the easiest method.
NOTE The container is a helper object, and as such does not render.
Because the container starts out in an open state, you can manipulate it
and its contents freely.

5

Move the container and note that its contents move along with
it. Then move some of the contained items and note that their movement
doesn’t affect other objects.
In effect, the objects in the container are children of the container. But
there’s much more to the Container feature than a simple hierarchical
relationship.

6 Undo any movements from the previous step, and then select the
container.

7 Go to the
Modify panel and on the Manage Container rollout,
click the Close button.
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A file dialog titled Container Definition File opens, with the default file
name container_start_Container001, based on the scene-file name and the
container name. The file name extension .maxc is added when you save
the file.
NOTE .maxc stands for “Max container,” and is actually a standard 3ds Max
scene file with a special file name extension. If you ever have problems
opening a container file, you can load it as a regular scene by changing the
extension to .max.
8 Navigate to the \scenes\modeling\container folder and click Save to store
a copy on disk using the default name.
After you close the container, its appearance in the viewport changes to
indicate that it’s now closed.

9 Move the container and then try to select an object within it.
Moving the container works as before, but you can no longer select the
contents. This behavior mimics the real world; if you put stuff in a box
or other container and then close it, the contents are no longer directly
accessible.
10 On the Manage Container rollout, click Open.
The box returns to its previous status, with one difference: On the Local
Content rollout, the Saved Local Definition field contains the name of
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the saved container. When a container has a local definition, that
effectively means you’re the container’s owner, although it doesn’t
necessarily mean you have full control of its contents; this will become
clearer later in the tutorial.

TIP The entire path and file name probably don’t fit in the Saved Local
Definition field, but you can see them, along with a tooltip, by positioning
the mouse cursor over the field. In fact, most controls on the container rollouts
offer helpful tooltips.

Share the container with yourself:
Henceforth this tutorial will refer to Session 1 and Session 2 of 3ds Max. The
best way to learn how the Container feature works without getting mixed up
is by working in two different sessions of the program. In effect, you’re
simulating two users: one who originates a container in Session 1, and another
who inherits it in Session 2. When you inherit a container, you can still use
it, but only within the limits set by the originator.
One way to work in two different sessions of 3ds Max is by saving your work,
resetting the program, and then reloading your work from the other session.
As you can imagine, however, going back and forth this way is slow and
cumbersome. Much better is to run 3ds Max twice, thus having two different
sessions running concurrently on the same machine. We recommend this
method if your machine has at least 2GB of system memory and 512MB or
more of graphics memory. If you’re not sure whether you have enough
memory, the best way to tell is just to try it.
Or, if you have two networked machines, run 3ds Max on both and switch
back and forth. This latter method is closer to a typical studio setup with
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multiple users on the same team sharing data, but the single-machine approach
works fine as well.
1 Save Session 1 as my_container1.max.
2 In Session 2, add the Containers toolbar as before, if necessary, and then

click
(Inherit Container). Using the Inherit Container file dialog,
navigate to the folder in which you saved the container file
(container_start_Container001) in the previous section, and then open the
file.
The container and its contents appear in the viewports, in the same
location from which you saved them. The container is closed and selected.

Click

(Zoom Extents All).

3 Move the container and then try to open it.
You can move the container, but you cannot open it because the Open
button on the Manage Container rollout is unavailable. Also note that
the Edit In Place button is unavailable. To see one reason for this, return
to Session 1.
4 In Session 1, take a look at the Rules rollout.
The When Inherited, Allow option is set to No Access (Closed), which
means that the inheritor can work with the container, but not its contents.
This capability is useful for a team in which one member creates the
content and another simply arranges that content to set up a scene, such
as a game level.

Next
Using Rules on page 585
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Using Rules
Change the rules:
Besides No Access, the container provides three other rules that allow various
levels of access to other users. In this procedure you’ll look at Only Edit In
Place.
1 In Session 1, on the Rules rollout, choose Only Edit In Place and then
close the container.

This resaves the container with the rule change applied.
2 Return to Session 2.
On the Manage Container rollout, a
icon appears next to the Update
button. This indicates that an update is needed to keep in sync with the
source container; the one created by the originator.
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3 Click the Update button.
The container looks the same, but now the
icon appears next to
the Update button, indicating that the container definition is current.
Also, while the Open button is still unavailable, the Edit In Place button
is available.
4 Click Edit In Place.
The inherited container opens in Edit In Place mode. Edit In Place is a
mode that you enter and exit by clicking this toggle button.
5 In Session 1, try to open the container.
The Open button is available, but when you try to use it you get a message
that the container’s definition is currently being edited by you in another
instance of 3ds Max.
This demonstrates two important Container features:
■

When a container is set to Only Edit In Place, it can be edited by only
one person at a time. This is thanks to a locking mechanism in the
form of a file with the same name as the container, appended with
.lock, which 3ds Max creates when Edit In Place is active. If you ever
have trouble accessing a container, it might be due to the presence
of this file, possibly as a result of exiting or resetting 3ds Max while
Edit In Place is active. A warning is displayed when you attempt to
do so, but you can ignore it if you choose. If this happens, simply
delete the .lock file.

■

When someone else is editing a container, 3ds Max can determine
that person’s user name and tell you what that is.
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6 In Session 2, select the wine glass and move it upward a short distance.
Then select the container and click Edit In Place.
This exits Edit In Place mode, saving any changes to the container
contents and unlocking the container file.
7 In Session 1, open the container.
The wine glass changes position, reflecting the edit from Session 2.
NOTE At no time does the Update button become available in Session 1,
because the container is local to Session 1 and the Update function applies
to inherited containers only.
8 Still in Session 1, close the container without changing its contents.

9 In Session 2, the
icon is again visible next to the Update button,
even though the container definition hasn’t changed.
The Update function doesn’t look at the container definition; it simply
compares the date and time stamp on the file with the version you
inherited, and if it’s newer, advises you to update.
Lock an object’s transforms:
Say the originator is now happy with the wine glass’s position and doesn’t
want it change any more. The ability to lock specific parameters of a container
definition is an important Container feature.
1 In Session 1, open the container, then, on the Rules rollout, click the Edit
button.
Track View opens showing the container hierarchy.
2 Scroll down to the wineglass item and click the Transform entry to
highlight it.

TIP As long as
(Filter - Selected Objects Toggle) is on in Track View,
you can find the object faster in the list by selecting it.
3 Right-click the Transform entry, and from the quad menu ➤ top-left
quadrant, choose Lock.
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The Transform entry and all its children (branches and leaves) now show
“(Locked)” after their names in the Track View hierarchy.

4

Exit Track View and then close the container.

5 In Session 2, click Update and then click Edit In Place to open the
container.
6 Move the objects in the container, including the wine glass.
You can move everything except the wine glass.
7 Undo any changes from the previous step, and then select the container
and click Edit on the Rules rollout.
8 In Track View, find the wine glass item and then its Transform track.
Click the Transform track to highlight it.
9 Right-click the Transform track and choose Unlock.
The Transform track is no longer locked, but its child tracks still are. Lock
affects child tracks, but Unlock affects only highlighted tracks.

588 | Chapter 3 Modeling Tutorials

10 Undo (Ctrl+Z) to restore the the Transform track to Locked status.
11 Right-click the Transform track and choose Unlock Leaves.
This unlocks the Transform track as well as all of its child tracks. Now
you can transform the wine glass if you want.
12 Undo the Unlock Leaves command and any other changes from the
previous step, then select the container and click Edit In Place to close
it.
Change the rules again:
As you’ve seen, you can lock specific tracks for objects in a container, but if
you use the Only Edit In Place rule, the inheritor can easily defeat your locks.
If you use a different rule, however, the inheritor must abide by your locks
unless you revise them.
1 In Session 1, open the container and on the Rules rollout, choose
Anything Unlocked.
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With Anything Unlocked enabled, you can use the four icon buttons at
the bottom of the Rules rollout to quickly lock all modifiers, materials,
transforms, and objects, and you can also use the Edit button to lock
specific tracks, as before. For the sake of convenience, in this exercise
you’ll just use the existing locked transform tracks for the wine glass.
2 Close the container, then go to Session 2 and click Update.
This time something different happens: The container opens, and Edit
In Place is unavailable.
3 Go to Session 1 and open the container.
No problem opening it this time. Edit In Place is the best rule for passing
a single container back and forth between team members while preventing
accidental overwriting; the remaining rules are better suited for one-way
transfer of containers, as you’ll see in the following steps.
4 Return to Session 2 and click the Close button.
Instead of simply closing the container, 3ds Max prompts you for a file
name.
5 Enter the name DinnerSetting and click Save.
This saves a local definition of the container, although it still has a
connection to the source definition, as indicated by the source file name
under Source Definition on the Inherited Content rollout.
NOTE When any user has this local container open, it is locked, just like an
Edit In Place container.
6 Open the container again.
Now you can see the name of the container file you saved under Saved
Local Definition on the Local Content rollout.
Depending on whether the inherited container is open or closed, the
Modify panel shows either the Local Content or Inherited Content rollout;
never both.
7 If Track View isn’t open, click Edit on the Rules rollout and find the
Transform section of the wineglass hierarchy.
Now the “(Locked)” text is in italics, indicating that you, as the inheritor
of this data, cannot unlock those tracks. Try to unlock them; you can’t,
even if you change the rule. You’re limited by the rules set in the container
you inherited.
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8 Return to Session 1 and try to move the wine glass; you can’t because its

Transform tracks are locked. On the Containers toolbar, click
(Override All Locks).
The toggle button stays highlighted to indicate that this condition is
active.
9 Move the wine glass and then close the container.
10 In Session 2, select the container and then update it.
The glass moves to reflect its new position from the source container.
11 Check the glass’s Transform tracks in Session 2; they’re still irrevocably
locked.
The overridden transforms are inherited in Session 2, but the overrides
themselves are not. Thus, using the Anything Unlocked rule, the
originator of the container can keep a firm grasp on which changes the
inheritor can make, but can override her own rules at will.
12 Create a sphere or any other object primitive in Session 2. On the

Containers toolbar, click
(Add Selected To Container). Use the
Select dialog that opens to highlight the container and then click the
Add button.
NOTE You can add objects only to open containers.
13 Close the container in Session 2 and then return to Session 1 and close
and reopen the container.
The new object from Session 2 doesn’t appear. Source containers set to
Anything Unlocked (or Only Add New Objects) move data in one direction
only: from the originator to the inheritor. If you like, add an object in
Session 1, close the container, and then update in Session 2; the object
is added to that container, even though it has a local definition. In a
sense, the container in Session 2 is a hybrid of of a source and local
container.
14 In both sessions, close the containers and then reset 3ds Max.
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Next
Assembling Containers on page 592

Assembling Containers
As mentioned, the Container feature is intended primarily for use by teams
working together on projects. In this last exercise, you’ll simulate a team of
three: one person creating content, another one using a subset of that content
to assemble a dinner-table scene, and a third using a different subset to put
together a conference-room scene at an office or convention. You’ll do so
using the remaining rule: Only Add New Objects.
Use the Only Add rule:
1 In Session 1, open container_start.max.
2 From the Named Selection Sets drop-down list on the main toolbar,

choose each named selection set in turn and use
(Create Container
From Selection) to add the objects to containers. After you create each
container, rename it to reflect its contents: dinner_setting, office_setting,
table, and chair.
You should end up with four containers, each set to the default No Access
rule.
3 Close the two table-settings containers and give them the file names
dinner_setting and office_setting (3ds Max automatically adds the .maxc
extension).
4 Select the container with the table, set its rule to Only Add New Objects,
close it and save it as table. Do the same with the chair container, saving
it as chair.
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5 In Session 2,
inherit the chair.maxc container file; it comes in
open. Also inherit the dinner_setting.maxc container file, which comes in
closed and can’t be opened or edited.
6 Try to select the chair object; you can’t.
That’s because the object is locked as a consequence of using the Only
Add New Objects rule. When an object is locked, you can’t select it, so
of course you can’t transform it directly. However, you can transform it
via its container.

7 Select the dinner_setting container, then click
(Add Selected To
Container). Use the Select dialog that opens to highlight the chair
container and then click the Add button.
You now have a nested container setup: The chair container contains the
chair object as well as the dinner_setting container and its contents.
8 Inherit the table.maxc container; like the chair container, it comes in open,
but with the contents locked.
9 Select the chair container and use Shift+Move to create three copies.
Cloning the chair container also clones its contents; the chair object and
the dinner_setting container and contents.
10 Position the copies around the table in any arrangement you like. As long
as you move them horizontally only, the chairs and place settings remain
at the correct heights for the table.
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You now have a basic setup for four people eating dinner at a table. You
could then add other objects such as wine bottles, flowers, and so on.

11 Select all four chair containers and then
container.

add them to the table

Now when you move the table container, all four place settings and chairs
move along with it.
12 Close the table container and give it the file name dinner_table.
Because you’re prompted to create a new local container definition when
closing an inherited container set to Only Add New Objects, this helps
prevent inadvertently overwriting the original container definition.
NOTE When any user has this local container open, it is locked, just like an
Edit In Place container.
13 Make a few copies of the table container and arrange them to create a
restaurant dining-room setup.
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14 Save the scene as my_dining_room.max.
Set up the conference table:
1 Reset 3ds Max, then inherit the chair, table, and office_setting containers.
Because the office setting is offset from the chair, you need to position
them closer together.
2 Select the office_setting container, then move it horizontally and rotate it
a half-turn so it’s positioned correctly with respect to the chair.
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3 As before, add the office_setting container to the chair container.
4 Make three copies of the chair container, and then add all four chair
containers to the table container.
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5 Close the table container and give it the file name conference_table.
6 Make some copies of the table to populate a conference room. Position
and rotate each conference table to create a natural-looking arrangement.

Summary
In this tutorial you learned how to create containers from selected objects,
how to save and inherit containers, and how to restrict access to certain
parameters from other users. You also learned how to combine containers for
easy setup of complex scenes containing repetitive elements.
There’s much more to the Container feature than we’ve shown here; for
example, you can merge contained elements into your scene and use
low-resolution proxies to set up complex geometry quickly. To learn more,
consult the Container section of the 3ds Max Help.
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Animation Tutorials

4

The tutorials in this chapter show you the fundamentals of creating animation with 3ds Max.

Different kinds of balls have different bounces.

Features Covered in This Chapter
■

Auto Key animation

■

Set Key animation

■

Ghosting and trajectories

■

Track View: The Curve Editor

■

Rigging a model with hierarchies and paramenter wiring

■

Sound effects

599

Animating with Auto Key: Bouncing Balls
A bouncing ball is a common first project for new animators. This classic
example is an excellent tool for explaining basic animation methods in 3ds
Max.

Different kinds of balls have different bounces.

Skill level: Beginner
Time to complete: 1 1/2 hours

Bouncing a Ball
To create a bouncing ball, first you use Auto Key to block out the motion, and
then use the Curve Editor and other tools to make the motion more realistic.
(This is a very typical workflow for animators.)
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Open the starting scene and set the start frame to frame 0:

1 On the Quick Access toolbar, click
(Open File), navigate to the
\scenes\animation\auto_key folder, and open bouncing_ball_start.max.
NOTE If a dialog asks whether you want to use the scene’s Gamma And LUT
settings, accept the scene Gamma settings, and click OK. If a dialog asks
whether to use the scene’s units, accept the scene units, and click OK.
The scene contains a basketball and a plane that will act as the floor. It
isn't animated yet.
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2 Look at the start frame, at the left of the time bar and time slider.

If the first frame shows frame 1 instead of frame 0, click
(Time
Configuration), among the animation controls near the lower right of
the 3ds Max window, then in the Time Configuration dialog, change the
Start Time value to 0.
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Make sure the Length of the animation is 100 frames, then click OK.
For some purposes, frame 1 is a useful start frame (for example, a character
animator might want to reserve frame 0 for a “reference pose”), but the
exercises in this tutorial will start at frame 0.

Use Auto Key to Block Out the Bounce
Auto Key provides an easy way to block initial animation.
A simple diagram illustrates the path of a bouncing ball.

The shape of the curve that the ball follows, its trajectory, affects the realism
of the animation. So does the shape of the ball itself, which we’ll get to later
in this lesson.
The default frame rate for 3ds Max is the NTSC (National Television System
Committee) standard of 30 frames per second. If we want a single bounce of

Bouncing a Ball | 603

the ball to last one second, then it will fall for the first 15 frames, and rebound
for the next 15 frames.
Set up the scene:
■

Continue from the previous lesson.

Use Auto Key to animate the ball falling:

1 Click

(Auto Key) to turn it on.

The Auto Key button turns red to show that you are now animating.

The time slider background and the border of the active viewport also
turn red. Now when you move, rotate, or scale an object, 3ds Max creates
keyframes that control the object’s motion.

The time slider background and active viewport border turn red while you are
animating.
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2 Make sure that
basketball to select it.

(Select Object) is turned on, then click the

3 Drag the time slider to frame 15.

4 In the Perspective viewport, right-click the basketball. Choose Move from
the quad menu.
5 Move the basketball vertically so it touches the floor, and even drops a
little bit through the floor.

The ball touches the floor at frame 15.
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(You will correct the intesection with the floor in a later procedure.)
If you drag the time slider between frame 0 and frame 15, you will see
that 3ds Max has animated the fall of the basketball. Red boxes appear
on the timeline at both frame 0 and frame 15: these represent keys that
3ds Max created when you moved the ball.

Keys appear on the timeline at frame 0 and frame 15.

Clone a key to complete the bounce:
You could drag the time slider to frame 30, and then move the ball upward
so it approximately returns to its original position, but 3ds Max lets you
position the ball more accurately than that.
1 On the timeline, click the key at frame 0 to select it.
The key turns white.

2 Hold down the Shift key, then drag the key from frame 0 to frame 30.

Shift+drag is a general method for cloning keys on the timeline. (Dragging
a key without holding down Shift simply moves the key.) Now at frame
30, the ball is in precisely the position it was in at frame 0.

3 Click

(Auto Key) to turn it off.

4 Drag the time slider to see the complete animated bounce.
In the animation you’ve just created, the ball moves down and then up, but
the motion isn’t very bouncy: It looks stiff and computer generated. In the
next section, you adjust key timing to make the bounce more realistic.
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Next
Use the Curve Editor to Improve the Motion on page 607

Use the Curve Editor to Improve the Motion
The Curve Editor is part of the Track View feature, which is a general-purpose
tool for managing and adjusting animation.
Set up the scene:
■

Continue from the previous lesson.

Open the Curve Editor:
■

Right-click the basketball, and choose Curve Editor from the quad menu.
3ds Max opens the Curve editor. The tracks you just created for the ball
should be visible on the left, and the curves themselves should appear in
the curve window to the right.

TIP If the tracks and curves don’t appear when the Curve Editor opens, pan
in the controller window at the left until you see the position tracks, then click
and Ctrl+click to highlight them.
The Z track, in blue, clearly shows the up-and-down movement of the ball.
The X and Y tracks are both flat, which indicates no change in these
dimensions. In fact, the ball should travel along the X-axis, as if it were
given some forward momentum when it was dropped.
NOTE The track curves are color-coded like the axes on transform gizmos: X
is red, Y is green, and Z is blue.
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Add movement along the X-axis:

1 Drag the time slider to frame 30. Turn on
(Auto Key) once
again, then in the Left viewport, move the ball to the right along its
X-axis.

The curves in the Curve Editor also update to show the change you made.
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That doesn’t look quite right: As you can see if you scrub the time slider,
the ball drops vertically, and then travels forward. Instead, the effect we
want is a smooth forward motion, as in the diagram at the beginning of
this lesson. The culprit is the Y Position key at frame 15, which pins the
ball to the same Y position it has at frame 0.

2 Turn off

(Auto Key).

3 In the Curve Editor, click the Y Position key, along the green curve, to
select it.

The key turns white when you select it. It also shows some tangent
handles.
4 Press Delete to delete the Y Position key at frame 15.

Now the basketball moves forward from frame 0 to frame 30, as you can
see if you scrub the time slider. The animation still looks too mechanical,
but you’ll improve that soon.
NOTE The X Position track is still flat, indicating no change along that axis.
You could delete all the keys in the X track without affecting the animation.
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Add a trajectory and ghosting to improve animation display in the viewports:
You can display the trajectory of an object in viewports, and also “ghost”
images of the moving object. Both these options help you visualize your
animation.
1 In a viewport, right-click the basketball, and choose Object Properties
from the quad menu.
3ds Max opens the Object Properties dialog.
2 In the Object Properties dialog ➤ Display Properties group, click
Trajectory to turn it on, and then click OK.
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Now viewports show a trajectory for the basketball, in red, with white
tick marks along its length. Each tick represents a frame.

Basketball trajectory in a viewport

The ticks are more closely spaced at the beginning and end of the
trajectory (this is easiest to see in the Left viewport). This is a timing effect
known as “ease in, ease out” (or “slow in and slow out”). However, the
ticks are evenly spaced around frame 15, where the ball bounces off the
floor. This is one reason the bounce doesn’t appear realistic, yet.
3 From the menu bar, choose Views ➤ Show Ghosting to turn it on.
Now when you drag the time slider, viewports show ghost images of
where the ball has traveled.
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The default ghosts are closely spaced, and a little hard to read. You can
improve this by changing the default settings.
4 From the menu bar, choose Customize ➤ Preferences. Go to the
Viewports tab.
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5 In the Ghosting group, change the value of Ghosting Frames to 4, and
change the value of Every Nth Frame to 2. Click OK.
Now when you scrub the time slider, you see fewer ghosts, spaced two
frames apart. This makes it a bit easier to see how the animation is
progressing.
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Adjust the timing of the bounce, in the Z dimension:
1 In the Curve Editor ➤ Controller window (the list of objects and tracks
at the left), click the Z Position track to display the curve for just that
track.

2 Click the “floor” key at frame 15 to select it (you also can select the key
by dragging a box around it).
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3 On the Track View - Curve Editor toolbar, click
To Fast).

(Set Tangents

4 Scrub the time slider.
NOTE As you might notice, the trajectory display in viewports doesn’t update
until you move the time slider.
Now the bounce has a snap to it that makes it look more like a real
bounce.
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Adjust the basketball’s forward motion:
As it did for the ball’s up-and-down motion, Auto Key applied ease in, ease
out to the ball’s forward motion. But this isn’t necessary, and in fact would
give strange results when you repeat the bounce, as you do in the next section.
1 In the Curve Editor ➤ Controller window, click the Y Position track to
display the curve for that track.

2 Drag to select both the starting and the ending key in this track.
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3 On the Track View - Curve Editor toolbar, click
To Linear).

(Set Tangents

3ds Max removes the ease curves from this track, making the forward
movement uniform.

Save your work:
■

Save the scene as my_bouncing_basketball_adjusted.max.

Next
Repeat the Bounce on page 618

Repeat the Bounce
Typically, a bouncing ball does not bounce once. The Curve Editor gives you
the means of repeating the initial bounce.
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Set up the scene:
■

Continue from the previous lesson.

Remove the X Position keys:
The X Position track has keys that don’t change, so you can safely delete them.
1 In the Curve Editor ➤ Controller window, click the X Position track to
display the curve for that track.

2 Drag to select all the keys in this curve.

Dragging to select the X Position keys
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All X Position Keys selected

3 Press Delete to delete the X Position keys.
Repeat the animation:
1 In the Curve Editor ➤ Controller window, click the Z Position track,
then hold down Ctrl and click the Y Position track so both curves are
visible.

2 On the Track View - Curve Editor toolbar, click
Out-Of-Range Types).

(Parameter Curve

3ds Max opens the Param Curve Out-Of-Range Types dialog.
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This dialog presents various options for how to continue a portion of
animation outside the range of the keys you’ve created. Each option is
represented by a graphic button. In the graphic, the original animation
is represented by a solid trace, and the effect of continuing the animation
is represented by dotted traces.
NOTE You don’t need to select keys before you open this dialog: Parameter
Curve Out-Of-Range Types operates on whatever keys are present in the
tracks you select.
You can click a graphic button to choose the same type for both incoming
and outgoing animation, or use the smaller buttons to choose incoming
and outgoing types individually.
At first glance, Loop seems the obvious choice, but while this option
successfully loops the bounce, it also loops the forward motion of the
basketball, which is not what we want. You can see this effect in both
the Curve Editor and the viewports.
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The Z Position track repeats successfully, but the sawtooth shape of the Y Position
track shows that the ball keeps returning to its starting position.

In viewports, the trajectory shows the same effect: Loop
creates a closed loop for the ball, instead of forward
motion.

3 In the Param Curve Out-Of-Range Types dialog, click the outgoing button
for the Releative Repeat option, then click OK.
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(You can leave the incoming animation set to Constant, because the
bounce begins at the start of the scene animation.)
Now the ball bounces as before, but at each continuation of the bounce,
the forward motion begins where it ended. You can see the difference in
the Curve Editor, if you zoom out in the curve window: The Z Position
track goes up and down, but the Y Position track continues in a straight
line.

4

Zoom out in the Perspective viewport so you can see the full
trajectory of the basketball.
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Save your work:
Save the scene as my_bouncing_basketball_continuous.max.

■

Next
Add Rotation on page 624

Add Rotation
The bounce is beginning to look good, but as it bounces forward, the basketball
remains perfectly level, and that is not realistic.
Set up the scene:

Continue from the previous section, or

■

open bouncing_ball_02.max.

Turn off ghosting:
The rotation of the textured ball is easier to see if you turn off ghosting.

1

Select the basketball, if it is not already selected.
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2 From the menu bar, choose Views ➤ Show Ghosting to turn off this
option.
If you were to use Auto Key to set rotation keys for the ball, without any
preparation, you would run into trouble. The reason is that 3ds Max uses Euler
XYZ as the default rotation controller. For continuous animation, there are a
couple of problems with this controller: It is not good at handling rotation
greater than 180 degrees, and it sets keys for all three tracks, even when you
animate only a single axis. These problems are exaggerated when you set the
Out-Of-Range type; for example:

Out-of-range curves with Euler XYZ rotation

In this example, 3ds Max has generated extraneous and unrealistic sideways
rotation for the ball.
When you want rotation greater than 180 degrees, or continuous rotation
about a single axis, the solution is to use a TCB rotation controller.
Change the controller type:
1 In the Curve Editor, click to select the main Rotation track (not one of
the subordinate X, Y, or Z Rotation tracks).
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The main Rotation track

2 Right-click the main Rotation track. From the quad menu, choose Assign
Controller.
3ds Max opens an Assign Controller dialog.
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3 In the Assign Rotation Controller dialog, click to choose TCB rotation,
then click OK.
Now the basketball has a single Rotation track, with no subordinate X,
Y, and Z Rotation tracks.
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4 On the Track View - Curve Editor toolbar, click
3ds Max opens the Track View ➤ Filters dialog.
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(Filters).

5 In the Filters dialog ➤ Show group (on the left), click to turn on
Controller Types, and then click OK.
Now the controller window lists controller types.

TIP Although by default, 3ds Max does not display controller types in the
controller window, turning on their display can help you keep track of the
animation you are creating.

Now you are ready to create rotation keys for the basketball.
Add rotation to the basketball:

1 Turn on

(Auto Key).

2 On the main toolbar, turn on

(Angle Snap).

3 Drag the time slider to frame 15. In the Perspective viewport,
rotate the basketball 90 degrees forward in the X-axis. Watch the X field
in the status bar to check the value.
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Forward rotation at frame 15

4 Drag the time slider to frame 30.
another 90 degrees along the X-axis.

5 Turn off

Rotate the basketball forward

(Auto Key).

Make the rotation continuous:
1 In the Curve Editor, click the Rotation : TCB Rotation track to highlight
it.
NOTE No curves appear in the curve window: The TCB family of controllers
uses dialogs to manage animation, rather than editable curves.
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2 On the Track View - Curve Editor toolbar, click
Out-Of-Range Types).

(Parameter Curve

3 In the Param Curve Out-Of-Range Types dialog, click the outgoing button
for the Releative Repeat option, then click OK.

(As before, you can leave the incoming animation set to Constant, because
the bounce begins at the start of the scene animation.)
4 Scrub the time slider to see the animation. The texture of the basketball
makes it easy to see the rolling motion.
Save your work:
■

Save the scene as my_bouncing_basketball_rolling.max.

Next
Add Squash and Stretch on page 631

Add Squash and Stretch
Squash and Stretch enhances the effect of animation.
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Objects deform as they move or collide. In the real world, this effect is
sometimes obvious (think of a soap bubble), and sometimes subtle. In
animation, it pays to exaggerate this effect: Although the exaggeration might
go beyond realism, it reinforces the illusion of realism when we watch the
animation. This effect is known as “squash and stretch.”
It is worth looking again at the diagram of a bouncing ball:

The ball should stretch as it falls, squash when it collides with the floor, and
then stretch again as it rebounds.
The Stretch modifier in 3ds Max provides a convenient way to animate squash
and stretch.
Set up the scene:

Continue from the previous lesson, or

■

open bouncing_ball_03.max.

Apply a Stretch modifier to the basketball:

1

Select the basketball, if it is not already selected.
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2 Go to the

Modify panel. From the Modifier List, choose Stretch.

TIP While the Modifier List is open, you can press the S key multiple times
to find modifiers whose name begins with “S.”
3 On the Parameters rollout for the Stretch modifier, change the value of
Amplification to –30.

Positive amplification tends to squeeze an object in the middle as it
stretches, while negative amplification makes the middle of the object
fatter, which is the effect we’re looking for.
We also want the basketball to stretch along the Z-axis: As it happens,
that is already the default.
Animate stretching and squashing:

1 Turn on

(Auto Key).

2 Drag the time slider to frame 6.
3 On the Parameters rollout for the Stretch modifier, change the Stretch
value to 0.1.
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The Stretch field’s spinner arrows now show red brackets, indicating that
3ds Max has created an animation key for this parameter. In the viewports,
you can see that the basketball is elongated along its direction of travel.
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4 Drag the time slider to frame 15, where the basketball collides with the
floor.
5 On the Parameters rollout for the Stretch modifier, change the Stretch
value to –0.2.
This squashes the basketball at the point of impact. Incidentally, it also
corrects the way the basketball used to sink into the floor!

6 Drag the time slider to frame 30, and change the Stretch value back to
0.0.
TIP Just right-click the spinner arrows to set the value back to zero. In 3ds
Max, this is a standard shortcut for setting a numeric field to its minimum
nonnegative value.

7 Turn off

(Auto Key).

8 You need to “bracket” the squash so it doesn’t begin before impact, and
goes away when the ball rebounds.
Shift+copy the key at frame 6 key to the following frames:
■

Frame 14

■

Frame 16

■

Frame 24
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Repeat the stretch and squash:
1 In the Curve Editor ➤ controller window, locate the track for the Stretch
parameter.
The hierarchy looks like Basketball ➤ Modified Object ➤ Stretch ➤
Stretch : Bezier Float. You have to scroll down to get past several position,
rotation, and scale tracks that you arent using in this exercise.

2 On the Track View - Curve Editor toolbar, click
Out-Of-Range Types).

(Parameter Curve

3 In the Param Curve Out-Of-Range Types dialog, click the outgoing button
for the Cycle option, and then click OK.
Now the squash and stretch pattern repeats indefinitely.
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Play the animation:

■

Click
(Play) to play the animation.
Animation controls, including playback controls, are in the lower-right
corner of the 3ds Max window, just to the left of the viewport navigation
controls.

Click
(Stop) when you are done. (This is the same button as the
Play button, while playback is active.)
This completes the animation of bouncing a basketball.
Save your work:
■

Save the scene as my_bouncing_basketball_completed.max.

To see a completed version of the basketball animation, you can
open bouncing_ball_completed.max.

Next
Different Types of Balls: Mass, Elasticity, and Friction on page 637

Different Types of Balls: Mass, Elasticity, and Friction
Not all balls are equal. Mass and elasticity affect how high the ball will bounce,
and how far it will travel. So does the friction of the surface on which the ball
lands. This lesson compares the bouncing of a bocce ball, a tennis ball, and a
golf ball.
Even a hard rubber ball won’t bounce, if you drop it onto the dry part of a
sandy beach. In this lesson, we assume that the balls are bouncing on a hard,
uniform surface such as smooth concrete or a hardwood floor. An uneven
surface can cause unexpected motion: That is the subject of the lesson that
follows.
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The friction of air (air resistance or “drag”) can affect a ball’s motion as well.
Usually this is a subtle effect. On the other hand, even a lightweight, highly
elastic ball such as a golf ball eventually loses momentum and comes to a
stop. So unlike the indefinitely bouncing basketball in the previous lesson,
the balls in this lesson bounce for a limited time only, and with decreasing
energy.

Bouncing a Bocce Ball
We’ll start with a heavy ball that doesn’t have much bounce to it, at all. Bocce
balls weigh from 31 ounces to 42 ounces (900 to 1200 grams): on the average,
a bit over 2 pounds (about 1 kilogram).
Here is the graph of a bocce ball dropped onto a hard, smooth floor from a
height of just over 25 feet (7.6 meters):

As the graph shows, the ball bounces only twice, and does not have much
forward momentum, either.
NOTE This chart, as well as the charts for the tennis and golf balls, is based on
real-world values. It was created by videotaping the actual bounce of the ball, and
then rotoscoping the height and forward distances.
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Open the starting scene:

■

On the Quick Access toolbar, click
(Open File), navigate to the
\scenes\animation\auto_key folder, and open compare_bocce_start.max.
NOTE If a dialog asks whether you want to use the scene’s Gamma And LUT
settings, accept the scene Gamma settings, and click OK. If a dialog asks
whether to use the scene’s units, accept the scene units, and click OK.
The scene contains a bocce ball and a plane that will act as the floor. It
isn't animated yet.

Keyframe the bounces and adjust the keys:

1 Turn on
(Auto Key), and then in the Front viewport,
move the ball to create the following keyframes:
■

Frame 12: Down to floor level, and forward about 20 units.
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Don’t sink the ball through the floor as you did with the basketball:
Bocce balls are typically metal or wood, so squash and stretch is not
an issue in this exercise!

TIP After you key the first contact with the floor, you can click
(Zoom Extents Selected) to get a better view of the ball and its trajectory.
■

Frame 19: In the air again, to a height of about 60 units, and forward
about 20 units.

■

Frame 26: Back to floor level, and forward about another 20 units.

■

Frame 28: In the air again, to a height of about 10 units and forward
about 10 units.

■

Frame 30: Back to the floor, and forward about 10 units.

■

Frame 60: At floor level, forward about 100 units. At this point, the
ball is just rolling, so you all you need to do is move it to the right
along its X-axis.

2 Turn off

(Auto Key).

The bounce is now blocked out.
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As with the basketball, the keys where the ball strikes the floor are not
crisp enough, yet.
3 Right-click the bocce ball, and choose Curve Editor from the quad menu.
TIP If the tracks and curves don’t appear when the Curve Editor opens, pan
in the controller window at the left until you see the position tracks, then
click and Ctrl+click to highlight them.
4 In the Curve Editor, click the Z Position track to highlight it. Then click
and Ctrl+click the three keys where the ball strikes the floor.
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The three Z Position floor keys selected

5 On the Curve Editor toolbar, click

(Set Tangents To Fast).

The Z Position bounce keys corrected

6 Click to highlight the X Position track. In the curve window, drag a box

to select all the keys along the X Position curve, and then click
(Set Tangents To Linear).
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X Position rolling keys corrected

NOTE The ball is actually rolling as well as bouncing, but because (unlike
the basketball) it has a uniform texture, we don’t need to worry about rotating
it: In viewports, it would look just the same.

Trajectory of the bocce ball after adjusting the keys
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7

Play the animation.
The keys you created give a convincing animation of a heavy, solid ball.

Save your work:
■

Save the scene as my_bouncing_bocce_ball_completed.max.

Bouncing a Tennis Ball
As you might expect, a tennis ball bounces more often than a bocce ball, and
travels farther while it does so.

A tennis ball is hollow rubber, coated with felt. The standard weight of a tennis
ball is 22 ounces (624 grams).
In this section, we won’t make you enter keyframes by hand again. Instead,
we demonstrate a shortcut way to model the diminishing energy and magnitute
of bounces: This is a technique that you could apply to an out-of-range,
repetitious bounce such as you created for the basketball in the previous
lessons.
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Open the starting scene:

■

On the Quick Access toolbar, click
(Open File), navigate to the
\scenes\animation\auto_key folder, and open compare_tennis_start.max.
The scene contains a tennis ball and a plane that will act as the floor. The
ball is animated, but it keeps bouncing back to approximately the same
height: the scene doesn’t yet model a normal loss of energy. (As the ball
travels, its bounces do grow closer together: The spacing of the keyframes
is based on the real-world chart shown above, but the height of the bounces
isn’t adjusted, yet.)

Adjust the Z Position curve by using a multiplier curve:

1 In any viewport,
select the tennis ball, right-click it, and choose
Curve Editor from the quad menu.
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TIP If the tracks and curves don’t appear when the Curve Editor opens, pan
in the controller window at the left until you see them, then click to highlight
the position tracks.
2 In the Curve Editor ➤ controller window, click the Z Position track to
display this curve in the curve window.

3 From the Curve Editor menu bar, choose Curves ➤ Apply - Multiplier
Curve.
3ds Max adds a multiplier curve to the Z Position track. It also changes
the curve window display so all curves are visible.

4 Click
(the plus-sign icon that now appears next to the Z Position
entry in the controller window). Then click the Multiplier Curve track
to highlight it.

As you can see, the default value of the multiplier curve is completely
flat.
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5 Ctrl+click the Z Position track so you can see both the Z Position track
and its multiplier.

6 Click to highlight the key at the right of the multiplier curve.

This key is close to the final key for the tennis ball itself, but is slightly
above it, overlapping.
7 A transform curve is extremely sensitive to changes in the multiplier curve
you apply to it. Because of this, adjusting the multiplier by dragging in
the curve window is not the best method: You can get wild results.
Instead, type in the value.
The Key Stats toolbar is the status bar at the lower left of the Curve Editor.
The first field shows the current frame number, and the second field is
the key value. In this field, initially set to 1.000, enter –0.01.
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Now the multiplier curve “damps” the bounce of the tennis ball,
simulating the loss of energy as it travels and strikes the floor.

Are the new values realistic? Comparing the results obtained from the
multiplier curve with the chart for an actual tennis ball, it appears that
in real life, the tennis ball loses energy, and bounce height, even more
quickly than our simulation. If realism is a concern, consider keyframing
each bounce, as you did for the bocce ball. But if your main concern is
creating a general impression, then the multiplier curve is a useful
shortcut.
Save your work:
■

Save the scene as my_bouncing_tennis_ball_completed.max.

Comparing the Golf Ball
In this section, you simply compare the path of a bouncing golf ball to the
other two balls in this example.
A golf ball typically weighs 1.62 ounces (45 grams), and is made of rubber (or
a comparably elastic plastic) wound around a core, then encased in a plastic
shell. Its extreme elasticity means that it bounces a lot: So much so, that to
animate it requires more than the default 100 frames of a 3ds Max scene.

648 | Chapter 4 Animation Tutorials

Open the scene with all three balls:

■

On the Quick Access toolbar, click
(Open File), navigate to the
\scenes\animation\auto_key folder, and open compare_completed.max.
The scene contains the bocce ball, the tennis ball, and the golf ball. They
are animated already. All are dropped from the same height at the same
time.
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Compare the balls and how they bounce:

■

Play the animation.
The balls bounce according to their mass and elasticity.
Incidentally, the golf ball hits the floor slightly before the tennis ball,
which precedes the bocce ball: So our real-world measurements account
for air resistance, as well as mass and elasticity.

Click

(Stop) when you are done observing the animation.

You can also play the movie compare.avi to see a rendered version of this
animation.

Next
Using a Helper to Control Changes in Direction on page 651
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Using a Helper to Control Changes in Direction
Bouncing a ball on an uneven surface can cause changes of direction. In this
lesson, you use a point helper to control those changes, making the animation
easy to edit.
Open the scene:

■

On the Quick Access toolbar, click
(Open File), navigate to the
\scenes\animation\auto_key folder, and open bouncing_chaos_start.max.
NOTE If a dialog asks whether you want to use the scene’s Gamma And LUT
settings, accept the scene Gamma settings, and click OK. If a dialog asks
whether to use the scene’s units, accept the scene units, and click OK.
The scene is the bouncing golf ball from the previous lesson. The plane
has a texture that suggests a tile floor with recessed grooves for the grout.
Uneven surfaces such as asphalt, tiles with grout, and so on, can make a
bounce take off in unexpected directions.
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You will retain the bounces, but remove the forward motion and replace
that with changes of direction in X and Y.
Remove the motion in X and Y:

1

Select the ball, right-click it, and choose Curve Editor from the
quad menu.
TIP If the tracks and curves don’t appear when the Curve Editor opens, pan
in the controller window at the left until you see them, then click to highlight
the position tracks.

2 Highlight the X Position track. Drag to select all keys in the curve window,
and then press Delete.
Now the ball bounces in place, with no forward motion.

3 Highlight the Y Position track, and delete all its keys as well.
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4

Close the Curve Editor.

Now you want to add more “chaotic” motion to the ball: When it strikes the
face of a tile, it should continue in the same direction, but when it strikes a
groove with grout, it should change its direction.
You could animate this lateral motion using the ball itself, but a better method
is to use a helper object: With this method, the helper animation is
independent of the ball and its bounce track, so if you later need to change
the lateral motion, you can do so without affecting the bounce.
Create a Point helper to control the ball:

1 On the
Create panel, turn on
Type rollout, click to turn on Point.

(Helpers), then in the Object

NOTE Many animators use the Dummy helper instead of Point. The advantage
of using a Point helper is that you can adjust its size without having to scale
it. Scaling a helper in a hierarchy will affect its children objects: This is an
effect that usually you want to avoid.

2 Click

(Maximize Viewport Toggle) to display all four viewports.
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3 If you are not at frame 0, click

(Go To Start).

4 In the Top viewport, click near the golf ball to create the Point helper.
5 On the Point helper’s Parameters rollout, click Box to turn it on, and
then change the size of the box to 40.

6 On the main toolbar, click

(Align), and then click the ball.

7 In the Align Selection dialog ➤ Align Position (Screen) group, turn on
X Position, Y Position, and Z Position. Then choose Center for both
Current Object (the Point helper) and Target Object (the golf ball).
8 Click OK to close the Align dialog.
Link the ball to the Point helper:

1 In the Top viewport,
the helper.

zoom in to get a better view of the ball and

2 On the main toolbar, turn on
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(Select And Link).

3 Select the ball, then drag to the box of the Point helper, and release the
mouse.

Now the ball is a child of the Point helper: When you move the point,
the ball will follow along.

4

Move the Point helper.
The ball and its trajectory both follow the Point.

5

Undo the Point helper movement.

Animate the changes in direction:
To make the ball move erratically, you want to give it lateral motion (via the
Point helper) every time the ball hits the ground. If the ball hits a tile, it should
continue forward. If the ball hits grout, it should change direction.
It’s easiest to move the Point in the Top viewport, while you watch the effect
in the Perspective viewport.

1 In the Top viewport, click
the floor, once again.

2 Turn on

(Zoom Extents) so you can see all of

(Auto Key).

3 Drag the time slider to frame 10. This is the first frame where the ball
touches down.
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4 In the Top viewport, move the Point along its X-axis, forward about one
tile. The ball should land on a tile.
5 Drag the time slider to frame 37. Move the point along its X-axis again,
about one and a half tiles. This time, the ball should land on grout.

At frame 37, the ball lands on grout.

6 Drag the time slider to frame 59. At this frame, move the ball in both X
and Y, to the right and onto grout again.
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At frame 59, the ball has veered to the right, only to land on grout once again.

7 At frame 81, change the ball’s direction once more, so it moves to the
left.
8 By now, you should have the general idea. Move the time slider from
one floor-contact frame to the next. After frame 81, these frames are 101,
117, 134, 147, 160, 173, 183, 193, 202, 219, 226, and 230.
Keep the ball moving laterally in the same direction if it lands on a tile,
and change the lateral direction if it lands on grout.
Here is how the completed scene looks, after animating the helper:
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Save your work:
■

Save your completed scene as my_chaotic_bounce.max.

To see a completed version of the chaotic bounce, you can
the scene, bouncing_chaos_completed.max.

open

You can also play the movie chaosbounce.avi to see a rendered version of
this animation.

Summary
This tutorial introduced several basic techniques of animating with Auto Key:
■

You can use Auto Key to block out animation.

■

You can use ghosting or trajectory display (or both) to help visualize an
animation.

■

You can use the Curve Editor to refine initial animation; for example, by
changing the tangency and thus the speed of a key, or by deleting
unwanted keys.
The Curve Editor also lets you create “out of range” repetition of an
animation, and adjust amplitude by using a multiplier curve.

■

The TCB Rotation controller is better than the default Euler XYZ Rotation
controller when you want to have continuous rotation.

■

A helper object such as Point can be useful for “separating” animation into
multiple tracks, such as bouncing versus lateral motion.

This tutorial also introduced you to some of the general principles of
animation:
■

Mass Making an object behave as if it has weight, perhaps based on
real-world observation, greatly increases the realism of an animation.

■

Ease In, Ease Out Having a motion begin a bit slowly, then slow again
when it comes to an end, in many cases also increases realism. Auto Key
creates ease-in/ease-out timing by default. In some cases, as you saw, this
isn’t the best solution. When a ball rebounds from a hard surface, the
motion should be fast.

■

Squash and Stretch Objects stretch out as they travel, and squash when
they are stopped. You can exaggerate this effect, whether for a ball or a
character, and still have a successful animation.
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Animating with Set Key
Set Key mode is an animation mode in 3ds Max that allows you to try out
different poses on a character or hierarchy, and then use those poses to create
keys on selected tracks.
It differs from Auto Key mode, where every transform and each change to an
object’s animatable parameters will result in animation. In Set Key mode, you
have to take an action (clicking the Set Keys button) in order to set a key.
Nothing happens automatically.
Mechanical, forensic, and industrial animators might find that Set Key
animation provides a precise and deliberate workflow to use instead of Auto
Key mode.
This example uses a simple chess set and the quickest possible checkmate, a
four-move game, to illustrate a typical Set Key workflow.
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The moves you will animate are:
■

White king-side knight’s pawn moves ahead two squares.

■

Black queen’s pawn moves ahead two squares.

■

White king-side bishop’s pawn moves ahead two squares.

■

Black queen moves diagonally to checkmate White king.

In this tutorial you will learn how to:
■

Turn on Set Key mode.

■

Use keyable icons in Track View.

■

Use key filters.

■

Create keys using Set Keys, and use its keyboard shortcut.

■

Move a pose in time.

Skill Level: Beginner
Time to complete: 20 minutes
Set up the scene:

■

On the Quick Access toolbar, click
(Open File), navigate to the
\scenes\animation\set_key folder, and open wood_chess_set.max.
NOTE If a dialog asks whether you want to use the scene’s Gamma And LUT
settings, accept the scene Gamma settings, and click OK. If a dialog asks
whether to use the scene’s units, accept the scene units, and click OK.
This scene is a wooden chess set. It isn't animated yet.

TIP You might want to

zoom in more closely on the chessboard in

the Perspective viewport, and
pan a bit, to see it better. It is shown
this way in the illustrations that follow.
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Use Set Key mode to move your pawns:

1 Turn on

(Toggle Set Key Mode).

The Set Key Mode toggle turns red, as does the time slider background
and the active viewport outline.

2 In the Perspective viewport,
select the pawn in front of the white
knight at the lower-right corner. If the transform gizmo isn't already

displayed, right-click and choose

Move from the quad menu.
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Pawn selected and Set Key mode turned on

First, you will set a key to keep the pawn in place at frame 0.

3 Click

(Set Keys).

The button turns red for a moment. A key appears at frame 0 on the track
bar.
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NOTE The Set Keys button also works in Auto Key mode.
4 Drag the time slider to frame 10.

5 Using the transform gizmo,

move the pawn ahead two squares.

Pawn position at frame 10

6 Click

(Set Keys) to set a key at frame 10.

A key appears in the track bar at frame 10.
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Now you'll animate the first move by the Black side.
Animate the Black king's pawn:
1 Go to frame 20.

2

Select the Black king's pawn.

3 Press K on the keyboard. This is the shortcut for the Set Keys button.
A key appears in the track bar for the Black pawn.
4 Drag the time slider to frame 30.
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5

Move the pawn ahead two squares.

6 Drag the time slider to frame 35.
The pawn jumps back.
The reason the pose was discarded is because you didn't set a key at frame
30. This is an important difference between Set Key and Auto Key. By
doing this lesson, you just learned that if you don't set keys while using
Set Key, you cannot retrieve your work.

7 Drag the time slider back to frame 30 and
place again.

move the pawn into

Animation at frame 30

Press K again to set the key.
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8

Play the animation.
The White pawn moves, and then the Black pawn moves.

Animate the bishop's pawn:

1

Select the White king-side bishop’s pawn and go to frame 40.

Select this pawn at frame 40.

2 Press K to set a key.

3 Go to frame 50. Now
press K again.
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move the pawn two squares ahead and

Animation at frame 50

Move a pose in time:
You might get a pose completely set up, only to discover that you are on the
wrong frame. There’s a simple trick that lets you move the pose to another
frame in time.

1 At frame 50,

select the Black queen, and press K to set a key.

2 Drag the time slider to frame 55.

3

Move the queen diagonally four squares. Use the corners of the
transform gizmo to move in both X and Y at the same time.
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Move the queen using the corners of the XY transform gizmo.

TIP Before moving the queen, arc rotate the viewport so you can see the
transform gizmo corners. You can also press + on the keyboard to enlarge
the gizmo.
Let’s say you realize you need this pose to happen at frame 60, not frame
55. Here’s what you do.
4 Right-click the time slider frame indicator (it reads 55/100) and drag to
frame 60.
Now you are at frame 60, and the queen hasn’t jumped back to the
previous position.

5 Click

(Set Keys) or press K to set a key.
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Set keyable tracks and key filters:
You’ve seen how to use Set Key in its simplest form. Now you’ll add a level of
complexity by selectively determining which tracks will be keyed.
The Black queen has the White king in checkmate. Traditionally the king is
knocked over to end the game.
You’ll set the Keyable tracks so that you can animate the rotation of the king,
along with its X and Y positions, but not its Z position. You don't want the
king dropping through the board.
NOTE When using Set Key animation, it’s useful first to determine which tracks
will be keyed and which won’t. In simple transforms this isn’t crucial, but if you’re
using Set Key to keyframe materials or object parameters, this is extremely
important. If you don’t define which tracks are keyable, all the animatable material
or object parameters will receive keys when you click Set Keys.

1

Select the White king, then right-click and choose Curve Editor
from the quad menu.
The Curve Editor dialog is displayed, with the King’s tracks displayed at
the top of the controller window at the left of the dialog.

2 On the Track View toolbar, click

(Show Keyable Icons).

The tracks for the White king show red “keyable” icons in the controller
window.
3 Click the red icons next to the Z position track and the Scale track.
The icons turn black to show they are inactive.
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Keyable tracks turned off for Z position
and scale

Now you will not be able to key the Z position or the scale of the king.
You can still key the rotation and the XY position tracks for the king.
If you want to key the rotation and the position tracks individually, you
can use the Key Filters.
4 Go to frame 75 and with the White king selected, press K.
This creates a position and rotation key at frame 75.
5 Go to frame 90, then click
is to the right of the Set Key button.

(Key Filters). This button

6 On the Set Key Filters dialog, turn off everything except Position.
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7

Close the Set Key Filters dialog.

8 Go to frame 100, then move the White king off the board to the left.

Rotate the king so it is on its side, then click
Keys) to create a key.

9

(Set

Play the animation. The White king moves off the board, but
doesn’t rotate, since Key Filters did not allow the rotation track to be
keyed.

10 Click

(Key Filters) and turn Rotation back on, then
close the dialog again.

11 Go to frame 100,

rotate the White king, and then set a key.
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TIP If you want to replace a key with a different one, delete the key in the

track bar, then use
(Set Keys) again to set a new key. Set Keys
doesn’t automatically replace a key that has already been set.

12

Play the animation. Now the rotation has been keyframed.

Checkmate!

13 Save your file as mycheckmate.max.

You can

open quickest_checkmate.max to compare with your file.
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Summary
In this tutorial, you have learned to use Set Key animation. You've learned
how to create keyframes with the Set Keys button, set Key Filters, and make
tracks keyable in Track View. You will find it useful to apply these lessons to
animating complex structures.

Adding Sound Effects to Animation
In this tutorial, you add audio files to Track View, then in the Dope Sheet
Editor, use ProSound to synchronize the sounds with the animation.
The scene shows a World War One airfield somewhere in the north of France.
A biplane is poised for takeoff, but it has no sound. Your task is to take a group
of four .wav files and assemble them so that they play back as the plane rolls
down the runway and takes to the sky.

In this tutorial, you will learn how to:
■

Add audio files to a scene and control audio playback

■

Use the Dope Sheet track editor to synchronize playback of audio clips
with scene animation

■

Use track controls to lengthen or shorten audio segments
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Skill level: Beginner
Time to complete: 20 minutes

Adding Sound Effects
You will start by adding a number of audio files to your scene. Next, you’ll
display the files as clips on the Dope Sheet track editor and adjust their
sequencing to fine-tune the audio playback.
Set up the lesson:

■

On the Quick Access toolbar, click
(Open File), navigate to the
animation\prosound folder, and open prosound_start.max.
NOTE If a dialog asks whether you want to use the scene’s Gamma And LUT
settings, accept the scene Gamma settings, and click OK. If a dialog asks
whether to use the scene’s units, accept the scene units, and click OK.

Add sound files to your scene:

1 On the main toolbar, click

(Curve Editor (Open)).

2 In the Curve Editor controller window, click the Sound track to highlight
it.

3 Right-click and from the quad menu, choose Properties.
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4 In the ProSound dialog ➤ Input Files group, click Add.

The Open dialog automatically opens to the sounds folder in your working
directory. If the sound files flyby.wav, inflight.wav, start_engine.wav, and
takeoff.wav are not there, navigate to the folder where you saved your
ProSound tutorial scene files.
5 Highlight the flyby.wav, inflight.wav, start_engine.wav, and takeoff.wav
sound files, in any order, then click Open.
The files display as a list in the Input Files group. While it is not
mandatory, it can be helpful to place the files in the order in which their
sounds are heard in the sound track.
6 From the Input Files group sound files list, highlight start_engine.wav and
click Move Up as many times as needed to place the file at the top of the
list.

7 Highlight takeoff.wav and click Move Up until it displays just below
start_engine.wav. Use Move Up to place the flyby.wav next in the list.
8 Highlight a file in the list and in the File Details group, click the Play
button to hear how it sounds.
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The File Details group also contains options that let you control how the
file plays back in the scene. You can, for example, loop the file so it repeats
a specified number of times, or enter the first and last frame on which
the sound is played. The Active option lets you include or exclude the
sound file in the playback.
In this tutorial, however, you will set these and other file playback
parameters in a more visual way by using the Dope Sheet.
9 Close the ProSound dialog.
View the sound tracks in the Curve Editor and Dope Sheet:

1 On the Curve Editor track view hierarchy,
expand the Sound track
to display the master track as well as four additional tracks, each of which
represent the sound files you loaded into the scene.

2

Expand each track. Each time you do so, highlight the track’s
Waveform component to display it.
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A waveform is an image that represents an audio signal, showing a change
in amplitude over time. Soft sounds, like footsteps, produce a narrow
pattern, whereas sharp sounds, like the scrape of a chair leg, show a wider
pattern. Waveforms help you visualize the events in an audio recording.
Notice how only one track waveform is visible at a time in the Curve
Editor. (The master track waveform provides a visual compilation of all
tracks.)
In this tutorial, it would be helpful to view all the waveforms together,
so you can better adjust the timing of their audio segments. You can view
multiple waveforms from the Dope Sheet.
3 On the Curve Editor menu, choose Modes ➤ Dope Sheet.

4 Collapse the master track to view just the waveforms and volume
components of the four individual sound tracks.
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The first, second, and fourth sound tracks were recorded in mono and
show a single waveform. The third sound track, flyby.wav, was recorded
in stereo and displays two waveforms, one for its left and another for its
right channel.

5

Play the animation to hear the sound files.

The segments overlap and produce a jumbled sound. You need to adjust
the timing so each plays back at a more logical place in the animation.

Stop the playback.
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Synchronize the audio with the animation:

1 On the Dope Sheet toolbar, click

(Edit Ranges).

2 Click the start_engine.wav range bar and move it left and right to see how
you can reposition the audio segment anywhere on the timeline.

You need to reposition the start_engine segment to coincide with the
part in the scene animation where the biplane propeller starts to turn.
3 Move the Dope Sheet window until the Camera01 viewport is visible.
4 Drag the time slider until you see the propeller start to pick up speed,
which is around frame 50.

5 Click the start_engine.wav range bar and drag it until the segment
waveform is positioned at the vertical blue lines, which indicate the
current frame.
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6 For now, concentrate on just the start_engine.wav track by selecting the
other track range bars in the Dope Sheet and moving them to the right,
past frame 200.

TIP Alternatively, you could temporarily mute the sound tracks in Track View
by selecting their file names in the ProSound dialog and turning off the Active
checkbox, as described in the previous procedure.
Scrub the animation.
The plane starts to move down the runway at frame 160. This is where
you want to place the start of the takeoff.wav audio segment.
7 Click the takeoff.wav range bar and drag it until the segment waveform
starts at frame 160.
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As the plane begins to taxi down the runway it would be a good idea to
prolong the start_engine audio segment, to simulate a sputtering takeoff.
You could prolong the segment by going back to the ProSound dialog
and in the File Details group, set Loops to repeat the segment as many
times as needed. The next step shows you a different method.
8 On the Dope Sheet, click the right end point of the start_engine.wav range
bar and drag to the right.

As you drag, the audio segment is repeated. You can drag for as many
repetitions, or loops, as you like.
The end of each repetition is indicated by a vertical bar, as shown in the
next illustration.

9 Continue dragging until the segment is repeated just once.
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10 Move the Dope Sheet window until the Camera04 viewport is visible.
11 Scrub the animation again until, at around frame 405, you see the wheels
of the biplane detach from the ground.
12 On the Dope Sheet editor, drag the flyby.wav range bar until the segment
waveforms start at frame 405.

13 Scrub the animation again.
The waveform should peak at or around frame 435, when the biplane
passes directly overhead.
14 On the Dope Sheet, reposition the inflight.wav range bar so that the
waveform fades out at the end of the animation, as shown in the next
illustration.
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15 Replay the animation to hear how all the audio segments fit together.
By default, the audio plays forward as you play the animation forward;
there is no audio when you scrub animation in reverse.
16 To hear the audio in reverse when scrubbing, highlight, then right-click
the Sound track in the Curve Editor or Dope Sheet and from the quad
menu choose Properties. In the ProSound dialog ➤ Playback group, turn
on Permit Backwards Scrubbing.

17 Try scrubbing the animation back and forth.
You can now hear all audio in the scene play in reverse.
18 Compare your work with the finished version of the scene by opening
prosound_completed.max.
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Summary
In this tutorial, you learned how to add multiple audio files to your scene and
mix them in the Dope Sheet editor for playback during an animation.

Rigging a Car
In this tutorial you establish relationships and other constraints to “rig” the
moveable parts of a car so they can be animated together easily.
There is more to animating a car than simply giving it a trajectory. You should
also consider such aspects as wheel rotation, the link between the steering
wheel and front wheels, as well as body roll. Animating these aspects
individually however, can become quite complicated. This tutorial shows how
to wire, for example, the steering wheel to the front wheels, so the animation
is consistent and realistic.

In this tutorial, you will learn how to:
■

Use List controllers to manage animated components of a model

■

Define controller behaviour though the use of expressions

■

Use the MacroRecorder to automate the assignment of List controllers

■

Create a toolbar to hold custom tools
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■

Use wiring and expressions to rig objects for animation

Skill level: Advanced
Time to complete: 1+ hours

Using List Controllers
A controller in 3ds Max is a plug-in that manages the values involved in
keyframe animation, such as changes in object scaling, color, or translation.
List controllers combine two or more controllers and can be very useful when
combining relationships between objects.
List controllers, for example, are helpful when using expressions and
constraints to control a child object through a parent object, particularly if
the child and parent objects are not using the same orientation. The List
controller uses added internal controllers that lets you maintain control over
the child object’s local orientation, even though it remains constrained to
that of its parent.

Local orientation of a child object can differ from its parent.
Right: Orientation of the parent chassis
Left: Orientation of the front left car wheel

The child object (car wheel) of the rig you are about to animate in this tutorial,
is oriented differently from the parent object (the car body). To turn the wheel
using wiring, you would have to rotate the wheel on its Y axis (based on the
orientation of the body of the car), not its X axis (the wheel’s local orientation).
To regain control of the local orientation of the child object, you will add list
controllers to the position and rotation tracks of the front left wheel animation.
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Set up the scene:

■

On the Quick Access toolbar, click
(Open File), navigate to the
animation\car_rigging folder and open car_rig_01_start.max.
NOTE If a dialog asks whether you want to use the scene’s Gamma And LUT
settings, accept the scene Gamma settings, and click OK. If a dialog asks
whether to use the scene’s units, accept the scene units, and click OK.

Manually assign List controllers:
In this procedure, you will manually assign List controllers to the position
and rotation tracks of the front left wheel of your Chevy.
1 From the main toolbar Selection Sets list, choose Garage_All.

2 Right-click the Perspective viewport and choose Hide Selection from the
quad menu.
All scene objects other than the car are hidden.
3 Press H to display the Select From Scene dialog and expand the Chassis
object (the car body).
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Notice how the four wheels, as well as the steering wheel, are children
of the object . This hierarchy is typical to 3D car models.
4 Choose Wheel-FL from the object list, then click OK.
The front left wheel in the scene is now selected.

5 Go to the

Motion panel and expand the Assign Controller rollout.

A list of default animation controllers displays as tracks in an Explorer
format.

6 Highlight the Position:Position XYZ track, then click
Controller).

(Assign
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7 On the Assign Position Controller dialog, double-click Position List.
8 On the Assign Controller rollout ➤ Position:Position List track, click
the + icon to expand the position list.

9 Click the Available track, then click

(Assign Controller) again.

10 On the Assign Position Controller dialog, double-click Position XYZ.
In the explorer, a second Position XYZ: Position track has been created
below the first. This track represents the controller that will control
keyframe information of X, Y, and Z axes based on the local position of
the child object (the front left wheel).
Next, you will repeat the procedure by assigning a List controller to the
rotation track of the front left wheel.
11 On the Assign Controller rollout list of tracks, click Rotation: Euler XYZ

and click

(Assign Controller).
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12 On the Assign Rotation Controller dialog, double-click Rotation List.
13 On the Assign Controller rollout list of tracks, expand the Rotation: List
track by clicking its + icon.

14 Click the Available track and click

(Assign Controller).

15 On the Assign Rotation Controller dialog, double-click Euler XYZ.
A second Euler XYZ track is created. This track controls rotation keyframe
information of X, Y, and Z axes based on the local coordinates of the
front left wheel.
Automating the assignment of List controllers:
MacroRecorder is a simple scripting utility that records your interactions in
3ds Max. It converts your actions into a script that you can reuse to accomplish
repetitive tasks.
In the previous procedure, you manually assigned position and rotation list
controllers to a single wheel on your Chevy. You will now use MacroRecorder
to automatically assign list controllers to the remaining three wheels, as well
as the car body and steering wheel, so that the entire rig uses the same
coordinate system in its animation.
1 Go to the bottom-left corner of the 3ds Max window, right-click the
MAXScript area and choose Open Listener Window.
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3ds Max opens the MAXScript listener dialog.

TIP If the upper, Macro Recorder pane (with a pink background) isn’t easy
to see at first, drag the bar that divides the panels downward, so the two
panes are roughly equal in area. You can also resize this dialog.
2 From the menu bar, choose MacroRecorder ➤ Enable.
From this point onward, almost any action you perform in 3ds Max will
be recorded in a script.
3 Select the rear left wheel of the car (the Wheel-RL object).
4 Repeat steps 6 through 16 of the previous procedure to assign list
controllers to the position and rotation of the rear left wheel.
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As you progress, notice how the pink Macro Recorder area accumulates
scripting data.
5 Right-click a gray area of the main toolbar (below the Selection Sets
drop-down is a handy area), then choose Customize.
6 On the Customize User Interface dialog, make sure the Toolbars tab is
active, then click New.
7 On the New Toolbar dialog, type myTools and click OK.
8

Close the Customize User Interface dialog and reposition the
new toolbar to the right of the MAXScript Listener window.

9 Highlight the last four lines of the script, then drag and drop them onto
the myTools toolbar.
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3ds Max creates a button on the toolbar.

10 Right-click the newly created button and choose Edit Button Appearance.
11 On the Edit Macro Button dialog, choose the Text Button option and in
the Label field, type List Con, then click OK.

3ds Max changes the button to a text button.
12 On the MAXScript Listener window menu bar, choose MacroRecorder
➤ Enable to turn off script recording.
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The MacroRecorder stops recording your actions in 3ds Max.
13

Close the MAXScript Listener window, then resize the myTools
toolbar until the List Con label is fully displayed.

You are now ready to use the List Con tool to quickly assign list controllers
to the remaining wheels of your car model.
14 In any viewport, select the front right wheel of the car (the Wheel-FR
object).
15 On the myTools toolbar, click List Con.
On the Motion panel ➤ Animation Controller rollout, expand the
Position XYZ track to display one of the list controllers that was assigned
by the script you just created.
16 Select the last remaining wheel in the model and click List Con again.
17 Repeat the previous step for the Chassis object.
18 Repeat the previous step for the SWheel object.
NOTE You can apply the MacroRecorder script to only one object at a time.
You must therefore click the List Con button once for each object you want
to modify.
19 Save your work as mycar_rig_02.max.
The myTools toolbar you created in this procedure is now available for all
future 3ds Max work sessions.
In the next lesson, you will learn how to animate the rotation of the car
wheels.
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Rotating the Wheels
In this lesson, you will learn how to rotate the wheels by an amount that
corresponds to the distance travelled by the car model.

Let’s start by taking a look at the trigonometry involved in calculating the
wheel rotation.
In any circular object, the amount of rotation (α) is defined by the radius of
the circle and the arc length encompassed by the α angle. That amount of
rotation (α) expressed in radians, is equal to the arc length, divided by the
radius of the circle (arc length / R), where:
■

The radius of the car wheel is constant and equal in this case to 13 units.

■

The arc length, when flattened, represents the distance travelled by the
car and its wheels.
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Therefore, the wheel rotation calculation (arc length / R) becomes distance /
13. Whereas the radius of the wheel is constant and equal to 13, the distance
travelled is variable.
Set up the lesson:

■

Continue from the previous lesson or

open car_rig_02.max.

Rotate the wheels (in World X coordinates):
1 In the Perspective viewport, select the car body.
The car is currently oriented on the World X axis: you will begin working
in this coordinate system.
2 Right-click the car body object and from the quad menu, choose Wire
Parameters.
3 From the menu, choose Transform ➤ Position ➤ (2nd) Position XYZ
➤ X Position.

Rotating the Wheels | 695

NOTE It is important to always leave the first animation controller at the top
of the list (in this case, the Position XYZ Controller) untouched, since it serves
as a “lock” for the parent/child relationship. When choosing controllers to
work on, always work from top of the controller list downward, starting with
the second controller.
A rubber band shows the link you are about to make between your two
selected objects.
4 Select the front left wheel of the car (Wheel-FL).
5 From the menu, choose Transform ➤ Rotation ➤ (2nd) Euler XYZ ➤
Z Rotation.

The Parameter Wiring #1 dialog opens. You use this dialog to set up one
and two-way control relationships between objects. The position and
rotation of the two objects you just selected to affect one another are
highlighted.

696 | Chapter 4 Animation Tutorials

6 On the Parameter Wiring dialog, click the right-pointing arrow above
“control direction”.

This ensures that the Chassis X position is controlling the Wheel-FL Z
rotation and not the other way around.
The bottom-right corner of the Parameter Wiring dialog displays the
wheel object Expressions panel. It shows the distance travelled as
X_Position.
7 Next to X_Position, type /13.
The expression should now read X_Position/13, the distance divided by
the radius of the wheel.
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8 Click Connect, but do not close the dialog.
9 Test your work by moving the car body on its X axis.
Notice how the front-left wheel does not rotate. Even though you added
a position list controller to the car and wheel, the first controller in the
list (the one that ensures the parent/child “lock”) is still active. You need
to make the second position controller (the one used in the wiring process)
the active one.
10 If you moved the car model, press Ctrl+Z to undo the move.

11 With the car body selected, on the
Motion panel ➤ PRS
Parameters rollout, click the Position button at the bottom of the rollout.
12 On the Position List rollout, highlight the second Position XYZ controller
and click Set Active.

13 Try moving the car on its X axis again.
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TIP To better see the wheel rotation, use the Front viewport, and change its
display mode to Smooth + Highlights.
The wheel now rotates, and at the correct rate, but its motion is backward.
14 In the Parameter Wiring dialog, on the Expressions panel, add a minus
sign (-) in front of the expression, then click Update.
15 Move the car on its X axis again and notice how the wheel rotates in the
proper direction.
16 Repeat the preceding steps for each of the remaining three car wheels.
TIP To select the wheels on the right side of the car, you can press H after
you choose the car body’s X Position, and then use the Pick Object dialog to
pick the wheel.
Because the wheels were mirrored, the wheels on the right side of the car
do not need the minus sign added to their expression, whereas those on the
left side do.
17

Close all the Parameter Wiring dialogs.

Add subcontrollers for Y rotation:
In the previous procedure, you learned how to add controllers that determine
car wheel rotation for the length of distance travelled by the model along the
World X axis. However, if you tried to rotate the car in any way, wheel rotation
would be reduced or stop altogether. You therefore need to add controllers
that account for the car’s displacement in a Y direction.
1 In the Top viewport, select the car body object and rotate it 90 degrees
clockwise so that its front bumper points at 12 o’clock.
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The car is now oriented on the World Y axis, so you will begin working
in this coordinate system.

2

Orbit the Perspective viewport until you can see the front left side
of the car.
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3

Move the car forward and backward on the Y axis. Notice that
the wheels do not rotate.
To get the wheels rotating, you will need additional animation controllers,
ones that will control the car’s displacement in the Y direction. You will
add these as sub-controllers, so you do not overwrite the controllers
already in place.

4 Go to the bottom-left corner of the 3ds Max window, right-click the
MAXScript area, and choose Open Listener Window.
5 On the MacroRecorder panel, highlight the line that reads:
$.rotation.controller.Available.controller = Euler_XYZ ()
Be sure not to include the line’s carriage return when you make your
selection. Press Ctrl+C to copy this line to memory.
If you are not continuing from the previous lesson, this line will not be
available from the Open Listener window. If this is the case, copy the
line from the text of this tutorial.
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6

Close the MAXScript Listener window, then
the front left wheel (Wheel-FL).

select

7 Click inside the MAXScript entry field (the white box in the bottom-left
corner of the 3ds Max window), press Ctrl+V to paste the line of code,
then press Enter.

8 On the
Motion panel ➤ PRS Parameters rollout, make sure that
the Rotation button is active, Then on the Rotation List rollout, verify
that a new sub-controller has been added to the rotation list (there should
be 3 in all).

9 Repeat step 7 to add a fourth rotation sub-controller. You will need this
later on in the tutorial.
The front left wheel should now have four Euler XYZ tracks.

10

Select another wheel and repeat steps 7 to 9 until all four wheels
have four Euler XYZ tracks in their respective rotation lists.

Rotate the wheels (in World Y coordinates):
1 Select the car body, then right-click and from the quad menu, choose
Wire Parameters.

702 | Chapter 4 Animation Tutorials

2 From the menu, choose Transform ➤ Position ➤ (2nd) Position XYZ
➤ Y Position.

3 Select the front left wheel (Wheel-FL).
4 From the menu, choose Transform ➤ Rotation ➤ (3rd) Euler XYZ ➤
Z Rotation.

5 On the Parameter Wiring dialog, click the right-pointing arrow above
Control Direction to ensure that the Chassis Y position is controlling the
Wheel-FL Z rotation.
6 On the right-hand Expressions panel, type /13, then click Connect.
The expression for the left-hand wheel should be Y_Position/13
7 Click Connect.
8 Repeat steps 3 to 8 for each of the other three wheels.
NOTE The expression for the right-hand wheels should be –Y_Position/13.

9

Close the Parameter Wiring dialogs.

10 In the Top viewport,
horizontally or vertically.

rotate the car so that it is not pointing
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11 On the main toolbar, click
coordinate system to Local.

(Select And Move), then set the

12 If you need to, adjust the Perspective viewport so you can see the side of
the car.
13 Move the car on its local X axis. Notice how the wheels are rotating
properly.
14 In the Top viewport, rotate the car until the front bumper is pointing to
the left.
15 Save your file as mycar_rig_03.max.
Rotate the wheels (under a path constraint):
In the previous procedure, you learned how to add controllers that rotate the
car wheels for any distance of travel in World X and Y space. The wheels will
therefore rotate properly when you manually move the car around the scene
in any direction.
However, you would most often animate motion of a car by placing it on a
predefined path using the Path constraint. This type of animation requires a
different expression.
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This new expression uses the same formula (distance divided by radius) as the
ones you have been using, but while the radius of the wheel remains constant,
the distance travelled is calculated differently.

1 Continue from the last procedure or

open the file car_rig_03.max.

2 From the main menu ➤ Selection Sets list, choose Car Path.

A warning message displays.
3 Click Yes to display the path you will use to animate the car motion.
4 From the main menu, choose Create ➤ Helpers ➤ Point.
5 On the Parameters rollout, turn on Box and set Size to 100.0.

This increases the size of the helper gizmo and makes it easier to select
in the scene.

Rotating the Wheels | 705

NOTE Many animators use the Dummy helper instead of Point. The advantage
of using a Point helper is that you can adjust its size without having to scale
it. Scaling a helper in a hierarchy will affect its children objects: This is an
effect that usually you want to avoid.
6 In the Top viewport, click a point near the car to place a Point helper.

7 With the Point helper still selected, on the main toolbar click
(Align), then in any viewport, select the car body.
8 In the Align Selection dialog ➤ Align Position group, make sure X
Position and Y Position are on and Z position is off.
9 In the Current Object and Target Object groups, make sure Pivot Point
is chosen, then click OK.
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10 In the Front viewport, move the Point helper on its X axis to the right
until it is just to the left of the rear axle of the car.
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Point helper moved to left of rear axle

The Point helper location you have specified will become the pivot point
of the car when the front wheels turn.
11 On the command panel ➤ Name And Color rollout, rename the helper
Dummy_CAR.
12 In any viewport, select the car body.

13 On the main toolbar, click
(Select And Link), then in the Front
viewport, click the car body and drag to the Point helper. This makes the
car body the child of the Point helper.

14 On the main toolbar, click

(Select Object) to exit link mode.

15 From the main toolbar Selection Sets list, choose Garage_All. Click Yes to
dismiss the warning and unhide the rest of the scene geometry.

16 In the Top viewport, use
lot.

(Zoom Extents) to view the entire parking

17 In the Perspective viewport, click the Perspective label and from the
menu, choose Cameras ➤ Camera_Wall-E.
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Animate the dummy by constraining it to a path:
1 In any viewport, select the Dummy_CAR helper.
2 From the main menu, choose Animation ➤ Constraints ➤ Path
Constraint.
3 In the Top viewport, click on the green path (CarPath).
The helper and the linked car are repositioned at the start of the path.
NOTE You could, as an alternative, constrain the car directly to the path. In
this case, however, it is preferable to constrain the helper parented to the car
so you can retain extra control over the car’s behavior (such as defining skids
around tight corners).
4 Scrub the animation.
The car’s orientation remains constant throughout the animation.

5 In the
Motion panel ➤ Path Parameter rollout ➤ Path Options
group, turn on Follow.

6 Scroll down to display the Axis group, and turn on Flip.

The Flip option prevents the car from driving in reverse.
7 Scrub the animation again.
Car motion is improved, but at the last frame the car points at an awkward
angle. This is a common behavior to paths based on a NURBS curve. You
will now correct this problem.
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TIP NURBS curves, when used as animation paths, provide a smoother “ride”
than ordinary splines.
8 Go to the last frame of the animation (frame 150), and make sure the
Point helper is selected.

9 Turn on

(Auto Key).

10 In the
Motion panel ➤ Path Parameters rollout ➤ Path Options
group ➤ % Along Path box, type 99.9 and then press Enter.

11 Turn off

(Auto Key) and scrub the animation.

The car is properly oriented on the path, but the wheels no longer rotate.
This is because the expression that defined the wheel rotation you
formulated earlier no longer applies. The distance travelled by the car
was dependent on the X and Y displacement in the World coordinate
system. Displacement is now tied to the length of the path and the
percentage of the path that the car has travelled. You must therefore
modify the expression to reflect this change.
Wire wheel rotation to a path:
1 In any viewport, select the animation path (CarPath) then go to the

Utilities panel.
2 Click Measure and in the Shapes group, take note of the path length.

3 Select and right-click the Point helper, then from the menu choose Wire
Parameters.
4 From the menu, choose Transform ➤ Position ➤ Path Constraint ➤
Percent.
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5 Click one of the car wheels and choose Transform ➤ Rotation ➤ (4th)
Euler Rotation ➤ Z Rotation.

6 On the Parameter Wiring dialog, set the control direction to the right,
which places the Percent parameter in control of the wheel rotation.
7 On the right-hand Expressions panel, type (2365*Percent)/13.
NOTE The value 2365 is the length of the animation path you measured
earlier. When multiplied by the percent variable, it calculates the distance
the car has travelled at any given moment in time along the path. When
divided by the radius of the wheel (13), it provides the amount of rotation
needed for the wheel to turn.
8 Click Connect.
9 Scrub the animation to see the wheel rotation.

10 To better see the animation, click
(Time Configuration) and in the
Time Configuration dialog ➤ Time Display group, choose FRAME:TICKS.
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11 Repeat steps 3 to 8 to link the Point helper to each of the remaining three
car wheels.
Remember to add a minus sign (-) operator to the expression of the wheels
on the right side of the model so they don’t rotate in the opposite
direction.
12 Save your file as mycar_rig_04.max.

Pivoting the Wheels
You now need to make sure the front wheels pivot or “turn” as the car moves
left or right along the animation path. For added realism, you will also establish
a relationship between the wheel pivot and the turn of the steering wheel.

712 | Chapter 4 Animation Tutorials

Set up the lesson:

■

Continue from the previous lesson or

open car_rig_04.max.

Set up helpers for the front wheels:
In the same way you created a Point helper to direct the car animation along
a path, you will also create two more Point helpers to control the pivot of the
front wheels by the rotation of the steering wheel.

1 In the Top viewport,
to Wireframe mode.

zoom in on the car and press F3 to switch

2 From the main menu, choose Create ➤ Helpers ➤ Point.
3 Click anywhere around the car body and in the Parameters rollout, turn
on Box, then in the Size box, type 50.0 and name the helper Dummy_FL.
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4 With the helper still selected, click the List Con button on the myTools
toolbar you created earlier in the tutorial.
The List Con script automatically assigns the two Position list and
Rotation list controllers you set up earlier, permitting you to retain control
over the helper’s local orientation.
NOTE If the myTools toolbar is not currently displayed on your interface,
right-click a gray area on the main toolbar and choose myTools from the
menu.
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5 From the main toolbar, click
click the car body.

(Align) and in the Top viewport,

6 In the Align Selection dialog ➤ Align Position group, turn off X Position,
Y, Position and Z Position. In the Align Orientation group, turn on X
Axis, Y Axis and Z Axis.
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These settings ensure that the car and the helper have the same
orientation.
7 Click OK to close the dialog.
8 From the main toolbar, use Shift+Move and drag the helper to make a
copy.
TIP Set the coordinate system to Local to make moving the Point helper
easier.
9 In the Clone Options dialog, name the copy Dummy_FR.
Next, you will align the helper and the right front wheel pivot to pivot
in X, Y and Z positions.

10 In the Top viewport,
choose Hide Selection.

11

select the Chassis object, right-click and

Select the new point helper. Click
click Wheel_FR.
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(Align), and then

12 In the Align Selection dialog ➤ Align Position group, turn on X Position,
Y Position, and Z Position.
Make sure Pivot Point is chosen in both the Current Object and Target
Object groups.
In the Align Orientation group, turn off X Axis, Y Axis and Z Axis.

13 Click Apply, then click OK to exit the dialog.

14

Select Dummy_FL, and from the main toolbar click
(Align) tool again. In the Top viewport, click Wheel_FL.

15 Repeat steps 12 and 13 to align the helper to the front left wheel.
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Point helpers aligned to front left and right wheels

Now you will now rework the hierarchy and parent/child relationships
of the car setup, so you can pivot (steer) the wheels. These steps also
prepare for the body roll you will rig in the next lesson.
Link the wheel helpers to the car helper:

1 On the main toolbar, click

(Select And Link).

2 Ctrl+select the two wheel helper objects, then drag to the Dummy_CAR
object.
This links the helpers as children of the Dummy_CAR object.
Link the rear wheels to the car helper:

■

With
(Select And Link) still active, select both rear wheels (Wheel-RL
and Wheel-RR) and drag to the Dummy_CAR helper.
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Link the front helpers to their wheels:

1

Link the front left wheel (Wheel-FL) to the Dummy_FL helper.

Linking front left wheel to front left wheel helper

2

Link the front right wheel (Wheel-FR) to the Dummy_FR helper.

3 Click

(Select Object) to turn it on and turn off Select And Link.

Unhide the car body:
■

In the viewport, right-click and choose Unhide By Name from the quad
menu. On the Select From Scene dialog, choose Chassis, and then click
Unhide.

Rotate the wheels (in World X coordinates):
1 Click the Camera_Wall-E viewport label and from the menu, choose
Cameras ➤ Camera_Birdseye.
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2 On the main toolbar, click

(Select) to turn it on.

3 In the Camera viewport, select the steering wheel (SWheel).
4 Right-click the steering wheel and choose Wire Parameters.
5 From the menu, choose Transform ➤ Rotation ➤ (2nd) Euler XYZ ➤
Z Rotation.

6 Click the Dummy-FL object, which is the front left wheel helper, and
choose Transform ➤ Rotation ➤ (2nd) Euler XYZ ➤ Z Rotation.

7 On the Parameter Wiring dialog, set the control direction to both ways,
since the manual turning of either object affects the other.

8 Click Connect, and leave the Parameter Wiring dialog open.
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9 On the main toolbar, turn on
coordinate system to Local.

(Select And Rotate) and set the

10 Rotate the steering wheel on its local Z axis.
Notice how the steering wheel and the front wheel turn in the opposite
direction. You will correct this by modifying the controller expression.
A second adjustment is also required. The front wheel needs to turn far
less than the steering wheel. This is because the pivot range of a front
wheel is about 90 degrees, whereas a steering wheel range of movement
is two to three complete revolutions.
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Steering wheel and front wheel turn in opposite directions

11 Cancel or undo the rotation you made in the previous step.
12 In the left-hand Expressions panel, under “Expression for SWheel’s
Z_Rotation”, type: –Z_Rotation*8.
13 In the right panel, under “Expression for Dummy_FL’s Z_Rotation”, type:
–Z_Rotation/8.

The minus sign (-) operator ensures that the two rotations are aligned,
and the *8 and /8 factors ensure that the front left wheel pivots (rotates
in Z) eight times less than the rotation of the steering wheel.
14 Click Update and test your work by rotating the steering wheel on its
local Z axis again.
Notice the more realistic behavior.
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15 Repeat steps 4 to 14 to wire the steering wheel and the front right wheel
helper. (You can use H to select the front right wheel helper.)
Be sure to specify exactly the same expressions as you did in steps 13 and
14, since the right wheel helper was copied, not mirrored, from the front
left helper.
You can see the effect of wiring the front right wheel in the Top viewport.
16

Close the Parameter Wiring dialogs.

Animate the steering:

1 If your timeline is displayed in frames and ticks, click
(Time
Configuration) and in the Time Configuration dialog ➤ Time Display
group, choose Frames.

2 Activate the Top view, press F3 to switch back to Smooth + Highlights

mode, then click
animation path.

(Zoom Extents) so you can see the entire

3 Go to frame 50, the point where the car is in the middle of its first turn.

4 Select SWheel and on the main toolbar, click

(Select And Rotate).

5 Turn on
(Auto Key) and rotate the steering wheel until the
Z axis status bar reads –280.
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Steering wheel rotation at -280 degrees about the Z axis

6 Go to frame 115, the point where the car is in the middle of the second
turn, and rotate the steering wheel until the Z axis status bar reads 500.
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Steering wheel rotation at 500 degrees in the Z axis

7 Go to the
end of the animation and rotate the steering wheel
until the Z axis status bar reads –220.

8 Turn off

(Auto Key) and test your animation.

9 Save your file as mycar_rig_05.max.

Setting Car Body Roll
Body roll is a phenomenon that occurs when a car rounds a sharp corner. This
behavior is not usually apparent in modern day cars unless they are travelling
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at high speed. In older cars, such as our 1957 Chevy, however, the amount
of body roll is discernible to both passengers and bystanders even when the
vehicle is travelling at low speed.

Set up for the lesson:

■

Continue from the previous lesson or

open car_rig_05.max.

Create the body roll effect:
In this lesson, you will create the effect of body roll by rotating the car along
its local X axis. Roll direction will be based on the rotation of the steering
wheel.
1 Make sure you are at frame 1 in your animation.

2 In the Top viewport,
Wireframe mode on.

zoom in on the car and press F3 to turn

3 On the main toolbar, click
(Select And Rotate) and make sure
the coordinate system is set to Local.
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4 In any viewport,

select the steering wheel object.

The steering wheel rotates about its local Z axis.
5 Select the car body object.
The car body rolls about its local X axis.
6 Select the steering wheel again, then right-click and from the quad menu,
choose Wire Parameters.
7 Choose Transform ➤ Rotation ➤ (2nd) Euler XYZ ➤ Z Rotation.

8 Click the car body and choose Transform ➤ Rotation ➤ (2nd) Euler
XYZ ➤ X Rotation.

9 On the Parameter Wiring dialog, set the control direction to the right so
the steering wheel rotation in Z controls the body roll in X.
10 On the right-hand Expressions panel, complete the expression so it reads:
Z_Rotation/40, then click Connect.
NOTE The /40 factor in the expression divides the steering wheel rotation
by 40 to ensure body roll rotation is significantly smaller than the rotation of
the steering wheel. If you like, try experimenting with other values.
11 Click the Camera viewport label and choose Camera ➤ Camera_Wall_S
then scrub the animation to see the effect of the body roll.

Setting Car Body Roll | 727

Body roll visible in the Left viewport

12 Save your file as mycar_rig_06.max.

Adjust Driver Viewpoint
As a driver, when you use a steering wheel to initiate a turn, your eyes tend
to follow the direction of the turn. When you turn left, you look left: when
you turn right, you look right. In this lesson, your final task is to make the
viewpoint of the driver react to the rotation of the steering wheel.

Set up the lesson:

■

Continue from the previous lesson or
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open car_rig_06.max.

Change the driver’s point of view:
In this procedure, you will wire the rotation of the “driver view” camera to
the steering wheel.

1 On the
Display panel ➤ Hide By Category rollout, turn off
Cameras to re-display the cameras in the scene.
2 In the Front viewport, select the Camera_Driver object.

Camera_Driver object

This is the camera that occupies the driver’s seat.
3 Click the List Con button on the myTools toolbar you created earlier in
the tutorial.
The List Con script automatically adds position and rotation list
controllers, permitting you to retain control over the camera’s local
orientation.
NOTE If the myTools toolbar is not currently displayed on your interface,
right-click a gray area on the main toolbar and choose myTools from the
menu.
4 With the camera object selected, go to the hierarchy panel and on the
Adjust Pivot rollout, click Affect Pivot Only.
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Notice that the swivel axis needed for the camera is the Y axis (displayed
in green).

Camera swivel on Y axis

5 Click Affect Pivot Only again to exit pivot mode.
6 Select the steering wheel, right-click it, and from the menu choose Wire
Parameters.
7 Choose Transform ➤ Rotation ➤ (2nd) Euler XYZ ➤ Z Rotation.

8 Click the Camera_Driver object and choose Transform ➤ Rotation ➤
(2nd) Euler XYZ ➤ Y Rotation.
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9 On the Wiring Parameter dialog, set the control direction from left to
right so the steering wheel controls the camera rotation.
10 On the right-hand Expressions panel, complete the expression so it reads:
Z_Rotation/10 and click Connect.
Keep the dialog open for now.
NOTE The /10 factor in the expression prevents the camera from rotating
too far in either direction. You can experiment with different values to produce
the results you need.
11 In the Camera viewport, click the Camera_Birdseye label and choose
Views ➤ Camera_Driver.
12 Scrub the animation to observe the wiring effect.
As the steering wheel rotates, the camera viewpoint swivels in the wrong
direction.
13 In the Wiring Parameters dialog, add a negative operator in front of the
expression, so that it reads: –Z_Rotation/10, then click Update.
14

Close the Wiring Parameters dialog and scrub the animation
again.

The rig is now complete. To view a version of the finished product,
open car_rig_final.max.

Summary
In this tutorial, you learned how to assign controllers to components of a
model, and use expressions to ensure the controllers animate the components
correctly. You also learned how to use Point helpers to animate a model along
a path and were shown how to rework the model hierarchy so that a child
object can respond to the animation of its parent.
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732

Character-Animation
Tutorials

5

3ds Max Provides two character-animation systems: CAT and character studio. The first section
of this chapter demonstrates how to use CAT tools to skin a character. The second section
demonstrates how to use character studio for skinning and animating characters, and how
to manage various kinds of character motion including walk cycles.
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Skinning a Character
This tutorial shows how to skin a character. In the first brief part you use the
Skin modifier to apply a character skeleton from CAT to a mesh-based character
model. After that you fine-tune the relationship between the two with the
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ability of the Skin modifier to set weights on a per-vertex basis. If this subject
is new to you, rest assured: All of the puzzling terminology in this introductory
paragraph will be explained.
As a bonus, the last part of the tutorial briefly presents methods for adjusting
a skinned character for mesh and rig changes, as well as a method for quickly
transferring skinning data between models of varying resolution, which can
save lots of time when skinning similar characters that require different
numbers of polygons.
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In this tutorial, you will learn how to:
■

Use the Skin modifier to transfer animation from a rig to a character mesh.

■

Adjust vertex weighting to correct animation at joints and other moving
parts.

■

Account for changes in the mesh and rig.

■

Transfer animation between character meshes of different resolutions.

Skill level: Intermediate to Advanced
Time to complete: 4 hours

Performing the Initial Skinning
The initial portion of this tutorial involves opening the scene containing the
character mesh to skin, opening a rig to serve as the character skeleton,
connecting the two with the Skin modifier, and finally animating the character
using an included file.
Set up the lesson:
1 Reset 3ds Max.

2 On the Quick Access toolbar, click
(Open File), navigate to the
\character_animation\skinning\ folder, and open the file applying_skin.max.
NOTE If a dialog asks whether you want to use the scene's Gamma And LUT
settings, accept the scene Gamma settings, and click OK. If a dialog asks
whether to use the scene's units, accept the scene units, and click OK.
The character model in the scene appears at the world origin (0, 0, 0).
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Meet Emma, a medium-resolution character mesh of about 7,500
polygons. Emma is great with kids and works well in TV, games, movies,
and other applications that don’t require extreme closeups. In addition
to the main character mesh, which is what you’ll be working with, the
scene contains separate objects for the hat, hair, and eyeballs.
Next you’ll load the character rig to which you’ll skin Emma.
Load the Emma rig:

1 On the Create panel, click
from the drop-down list.

(Helpers) and then choose CAT Objects

You might be familiar with character studio; CAT is a newer, separate
character-animation system included with 3ds Max that offers a different
albeit overlapping set of capabilities. This tutorial deals minimally with
CAT features, instead spending most the time with the Skin modifier.
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TIP For detailed info about CAT, see the CAT section in the main help.
2 On the Object Type rollout, click CATParent.
The CATRig Load Save rollout that results provides a list of preset character
rigs, but you’ll be using a different rig created especially for this tutorial.
The easiest way to do this is to load it onto an existing CATParent.
3 On the CATRig Load Save rollout, make sure (None) is highlighted, and
then in the Perspective viewport, next to Emma, drag out a CATParent
object.

CATParent on right

4 Go to the

Modify panel, and on the CATRig Load Save rollout,

click
(Open Preset Rig). Navigate to the
\sceneassets\animations\ folder , and open emmarig.rg3.
The rig appears at the CATParent location.
NOTE This rig has been specially modified, or “posed,” to fit the shape of
the Emma model. Usually you need to do this yourself before skinning a
model, so the initial application of the Skin modifier doesn’t require too much
adjustment, but that’s not within the scope of this tutorial. At any rate, the
process is fairly straightforward, especially as bones in CAT rigs are, in effect,
standard polygon geometry. They’re compatible with all of the modeling
tools in 3ds Max, and can even be replaced by other objects.
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While skinning a character it’s usually desirable to hide the rig, but for
times when you might want to toggle its visibility, it’s best to give the
entire rig a name so it’s easy to select.
5 Navigate the viewport so the character mesh and rig don’t overlap, then

with
(Select Object) on, drag a region around the rig to select
all of its bones. In the Named Selection Sets field on the main toolbar
(currently reads “Create Selection Set”), type the name EmmaRig and
press Enter to make sure the software registers the name. This is the same
name as the CATParent, but as it’s a selection set, not an object, there’s
no conflict.
Ideally, when skinning a character, the rig should be centered on the
skin mesh. Because Emma is already positioned at the world center, this
is easy to do.
6 Make sure the CATParent (named EmmaRig) is selected, and then activate

(Select And Move) on the main toolbar.
7 Right-click the X and Y spinners on the status bar (the small up/down
arrows next to the numeric fields) to set them to 0. Z should already be
at 0.
The skeleton jumps to the world center and is perfectly aligned with the
Emma character mesh.
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Emma and rig, both at world center

Next you’ll apply the bones to the mesh using the Skin modifier.
Set up for skinning:

1 With
(Select Object) on, select the Emma object and from the
Modify panel ➤ Modifier List ➤ Object-Space Modifiers category, choose
Skin.
This applies the Skin modifier to the mesh. The next step is to tell the
Skin modifier which bones are to affect the mesh shape. In this case, it’s
all of them.
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2 On the Parameters rollout, click the Add button next to Bones.
This opens the Select Bones dialog, which is the same as the familiar
Select From Scene dialog.
3 Set the Display filters to Display Geometry only and highlight all list
entries except the first four. One easy way to do this, because all the
desired bones start with “Emma,” is simply to type e in the Find field.
Click Select to finish.

The bones appear in the list on the Parameters rollout and the basic
skinning is done. You can demonstrate this by moving the leg via the
foot platform.
4 Select EmmaRigLPlatform, the wireframe rectangle under the left foot, and
move it around.
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You can probably see some problems already, such as the loss of volume
at the knee. You’ll deal with these in the following sections of the tutorial.
5 Before continuing, save your scene with the name MyEmma1.max.
Animate the rig:
When skinning a character, to work efficiently it’s best to first create a basic
animation containing the various poses that the character is likely to assume.
This lets you adjust skinning anomalies in the different poses without having
to consume time posing and reposing the character manually.
We’ve included an animation file you can load onto the rig using CAT’s Clip
Manager feature. It’s instructive to go through this process, and it doesn’t take
long, but if you prefer to start skinning now, skip to the next section.
1 Continue working from the previous section or load the file you saved
at the end of it.

2

Select the CATParent: the triangular object at the base of the
rig.
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3 Go to the Motion panel
and scroll down to the Clip Manager
rollout. Make sure the Clip button is active.
This is where you load and save animation for CAT rigs.

4 At the bottom of the rollout, click
(Browse), and then use the
Open dialog to open the file \sceneassets\animations\emma_stretching.clp.
When the Clip Options dialog opens, click Load to accept the default
settings.
CAT has two modes: Setup, for modifying the rig, and Animation, for
animating it. Setup is the default mode; to play animation it’s necessary
to switch to Animation mode.

5 At the top of the Layer Manager rollout you can see the
Setup/Animation Mode Toggle button, indicating the rig is currently in
Setup mode. Click this button.

The button image changes to
is active.

, signifying that Animation mode

6 Also, click
in the animation controls section of the 3ds Max window
to open the Time Configuration dialog. Set Length to 500 and click OK
to close the dialog.
7 Activate the EmmaRig selection set, right-click in the viewport, and choose
Hide Selection.

8 Scrub the time slider or
play the animation. It “exercises” all parts
of the body that are likely to need skinning adjustments, starting with
the feet and ending with the fingers.
However, the cap, hair, and eyeballs, or “accessories,” don’t move with
the rest of the mesh.
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9 Return to frame 0, then, on the main toolbar, activate
(Select
And Link), and drag from each accessory to the EmmaRigHead object to

link them as children (four drags in all).
to ensure that everything moves together.

Play the animation again

TIP Alternatively, select the four accessories first, then activate Select And
Link and drag from any of the selected accessories to the EmmaRigHead object.
This links them all at once.

10 Exit Select And Link mode by clicking
(Select Object) and then
right-click in the viewport and choose Unhide All.
11 Save your scene with the name MyEmma2.max.

Weighting the Character's Lower Half
In this portion of the tutorial you learn to improve the skinning by adjusting
the Weight setting for vertices with respect to rig bones, thus determining
how the rig animation affects the character mesh. You start with the lower
half of the character, beginning with the feet.
Set up the lesson:
■

Continue from the previous section or, on the Quick Access toolbar, click

(Open File), navigate to the \character_animation\skinning\ folder,
and open the file configuring_skin.max.
NOTE If a dialog asks whether you want to use the scene's Gamma And LUT
settings, accept the scene Gamma settings, and click OK. If a dialog asks
whether to use the scene's units, accept the scene units, and click OK.
This scene contains the Emma character skinned and animated, with the
correct links already in place and the rig hidden.
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Start skinning the character:
NOTE Much of the information in this procedure and the following one provides
background information on how Skin works. We recommend you read over it
now, but don’t worry if it’s not fully comprehensible. Continue working through
the tutorial, following the steps and reading the explanations, and after you’ve
gained some hands-on experience with adjusting Skin, return here and read these
explanatory sections again. They’ll probably make a lot more sense the second
time around.

1 Scrub the time slider or
play the animation and check for problem
areas. For example, around frame 70 the knees become narrower, and
thus look unnatural. Even more blatant is the distortion of the shoulder
around frame 210.
IMPORTANT Loss of volume, such as the narrowing of the knees when bent,
is the main thing to correct for when adjusting character skinning. A potential
second issue is the interpenetration of the mesh around bent body joints,
but that tends to be less noticeable in the final animation, and can be
accounted for to an extent by attributing it to folds in the character’s clothing.
This tutorial focuses on correcting for volume issues.
2 Return to frame 0.

3 Make sure
(Select Object) is active . Select the Emma object and
go to the Modify panel. On the Parameters rollout, click Edit Envelopes.
The character mesh turns gray except for a color gradient around the
pelvis region. The gradient shows the weighting of the skin vertices
assigned to the pelvis. By default, EmmaRigPelvis is the first entry in the
Bones list on the Parameters rollout, so its values are the first to be
displayed when you turn on Edit Envelopes.
The term “weighting” will be explained shortly.
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TIP The Skin modifier has quite a few parameters spread out among several
rollouts. In some cases you might want to see more settings than can fit
comfortably in a single column. To expand the command panel, position the
mouse cursor over the left edge so it becomes a horizontal, two-headed
arrow, and drag leftward until you see two columns.

Drag the left edge of the command panel to the left to expand it to multiple columns.

4 Try clicking some of the other entries in the list to see the weighting of
vertices in other parts of the skin mesh. Alternatively, click the bone
representations in the viewport; each is displayed as a straight line with
a (non-mesh) vertex at either end. As you do so, the highlighting in the
list on the Parameters rollout switches to that bone.
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Bones appear as straight lines with vertices at
the ends.
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IMPORTANT A bit of background info on how the Skin modifier works is in
order here. When you add bones to Skin, the modifier looks at the mesh to
which it’s applied and automatically assigns each vertex to one or more bones
based on proximity. It also calculates a Weight value for each bone assigned
to a vertex to specify the degree to which moving the bone affects the vertex;
again, this is based on proximity. If a vertex is close to one bone but relatively
distant from any others, it’s assigned to that bone with a weight value of 1.0,
which means 100%. In other words, the vertex responds to movement of
that bone only, and moves in exactly the same direction and distance as the
bone.
If, however, a vertex is, say, equidistant from two bones but far from any
others, Skin assigns both bones to the vertex and gives each a Weight value
of 0.5, or 50%, for that vertex. In such a case, the motion of both bones
contributes equally to that of the vertex. If only one of the bones moves, the
vertex moves half that distance. This is how the Skin modifier accommodates
for the motion of a character mesh around bending joints such as knees and
shoulders.
The Weight values for a highlighted bone appear by default on the mesh as
a gradient, with red representing higher weights, decreasing to orange,
yellow, green, and then blue for the lowest values. Vertices use the same
color scheme, and since you’ll be adjusting weights at the vertex level, it’s
usually best to have the viewport set to Smooth + Highlights + Edged Faces
display mode (toggle with F4) or Wireframe mode (toggle with F3).
Incidentally, the Skin modifier determines which vertices are affected by a
bone or bones by creating an “envelope” around each bone, which is a
capsule-shaped 3D volume that you can edit interactively to adjust the vertex
weighting at a high level. However, you have better control by adjusting
Weight values for individual vertices and groups of vertices. This is a
more-common practice in professional environments such as
game-development studios, so it’s the one this tutorial focuses on. This
method is a bit more painstaking, but can produce optimal results reasonably
quickly.
Make no mistake, however: Skinning a character is a detail-oriented task, and
requires lots of experimentation and trial-and-error, so it benefits from a
liberal supply of patience. This aim of this tutorial is to demonstrate the overall
process, but it’s impractical to describe every step in detail in such a context.
In other words, we can’t show you exactly what to do every step of the way,
but instead provide guidance and examples; the rest is up to you.

5 Save your work under a different filename, such as MyEmma3.max.
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We won’t keep reminding you, but it’s important to remember when
going through a complex method such as skinning a character to save
your work incrementally as you go so you can easily return to a previous
version if things start to go wrong.
Examine some Skin modifier options:
You edit a vertex’s weight by changing its Weight value with respect to a
particular bone. In order to do that, the vertex must be assigned to two or
more bones, because Weight is a relative value. For a given vertex, if its Weight
value with respect to bone A is, for example, 0.6, and its Weight value with
respect to bone B is 0.4, then bone A’s motion has half again as much influence
over the vertex’s motion than does that of bone B. The total of Weight values
for each vertex must always equal 1.0. So, when skinning a character using
this method, you need to know which bone or bones a vertex is assigned to
and the Weight values for all vertex-bone assignments.
NOTE Best practice when skinning a character, which this tutorial follows, is to
focus on one body part at a time. When you're done with that part, mirror the
changes to the other side, as appropriate. To be more specific, you select a bone,
make sure most of the surrounding vertices are set to a Weight value of 1.0, and
then adjust the weights in the bending areas. You can think of this as “blocking
out” the weighting, much as you block out an animation by working on isolated
segments of the character’s movement before integrating the overall motion.
For example, in this tutorial you’ll start with the left leg, working upward from the
foot bone, and then mirror (copy and flip) the vertices’ settings to their counterparts
on the right leg. You can always go back later and tweak the weights anywhere,
but you work most efficiently by concentrating on a specific area at any given
time.
1 Even though you won’t be editing envelopes directly in this tutorial, it
might help you better understand how Skin works by taking a quick look
at this feature of the modifier. By default the envelopes are set not to
display in this scene, but you can enable them by going to the Display
rollout and turning off Show No Envelopes.
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With the forearm bone selected and Show No Envelopes
off, the capsule-shaped inner and outer envelopes appear
in the viewport.

As a very brief explanation, each envelope comprises two concentric
capsule-shaped volumes; vertices within the inner volume are fully
affected by that bone, and then the weighting falls off increasingly for
vertices that lie outside the inner volume and inside the outer volume.
Select some of the different bones to see their envelopes, and then turn
Show No Envelopes back on again.
Using envelopes is a fairly crude, high-level method of setting vertex
weights in Skin, and is suitable mainly for saving time when skinning
fairly simple bone-and-mesh setups.
2 Turn Show No Envelopes back on, as you won’t be using envelopes in
this tutorial.
3 While you have the Display rollout open, take a look at the other options
here.
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Show Colored Faces is on; you’ve already seen its effects.
4 If you turn on Color All Weights, you can see the vertex weighting
throughout the character mesh, not just for the current bone.
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With Color All Weights on, weighting is visible for the entire mesh,
not just the selected bone.

That’s not what we want for this tutorial, so turn it back off.
5 If you turn off Draw On Top ➤ Envelopes, you can no longer see the
bone representations superimposed on the mesh, so keep that one on.
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Disabling envelope display makes it impossible to select
a bone in the viewport.

6 Try the other options if you like, but when you’re done be sure to restore
them to their previous settings, as shown here:
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Begin adjusting vertex weights:
1 Back on the Parameters rollout, turn on Select ➤ Vertices.
This setting is off by default, but it needs to be on for adjusting vertex
weights, so always turn it on before starting a skinning session using the
method described in this tutorial.
The “stretching” animation begins with the feet and moves up the body,
so you’ll follow the same progression in adjusting the skinning.

2

Zoom in on the calves and feet, and make sure the display is set
to Smooth + Highlights + Edged Faces, as shown in the following
illustration.
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3 Scrub back and forth through the first 50 frames or so of the animation.
Notice how the bending of the feet also affects the bottom portion of the
calves. This is not realistic; it happens because the default envelope
assigned by Skin to this bone is a bit too large.
4 Select each of the foot bones in turn: EmmaRigLCalf, EmmaRigLAnkle, and
EmmaRigLToe.

From left to right: calf, ankle, and toe bone selected.
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End with EmmaRigLAnkle selected. The shading (orange, yellow, and blue)
indicates that most of the vertices’ weights for this bone are less than 0.5,
which is undesirable.
5 On the main toolbar, from the Selection Region flyout, choose the Lasso
Selection Region tool.

This is the best tool for region-selecting a contiguous group of vertices
with an arbitrary outline.
6 Drag a region around the foot and ankle vertices, as shown:
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Because the Backface Cull Vertices switch is off, this also selects most of
the vertices facing away from you. Depending on the view angle and
where you drag the region, a few vertices might not be selected. To make

sure all foot and ankle vertices are selected,
orbit around the model
to double-check. Add any vertices you missed to the selection, and remove
any vertices that shouldn’t be selected.
To undo the orbit, press Shift+Z.
TIP To add vertices to a selection, Ctrl+select them, and to remove vertices
from a selection, Alt+select them.
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7 On the Parameters rollout, in the Weight Properties group, set Abs. Effect
to 1.0.
Absolute Effect is the absolute weight setting.
The entire foot turns red, as a visual result of the weight setting change.
This way you know that no other bones can influence these vertices.

758 | Chapter 5 Character-Animation Tutorials

You can confirm that the toe animation no longer affects the foot mesh
by scrubbing the animation. You’ll fix that next.
8 Select the toe bone (EmmaRigLToe).
The foot is gray, indicating no weighting for this bone, but some blue
coloring is evident in the shin, indicating influence that the toe should
not have over this area.
9 Drag a region around the blue vertices (it doesn’t hurt to select too large
an area), and then set Abs. Effect to 0.0.
This removes any remaining leg vertices from the influence of the toe
bone.
Next you’re restore the vertices at the front of the foot to the influence
of the toe bone.
10 Drag a region around the front of the foot, just above the third lace (raised

portion at the top of the shoe). Again,

orbit around the model to
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make sure the selection is correct. To undo the orbit after the selection
is correct, press Shift+Z.

TIP A good way to check quickly whether your selection is correct is to use

(Zoom Extents Selected). For example, if you inadvertently selected
vertices on the other side of the character, the resulting view will be wider
than expected.
11 Set Abs. Effect to 1.0.
The selected vertices and surrounding mesh turn red. Now, when you
scrub the animation, the break between the weighted and unweighted
vertices for the toe bone is readily apparent, as compared to the right
foot. At the greatest amount of bend, around frame 10, the fourth lace
(unweighted) sits directly below the third lace. If you select the ankle
bone, you can see that there’s no transition between the weighting at
the front and the rear of the foot.
The way to resolve this is to create a transition mid-foot by weighting
those vertices between the two bones.

12

Return to frame 0 and then select the vertices for the two
uppermost laces.
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13 Drag upward slowly on the Abs. Effect spinner so you can see the color
change as the vertex weighting increases. Stop when you see a
yellow-orange color, around 0.4.

When you scrub now, the transition looks better. However, the uppermost
lace is too low.
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14 Select the vertices of the uppermost lace, select the ankle bone,
EmmaRigLAnkle, and drag the Abs. Effect spinner gradually upward.
As you do, you see the lace move upward due to the increasing influence
from the ankle bone. Stop around 0.6 or 0.7.
TIP For a useful guide while adjusting clothing vertices, keep in mind the
material of the clothing. For example, the sneakers might be made of canvas,
which is a fairly stiff fabric, so creasing that might not occur with a softer
fabric might be permissible for canvas. Also, with medium-resolution models
like this one, there might not be enough vertices for a fully natural look, so
a certain amount of compromise is necessary.
15 Continue adjusting the lace vertices around the bend until you get a
reasonable-looking effect.
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NOTE Adjusting the laces is a good example of the back-and-forth type of
adjustments required for good skinning. First you make the gross settings for
the front and rear portions of the foot, then you go in and select one lace at
a time and adjust it so it looks good with the rest of the laces in the bend.
16 Next, looking at the bottom of the foot, you might notice a fairly wide
gap between the set of vertices at the bend and those immediately behind
them. Again, select the offending vertices and raise the Abs. Effect spinner
value gradually until the shoe looks more realistic.

TIP In general, when adjusting vertex weights for a skinned character, try to
keep polygon sizes consistent; this allows for minimal distortion when the
character is animated.
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17 Advance to animation to frame 20, where the foot is bent the furthest in
the opposite direction.
There’s a fairly sharp bend at the bottom of the foot, but there’s not much
you can do about it because of the relatively low resolution of the
character mesh. Even if the budget allowed for more polygons in the
mesh, they would probably go into the face, which has higher priority,
so this type of distortion is usually tolerated in commercial applications
such as games.
Weight the rest of the leg:

1

Zoom out and select the ankle bone, EmmaRigLAnkle. Check the
animation that it affects, approximately from frame 30 to 50.
It looks all right, but the ankle influence goes fairly far up the calf, which
is incorrect.

2 Select all of the affected calf vertices. It doesn’t matter if you go too high,
but be sure not to select any of the ankle vertices.
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Wireframe display makes it easier to see the selected vertices, which are outlined
in white.

3 Select the calf bone, EmmaRigLCalf, and set Abs. Effect to 1.0.
This removes the calf vertices from the ankle bone’s influence.
4 Select the loop of vertices at the top of the ankle and set them to 1.0 for
the calf bone as well.
TIP This is a good place to take advantage of the Skin modifier’s loop-selection
tool. Select two adjacent vertices on the loop of edges around the ankle and
then, near the top of the Parameters rollout, click the Loop button. This
automatically selects all the vertices in the same edge loop as the two vertices
you selected.
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Lower than this is where the ankle bends, so you need to weight the
vertices between the ankle and calf bones.
5 Select the next loop down and set the calf weight to 0.5.

This loop is now weighted half for the calf bone and half for the ankle
bone.
6 Next, zoom out, if necessary, so you can see both legs.
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Some vertices on the right leg are influenced by the left calf bone, which
you can easily correct for.
7 Drag a region around the affected vertices in the right leg. Toggle
wireframe display mode and orbit around the model to make sure you
get all of them.
8 Set Abs. Effect for the selected vertices to 0.0.
Similarly, the calf has a bit too much influence over the thigh vertices of
the left leg, which is part of the cause of the loss of volume in the knee
when it bends. You’ll deal with this in a bit, but first take a look at the
thigh.
9 Select the thigh bone: EmmaRigLThigh.
Again, the default volume of influence is too large.
10 Go to frame 0 and select all the vertices on the right side of the mesh
(your left side) and set their weights to 0.0.
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Great precision isn’t necessary here; the main thing is to remove the
right-side vertices from the influence of the left-side bone.
Start using the Weight Tool:
In this section you’ll continue to block out the leg weighting, using the
convenient, powerful Weight Tool dialog.
Given a selection of vertices with the same bone and weight assignments,
Weight Tool lists all bones that affect the vertices along with the corresponding
Weight values. It also lets you edit the Weight value for the current vertex
selection and bone assignment, setting either an absolute Weight value or
adjusting the weights of the vertices relative to their current values. In addition,
Weight Tool provides controls for copying and pasting Weight values and
controls such as Ring and Loop for modifying the vertex selection.
NOTE If you select multiple vertices with different Weight values and bone
assignments, the Weight Tool dialog shows the settings for the vertex with the
lowest sub-object ID. To see settings for more than one vertex at a time, use the
spreadsheet-like Weight Table.

1 Near the bottom of the Parameters rollout, click
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(Weight Tool).

The Weight Tool dialog opens. Drag it to a convenient, out-of-the-way
location. You can keep it open as you work.

2 Select different vertices while keeping on eye on the list at the bottom
of the Weight Tool dialog.
The list shows the selected vertex’s bone assignments and the Weight
value for each assignment. Note that the Weight values always add up
to 1.0. If, for example, you change the Weight value for a particular bone
for a vertex that’s influenced by three different bones, 3ds Max changes
the values for the other two bones in the opposite direction, in proportion
to their current values.
Note also that the Set Weight value doesn’t change; this is a write-only
field.
3 Select all the vertices in the lower half of the knee area, down to the
bottom of the Capri pants.
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4 Make sure the calf bone is highlighted in the Weight Tool list, and then
click the 1 button on the Weight Tool dialog.

This sets the Weight value for all selected vertices to 1.0 with respect to
the calf bone. Note that the weights for the other two bones in the list
are now 0. You can get rid of 0 weights in the entire mesh by clicking
Advanced Parameters rollout ➤ Remove Zero Weights, but thats not
necessary at the moment.
5 Select the thigh vertices above the knee, select the thigh bone, and click
the 1 button on the Weight Tools dialog.
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6 Just to clean things up, select the calf bone in the right leg and any
vertices in the left leg that it influences and set their weights to 0. Do the
same thing for the right thigh bone.
NOTE After you select the right-leg calf or thigh bone and then region-select
the affected left-leg vertices, it’s possible that the bone doesn’t show up in
the Weight Tools dialog list because the selected vertex with the lowest ID
isn’t influenced by that bone, but that’s okay. Just go ahead and click the 0
button on the dialog; 3ds Max still recognizes that you’re setting the weights
for the selected bone.
This goes toward the general philosophy that you work more efficiently
by keeping things as clean as possible as you go, rather than going back
and trying to optimize them later. It’s analogous to the modeling practices
of paying attention to edge flow and making as many polygons as possible
quadrilateral, avoiding triangles or n-gons.
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Fix the knee:
1 Go to frame 40 and adjust the view so you can see both knees.

This is a good before-and-after view. The right knee is “before,” showing
marked volume distortion, while the left knee, after blocking out the
thigh and calf weights, looks more realistic.
However, if you look closely at the back of the left knee when the leg is
bent, it’s apparent that a good deal of fine-tuning remains to be done.
This requires a lot of tweaking, experimentation, and examining the
results, and, again, it’s not practical to give every detail of the process
here. We will, however, give you an example to start you off.
2 Start by selecting the calf bone, if necessary, and then select the uppermost
loops of vertices around the top of the knee. These aren’t technically
loops (they merge and split off), so select them manually, combining
region selection and clicking, rather than with the Loop tool described
preceding.
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3 Go to frame 40, where the leg is bent the most at the knee, and reduce
the weighting gradually until the vertices are better positioned.
TIP One good way to do this is to repeatedly click the – button all the way
to the right of the Set Weight button. Each click subtracts 0.05 from the
current Weight value of each selected vertex. Likewise, each click of the +
button next to it adds 0.05 to the weights.
If you’d like to take a look at the completed, fully skinned model, open
the included file configuring_skin_finished.max. In that file you can example
the weighting for all vertices that we came up with through extended
trial and error.
In general, what we ended up doing was weighting the vertices in the
lower half of the knee mainly to the calf, and, starting halfway up the
knee, giving gradually more weight to the thigh. Some manual tweaking
was required to accommodate for the “wrinkle” vertices at the back of
the knee.
4 As you’re going through and adjusting vertex weights, you’ll probably
encounter bones for which the selected vertex has a 0 weight. To keep
things simple, if you’re not planning to influence that vertex with the
bone, make a practice of clicking the Remove Zero Weights button on
the Advanced Parameters rollout. This affects the entire mesh, and helps
keep things as simple as possible.
Weight the pelvis:
After you finish skinning the left leg, it’s time to move up to the pelvis.
1 Select the pelvis bone: EmmaRigPelvis.

Weighting the Character's Lower Half | 773

Following the practice of blocking out the weighting, the fact that no
red is visible is not a good sign.
2 For the reason why, select the thigh bone and note that it has an
inordinate amount of influence over the pelvic vertices.
3 With the thigh bone still selected, select all vertices between the bottom
of the pelvis (including the top of the side pouch on the pants) to the
top of the belt, inclusive.
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4 Select the pelvis bone and set the Weight value to 1.0.
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5 Scrub the animation and stop around frame 67.

The schism between the weighting of the pelvis and thigh is glaringly
obvious. Fortunately, fixing this is relatively easy.
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6 Go to frame 0 and select the vertices at the crease between the leg and
pelvis, at the front of the body only. Make sure not to select any vertices
on the rear end.

7 Go back to frame 67 or so and then reduce the weighting so the vertices
move up and out of the deep crevasse they were in, giving a more natural
look to the bend.
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Complete the leg and mirror the weights:
In this section you’ll correct the weighting on the vertices in the character’s
rear end, and then quickly fix the weighting on the right side by mirroring
the vertex weights from the left side.
The first thing to fix is some unwanted influence of the first spine bone on
some pelvic vertices.
1 Select the EmmaRigSpine1 bone and note that several vertices in the front
of the pelvis area, on the left side, are highlighted.
The bone also influences vertices on the right side, but because you’ll
mirror all the vertex weights from the left side to the right, that’s not a
concern.
2 Select the highlighted vertices on the left side (don’t worry about selecting
too many) and then click the 0 button on the Weight Tool dialog.
3 Next, select the nine vertices in the lower crease, near the bottom of the
rear end, as shown in the following illustration.

Select the nine vertices on the character’s lower backside.

TIP You can select the vertices by clicking each in turn, holding down Ctrl
after the first one. Another, slightly easier way, is to turn on Backface Cull
Vertices in the Select group on the Parameters rollout, and then region-select
the vertices. Make sure the Weight Tool dialog shows “9 Vertices Selected”
and be sure to turn off Backface Cull Vertices after making the selection.
Currently these vertices are weighted only for the pelvis bone, so you
need to add weighting for the thigh bone.
4 Select the thigh bone, set the vertex weights to 0.5, and adjust from there.
For example, the lowest three vertices on this crease stick out too much,
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so you need to increase the thigh-bone weighting for them compared to
the other six vertices.
5 Continue working on the vertices in the rear end, adjusting them so you
get a realistic, rounded effect, like this:

As before, when in doubt, refer to the finished scene,
configuring_skin_finished.max, for specific guidance.
6 Also adjust the vertices in front, at the crease between the thigh and
pelvis. And while you’re at it, set weights to 0 for any torso vertices
influenced by the thigh bone.
7 When you’ve finished weighting the pelvis vertices, go to the Mirror
Parameters and turn on Mirror Mode.
The bones and vertices now use color coding: blue for the left side and
green for the right. Centered items, which cannot be mirrored, are colored
red.
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A few notes about the Mirror Mode settings:
■

Mirror PlaneThe axis normal of the plane about which the vertex
weights are mirrored. The default setting, which you’ll use for this
tutorial, is X, which means the YZ plane. The plane appears as an
orange wireframe in the viewport.

■

Mirror OffsetThe distance along the X axis to move the mirror plane.
The default value, 0, centers the plane to the character, so for this
tutorial it’s the desired setting.

■

Mirror Thresh(old)The amount of leeway for the detection of
symmetry. If this is too high, mirrored weights might go to the wrong
vertices, but if it’s too low, the Skin modifier won’t be able to detect
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symmetrical bones and vertices. You’ll experiment with this setting
in the next step.
8 Right-click the Mirror Thresh. spinner to set it to 0, so that all the bones
turn red, and then increase it until all the leg bones and arm bones turn
blue and green.
The default value is 0’0.5”, but in our scene we were able to reduce this
to 0’0.19”, which potentially allows for greater accuracy in mirroring
weights. Your results might vary slightly.
To do the actual mirroring, you use the five buttons under the Mirror
Mode button. From left to right, they mirror selected vertices only, all
bones from either side to the other, and all vertices from either side to
the other. For this tutorial, you’ll use Paste Blue To Green Verts, the
button outlined in red in the following illustration:

9 On the Mirror Parameters rollout, click
Verts).

(Paste Blue To Green

All of the weighting you’ve done for each vertex on the left side of the
character has now been copied to the vertices’ counterparts on the right
side, instantly correcting the skinning throughout that side. The left-side
vertices, previously blue, are now yellow to indicate that they’ve been
mirrored:
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10 Exit Mirror Mode by clicking the Mirror Mode button, and then scrub
the animation through the first 100 or so frames.
The animation looks mostly good on both sides of the character’s lower
half. However, there’s a slight problem around frame 80, when the leg
bends back, where the crease between the leg and buttock is a bit too
deep.
11 Select the crease vertices and increase their weights gradually with respect
to the thigh bone until the folding looks better.
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TIP A tool that can potentially help in a situation like this is Blend, which
evens out, or averages, the weighting of selected vertices. First save your
work as a backup, then select the vertices in and around the area of the crease
and then, at a frame where the crease is in effect, click Blend on the Weight
Tool dialog a few times. If it looks better, great. If not, load the saved file and
weight the vertices manually.
When you’re satisfied with the results, mirror the vertices to the other
side.
Another important consideration is the center line of vertices around the
pelvis, which are currently weighted 100% for the pelvis. In reality, these
areas would be pulled around by the movement of the legs, so they need
to be weighted accordingly.

12 Select the three center vertices at the bottom-front of the pelvis, select
the right thigh bone, and click the 1 button on the Weight Tool dialog.
Then select the left thigh bone and click the .5 button. Finally select the
pelvis and gradually increase its weight for the vertices, checking the
animation as you go, until it looks right.
That way you give equal weight to both thigh bones, maintaining that
balance as you then bring the pelvis into the equation.
13 Similarly, weight the vertices on the character’s left side of those center
vertices slightly toward the left thigh bone, and the ones next to those
a little bit further toward the left bone. When everything looks good,
mirror the vertices to the right side.
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Save your work:

➤

Click
(application button), choose Save As, and save the scene
as MyEmma4.max.

Weighting the Character's Upper Half
In this concluding section of the skinning tutorial you weight Emma’s torso,
neck, head, and hands, and learn some finishing-up techniques.
Set up the lesson:
■

Continue from the previous lesson, or, on the Quick Access toolbar, click

(Open File), navigate to the \character_animation\skinning\ folder,
and open the file configuring_skin01.max.
NOTE If a dialog asks whether you want to use the scene's Gamma And LUT
settings, accept the scene Gamma settings, and click OK. If a dialog asks
whether to use the scene's units, accept the scene units, and click OK.
This scene contains the Emma character with the skinning corrected for
the lower half of the character mesh.
Weight the torso:
Next you’ll adjust the weighting for Emma’s upper body. By now, you know
the drill: Look for problem areas, examine the weighting for vertices in those
areas, and adjust accordingly.
1 Start by examining the animation of the torso, roughly between frames
120 and 180.
It mostly looks okay, except for visual artifacts in the lower abs around
frame 149:
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This happens because the four vertices illustrated following are overly
influenced by the first spine bone at the sake of the pelvis bone.
2 To resolve this, go to frame 0 and select the four vertices shown here:

NOTE These vertices should be influenced only by the EmmaRigPelvis and
EmmaRigSpine1 bones. If you find any other bones influencing them, select
each bone and set the weight to 0.
3 Select either bone and set its weight to 0.5.
Now, at frame 149, the artifacts are greatly diminished.
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4 Back at frame 0, select the head bone, EmmaRigHead, and look at the
surrounding vertex weighting.
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Head motion should not affect the chest vertices; this is easy to fix.
5 Select the affected vertices on the front and back of the left side (from
the character’s point of view) of the chest and weight them to 0.0. As
you’ll be mirroring later, you needn’t bother with the ones on the right.

Fix the collarbone:
Currently the collarbone is not being used properly. To best correct that, you
first block out and adjust the arm.
1 Select the left upper-arm bone, EmmaRigLUpperArm, then select the
upper-arm vertices and weight them to 1.0.
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Make sure not to select the vertices at the edge of the shirt.
The forearm has two bones so it can rotate the same way a person’s does.
In Emma the bones are end-to-end rather than side-by-side, as in a real
human skeleton, but the end result is the same.
2 Select each forearm bone in turn and weight the vertices surrounding it
to 1.0. Also select the main hand bone, EmmaRigLPalm, and weight all the
hand vertices at 1.0 to it.
3 Weight the elbow vertices the same way you did the knee. The forearm
should have priority over the upper arm. Again, if you need guidance,
examine the included final scene.

Back to the collarbone: The shoulder is probably the biggest problem
area. For most arm animation, the upper-arm bone controls the skin
adequately, but when the arm is raised, the collarbone needs to come
into play. However, the collarbone currently does not have enough
influence, which results in the type of artifact illustrated here:
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TIP When resolving a problem like this, it helps to have different poses to
work on, as found in the animation in this tutorial. Thus, if you get stuck
trying to fix the skinning in one pose, you can move to a different pose and
do some weighting there. This often helps you find the route to success.
4 Go to frame 210, select the collarbone (EmmaRigLCollarbone), select the
vertices around the shoulder and top of the arm, and click the 1 button
on the Weight Tool dialog.

Left: Shoulder and upper-arm vertices selected
Right: After weighting to 1.0 for the collarbone
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5 Continue working on the arm, evening out the weights and keeping a
reasonably even distance between edge loops. While doing so, you
probably need to assign the uppermost upper-arm vertices partially back
to the upper arm bone, and some lower ones partially to the collarbone.
When you’ve done all you can, go to frame 220, continue working on
the upper arm and shoulder, and likewise at frames 230 and 240.
The following illustration shows four different animation frames with
the weighting completed:

1. Frame 210 with collarbone selected
2. Frame 220 with upper arm bone selected
3. Frame 230 with collarbone selected
4. Frame 240 with upper arm bone selected

790 | Chapter 5 Character-Animation Tutorials

TIP The underarm is not weighted the same as the upper arm. For example,
it’s influenced by the upper-spine and ribcage bones, while the upper arm
is not.
Also, the Copy and Paste functions come in handy for this sort of weighting.
If you find a good balance for a vertex, copy and paste its settings to its
neighbors and then adjust from there.

Weight the head and neck:
If you scrub through the animation section in which the neck moves, between
frames 250 and 320, you can see that the neck bone has too much influence
over vertices outside its usual anatomic domain, such as the collarbone area.
This is most evident on the character’s right side, because you’ve improved
the collarbone’s influence over the upper-chest vertices on the left side. So
the first thing to do is mirror the changes.
1 Select the hair object and hide it so it doesn’t get in the way.
2 Go to a neutral position, such as at frame 265, and select the vertices of
the upper arm, upper chest, and lower neck.

Make sure not to select the vertices on the vertical centerline of the neck.

Weighting the Character's Upper Half | 791

3 On the Mirror Parameters rollout, turn on Mirror Mode and then click

(Mirror Paste).
The selected vertices’ settings are mirrored to the opposite side of the
mesh. Now the distortion is less when bending the neck, but the neck’s
influence still extends beyond its proper volume.
4 Turn off Mirror Mode.
5 Select the neck bone and the colored vertices on the shirt (front and back)
and upper chest and set their weights to 0.0.
6 Select the head bone and remove any influence from the vertices of the
lower neck and upper torso.
TIP You can save time by reweighting only the character’s left side, as you’ll
eventually mirror everything to the right side anyway.
7 With the head bone still selected, select the head and upper-neck vertices
and weight them to 1.0.
Next you’ll weight the three neck loops increasingly (from top to bottom)
for the neck bone.
Start weighting the neck:
1 Select the neck bone, and use the Loop tool to select the uppermost of
the three neck loops. Weight it to 0.25.
2 Select the next loop down and weight its vertices at 0.5 for the neck bone,
so it’s also weighted 0.5 for the head.
3 Select the lowest neck loop (one up from the loop at the base of the neck).
There’s a significant amount of influence here from the top spine bone,
EmmaRigSpine3, which is undesirable.
4 Select EmmaRigSpine3 as well as the vertices in the neck and upper torso
and weight the vertices to 0.0.
5 Again select the lowest neck loop (one up from the one at the base of the
neck), then select the head bone and click the .25 button on the Weight
Tool dialog.
This sets the weighting proportions for this loop at 3 to 1 between the
neck and head.
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6 Select the loop at the bottom of the neck and set it to 1 for the neck bone.
This is just a starting point; then you adjust the side vertices for the
influence of the collarbones.
7 Manually select the bottom vertices on the right side of the neck (all the
way around except for the very front and back) , then select
EmmaRigLCollarbone and click the .5 button on the Weight Tool dialog.
8 Scrub the neck-twisting section of the animation and make sure the
movement looks natural.
9 Select the vertices you’ve just been working on, activate Mirror Mode,

and click

(Mirror Paste).

10 Turn off Mirror Mode.
11 Again, scrub the animation through the neck exercises and verify that
the weighting is good; for example, the collarbone should not move. If
not, tweak the weights as necessary.
Complete the neck:
The vertices in the vertical centerline of the front of the neck need to be
weighted equally to both collarbones. This is important to do because center
vertices are not mirrored.
1 Starting at the base of the neck and going upward, select the first three
vertices in the front centerline.
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These vertices are currently weighted 100% for the neck bone.
2 Select either collarbone, click the 1 button on the Weight Tool dialog,
then select the other collarbone and click the .5 button.
The vertices are now weighted at 50% for each collarbone.
3 Select the neck bone and go to a frame such as 260 where the central
neck vertices are not positioned correctly.
4 On the Weight Tool dialog, click the + button to the right of the Set
Weight button repeatedly (but slowly), adding weight incrementally until
the centerline is in the correct position.

As you do so, 3ds Max subtracts equal amounts of weight from the vertices
with respect to the two collarbones.
As you can see from the included final version, a bit more fine tuning
was required. We ended up with the bottom vertex at 0.6 for the neck
and 0.2 for each collarbone, and the upper two at 0.65 and 0.175
respectively
The three vertices immediately to the character’s left of the centerline
vertices are too far over, so they need to be adjusted.
5 Adjust the three vertices to the character’s left (your right) of the previous
three vertices.
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Again, some fine tuning is required here. We ended up with:
■

Top: 0.15 head, 0.85 neck

■

Middle: 1.0 neck

■

Bottom: 0.65 neck, 0.35 left collarbone.

6 Mirror these three vertices to the other side.
7 Orbit around to the character’s back, scrub the animation, and adjust the
center vertices as necessary.
For example, vertices in the shirt should not be influenced by the head.
If the central vertices in the back of the shirt move in response to head
and neck movement, assign them to the top ribcage bone. Similarly, you
might need to reduce the influence of the collarbone over vertices at the
top edge of the shirt.
A fair amount of fine tuning is required in this area of the character, and
it’s impractical to detail it here, but, as always, when in doubt, check the
results in configuring_skin_finished.max.
8 When you’re done weighting the upper torso, select all the left-side
vertices and use Mirror Mode ➤ Paste Weights to mirror them to the
right side.

9

Save your work.
In the next part you’ll learn how to skin the wrist and hands.
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Skin the hand:
You’ll start with the wrist and then move on and skin a finger.
1 Adjust the view to focus on the character’s left forearm and hand, and
scrub the animation between frames 350 and 380.
Currently the wrist is weighted 100% for the second forearm bone, so
the joint looks unnatural when bent.
2 Select the loop of vertices around the wrist and weight the vertices 50%
between the nearby forearm bone and the wrist bone, as a starting point.

3 Scrub the animation again. If it still doesn’t look right, continue to adjust
the weights of the wrist vertices until it does. Chances are, for this
particular loop, that you’ll need to increase the forearm weighting to
about 0.7.
TIP Sometimes you might want to give the forearm bone a bit of influence
over the vertices on the back of the hand nearest the wrist as well, but in this
case it’s probably not necessary.

Weight the fingers:
1 Scrub the animation through the frames in which the fingers move.
Currently you see only the bones moving, because all of the hand vertices
are weighted for the palm bone.
2 Select all the vertices for one finger. For this example we’ll use the
forefinger.
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3 Select the first bone of that finger; in this case EmmaRigLIndex1. Set it to
100% weighting.
The whole finger now responds to the motion of the first bone.
4 Select the vertices from the loop above the first joint to the end of the
finger, and weight them to the second bone: EmmaRigLIndex2.

5 Repeat the process, weighting the end set of vertices, after the second
joint, to the last bone.
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This is high-level blocking; next you’ll work at a more atomic level.
6 Select the six vertices below each joint and weight them 100% for the
underlying bone; do the same for the six vertices above each joint.

TIP Most likely the best way to select these vertices is one at a time.
Next you’ll weight the joint vertices.
7 Select the eight vertices around each finger joint and weight them to
50% for each neighboring finger bone.
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This allows for an even blend at the finger joints.
TIP If necessary, you can also use the Blend tool to weight the vertices near
each joint’s edge loop.
8 Similarly, weight the knuckle vertices 50% for the palm, and the vertices
just beyond the knuckle, near the top of the finger, at 25% for the palm.

This can vary depending on the animation and the location of the vertex.
The goal is to prevent distortion of faces that get “crushed” when the
finger bends. Aim for results that look like the following illustration:
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9 Do the same for each remaining finger, including the thumb, and then
mirror the results to the opposite side of the mesh.
Save your work:
■

Save the results as MyEmmaFinished.max.
This concludes the basic skinning portion of our program; you can find
the final version in the included file configuring_skin_finished.max. The
remaining section deals with follow-up techniques.

Next
Adjusting the Character Mesh and Rig on page 800

Adjusting the Character Mesh and Rig
In some cases, after you’ve skinned a character, you might need to make
adjustments, either to the character mesh (for example, adding details such
as pockets or increasing mesh resolution for more realistic-looking joints) or
to the rig, such as modifying the structure. This section shows how to recover
from such a situation without having to re-skin the character.
This section also covers using Skin Wrap to transfer a skinning solution to a
similar character with a different mesh resolution.
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Set up the lesson:

■

On the Quick Access toolbar, click
(Open File), navigate to the
\character_animation\skinning\ folder, and open the file
modifications_post_skin.max.
This scene contains the final Emma character with two modifications:
First, a patch has been added to the upper arm of the character mesh:

Second, the thigh bones have been subdivided to lend the rig more
articulation:
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Let the Skin modifier automatically adjust for mesh changes:
You can follow along on the included character or simply use this as a
procedure for your own project.
1 Expose the rig, if necessary, and return to Setup mode by selecting the

CATParent (the triangle under the rig), going to the

panel, and clicking

changes to

Motion

(Animation Mode) so the button image

(Setup mode).

The rig snaps back to its original position.

2 Go to the
Modify panel, select the character mesh, and turn off
the Skin modifier.
3 Go to the Editable Poly level in the modifier stack and make your changes
to the character mesh.
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For example, in the included scene, you could delete the shoulder patch
and use Bridge to replace it with clean quads.

4 Turn the Skin modifier back on and re-enable
for the rig.

(Animation mode)

The Skin modifier weights any new vertices automatically according to
surrounding existing vertices.
5 Scrub through the animation and tweak the auto-generated weighting
as necessary.
Let the Skin modifier automatically adjust for rig changes:
This method uses a special function in the Skin modifier that toggles whether
rig changes affect the character mesh.

1 Go to the
Modify panel, highlight the Skin modifier, and on the
Advanced Parameters rollout, turn off Always Deform.
2 Turn off the Skin modifier and set the rig to Setup mode.
3 Adjust the rig as necessary. For example, you might have been handed a
rig in which the leg bones were not of the same proportions. In this case,
you’d lengthen or shorten a bone in one of the legs.
4 After you finish making changes, select the mesh, turn on Always Deform,
and then turn the Skin modifier back on.
5 Select the CATParent and return to Animation mode.
The rig changes do not cause any unwanted deformation of the character
mesh.
NOTE This method is not foolproof. If, for example, the character is properly
skinned and you drastically change the proportion of the bones in one leg,
that leg’s skinning will probably need adjusting. This is mainly for instances
where the skinning is correct but the rig does not conform to the mesh in
an isolated area.
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Transfer skin to another mesh:
A quick way to transfer a skin map from one character to another that uses
the same rig is with the Skin Wrap modifier. Basically, Skin Wrap uses location
to transfer animation from one object to another. It does not depend on
topological similarities.
IMPORTANT Be sure to perform all the steps in this procedure at frame 0. You
can scrub in between steps to check the animation, but always return to frame 0
before changing settings, applying modifiers, and so on.

1

Open the final version of the Emma scene file
(configuring_skin_finished.max), turn off the Skin modifier, and place the
rig in Setup mode.

2 Open the final version of the Emma scene and use Tools menu ➤ Clone
to copy the mesh to two new objects. Name them Emma_LowRes and
Emma_HighRes. Move them to either side of the original.
3 Select Emma_HighRes, delete the Skin modifier, and apply the MeshSmooth
modifier. On the Parameters rollout, under Separate, turn on Materials
and Smoothing Groups.
This produces a model with about four times the number of vertices.
4 Select Emma_LowRes, delete the Skin modifier, and apply the ProOptimizer
modifier. On the Parameters rollout, click Calculate, and then set Vertex
% to 50.0.
This produces a model with the same look but about half the number of
vertices. It’s suitable for a mobile 3D application or for a character that’s
viewed only from relatively far away.
An important requirement of Skin Wrap is that the objects between which
you’re transferring animation be in close proximity. You’ll start with the
low-resolution model.
5 Move Emma_LowRes to the same location as Emma, which is (0,0,0).
TIP If you previously moved it on the X axis only, just right-click the spinner
to the right of the X field on the status bar.
6 Apply the Skin Wrap modifier to Emma_LowRes. On the Parameters rollout,
click the Add button, press H to open the Pick Object dialog, and select
the Emma object. Right-click to exit Add mode.
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There will probably be a short delay while Skin Wrap performs its
calculations.
7 Right-click in the viewport or click the Add button again to exit Add
mode.

8

Select the Emma object, turn on the Skin modifier again, set the
rig back to Animation mode, and hide the object and rig.

9

Play the animation. It plays back perfectly.
The process is the same with Emma_HighRes, except that applying Skin
Wrap takes longer because of the greater complexity of the mesh.

Save your work:
■

Save the file under a new file name.

Summary
You covered quite a bit of ground in this tutorial. You learned how to fit a
complex character mesh to an animated rig, how to adjust for edits to the
mesh and rig, and how to transfer the skinning data to a character with a
markedly different resolution. The main work in skinning a character is to
make sure the vertices at bend points are properly weighted among the bones
that influence the motion. This requires patience and attention to detail. But
the result, in obtaining a realistically animated virtual person or other
character, is well worth it!

Learning Biped
These tutorials introduce you to the fundamentals of character animation
using the 3ds Max Biped and Physique components. You will learn how to
create and control a virtual skeleton, which will drive the motion of your
character.
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Features Covered in This Section
■

Adjusting your biped with Figure Mode.

■

Applying Physique.

■

Creating a walk cycle using footsteps.

■

Creating and editing a generated walk cycle using footsteps.

■

Setting keys in freeform mode.

■

Combining animation clips to create an animated sequence.

■

Animating multi-legged creatures.
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Biped Quickstart
This tutorial introduces you to the elements of the 3ds Max character studio
feature and the workflow for some of its most important components.

In this tutorial, you will learn how to:
■

Create and pose a biped.

■

Associate the biped with a mesh using the Physique modifier.

■

Animate the biped using two different methods, freeform and footstep
animation.

■

Combine motions in the Motion Mixer.

Skill level: Beginner
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Time to complete: 1 hour

Creating a Biped
In this lesson, you'll create a default biped: a simple skeleton consisting of
bones connected in a hierarchy. A default biped is different from 3ds Max
Bone system objects because the biped structure automatically has built-in
joints like a human being. You can bend your knee so your foot touches the
back of your thigh, but you can’t bend it forward so that your toe touches the
front of your thigh. Biped creates skeletons in the same fashion. They are
ready to animate, and work accurately without additional setup .
Set up the lesson:
■

Reset 3ds Max.

Create a biped:

1 On the

Create panel, click

2 On the Object Type rollout, click

(Systems).
(Biped).

The Biped button highlights.
3 If you can’t see the Height spinner in the Create Biped rollout, scroll to
the bottom of the command panel.
4 In the Perspective viewport, place your cursor over the center of the grid,
press and hold the left mouse button, and drag upward.
A biped appears and grows with your cursor movement.
5 Drag upward until the Height spinner on the Create Biped rollout reads
approximately 70 units, then release the mouse button.
A biped is created in the viewport.
The biped is a hierarchy of special objects. Its parent object (Bip01) is its
center of mass (COM). The COM is displayed in the viewports as a small,
blue tetrahedron, initially centered in the biped’s pelvis. After you create
a biped, only the center of mass object is selected (not the entire biped).
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Name the biped:
When you create your first biped, it has a root name of Bip01. The root name
of each additional biped is incremented, so the next biped you create has a
root name of Bip02. The root name acts as a prefix for each part of the biped,
to make it unique from any other bipeds in the scene.
1 In the Create Biped rollout, highlight the current root name entry, Bip01,
in the Root Name field.

NOTE You can also change the biped root name from the Motion Panel if
you expand the Biped rollout.

2 Enter the new root name, MyBiped.
Renaming the biped's root name to the name of the character is common
practice and helps with scene organization.

3 On the Quick Access toolbar, click
as MyBiped.max.

(Save File), and save the scene
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Posing a Biped
Once you've created a biped, you need to pose it to match the character model
that the biped will control. This is done in Figure mode, which allows you to
bend, rotate, and scale parts of the biped to conform to the character mesh.
In this lesson, you will adjust a biped to fit a character mesh.
Character meshes are usually built in one of two stances. The most common
is with the arms out and the legs slightly spread, like da Vinci's drawing of
the Vitruvian Man. Or, the character mesh is built in a resting position with
arms at its sides and legs together.
For this lesson, you'll be working with a character named Dr. X.

Left: Dr. X exhibiting the Vitruvian Man stance; right: a resting position.

Set up the lesson:
1 Reset 3ds Max.

2 On the Quick Access toolbar, click
(Open File), navigate to the
\character_animation\quick_start folder, and open dr_x_01.max.
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NOTE If a dialog asks whether you want to use the scene’s Gamma And LUT
settings, accept the scene Gamma settings, and click OK. If a dialog asks
whether to use the scene’s units, accept the scene units, and click OK.
This scene contains a character mesh named DoctorX.
Build the biped:
Now that you know how to create a biped, you're going to use the character
mesh as a template for building the biped that will control Dr. X.

1 On the

Create panel, click

(Systems).

2 Turn on
(Biped) and make sure you can see the Height
spinner in the Create Biped rollout.
3 In the Front viewport, click down at Dr. X's feet and drag up until the
biped is about 1.0m in height
This will place the center of mass (COM) roughly at Dr. X's pelvis.

The new biped and Dr. X.
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4 In the Create Biped rollout, change the Root Name to Dr. X.
NOTE When you change the name on the Create Biped rollout, the name
is used as a prefix for all the biped’s component parts; for example, Dr. X L
Foot. If you use the usual Name And Color rollout, only the name of the
biped’s COM is changed; all other parts remain prefixed with Biped01 (or
whatever the current sequence number is).

Position the biped:
Once the biped is added to the character mesh, you need to adjust the biped
to better match the stance of the mesh. First, you'll adjust the position of the
biped within the Dr. X model.

1 Click the

Motion panel tab.

2 In the Biped rollout, turn on

(Figure Mode).

All changes to the biped's reference pose must be done in Figure mode.

3 In the Left and Front viewports, click
in around the pelvis of Dr. X.

(Zoom Region), and zoom

The illustrations show the COM in white and arrows pointing at the
center line of the mesh.

Zoom into Left viewport
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Zoom into Front viewport

4 In the Track Selection Rollout, make sure
is turned on.

5

(Body Horizontal) button

Move Dr.X, the COM, in both the Left and Front viewports so
that it lines up with the vertical center line of the character mesh.

Bip01 moved in the Left viewport
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Bip01 moved in the Front viewport

Adjust the legs:
Next, you'll adjust the legs so they conform with those of the character. When
adjusting legs, you'll want to pay close attention to the key bend points at the
knees and ankles.
1 Activate the Front viewport. Maximize the viewport by pressing Alt+W,

then click

2

(Zoom Extents).

Select the biped's left thigh, Dr.X L Thigh. This is colored blue by
default, and its name appears in the name field at the top of the Motion
panel when selected.

TIP If you select the mesh by mistake, deselect by clicking outside the figures,
and then try again.
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3 From the Track Selection rollout, click

(Symmetrical).

The biped's right thigh, Dr.X R Thigh is now added to the selection set.

4 In this step, you rotate the biped's legs to run roughly along the legs of
the mesh. To make these rotations, you'll have to switch between the
Front and Left viewports. Press F and L on the keyboard to make these
switches.

Click
■

(Select And Rotate) and make the following rotations:

In the Front viewport, rotate about 12.0 degrees about the Z axis. A
readout appears in yellow as you rotate the selection.
TIP Sometimes the legs will rotate in parallel, instead of in opposite
directions. If this happens to you, select and rotate each leg individually.
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■

In the Left viewport, rotate about –8 degrees about the Z-axis.
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5 On the main toolbar, choose
(Select And Non-Uniform Scale).
Scale the thighs along the X-axis until they match the skin model: about
85 percent. Type in the value or use the spinners while viewing the results
in the viewport.

6 Press the Page Down key on the keyboard.
Page Up and Page Down are shortcuts for moving up and down the
hierarchy. Since both thighs were selected, now both calves are selected
after you press Page Down.
7 As you did with the thighs, scale the calves until they match the mesh:
about 90 percent along the X axis.
This aligns the biped's ankles more closely with the ankles of the character
mesh.
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The Left view of the scaled thighs and calves.

8 Press Page Down again to select the biped feet. Scale the feet from the
Front and Left views to more closely fit in the shoes.
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9 On the Structure rollout, adjust the Ankle attach value to slide the foot
to better fit in the mesh: about 0.1.
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10 In the Front viewport, rotate the feet so they align with the mesh.
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Rotate the feet to fit the mesh.

11 Save the scene as my_drx01.max.
The procedures you've just completed give you an idea of what it takes to
align a biped to a mesh, and that patience is the key to this process. This
character still needs work: the feet as well as the entire upper body must be
adjusted. If you want, read the following tips for biped alignment, then use
the same procedures to experiment with aligning the rest of the biped.
Otherwise, continue to the next lesson.

Tips for Biped Alignment
Here are some tips that may help when adding a biped to a character mesh.
■

The most important tip is to make sure the COM is always aligned with
the mesh.
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■

When scaling and rotating biped parts, pay attention to the model in
multiple viewports. A rotation, for instance, may look good in one viewport,
but another viewport may indicate a problem.

■

Examine the character mesh's complexity. If the character is wearing
mittens or shoes, you probably don't need five fingers and toes. Adjust the
biped structure accordingly.

■

Remember ponytails. If the character has a lot of hair or a long nose, like
an elephant trunk, you can use a ponytail to control that part of the mesh.

■

If the character mesh has a short torso or long neck, it may be best to
reduce the number of Spine Links or increase the number of Neck Links.
You can add up to 25 links in the neck, tail or ponytails, and up to ten
links in the spine.

■

If the character is carrying something like a weapon or tool, add a Prop to
control that object.

Applying Physique
After the biped is posed to match the character mesh, you apply the Physique
modifier to the character mesh. The Physique modifier associates the biped
with the character mesh.
After Physique is applied and set up, any animation on the biped is passed on
to the mesh, making it move as if there were bones and muscles underneath.
Set up the lesson:

1 On the Quick Access toolbar, click
(Open File), navigate to the
\character_animation\quick_start folder, and open dr_x_02.max.
This scene contains Dr. X and a completely posed biped.
2 In the Front viewport, zoom in on the biped's pelvis (orange triangle)
and the center of mass, or COM (blue tetrahedron).
Apply Physique:
1 Select the character mesh, DoctorX.
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2 On the

Modify panel, choose Physique from the Modifier List.

The Physique rollouts appear in the command panel.

3 In the Physique rollout, click
biped's COM.

(Attach To Node), then click the

The Physique Initialization dialog displays.
4 Click Initialize.
The character mesh is now associated with the biped. The orange
deformation spline running through the mesh indicates that the entire
biped structure has been associated with the mesh.

Orange spline follows Dr. X mesh. (This view uses
See-Through display mode with the biped bones
hidden.)

TIP To toggle the view to See–Through display mode, select the DoctorX
mesh and press Alt+X.
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Adjust the envelopes:
Physique associates the biped with the mesh by means of the mesh's vertices.
Each biped part is surrounded by an area called an envelope, and mesh vertices
that lie inside an envelope are effected by that biped part. The default size of
an envelope depends on the size of the biped part, which you set when you
pose the biped.
Often, envelopes must be manually adjusted to make the biped work properly
with the mesh. If you notice irregular spikes poking out from the mesh, it's a
good indication that one or more vertices lie outside of an envelope's area of
influence. You can see this effect by rotating the arm.

1 Right-click the Top viewport to activate it and use
to view Dr. X’s left arm.

2 Select DrX Biped L Forearm, and

rotate it up and down.

Some vertices don't move with the arm.
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(Region Zoom)

Vertices that are not influenced by the envelope pull out of shape.

3 Press Ctrl+Z to put the arm back to its original position so you can adjust
the envelope.
4 Select the DoctorX mesh again and in the modifier stack, click the plus
(+) symbol next to Physique and highlight the Envelope sub-object.
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The orange splines running through the biped have turned yellow. These
are deformation splines, which deform the mesh as the spline moves.
5 Select the deformation spline running along the biped's left forearm to
display the associated envelopes.
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Notice that each biped part has two envelopes, an inner one (red) and
an outer one (purple). Some of the vertices near the opening of the glove
are outside the outer envelope boundary. These vertices won't be affected
at all by the biped's lower arm unless the envelope is enlarged.
6 In the Blending Envelopes rollout, in the Envelope Parameters group,
increase the Radial Scale parameter to 2.0.
The vertices at the opening of Dr. X's glove are now within the envelope.

The dark outer envelope completely encompasses the lower arm.

Many more small adjustments are needed to make all the envelopes fit
the mesh correctly. In the next lesson, you'll load a file that has a mesh
with envelopes that are properly adjusted.
NOTE Keep in mind that the default envelopes are based on the size of the
biped bones. Therefore, if you adjust the envelopes of a character that uses
the Classic biped body type, and later change to the Skeleton body type, the
envelopes are going to be much smaller and will require more editing.
When you have finished adjusting envelopes, you can apply a
MeshSmooth modifier to the mesh above the Physique modifier to make
the mesh look smoother.
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7 Apply the MeshSmooth modifier to the mesh above the Physique
modifier, and make sure that its Iterations value is set to 1.
When MeshSmooth is placed above Physique on the stack, you only need
to adjust envelopes for the low-poly version of the model. The Physique
settings are passed up the stack to the MeshSmooth modifier.
8 Save your work as my_drx02.max.

Animating the Biped with Freeform Animation
There are two types of animation that a biped can perform: Freeform animation
and Footstep animation. In this lesson, you'll use Freeform animation to make
Dr. X do a series of deep knee bends. Freeform animation does not use
footsteps. You manually set all the keys in a Freeform animation.
To get an idea of how your animation should turn out, view the preview
animation, dr_x_kneebends.avi, in the folder \sceneassets\renderassets\.

Dr. X doing his deep knee bend exercises.
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Set up the lesson:

1

Open dr_x_03.max.
This scene contains Dr. X with properly adjusted envelopes.

2 Press the H key and choose DrX Biped L Foot from the object list.
Plant the feet:
Since Dr. X is doing squats, his feet are not required to move. You'll plant his
feet to keep them from moving throughout the exercise.

1 Go to the

Motion panel.

2 Expand the Key Info rollout, and expand the IK expansion bar.
The left foot is selected, so you can set a key for it.

3 the Key Info rollout, click

(Set Planted Key).
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4 In the Track Selection rollout, click
R Foot.

5 Click

(Opposite) to select DrX Biped

(Set Planted Key) to set a key for the right foot.

Animate the first knee bend:
You'll start by animating the knee-bending motion. Dr. X will start the knee
bend in his current stance with arms outstretched, and perform a total of four
squats. When completed, he'll return to his original stance.
When the feet are planted, you animate the knees bending by moving the
biped's center of mass up and down.
1 Make sure the time slider is at frame 0.

2 In the Track Selection rollout, click

(Body Vertical).

This selects the center of mass’s body vertical track.

3 Turn on

(Auto Key).

4 Move the center of mass (COM) downward slightly to make the character's
knees bend a little bit.
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This places a key for the center of mass's body vertical track at frame 0.
5 Right-click the Front viewport to activate it, and drag the time slider to
frame 15.

6

Move the COM down about –0.25m on the Z-axis.
Watch the Coordinate display Z-field until it reaches about –0.25m and
release the mouse button. A key is automatically created at frame 15. This
is Dr. X's squatted pose.
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7 Scrub (drag) the time slider to see Dr. X bend his knees once.
Copy and paste the standing posture:
1 Drag the time slider to frame 0.
2 Expand the Copy/Paste rollout.
The tools on this rollout enable you to quickly copy and paste keys from
one frame to other frames. By default, the Posture option is selected. This
option pastes keys from individual body parts.

3 In the Copy/Paste rollout, click
Collection Dr. X poses.

4 Click

(Create Collections). Name the

(Copy Posture).

5 In the Copied Postures field, rename the posture Standing.
6 Drag the time slider to frame 30.

7 Make sure

(Auto Key) is still on.
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8 On the Copy/Paste rollout, paste options group, click
Vertical).

9 Click

(Paste

(Paste Posture).

Dr. X stands up again. When you paste a posture with Auto Key turned
on, a key is created at the current frame with the new posture. Here, a
new key was created for the COM's Body Vertical track at frame 30.
Copy and paste the squatting posture:
1 Go to frame 15.

2 On the Copy/Paste rollout, click
posture Squatting.

3 Go to frame 45, and click

(Copy Posture). Rename the

(Paste Posture).

Paste the remaining postures:
Now that you've stored the two postures, you can easily paste them to other
frames.
1 Go to frame 60. Choose the Standing posture from the Copied Postures
list, and click Paste Posture.
2 Go to frame 75. Choose the Squatting posture from the Copied Postures
list, and click Paste Posture.
3 On frame 90, paste the Standing posture.
4 On frame 105, paste the Squatting posture.
5 On frame 120, paste the Standing posture.
You have now created all the knee-bend motions for this animation. If
you like, you can play the animation to see the motion.

6 Turn off

(Auto Key).
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7 Save the scene as MyDrX02.max.
Animate the arms:
Now that the legs are set to bend, you'll rotate the arms and lock the upper
body. As Dr. X dips down, his arms are going to swing forward, then back out
to his sides as he rises. You'll also set two keys to lock the upper body to keep
Dr. X facing forward.
1 Press the H key and choose DrX Biped L UpperArm.

2 On the Track Selection rollout, click
opposite upper arm.

(Symmetrical) to select the

3 Drag the time slider to frame 0.

4 On the Key Info rollout, click

(Set Key).

This sets a key for the arms in their outstretched position.
WARNING Be sure to use the Set Key button on the Key Info rollout, not
the Set Key text button under Auto Key.

5 On the Copy/Paste rollout, click
Arms Out.

(Copy Posture). Name the posture

6 Drag the time slider to frame 15.

7 Turn on

8 In the Top viewport,
the Z-axis.

(Auto Key).

rotate the arms about –75 degrees around

Look at the Z-field in the Coordinate display Z-field when rotating the
arms. A key is added, and Dr. X's arms are in the forward position.
TIP Sometimes the arms will rotate in parallel, instead of in opposite
directions. If this happens to you, select and rotate each arm individually.
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9 On the Copy/Paste rollout, click Copy Posture, and name the posture
Arms Forward.
10 Paste the copied postures to set keys for the arms on these frames:
■

Frame 30: Arms Out

■

Frame 45: Arms Forward

■

Frame 60: Arms Out

■

Frame 75: Arms Forward

■

Frame 90: Arms Out

■

Frame 105: Arms Forward

■

Frame 120: Arms Out

11 Turn off

(Auto Key).

Biped Quickstart | 835

Play the animation:
1 Select all the parts of the biped, and right-click and choose Hide Selection.

2 Select the mesh. On the
Modify panel, turn on the MeshSmooth
modifier by clicking the light bulb to turn it on.

3

Play the animation.

Stop the animation when you are done watching playback.
4 Save the scene as my_drx03_freeform.max.
Save a motion clip:
When you're happy with the results of the animation, you want to save it so
that in the future you can apply the motion to other bipeds in other scenes.
When you save a motion, it is saved in the .bip file format, the native format
for biped character movement.
1 Right-click a viewport and choose Unhide All.
2 Select any part of the biped.

3 On the Biped rollout, click

(Save File).

3ds Max displays the Save File dialog.
4 Specify a folder where you are storing your motion files, such as a new
\character_animation\motions folder.
5 Type my_kneebends as the file name and click Save.
The motion is saved as a BIP file.
To learn more about freeform animation, see the tutorial Freeform
Animation on page 907.
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Animating the Biped with Footsteps
Now that you're familiar with freeform animation, you'll learn the basics of
footstep animation. Footstep animation only controls the placement of the
biped's feet. In this lesson, you'll create a footstep animation where Dr. X
walks for eight steps.
You can see what your animation should look like by viewing the preview
animation, dr_x_walk.avi, in the folder \sceneassets\renderassets\.

Set up the lesson:

1 Once again,
open dr_x_03.max in the
\character_animation\quick_start folder.
This scene contains Dr. X with Physique applied to the mesh, and all
envelopes adjusted. The mesh is ready for animation.
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2 Press the H key and choose DoctorX from the object list.
3 In the Perspective viewport, right-click the mesh and choose Hide
Selection from the quad menu.
Hiding the mesh makes it easier to select the biped and test the animation.
This is especially true if you have a highly detailed mesh.

838 | Chapter 5 Character-Animation Tutorials

4 Press the H key again and choose DrX Biped, the center of mass.
Create the footsteps:
Now you'll make Dr. X walk forward in a straight line.

1 Go to the

Motion panel.

2 On the Biped rollout, turn on

(Footstep Mode).

Using the rollouts that now display, you'll create footsteps for Dr. X.

3 On the Footstep Creation rollout, click

(Create Multiple Footsteps).

3ds Max opens the Create Multiple Footsteps: Walk dialog.
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4 In the General group, increase the Number Of Footsteps to 8, then click
OK.

5 On the Footstep Operations rollout, click
Footsteps).
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(Create Keys For Inactive

When the footstep keys are created, Dr. X changes his pose.

6 Click
(Play Animation). You can also scrub the time slider to
examine the animation more closely.
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By just watching the biped walk, you can tell that Dr. X's walk doesn't
look right. You can see that the feet are too close together, and his arms
are straight down at his side. In addition, the shoes and hands will collide
or intersect with other body parts when the mesh is displayed again.
Next, you'll do some fine tuning to make Dr. X's walk look better.
Fine-tune the animation:
In this part of the lesson, you'll make a few adjustments to clean up the
animation.
1 If you don't see footsteps outlined in front of Dr. X, do the following:
■

On the Biped rollout, click the gray expansion bar below the buttons.
Additional buttons appear.

■

In the Display group, click
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(Show Footsteps And Numbers).

NOTE
If the footsteps still fail to display, click the Show Footsteps
And Numbers button and hold until you see the button flyout. Choose
the Show Footsteps And Numbers button from the flyout.
2 In the Perspective viewport, zoom out, if necessary, to see all the footsteps.
Drag a selection window around all the footsteps. Be sure to include the
two footsteps under the biped's feet.
The footsteps turn white after they're selected.
NOTE Because you're working in Footstep mode, only the footsteps can be
selected, so you can drag over the biped without fear of selecting other
objects.
3 On the Footstep Operations rollout, turn off Length and increase the
Scale to 2.5.

The biped's stance widens to more closely match how it looked in Figure
mode. However, now that the stance is wider, the hands will intersect
the legs when the mesh is unhidden. You'll fix that next.
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Rotate the arms:
With the wider stance, the hands intersect the legs as they swing past. Now
you'll do a little freeform animation to give the arms some clearance.

1 On the Biped rollout, turn off

(Footstep Mode).

Now you can rotate Dr. X's arms.
2 Press the H key and select DrX Biped L Upperarm.

3 In the Track Selection rollout, click

(Symmetrical).

Notice the keys in the time line. At each of the keys, you'll rotate the
arms.

4 Turn on
(Auto Key) and
click the right arrow on the time slider.

(Key Mode Toggle), then

The time slider jumps to frame 30.

5 On the main toolbar, click

(Select And Rotate).

6 On the Coordinate display, in the Y field, enter 12.
The arms are rotated out away from the body.
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TIP Sometimes the arms will rotate in parallel, instead of in opposite
directions. If this happens to you, select and rotate each arm individually.
7 Continue clicking the right arrow on the time slider to jump to the next
key and repeat the same amount of rotation for each key on the time
line.
Don't forget the key at frame 0.

8 Turn off

9

(Auto Key) to end the animation process.

Play the animation.
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Save the motion in a BIP file:
You can save the footstep motion for later use in other scenes.

1 On the Biped rollout, click

(Save File).

The Save File dialog displays.
2 Specify a folder where you are storing your motion files, such as a new
\character_animation\motions folder.
3 Type my_DrXWalk as the file name, and click Save.
The footstep motion is saved in the BIP file.
Prepare for playing or rendering:

1 Press the H key. In the Select From Scene dialog, click
then click OK.
2 Right-click the biped and choose Hide Selection.
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(Select All),

The biped is now hidden.
3 Right-click again, and choose Unhide By Name from the quad menu.
The Unhide Objects dialog displays.
4 Select DoctorX from the list and click Unhide.
Dr. X's mesh is unhidden.
5 Click the mesh to select it.

6 On the
Modify panel, make sure the MeshSmooth modifier is
turned on (the light bulb icon should be white).

7 Click the Perspective viewport and then click

(Play Animation).

8 Save the scene as my_drx03_footsteps.max.
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Combining Motions with the Motion Mixer
In this lesson, you'll use the Motion Mixer with the two motion files you've
just created. The Motion Mixer lets you create a smooth transition between
Dr. X doing his deep knee bends and walking.
Set up for this lesson:

■

Once again,
open dr_x_03.max in the folder
\character_animation\quick_start\.
This scene contains Dr. X ready for animation.

Open the Motion Mixer:
The Motion Mixer is like a sound mixer, except here you work with animation
files instead of audio files. You'll add motion clips, which are .bip files, to the
Motion Mixer, and create transitions between the clips to blend them smoothly
together.
1 Select any part of the biped.

2 Go to the

Motion panel.
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3 On the Biped rollout, turn off

(Figure Mode) if it is on.

4 On the Biped Apps rollout, click

(Mixer).

3ds Max opens the Motion Mixer window.

The biped is automatically displayed in the Mixer. It has a default
trackgroup labelled All, where you will start laying out your tracks, motion
clips, and transitions. The label All indicates that motions placed on
tracks will apply to the entire biped, rather than specific body parts.
TIP The Motion Mixer window can be resized. For better viewing of what's
added to the Mixer, you can drag the edge of the window vertically and
horizontally.
Opening the Motion Mixer also automatically turns on the Mixer Mode
button on the Biped rollout.

When Mixer Mode is on, the biped performs the motions in the Motion
Mixer.

Biped Quickstart | 849

Add the clips to the Mixer:
Trackgroups are populated by tracks, in the form of Layer tracks or Transition
tracks. On each track, you add clips and transitions. The final product of your
efforts is called a mix.
Here, you'll add two clips to the trackgroup with a transition between them.
1 Click the topmost track on the All trackgroup to select it. The track turns
a lighter gray color when selected.

By default, the topmost track is a layer track, which is designed for
consecutive clips with no transitions between them. You want to create
a transition between two clips, so you'll need a transition track.
2 On the Mixer menu bar, open the Tracks menu and choose Convert To
Transition Track.
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The track is changed to a transition track that is taller than the original,
with room for two tracks and a transition.
TIP You can right-click the track to access the same menu options.
3 From the Tracks menu, choose New Clips ➤ From Files.

3ds Max displays the Open dialog.
4 If you've done the two previous lessons and want to use the motions you
created, browse to the folder where you saved your motions, and choose
my_kneebends.bip. Otherwise, browse to the folder \sceneassets\animations\
folder and choose kneebends.bip.
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The clip holding the knee-bend motion is added to the track.
5 Right-click a blank area of the transition track, and choose New Clips ➤
From Files from the pop-up menu. Choose the file my_drxwalk.bip or
dr_x_walk.bip.
The second clip is added to the track, and a transition is automatically
added between the two clips. The transition is colored with a darker
version of the clip color, and spans the transition time between the two
clips.

6 On the Motion Mixer toolbar, click
see the entire mix in the display.
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(Zoom Extents) so you can

7 On the Motion Mixer toolbar, click

(Set Range).

This feature automatically sets the length of the animation to the number
of frames needed for the mix. In this case, it sets the animation length
to 225 frames.
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Play the mix:
You've just created a basic mix comprised of two clips and a transition. Now
you'll play the animation.

1 On the Biped rollout, turn on
on.

(Mixer Mode) if it’s not already

2 Click
(Play Animation). Watch the animation in the viewport
and its progress in the Mixer window.
Dr. X does his knee bends in the first clip.

He smoothly transitions to walking in the second clip.
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The feet slide a little during the transition. This problem can be fixed
with the Mixer, but that's beyond the scope of this tutorial.
3 Save the scene as my_drx03_mixer.max.
TIP If you want to render this animation, hide the biped, select the mesh,
and turn on the MeshSmooth modifier on the Modify panel before rendering.

Summary
This tutorial introduced you to some of the essential components of character
studio: creating a Biped system, using the Physique modifier to skin the Biped,
animating the Biped in both freeform and footstep modes, and using the
Motion Mixer to combine animated clips that have already been created.

Animating with Footsteps
Footstep mode uses a unique footstep gizmo to control the contact of the foot
with the ground. When you move a footstep gizmo to a new location, the
animation updates to match the move.
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In this tutorial, you will learn how to:
■

Animate a biped using footsteps.

■

Make a biped walk, run, jump, and follow uneven terrain.

■

Change the duration of a footstep animation using IK keys.

Skill level: Beginner
Time to complete: 1+ hours

Creating a Distinctive Walk
In this lesson, using automatically created motion as the basis, you’ll animate
a biped walking with a rolling, springy step.
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The automatic footsteps generate a starting point for you. You’ll then change
the automatic walk into something more expressive and distinctive. This
sophisticated yet simple approach results in a natural-looking motion that
you can create quickly.
Set up the lesson:
1 Reset 3ds Max.

2 On the Quick Access toolbar, click
(Open File), navigate to the
\character_animation\footstep_animation folder, and open walk_start.max.
NOTE If a dialog asks whether you want to use the scene’s Gamma And LUT
settings, accept the scene Gamma settings, and click OK. If a dialog asks
whether to use the scene’s units, accept the scene units, and click OK.
In this file, a biped is standing near the origin.
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Biped near origin of grid.

3 Switch to Local coordinates, if they are not already active.

4 Maximize the Perspective viewport by pressing Alt+W.
5 Click any part of the biped to select it.
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A white box outlines the selected body part.

6 Go to the

Motion panel.

The Biped controls are displayed.
Next you’ll turn on Footstep Mode. If Figure Mode was on, it turns off
automatically.
Create multiple footsteps:

1 On the
Motion panel ➤ Biped rollout, turn on
(Footstep Mode).

2 On the Footstep Creation rollout, click

(Create Multiple Footsteps).

3 In the Create Multiple Footsteps: Walk dialog ➤ General group, change
Number Of Footsteps to 8, then click OK.
Footprints are displayed in white in the viewport. These are inactive
footsteps. They do not yet control any animation for the biped. If you
click the Play Animation button, the biped won't move.
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Inactive footsteps

4 In the Footstep Operations rollout, click
Footsteps).

(Create Keys For Inactive

The footsteps are activated. Animation keys are created for the biped.

5

Play the animation.
The biped walks.
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The biped takes a step.
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The biped takes another step.
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The biped keeps on walking.

6 On the Biped rollout, turn off the Footstep Mode button.
Notice that the first footstep is numbered 0, and the last footstep is
numbered 7.

7 In the Track Selection Rollout, click
(Body Horizontal), if is not
already turned on. This selects the horizontal position track for the center
of mass (COM) object.
The track bar displays keys for the length of the animation.

Body Horizontal keys

8

Play the animation.
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The biped walks, but without much character.
In the following procedures, you'll begin individualizing the motion by
adjusting the keys for the Body Horizontal, Vertical, and Rotation tracks.
You'll exaggerate the rotation of the center of mass to create a more
energetic walk.
Adjust body rotation keys:

1 In the Perspective viewport, click
(the front face of the
ViewCube) to shift the view so that the biped is walking toward you.
Then drag the time slider to frame 0.

Be sure that a part of the biped is still selected. In the Track Selection

rollout, click

(Body Rotation).
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2 Right-click the track bar, and from the pop-up menu choose Filter ➤
Current Transform.
Now the track bar displays the rotation keys.

3 On the 3ds Max status bar, click
turn it on.

(Key Mode Toggle) button to

Key mode lets you use Previous and Next Key buttons to jump between
keyframes for the selected object. You can also use the < and > keys on
the keyboard to move between keyframes without clicking the mouse.
4 Press > on the keyboard to advance the time slider to frame 24.
5 Use the Transform gizmo to adjust the body rotation. Move your cursor
over the gizmo; when the circle turns yellow and the X in the center
turns red, click and drag to rotate. If you can't see the X, zoom into the
viewport. Rotate 5 to 10 degrees about the X axis to move the hips down
toward the leg that is in motion. When you rotate, one foot will cross
the other.
TIP The rotation is displayed in yellow text above the Transform gizmo, and
also in the Coordinate fields on the status bar. You can use the plus (+) and
minus (–) keys to change the size of the Transform gizmo.
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Rotation of the center of mass object about the X axis.

6 On the

Motion panel ➤ Key Info rollout, click

(Set Key).

When you set the key, the biped will shift position slightly. In the
viewport, you can see that the blue foot is no longer crossing the green.
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Biped foot snaps away from the other foot.

What is happening is that the foot, calf, and thigh bones are being
controlled by the footstep gizmos. The footsteps represent a pair of keys
with IK Blend set to 1 and the Join To Prev IK key turned on. When you
set the key, these settings force the foot, calf, and leg bones back into the
correct path for walking.
7 Click Next Key three times to move to frame 40.
8 Rotate the Transform gizmo –6 to –10 degrees about the X axis.
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Negative rotation with blue foot in contact with the ground.

9 Slowly go through the rest of the rotation keys, repeating this process.
At keys where the blue foot comes in contact with the ground (frames
40, 69, and 99), rotate about the X axis in a negative direction, then set
a key. At keys where the green foot is down (frames 54, 84, 116), rotate
about the X axis in a positive direction, then set a key.
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Positive rotation at frame 54.

10 Repeat this pattern until you have finished rotating the COM at the end
of the animation. Don't make your adjustments too precise. Slight
variations from frame to frame make the motion look more natural.
When you are done, play the animation and notice the increased hip
swings that result from rotating the center of mass back and forth.

11 On the Biped rollout, click
mywalk.bip.

(Save File) and save the file as

If you load the newly saved mywalk.bip file into a scene containing a
skinned character, the character will swing its hips according to the
instructions you saved in this file. Play the animation to determine if you
need to adjust it. For instance, Dr. X (from the quick start tutorial) has
huge feet, which may need to be moved further apart so they don't pass
through the legs accidentally.
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Dr. X character with distinctive walk.

Add spring to the step:
1 Continue from before, or load the mywalk.bip file that you saved earlier.

To load a BIP file, create or select a biped. On the

Motion panel

➤ Biped rollout, click
(Load File), and open the file. This transfers
all the movement information in the file to the biped.

2 On the Track Selection rollout, click

(Body Vertical).

This selects the vertical position track for the center of mass object.
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3 Turn on

(Key Mode Toggle), if it isn't already on.

4 Starting at frame 0, move through the animation using the < and > keys.
When you come to a frame where either a green or blue foot comes in
contact with the ground, move the COM down just a few units.
The knees bend because the feet are controlled by the footsteps.

5 After making a change at a frame, click
rollout.

(Set Key) on the Key Info

This sets a key for the change you've made in the viewport; otherwise,
the change is discarded.

6

Play the animation.
The biped walks with newfound bounce.

7 On the Biped rollout, click

(Save File). Name the file mywalk2.bip.

Add arm and hand motions:
Arm and hand motions are an integral part of an individual’s gait. In the
following sequence, you'll customize the arm motion by moving the hands
and rotating the arms.
You previously created keyframes using the Set Key button; however, for this
technique, you'll use Auto Key instead.

1 Continue from before, or
in the previous section.

load mywalk2.bip, the file you saved

If you prefer, you can begin at the end of the last procedure by
opening springystep.max.

2 Turn on

(Auto Key).
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3 Drag the time slider to frame 0.
4 Dragging the time slider to the right, flip through the frames of animation.
Drag forward and backward, and watch the how the arms and legs swing.
Study the motion carefully.
When the green foot is extended, the blue arm swings forward. When
the blue foot swings out, the green arm swings forward. See if you can
find the frame at which the hand extends the farthest forward.
5 In the viewport, select the green hand of the biped (Bip01 RHand).
The track bar displays the keys for the hand.
6 Drag the time slider to frame 30.
There is a key in track bar at that frame for the hand object.
7 Right-click the hand, and choose Move from the quad menu.
Using the Transform gizmo, move the hand approximately 10 units
upward on the Z axis.
By moving the hand, you've also rotated the two arm bones. The keys
for the hand and arm bones are stored on a single track.

872 | Chapter 5 Character-Animation Tutorials

The hand moved upward.

8 Select the Bip01 R UpperArm object, then right-click and choose Rotate.
Rotate the upper arm approximately –30 degrees about the Z axis.
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The upper arm rotated around the Z axis.

9 Rotate the upper arm approximately 20 degrees about the Y axis, so the
elbows are flying out and away from the body.
10 Select the forearm object (Bip01 R Forearm) and rotate it so the hand moves
closer to the chest.
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The hand rotated close to the chest.

You can position the arm using forward kinematics (the rotation of the
parent objects) or inverse kinematics, using position transform on the
end of the chain: in this case, the position of the wrist. You can also rotate
the hands.

11 Use
(Orbit) to adjust the view angle so you can see the angle of
the other arm behind the biped.
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View of the arm behind the biped.

12 Select the blue hand, and right-click to choose Move. Move the hand
further away from the biped's body. Then move the blue hand upward
on the Z axis so the elbow bends slightly.
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13 Scrub the time slider back and forth to observe the animation so far.
14 Repeat the process at frames 60 and 90.
15 Repeat for the other side at frames 45 and 75.
TIP If you want exact duplication of these arm positions, you can use the
tools in the Copy/Paste rollout. Select both arm assemblies, create a collection,
then use Copy Posture and Paste Opposite at the correct frames. See Creating
a Simple Freeform Animation on page 908 for information on using those
features.

16

Play the animation.

Save it as mywalk3.bip.
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17 To see your work on a skinned character,
open dr_x_03.max from
the folder \character_animation\quick_start\ folder, and then load your
mywalk3.bip file. For comparison, you can also load
distinctive_walk_final.bip from the folder \sceneassets\animations\.
Remember to select part of the biped to access the Biped rollout.

Dr. X with spring in his step.

Add head motions:
You can edit the head motion to make the biped’s walk look more natural.
In this procedure, you'll add head rotations to accentuate the COM rotation.

1 Turn on

(Auto Key), if it isn’t on already.
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2 Turn on

(Key Mode Toggle), if it isn’t on already.

3 Drag the time slider to frame 0.

4 In the Perspective viewport, select the biped's head using
And Rotate).

(Select

5 Rotate the head down as if the biped is asleep.

The head rotated downward.

6 Advance the time slider to the next keyframe by pressing the > key.
7 Keyframe rotations for the head. You can rotate the head to
counterbalance the angle of the shoulders. Or, you can rotate the head
in the opposite direction so it follows the rotation of the COM. Each
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rotation will give a different result. Extreme rotations should be avoided.
Also, be careful to put the rotations only on existing keys.

Rotate the head to follow the movement, or rotate the head to oppose the
shoulders.

8 Continue to jump through the head's keys, setting rotations of your
choice to animate the head.
Natural head motion is smooth, so the orientations should change
gradually from one key to the next.

9 Turn off

(Auto Key) and

(Key Mode Toggle).

10 Play the animation, and notice how much the biped’s head movements
add to the animation.
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You can now save your work as mywalk4.bip. You can check your file
against head_rotate_with.bip and head_rotate_against.bip. Both these BIP
files are in the folder \sceneassets\animations\.

Dr. X's distinctive walk with head rotation.

To see a finished version of the walk, you can go to
\scenes\character_animation\footstep_animation and open
distinctive_walk.max.

Modifying Footsteps
In this lesson, you’ll learn how to copy and paste biped footsteps to extend
an animation. You'll also learn how to adjust and bend the steps, and to
produce the effect of walking on uneven terrain. You'll also make the biped
take a jump.
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Set up this lesson:

■

Continue from the previous lesson, or
open
paste_footsteps_start.max. This scene is in the folder
\character_animation\footstep_animation\.

Extend the walk:
1 Select any part of the biped.

2 On the
Motion panel ➤ Biped rollout, turn on
(Footstep Mode).
The Footsteps sub-object level is activated, and only the footsteps can be
selected.
3 Activate the Top viewport, then press Alt+W to maximize it.

4 Using

(Select And Move), region-select footsteps 3 through 7.

5 On the Footstep Operations rollout, click
(Copy Footsteps) to
place the selected footsteps into the footstep buffer.

6 Click
viewport.

(Paste Footsteps) to paste the selected footsteps into the

The new footsteps appear next to the biped's current footsteps.
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Pasted footsteps appear.

TIP If you have Transform gizmo on, use the minus key (-) to shrink the
Transform gizmo, so it doesn’t cover up the footsteps.
7 The new footsteps can be moved as a set. Move them so the first footstep
of the new set is over footstep 7 of the original set. When footstep 7 of
the original set turns red, release the mouse button.
Footsteps from the original motion are inserted. Now there are 11
footsteps visible.
8 Press Alt+W to display four viewports.
9 To display the entire animation in the Perspective viewport, zoom out
and adjust your view until the biped and all 11 steps are visible.
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Pasted footsteps extend the motion.

10 With the Perspective viewport active, play the animation.
Since you are still in Footstep mode, the Motion panel is available. This

is a good time to save your mywalk_pasted.bip file, using
on the Biped rollout.

Save File

Scale the walk:

1 Make sure that

(Footstep Mode) is on.

2 In the Top viewport, region-select all the footsteps.
3 On the Footstep Operations rollout, turn off Length, and leave Width
selected.
4 Set Scale to 2.0 to double the spacing between the left and right footsteps.

5

Play the animation.
The biped walks with legs apart.

6 Set Scale to 0.25 or smaller to reduce the spacing between the left and
right footsteps to half of the original scaling (one-quarter the current
setting).
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If you hadn't previously doubled this parameter, a setting of 0.5 would
have scaled the width by 50%.
Now the biped puts one foot in front of the next.
TIP If your character has big feet, or if it's walking on a wire or a ledge, use
Scale Width and Length to adjust the footsteps.

Scale the width between the steps.

7

Play the animation.
The biped walks as if on a tightrope.

Bend the walk:
1 In the Top viewport, select all the footsteps from 7 on.
2 On the Footstep Operations rollout, set Bend to 20.0.
The footsteps bend to the left, beginning at footstep 7.
3 Play the animation.
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Walk on uneven terrain:
You can raise and rotate the footsteps to create the illusion of walking on
uneven terrain.
1 Make sure that Footstep mode is still on.
2 Maximize the Perspective viewport.

3 Use

(Select And Rotate) to select all the footsteps from 4 on.

4 Use the Transform gizmo arrows to rotate the selected footsteps
approximately –15 degrees about the X-axis so the footsteps go up a hill.
5 Select footsteps 8 through 11.
6 Rotate the selected footsteps about the X-axis approximately 21 degrees,
so that the footsteps go back down the hill.
7 Select footstep 11. Rotate it so it’s parallel with the grid.
8 Play the animation.
The biped’s feet follow the footstep placement.
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Add a jump:
If there is a period of time during a footstep animation when neither foot is
on the ground, the software interprets this period as a jump. There are several
different ways to create a jumping animation. In this set of procedures, you’ll
move footstep keys in Track View to make the jump.

■

Open footsteps_jump_start.max.
This is a slightly longer version of the same file you’ve been working on.
It has 15 footsteps instead of 11.

Move footstep keys in Track View:

1 Select Bip01. On the

Motion panel ➤ Biped rollout, turn on

(Footstep Mode), if it isn't already on.
2 In the viewport, right-click and choose Curve Editor from the quad menu.
Track View is displayed.
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3 On the Track View menu bar, choose Modes ➤ Dope Sheet. Pan the
controller window until you can see the Bip01 Footstep track displayed in
Track View. Expand the Bip01 Footstep track

Dope Sheet shows special footstep keys.

In the Dope Sheet display of footsteps, each blue block represents a left
footstep, and each green block represents a right footstep. The length of
the blocks is the period of time that the foot is in contact with the ground
during the footstep. The spaces between the blue and green blocks
represent periods in which the biped is not supported by the left or right
foot.
4 Resize the Track View window, or zoom into the track so you can see the
start and end frame numbers on each footstep.
5 Select footsteps 11 through 15 by drawing a box around them in Track
View, or by dragging a selection region in the viewport.
In Track View, notice that footstep number 11 starts at frame 165.

6 On the Track View toolbar, click

(Slide Keys).

7 In Track View, click in the center of footstep 11 and drag it to the right
until the number 166 (indicating the first frame of footstep 11) increments
to number 180. Release the mouse button.
This creates a gap between step 10 and 11. The keys in the other biped
tracks adjust to the change in the footstep track.
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The keys shifted to the right to create a gap.

By creating an area in the footstep track where neither foot is supporting
the biped, you have changed a walking step into a jumping step
8 Minimize Track View and then play the animation.

The gap between footsteps creates a jump.

9 In the viewport, move footstep 10 so it is next to footstep 9.
10 In the viewport, move footsteps 11 through 15 so there is more of a gap
for the jump. Move these footsteps about 5–7 units in the X-axis direction.
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More gap for the jump.

Now, if you shorten the duration of footstep 10, you can accentuate the
jump.

11 On the Track View toolbar, click

(Move Keys).

12 In Track View - Dope Sheet, click the right edge of footstep 10.
A white dot appears only on the right side of the key to show it's selected.
13 Drag the right edge of footstep 10 to the left to shorten the duration of
the key. Change the key so it ends at frame 160.

Shorten the duration of
footstep 10.
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14 Play the animation and observe the jump.
15 Turn off Footstep Mode.
Make the biped crouch before the jump:
The preparation for the jump, between footsteps 9 and 10, looks a little stiff
because the biped is not crouching enough before jumping. Resetting a vertical
key will fix this problem.

1 On the
Motion panel ➤ Track Selection rollout, click
(Body Vertical).
2 Drag the time slider to frame 153, where there is a Body Vertical track
key.
3 Press H and select Bip01, the center of mass.
4 Move the center of mass down approximately –5 units. Then on the Key

Info rollout, click

(Set Key).

If the biped jumps back to its original position, click Set Key and try again.
Click Set Key when you have a crouching position as illustrated here.
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Lower the center-of-mass object using the Body Vertical track.

5 Scrub the time slider to view the animation.
There appears to be a glitch in the motion. There are two Body Vertical
keys next to each other that are causing this problem.
6 Drag the time slider to frame 153.

7 On the Key Info rollout, click

at frame 154. Then click

(Next Key) to move to the next key

(Delete Key) to remove this second key.

8 Select Bip01 R Foot.
9 Drag the time slider to frame 167. Click Body Vertical and raise the foot
slightly, so the biped's knee is bent.
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10 On the Key Info rollout, click
(Set Free Key) to hold the bent knee
position. Set additional keys on the foot if it hyperextends before it hits
the ground, or if it goes through the ground at takeoff.
11 Play back the animation and observe the motion.

12 On the Track Selection rollout, click
(Body Rotation). Drag the
time slider to frame 160. Using the Transform gizmo, rotate the center
of mass so the body pitches forward.
The jump looks more natural now. The result should be similar to the
jump in footstep_jump_final.bip, which is in the folder
\sceneassets\animations\.
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Making a Biped Stop and Start Walking
In just a few key strokes, you can generate multiple footsteps to make a biped
walk. But what if you want the biped to stop and pause? To do that, you'll use
a simple manipulation of the footstep keys in the Track View - Dope Sheet.
Just stretching the length of the selected footsteps changes the animation so
the biped pauses in its path.
Set up the lesson:

■

Open standstill_start.max.

Make the biped stop and start:
1 In the viewport, select any part of the biped.
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2 Go to the

Motion panel.

The Biped controls are displayed in the rollouts.

3

Play the animation of the biped.
The biped walks seven steps forward without stopping.

You'll use footsteps 4 and 5 as the footsteps where the biped pauses.

4 On the Biped rollout, turn on

(Footstep Mode).

5 In the Perspective viewport, select footsteps 5–7, then right-click and
choose Move.
6 Move the footsteps so that footstep 5 is next to footstep 4.
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7 Play the animation to observe the change.
The animation looks a little funny right now; something's not quite right.
It's good practice to deactivate the footsteps, and then create new keys
from the moved footsteps. This will recreate the correct upper body
motions. You'll do that next.
Create keys to correct upper body motions:

1 In the viewport, select footsteps 4–7. On the

Footstep Operations rollout, click

Motion panel ➤

(Deactivate Footsteps).

To manipulate the footstep keys, you'll use Track View in Dope Sheet
mode.
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2 On the 3ds Max menu bar, choose Graph Editors ➤ Track View - Dope
Sheet.
3ds Max displays the Dope Sheet.
3 In the controller window, expand the Bip01 Footsteps ➤ Transform track,
and click to highlight it.
You should see the footsteps in the keys window.
4 Right-click the top of the Track View window and choose Dock ➤
Bottom.
The Dope Sheet moves out of the way of the viewport.
5 Make adjustments as needed to your viewport so you have a clear view
of the footsteps and the biped. When you select footsteps in the viewport,
you also select footstep keys in Dope Sheet.
6 Select footsteps 4–7 in the viewport, if they aren't already selected.
In the Dope Sheet, the selected keys appear in a brighter color, with white
dots on them.
7 Hold down the ALT key and click the white dot at the left side of footstep
key 4. This deselects the left side of that footstep key. Repeat for key 5,
deselecting the left side of the key.
Keys 4 through 7 are selected, but keys 4 and 5 display only one white
dot.

8 From the right side of key 5, drag to the right so the key ends at frame
200.

9 On the keyboard, press ALT+R to extend the animation to match the
footstep keys.
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Frames are automatically added to the animation.

The light grey background extends behind the footstep keys. The time
slider now shows that there are 230 frames in the animation.
10 Play the animation and observe the biped motion.
The biped walks, then stops and waits, and then walks again. The motion
seems a bit odd, though, as he steps off around frame 180.
TIP There are a number of different ways to play and observe biped motion.
One way is to drag the time slider to play the animation. For more control,
press the < and > keys on the keyboard. This lets you stop instantly if you see
a problem, and is more like a traditional animator flipping through the pages
of drawings.

11 On the Footstep Operations rollout, click
Footsteps).

(Create Keys For Inactive

12 Play the animation again.
The motion is better. When new keys are created, 3ds Max applies a new
upper-body motion.
TIP For this reason, when you animate starting with footsteps, work out the
foot motion before you worry too much about the upper body motion.
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13 Save your work as my_standstill.bip.

You can
scene.

open standstill_final.max to see a version of the completed

Changing Footsteps Using IK Keys
Footstep and Freeform modes both use the same underlying inverse kinematics
(IK) to animate the biped skeleton. Footstep gizmos are a method for
manipulating sequences of IK keys.
With inverse kinematics, you animate a hierarchy, such as a biped’s leg, by
animating a lower link in the hierarchy: for example, the biped’s foot. Inverse
kinematics is the opposite of forward kinematics. Forward kinematics doesn’t
use the hierarchy; for example, you might animate a leg by rotating the thigh.
In this lesson, you’ll learn how changing the IK keys affects the footsteps.
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Set up this lesson:

■

Open footsteps_keys_start.max.
A biped is displayed with four footsteps in the viewport.

Set IK Keys to create footsteps:
1 Scrub the time slider to play the animation.
The biped hops on his right foot. Notice that there is no footstep for the
right foot between footsteps 2 and 3.
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2 At frame 45, select Bip01 R Foot.

3 On the
Planted Key).

Motion Panel ➤ Key Info rollout, click

(Set

The pivot point is displayed in the viewport. If you can't see it, change
to Wireframe viewport shading, or navigate the viewport so you can see
beneath the heel.
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4 On the 3ds Max status bar, turn on

(Key Mode Toggle).

5 Click
Next Key to go to frame 48, and then click
Planted Key).
The pivot point shifts to the toe.
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(Set

Note that the lowest IK pivot is selected by default for cases where IK is
applied to new keys.

6 At frame 54, click

(Set Planted Key).
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The biped is moved back to the ground. A footstep is displayed beneath
the biped’s foot.
A footstep has been created, because there is now an interval of time
where IK is applied between the two planted IK keys. However, if you
drag the time slider to play the animation, you will see that the walk still
needs work.
Change the duration of footsteps using IK keys:

1 At frame 60, click

(Set Planted Key).

2 Play the animation now. The walk cycle is much better.
3 Right-click the foot and choose Dope Sheet.
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4 On the Dope Sheet tool bar, turn on
already.

5 On the Biped rollout, turn on
the track in Dope Sheet.

(Edit Keys) if it is not on

(Footstep Mode) to easily locate

6 Expand the Bip01 Footsteps ➤ Transform track. Notice that footstep 3
extends for 15 frames, from frames 45 to frame 60.

7

Turn off Footstep Mode.

8 Select Bip01 R Foot once more.
The keys for the foot are displayed in the Dope Sheet

9 At frame 63,

10 Turn on

set another planted key.

(Footstep Mode).

The Dope Sheet editor again displays the Footsteps track.
The duration of the footstep now is 18 frames, from frames 45 to 63.

11 Turn off

(Footstep Mode).

12 Close the Track View - Dope Sheet window.
Remove footsteps using IK keys:
By editing IK keys, you can remove footsteps as well as add them.

1 At frame 45, select the Bip01 R Foot object in the viewport, then
set a free key.
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2 At frame 48,

set a free key.

3 At frame 54,

set a free key.

NOTE The body vertical position is modified. The biped now floats up into
the air at frame 54.

4 At frame 60,

set a free key.

The footstep disappears.
There is only one IK key left. With no IK interval defined, there is no
duration, and therefore no footstep. The result is that the biped hops
between footsteps 2 and 3.
The animation could be made more realistic by adding arm movement
to the hopping steps, or by creating a freeform period for the hop, then
adding poses for a crouch, spring and landing. The point of this lesson,
however, has been to demonstrate that footsteps can actually be created
or removed by changing the IK keys.
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Summary
In this tutorial, you learned how to animate a biped using footsteps, add
upper-body freeform animation, and how to modify the footsteps to make
the biped, walk, run, and jump. You also learned how to change the duration
of a footstep animation using IK keys.

Freeform Animation
This tutorial shows you how to animate a biped using the freeform technique.
This technique does not use footsteps; instead, you are responsible for
animating every part of the biped.
Freeform animation gives you fine control over the biped's motion.
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In this tutorial, you will learn how to:
■

Use planted, sliding, and free keys.

■

Create a traditional walk cycle using animated pivot points.

■

Create a stretchy leg and a shaky walk using Biped SubAnim controllers.

■

Create animated 3ds Max bones from a biped animation.

Skill level: Beginner to Intermediate
Time to complete: 2 hours

Creating a Simple Freeform Animation
This lesson provides an introduction to using freeform animation techniques
with Biped.
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In this lesson, you will animate a biped swimming in place. You’ll use freeform
animation methods to produce the kicking legs and arm strokes.
In order to create this motion, you’ll use a combination of rotations and
moves. You'll also make use of Copy and Paste Posture Opposite to animate
one arm and copy its tracks to the other.
Set up the lesson:
1 Reset 3ds Max.

2 On the

Create panel, click

(Systems).

Create a biped and load a FIG file:
1 Click to turn on
Front viewport.

(Biped), and then create a biped in the

2 Go to the

Motion panel.

3 Turn on

(Figure Mode), then click

(Load File).

3ds Max displays the Open dialog.
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4 Open the file tut_swimmer.fig. This file is in the folder
\sceneassets\animations\.
The biped takes on new structural elements saved in the FIG file. This
simplified figure has one large toe on each foot and one large finger on
each hand, and its spine contains two segments instead of four.

The biped with FIG file
applied.

5 Turn off

(Figure Mode).

NOTE You cannot animate in Figure mode.

6 Select all the biped objects, and then click
7 Save the scene as MySwimmer01.max.
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(Zoom Extents All).

Start a freeform animation:
You start a freeform animation by activating automatic key recording and
transforming any part of the biped.
1 Right-click the Left viewport.
This activates the Left viewport without affecting the selection in the
scene.
2 Press Alt+W to maximize the viewport for a closer view of the biped.
The biped should be in wireframe. Change the shading display of the
Left viewport if it is not wireframe.

3 Turn on

(Auto Key).

The button turns red, and the active viewport is outlined in red.

4 On the
Motion panel ➤ Track Selection rollout, click
(Body Rotation).
NOTE Activating any of the Body ... buttons on the Track Selection rollout
automatically selects the center of mass (COM) object.

Rotation transform gizmo

The rotation transform gizmo lets you easily rotate an object about a
chosen axis. As you move your cursor over the gizmo in the viewport,
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the axis circles turn yellow, indicating the axis around which the rotation
will occur:
■

The red circle, displayed as a vertical line in this viewport, affects the
X axis.

■

The green circle affects the Y axis.

■

The blue circle, displayed as a horizontal line in this viewport, affects
the Z axis.

■

The light gray circle, displayed around the green circle, allows free
rotation around all three axes.

5 Move your cursor over the green circle.
The cursor turns yellow, meaning that any rotation is locked to that axis.
6 Rotate the center of mass approximately 90 degrees about the Y axis.
Watch the coordinate readout near the gizmo to see how far you're
rotating the biped. Rotate until the biped is lying prone.
TIP If you like, you can press A to turn on Angle Snap, which lets you easily
rotate to 90 degrees.

An animation key appears at the far left of the track bar, at frame 0.
You can select all three COM tracks under Track Selection to create
keyframes simultaneously. Try this:

7 On the Track Selection Rollout, click

then click

(Body Rotation).
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(Lock COM Keying), and

8 On the Track Selection rollout click to turn on both

Horizontal) and

(Body

(Body Vertical).

All the multiple tracks for the COM are now active.

9 Expand the Key Info rollout and click

(Set Key).

This sets keys for all the COM tracks at frame 0. The trackbar key shows
a multi-color display, indicating that both position and rotation keys
have been created.
10 Click Lock COM Keying again to unlock the COM tracks.
TIP It’s a good idea to set a key at the start of your animation for the three
COM tracks.

Pose one leg:
Now that the biped is prone, you're ready to animate the swimming motion.
First, you’ll position the legs. You’ll work on the right leg first, setting up its
position at frame 0.
1 Press Alt+W so you can see all four viewports again.
2 Select Bip01 R Thigh by clicking the lines of the thigh in the Left viewport.
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TIP As you hold your cursor over an object in the viewport, the object’s name
is displayed in a tooltip. You can also select an object by pressing H to choose
objects from the selection list.

The right thigh is selected.

3 Rotate Bip01 R Thigh approximately −30 degrees about the Z-axis.
The right leg is rotated, but the right foot is pointing straight down.

4 Press Page Down twice to select the right foot.
TIP The Page Up and Page Down keys let you quickly navigate through the
objects that make up a biped.
5 Rotate Bip01 R Foot about –50 degrees around the Z-axis.
The foot looks more natural in this position.
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So far you’ve used only forward kinematics to animate the biped. Next
you’ll use inverse kinematics by moving the foot to move the entire leg.
6 Right-click the same foot and choose Move from the quad menu.
TIP You can choose the transform tools either from the main toolbar or by
right-clicking to open the quad menu.
The Transform gizmo switches to an axis tripod showing two of three arrows
in this viewport. They are displayed at right angles with the Z axis pointing
up and the Y axis pointing left.

Ready to move the foot.

7 In the Left viewport, move the cursor over the Y axis of the gizmo until
it turns yellow, then move the foot a little to the right.
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The knee bends to accommodate the new position of the foot.

The knee bends.

In this move, you’ve just used inverse kinematics. The foot, calf, and thigh
are linked together in a hierarchical chain. By moving the end of the
chain, the foot, you rotated the lower and upper leg objects.

8

Save the scene as MySwimmer02.max.

Animate the leg:
Everything you’ve done so far has been at frame 0. Now you’ll move forward
in time and animate the pose at frame 10.
1 Drag the time slider to frame 10.

2

Move the foot downward on the Z axis until the knee straightens
out.
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3 Press Page Up twice to select Bip01 R Thigh.
4 Right-click and choose Rotate from the quad menu, then rotate the Bip01
R Thigh approximately −10 degrees about the Z axis.

Rotating the thigh.

5 Scrub the time slider back and forth between frame 0 and frame 10.
The leg moves up and down.
Use copy and paste:
Now you’ll use some specialized Biped tools to pose and animate the opposite
leg.
1 Return the time slider to frame 10.
2 Double-click Bip01 R Thigh.
The entire leg is selected from the thigh down to the toes.
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3 On the

Motion panel, expand the Copy/Paste rollout.

The Copy/Paste functionality includes the creation of collections. You
must create a collection before you can start creating postures.

4 On the Copy/Paste rollout, click
(Create Collection). This creates
a collection named Col01. Rename it to Swim – Crawl.
5 Make sure that the Posture button is active.

6 Also make sure that Capture Snapshot From Viewport is chosen. This
button is just above the Paste Options group.

Choosing Capture Snapshot From Viewport forces the thumbnail of the
pose to be taken from the active viewport. This particular posture, for
example, is better seen from the Left viewport rather than the Front.

7 Click

(Copy Posture).
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The posture of the right leg is copied into a buffer. Change the name of
the Copied Posture to RLeg – downkick.

8 Drag the time slider back to frame 0. Click
Opposite).

(Paste Posture

The left leg rotates downward. The right leg hierarchy is still selected.
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9 At frame 0, click

(Copy Posture) again.

10 Drag the time slider to frame 10.

11 Click

(Paste Posture Opposite) again.

Now the left leg is raised, and the right leg is down.

12 Scrub the time slider back and forth between frames 0 and 10 and watch
the legs kick.
Now you‘ll repeat this process to make the legs kick several times.
13 Save the scene as MySwimmer03.max.

920 | Chapter 5 Character-Animation Tutorials

Use Paste Posture to create multiple kicks:
You can use the Copy Posture tools to quickly duplicate all the leg keys from
one frame to another to create repeated kicking motions.

1 Make sure that
to frame 0.

(Auto Key) is still on and drag the time slider

2 On the Track Selection rollout, click

(Symmetrical).

Now both legs are selected.

3 At frame 0, click
L down.

(Copy Posture). Name the copied posture R up
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Both legs are added to the collection.
4 Drag the time slider to frame 20.
TIP You can type in the frame number in the Current Frame time control.

5 At frame 20, click

(Paste Posture).

6 Go to frame 30 and click
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(Paste Posture Opposite).

From this point forward, you can click either Paste or Paste Opposite as
you create a kicking cycle. For a smooth kick cycle, simply alternate the
posture every 10 frames up to frame 80. The track bar displays a total of
nine keys for the animation of the legs.
7 In the Copy Collections group click the Save Collection button to save
your collection. Name the collection Swim – Crawl. The CPY extension
is automatically added to the name.
8 Save the scene as MySwimmer04.max.
Animating a kicking leg was fairly easy, requiring only two poses: one with
the leg up, and one with the leg down. Animating the arms is more complex.
To animate the stroke of an arm, you’ll need five poses:
■

The arm outstretched

■

The arm down

■

The arm back

■

The arm drawn up out of the water near the ear

■

The arm entering the water

When one arm is animated correctly, you’ll use Copy Track and Paste Opposite
Track to animate the second arm. You’ll adjust the timing of the second arm
by sliding the keys in the track bar.
Animate one arm:

1 Make sure that
to frame 0.

(Auto Key) is still on, and drag the time slider

2 Press H. In the Select From Scene dialog, select Bip01 L UpperArm.

3 In the Left viewport,
rotate Bip01 L UpperArm approximately −160
degrees about the Z axis, until it is extended in front of the biped.
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4 Right-click the Top viewport and press Page Up to select Bip01 L Clavicle
and rotate it −20 degrees about the Y axis.
This should prevent the arm from passing through the head.

5 In the same viewport, press Page Down three times to select Bip01 L Hand.
Rotate it approximately −90 degrees about the X axis so the palm is facing
down.
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This completes the first arm pose, so it's a good time to save your data.
6 Double-click Bip01 LClavicle to select the entire left arm hierarchy.
7 Activate the Perspective viewport so that the snapshot will be easier to
identify, and then click Copy Posture. Name the pose LArm extended.
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Thumbnail snapshot from
perspective viewport.

8 Drag the time slider to frame 10.

9 On the main toolbar, click
(Select And Move), and then change
the Reference Coordinate System to World, if it isn’t already set to World.

This will facilitate working with the Transform gizmo in different
viewports.
10 Right-click in the Left viewport. Move Bip01 L Hand downward on the Y
and Z axes until it points straight down. This completes the second arm
pose.
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TIP If you grab the Move gizmo by the corner where the two axes meet,
you can move selected objects on both axes at once; that is, on the YZ plane.

11 Double-click Bip01 LUpperArm to select the arm hierarchy, then click

(Copy Posture). Name the pose LArm down.
12 Drag the time slider to frame 20.

13

Move Bip01 L Hand along the Y axis toward the legs.
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14 Activate the Front viewport and press Page Up three times to select Bip01

L Clavicle.

Rotate this part about 24 degrees around the Z axis.

This completes the third arm pose. Save it by double-clicking Bip01 L

UpperArm in the Top viewport to select the hierarchy, then click
Copy Posture. Name the pose LArm back. If you activate the Perspective
viewport before you copy the posture, you can adjust the viewport so the
pose is clearly visible in the thumbnail.

15 Drag the time slider to frame 30.
16 Activate the Top viewport.

17

Move Bip01 L Hand in the XY plane until the hand is level with
the shoulder.

928 | Chapter 5 Character-Animation Tutorials

18 In the Left viewport,
near the ear.

19 Finally,

move Bip01 L Hand on the Z axis so it is

rotate Bip01 L Hand about the X axis so the palm is flat.
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This completes the fourth arm pose. Save it to the collection by
double-clicking the upper arm to select the entire hierarchy, then click

(Copy Posture). Name the pose LArm up.

20 To create the fifth pose, go to frame 37.
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21 In the Left Viewport,
move the Bip01L Hand object on the Y axis
so it is in front of the head, and is level with the shoulders. Double-click
the Bip01 L Upperarm to select the entire arm hierarchy, activate the

Perspective viewport, and then click
pose LArm stroke.

(Copy Posture). Name the

NOTE The fifth pose is used to ensure that the rotation of the arm is correct
going from the out-of-water pose to the extended pose.
22 Save the scene as MySwimmer05.max.
Applying a twist pose:
You can use twist poses to correct upper arm rotations. Twist poses are
primarily used to correct arm twisting, but in this case we’ll use it to simply
position the arm efficiently.

1 Turn off

(Auto Key) if it is on.

2 Select Bip01 L Upperarm.
3 Drag the time slider to frame 33.
4 Expand the Twist Poses rollout.
5 In the Twist Poses drop-down list, choose each pose and observe the
change to the arm in the viewport.
Consider these default poses as additional copied postures that you can
use to “straighten out” problems by defaulting to fixed rotations.

Twist Poses
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6 When pose 5 is selected, the arm will be rotated and positioned correctly.

Expand the Key Info rollout and click
twist pose.

(Set Key) to keyframe the

Default Twist pose 5.

TIP Twist poses are designed to help you fix twisting that occurs in the mesh
attached to the biped. If you go to Figure Mode, you can enable Twist Links
by turning on the Twists check box, then set the number of twist links you
would like for the upper arm, forearm, thigh, calf, or “horse-link” (the extra
link in the Leg if Leg Links are set to 4). Unfreeze and unhide all and you will
be able to see the twist bones that have been added using this method. Once
the Twist Links functionality is enabled you can play with the Twist and Bias
settings.

Copy the Arm pose:
To complete the arm cycle, in the next few steps you’ll copy the arm pose to
frame 40.

1 Turn on

(Auto Key).

2 In the Top viewport, double-click Bip01 L Clavicle to select the entire left
arm.
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3 At frame 33, click

(Copy Posture).

4 Advance the time slider to frame 40, and click

(Paste Posture).

If you see any unusual rotations or out-of-place movements, you can set
additional keys to refine the animation.
5 Drag the time slider and watch the animation.
Repeat the animation:
If the animation is going to be 80 frames in length, you’ll need to repeat the
arm movement.
1 Double-click Bip01 L Clavicle, to select the entire left arm, if it's not already
selected.
2 In the track bar, drag a selection window around the keys for frames 10
through 40.
3 Hold down the Shift key and copy these keys by dragging them to the
right. When the first key is over frame 50, release the mouse button.
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4

Play the animation. The biped should perform two complete
strokes with its left arm.

5 Save your scene as MySwimmer07.max.
Add rotation to the spine:
Next you’ll add some rotations for the spine to make the animation more
convincing. This spine of this biped figure (tut_swimmer.fig) has only two
segments. You’ll rotate the large section representing the upper torso.

1 Make sure that

2

(Auto Key) is still on.

Select Bip01 Spine1.
NOTE The first spine object is Bip01 Spine. The large second spine object is
Bip01 Spine1.

3 Right-click the Front viewport.

4 Drag the time slider to frame 0, and on the Key Info rollout, click
(Set Key).
This sets a start key for the rotation.

5 Drag the time slider to frame 10 and
rotate Bip01 Spine1
approximately −15 degrees about the X axis.
This makes the body appear to follow the movement of the arm.

934 | Chapter 5 Character-Animation Tutorials

Spine rotation

6 On the track bar, click the key at frame 0 to select it, then hold down the
Shift key and drag a copy to frame 30. Watch the status area to know
when you are at frame 30.

The spine now rotates once in the 40-frame cycle.
7 Select Bip01 Pelvis.

8 Drag the time slider to frame 0, and on the Key Info rollout, click
(Set Key).
This sets a start key for the rotation.
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9 Drag the time slider to frame 10, and
rotate the pelvis a few
degrees in X so it follows the movement of the left leg.

Rotate the pelvis.

10 Copy these two keys to frames 20 and 30.
TIP For the pelvis, you can also add a few degrees of rotation around the Y
axis, if you like.
Next, you’ll copy the pelvis and spine rotation keys to repeat the motion.

11 Make sure that the pelvis is still selected, then hold down the Ctrl key
and click the Bip01 Spine01 object (the large torso spine object).
12 In the track bar, drag a selection rectangle around the four visible keys.
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13 Hold down the Shift key and drag the keys so the leftmost key is copied
to frame 40. Scrub the time slider back and forth to see the animation.
14 Copy the key from frame 0 to frame 80 to complete the set of keys.

The final set of Bip01 Spine1 keys.

Animate the head:
The biped can breathe as it swims, if you animate the head rotation
appropriately.

1 Make sure that

2 In the Left viewport,

(Auto Key) is still on.

select the biped's head, Bip01 Head.

3 Drag the time slider to frame 0, and
rotate the head about 70
degrees around the X axis, so the biped’s left ear is pointing down.

Rotate the head for breathing motion.

TIP Watch the Perspective viewport while rotating in the Left viewport.
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4 At frame 20,

rotate the head back down.

5 Hold down the Shift key and drag to copy the key at frame 0 to frame 40.
Watch the status area to know when you are at frame 40.
6 Scrub the time slider to observe the head rotation.
Actually, it would look better if the head were turned up at frame 30.
7 Slide the key you made at frame 20 along the track bar to frame 30. Do
not hold down the Shift key for this step.
The biped lifts and lowers its head once in the 40-frame cycle.
TIP You can drag the time slider to frame 30, then slide the key on top of it.
8 To explore another way to copy keys, right-click the time slider.
The Create Key dialog is displayed. This lets you create keys by choosing
a source and a destination.
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TIP You don’t have to turn on Auto Key to set keys this way.
9 Set Source Time to 30 and Destination Time to 70, and then click OK.
10 Right-click the time slider again.
11 Set Source Time to 0 and Destination Time to 80, and then click OK.
This completes the head motion, but the right arm motions still need work.
That comes next.
Animate the other arm with Copy Tracks:
Copy Tracks lets you copy and paste the animation tracks of selected objects
to other objects, or to opposite body parts.

1 Make sure that

(Auto Key) is still on.

2 In the Top viewport, double-click Bip01 L Clavicle to select the entire left
arm.
3 Activate the Perspective Viewport.
4 On the Copy/Paste rollout, turn on

5 Click

(Track).

(Copy Track).

The track is copied to the buffer. Name the track LArm – Crawl.
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6 Click

7

(Paste Track Opposite).

Play the animation.
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The biped is swimming the butterfly stroke. The two arms move together.
Next you'll change the timing so the arms alternate.
8 In the Top viewport, double-click the Bip01 R Clavicle.
The entire right arm is selected in the viewport.
9 Drag a box around all the keys in the track bar to select them. Slide all
the keys 20 frames to the right.

The biped swimming a freestyle stroke.

10

Play the animation.
Now the beginning and end are not quite right. The easiest way to correct
this is to copy and paste poses.

Fix the beginning and end:

1 Make sure that

(Auto Key) is still on.

2 In the Top viewport,
double-click the Bip01 R Clavicle to select
the entire right arm, if it’s not already selected.
3 On the Copy/Paste rollout, click

(Posture).
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4 Drag the time slider to frame 50, and click

(Copy Posture).

5 Drag the time slider back to frame 10, and click

6 At frame 40, click
(Paste Posture).

(Paste Posture).

(Copy Posture), then at frame 0, click

Now the arms alternate.

To correct the other end of the animation, you can crop the animation
to 80 frames.

7 In the time controls, click

(Time Configuration).

3ds Max opens the Time Configuration dialog.
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8 In the Animation group, change the End Time to 80. Click OK.
WARNING Do not click Re-scale Time.

9

Play the animation.
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Save your work:

1 On the Biped rollout, click
MySwimmer.bip.

2 Also

(Save File) and save the motion as

save your final scene as MySwimmer08.max.

Perfecting the animation:
■

If you like, you can improve the animation by adding some rotation keys
to the pelvis and spine and by adding secondary motion to the feet and
hands. Stagger the rotations of the extremities a few frames following the
movement of the hands and feet.

To see a finished version of the swimmer, you can go to
\scenes\character_animation\freeform_animation and open swim.max.

Using Controllers with Biped
You can add controllers on top of Biped animations to create a wide variety
of effects. You can use scale controllers to create stretchy legs or arms for
cartoon animation, or create the illusion of breathing by adding a scale
controller on the spine objects in the chest. You can add noise rotation
controllers to the spine to make a biped shake while he walks, or to create
twitching or random motion in the limbs or head.
Controllers can be added in the Motion panel ➤ Assign Controllers rollout,
or by using the Workbench.
Although this lesson is performed with footsteps, it could have been
accomplished just as easily with a freeform animation.
Set up the lesson:

■

Open stretchyleg_start.max.
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NOTE If a dialog asks whether you want to use the scene’s Gamma And LUT
settings, accept the scene Gamma settings, and click OK. If a dialog asks
whether to use the scene’s units, accept the scene units, and click OK.

Create stretchy legs with controllers:
In this exercise, you will add a scale controller to a biped's legs to stretch them
during a portion of an animation.

1

Play the animation.
The biped walks for 10 paces, zooms to a lower level, and then walks
another five steps. You’ll add the scale controller, then animate the biped
so that its legs stretch during the period of the downward leap.

2 Drag the time slider to frame 162, then
object, the blue leg.

3 On the

select the Bip01 L Thigh

Motion panel, open the Assign Controller rollout.

4 In the controller list window, expand the Biped SubAnim entry.
Now you can see the three list controllers.
5 Click the plus sign (+) next to BipScaleList to expand this controller

hierarchy. Select the entry marked Available, then click
Controller).

(Assign

3ds Max opens the Assign Scale Controller dialog.
6 Choose Scale XYZ from the list, and click OK to close the dialog.

7 On the 3ds Max main toolbar, click

(Select And Scale).

The Scale gizmo is visible on the thigh in the viewport.
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8 Turn on

(Auto Key).

First, you will set a key to start the stretch. You don’t want the stretch to
start before frame 162. You want the biped to have a normal leg
(unstretched) from the start of the animation up to this frame.
9 Using the Scale gizmo, stretch the leg very slightly in the X-axis at this
frame, so the final value in the Coordinate rollout is 100 (no stretch).

The leg at frame 162 (no stretch).

10 Go to frame 164, and stretch the leg so the foot reaches the footstep.
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11 Go to frame 167, and again stretch the leg in the X-axis, so the foot stays
on the footstep gizmo.
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Leg stretch at frame 167.

12 Go to frame 169. Here, you begin to shorten the leg stretch.
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Leg shortens at frame 169.

13 Go to frame 181, and stretch the leg back to normal. Adjust it visually
until the leg looks correct.
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Leg at frame 181 appears normal.

14

Play the animation. The biped’s back foot stays on the footstep
and the leg stretches out as the biped descends to the lower set of
footsteps.
For extra credit, add a scale controller to the green thigh, and stretch that
leg out, roughly between frames 161 and 171.

15 Turn off

16

(Auto Key).

Save your work as mystretchy_leg.max.
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You can
animation.

open stretchyleg_final.max to compare this version of the

Once you have controllers added to the biped body parts, you can animate
their parameters, or animate their weights. Here's an example that shows
animation of parameters.
Animate the weights of SubAnim controllers:

1

Open shake_and_walk_start.max.

2

Play the animation.
The biped takes a few steps, pauses for a moment or two, then walks on.

3 In the Perspective Viewport, select Bip01 Spine, the lowest spine object.

Freeform Animation | 951

4 On the

Motion panel, open the Assign Controller rollout.

5 In the Assign Controller window, expand the Biped SubAnim so you can
see the list controllers.
6 Expand the BipRotationList, and highlight the entry marked Available.
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7 Click

(Assign Controller).

3ds Max opens the Assign Rotation Controller dialog.
8 Choose Noise Rotation in the list, then click OK.
3ds Max opens the Noise Rotation Properties dialog. Don’t close this
dialog.

9

Play the animation in the viewport.
The biped shakes drastically as it walks.

10 In the Properties floater, turn off Fractal Noise.
11 As the animation plays, change the Frequency in the Properties dialog,
using the spinner. Lower the value until the shake becomes slower and
more rhythmic. Probably a value of 0.2 or less will be good to use, but
you can choose whatever you like.
12 As the animation plays, change the X, Y, and Z values. Set the three values
to 0.0, then change them individually, one at a time.
To create a shimmy effect, set X Strength to be 2.0, Y and Z Strength to
0.0.
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13 Close the Noise Rotation Properties dialog.
In this example, the biped should shake only while walking. The frames from
69 through 191 should not have any shaking. To complete this effect, you
will animate the weight of the noise controller.
Animate the weight of the noise controller:

1 On the
Motion panel, expand the Weight entry of the Noise
Rotation controller you added to the spine object. Highlight Weight 0.
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There is a trick to accessing the weights.

2 Open the Keyframing Tools rollout and click
SubAnims).

(Manipulate

The Motion panel now displays additional rollouts for Position List, Scale
List, and Rotation List.
3 Scroll to the Rotation List and select the layer Noise Rotation.

Now you're ready to animate the Weight field.

4 Turn on

(Auto Key).

5 Drag the time slider to frame 70.
6 Near the bottom of the Rotation List rollout, right-click the Weight field
spinner. This sets it to zero.
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TIP Right-clicking any spinner resets it to its lowest possible nonnegative
value.

7 Drag the time slider to frame 69.
TIP Use the < and > keys on the keyboard to move from frame to frame.
8 Change the Rotation List Weight field to 100.0.
The spinner is outlined in red to show its value is animated.
9 Drag the time slider back and forth from frame 0 to frame 100 to see the
animation. The biped shakes while walking and stops shaking during the
pause.
10 Next, you make the biped start shaking again at frame 191. At frame 190,
set a key with the Noise Rotation Weight set to 0.0, and to 100.0 at frame
191.
TIP At frame 190, hold down the Shift key while you right-click the spinner.
This will set a key without changing the value.

11 On the Keyframing rollout, turn off
you're done.

(Manipulate SubAnims) when

12

Play the animation.

13

Save your file as myshake_and_walk.max.

You can
open shake_and_walk_finished.max to compare this version
of the animation.
If you are exporting to a game engine, or if you want to use this animation
with Layers or in the Motion Mixer, you will need to collapse the list controller
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animation (see following procedure). This will add the controllers animation
keys to the tracks of the Biped SubAnim.
NOTE 3ds Max has different behaviors for controllers and constraints. The
controller animation will be layered onto the existing keys in the Biped SubAnim
track. If you have used a constraint, however, it will replace the Biped Subanim
tracks.
Collapse the list controller track:

1 Continue from before, or

2 If you open the file,

open shake_and_walk_finished.max.

select the Bip01 Spine object, open the

Motion panel, and expand the Assign Controller rollout.
3 In the Assign Controller window, highlight Biped SubAnim, and then
right-click.
4 Choose Properties from the pop-up menu.

3ds Max opens the SubAnim Property dialog.
5 In the Enable options, turn off Position List and Scale List, so the Rotation
List is the only one active.
6 In the Collapse options, turn off Position, and turn on Rotation List,
Don't Delete, and Per Frame.
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7 To collapse the rotation track, click the Collapse button at the bottom
of the SubAnim Property dialog.
Wait while the calculations take place.
When the collapse is completed, the dialog closes and the track bar fills
with keyframes.
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8

Save your work as mycollapsed_shaking.max.

You can
open shake_and_walk_collapsed.max to compare this
version of the animation.
TIP You can use the Workbench to reduce the number of keys created by collapsing
the tracks.

Creating Animated Bones with Biped
You can take the animated biped skeleton and use it to generate a 3ds Max
bone structure that follows the same animation, by using the File Export and
Import capabilities. In just a few steps, you will be able to take your biped
animation and use it without the biped attached.
Set up the lesson:

■

On the Quick Access toolbar, click
(Open File), navigate to the
\character_animation\freeform_animation folder, and open
createbones_start.max.
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Biped takes a bow.

Create animated bones from bipeds:
1 Play the animation.
Observe the biped and its movement.

2 From the

Application menu, choose Export.

3 Name the file mycreatebones.fbx. From the Save As Type list, choose
Autodesk (*.FBX), and then click Save.
3ds Max opens the Export FBX dialog.
4 Accept all the default values. and click OK.
Wait while the exporter calculates the TRS animation.

5 From the

Application menu, choose Reset.

The biped disappears and the viewports reset.
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6 From the
Application menu, choose Import, then import the
FBX file you just exported.
The import dialog appears.
7 In the Import Configuration group, click the More button next to Bones.
Use the Advanced Bone Options dialog that opens to set the Bone Objects
➤ Width and Length both to 3.
8 Click OK to close the dialog. Click OK again to import the FBX file and
create the bones.
A bone skeleton appears in the viewport.

9 Play the animation.
The skeleton has the identical animation as the original biped.
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10 Save your file as mycreatebones.max.

You can

open createbones_final.max for comparison.

See MotionBuilder Interoperability on page 1786 for more information about
working with bone animation, FBX files, and the MotionBuilder application.

Summary
This tutorial showed you a variety of ways to animate a Biped without using
Footsteps mode. In addition, it showed how you can apply a Biped animation
to a skeleton made from 3ds Max Bones.

Walk Cycles
Walk cycles are frequently used in animation. This section shows how to
animate both a biped walk and a quadruped walk.
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Both the Biped and CAT features can generate walk cycles for you, but creating
a walk cycle by hand is a traditional exercise for animators, and doing so can
help you understand how two-footed and four-footed creatures move about.
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Animating a Freeform Walk Cycle
While 3ds Max has a dedicated method (Footstep mode) for creating quick
and easy walking animations, you can also create walk cycles with freeform
animation.

In this lesson, you’ll use animated pivot points and IK blend keys to constrain
the feet to the ground plane.
Skill level: Intermediate to Advanced
Time to complete: 1 hour and 10 minutes

How a Biped Walks
If you don’t use Biped to create a walk for you, it helps to know that a human
walk cycle is defined by two steps: left foot to right foot, followed by right
foot to left foot (or vice versa). The two steps break down into four states:
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Left to right:
1. Contact
2. Down
3. Passing
4. Up
5. Contact again (same as 1, but with legs reversed)

1 Contact: Both feet are on the ground. At this point, the stride is at its
longest: this is known as an extreme pose.
2 Down or “Recoil”: After contact, the weight goes down on the front leg.
The body lowers, and both legs bend.
3 Passing or “Breakdown”: The front leg straightens and the back leg passes
it. The body raises to a point that is higher than in the contact position.
4 Up or “High Point”: The back foot is now the front one, and is about to
make contact. The other foot pushes up and forward, raising the body
to its highest position.
5 Contact: The same as pose 1, but with the opposite leg forward.
You can start animating the cycle at any of these poses. Animators often prefer
to begin with the contact pose, as that pose (in general, any extreme pose) is
a good reference to build from.
You have to decide how many frames the walk cycle will use. Twelve frames
yield two steps per second: this is a natural pace, which we will use in this
tutorial. Cartoonists sometimes use an 8-frame cycle to create a fast, humorous
walk. A 24-frame cycle would give (for film) one step per second, suitable for
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a slow-moving character. This tutorial uses a slightly slower 37 frames for the
cycle.

The First Step: Pivots and IK Keys
To use freeform animation for feet, yet keep those feet on the “ground” (the
3ds Max ground plane), you can use a system of pivot points and a few
different kind of IK keys. This lesson introduces those features.
Set up the scene:
1 Restart or reset 3ds Max.

2 On the

Create panel, click

(Systems).

Create a biped and load a FIG file:
1 Click to turn on
viewport.

(Biped), and create a biped in the Front

2 Go to the

Motion panel.

3 Turn on

(Figure Mode), then click

(Load File).

3ds Max displays the Open dialog.
4 Open the file tut_swimmer.fig. This file is in the folder
\sceneassets\animations\.
The biped takes on new structural elements stored in the FIG file. This
simplified figure has one large toe on each foot and one large finger on
each hand; its spine contains two segments instead of four.
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5 Turn off

(Figure Mode).

NOTE You cannot animate in Figure mode.

6 Click

(Zoom Extents All).

Set a key:
1 Change the Perspective viewport to Wireframe (press F3) and zoom in so
the feet are clearly visible.
2 Select Bip01 R Foot.
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3 On the

Motion panel ➤ Key Info rollout, click

(Set Key).

The foot is highlighted in white, and a key appears on the track bar at
frame 0. You have just started a freeform animation.

Track bar key at frame 0

Set different types of keys at frame zero:
There are two ways to set character animation keys in 3ds Max. You can use
the standard method of keyframing, which involves turning on Auto Key and
transforming objects. It is quick and easy, but if you forget that Auto Key is
on, you can set keys unintentionally.
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The second method uses the Set Key buttons on the Key Info rollout. These
buttons set several parameters at once. This is the method you'll use in the
steps that follow.

1 On the Track Selection rollout, click

(Body Vertical).

This selects the biped's center of mass, Bip01, and activates the
Move tool in one step. You’ve set a key for the foot, but there is a problem.
The foot can go through the ground plane. See for yourself in the next
few steps.
2 Right-click the Left viewport to activate it without changing the selection
set.
3 With the Body Vertical track still active on the Track Selection rollout,

move the center of mass down in the Left viewport.
The biped moves down through the ground plane (as indicated by the
grid in the Perspective viewport).
4 Press Ctrl+Z to undo the move.
Set planted keys:
Now you’ll set a planted key. A planted key does three things: It sets IK Blend
to 1, turns on Join To Previous IK Key, and also turns on Object Space.
Together, these three settings ensure that the foot will not pass through the
ground plane.
For more information about IK Keys, refer to the “Key Info Rollout” topic in
the 3ds Max Help.

1 In the Perspective viewport,

select Bip01 R Foot again.

2 On the Key Info rollout, click

(Set Planted Key).

The red pivot point becomes more pronounced.
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3 On the Track Selection rollout, click
(Body Vertical), and
move the biped down in the Left viewport.
The foot stays on the ground plane, and the knee bends to accommodate
the vertical movement of the biped.
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Planted foot stays on ground.

4 Press Ctrl+Z again to return the biped to its previous position.
Now you’ve seen the effect of the planted key on the foot. You can use the
same Set Key buttons on pivot points for the feet and hands. Next, you’ll
replace the key at frame 0 with a new one, changing the pivot point.
Set pivot keys:

1 At frame 0, right-click the Perspective viewport, and
R Foot.

select Bip01

It still has the planted key from before.
2 On the Key Info rollout, open the IK expansion bar and click Select Pivot.
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All pivot points for the foot are now visible as blue and red dots. The
pivot at the ankle is red, showing that this is the currently active pivot
point.
TIP Wireframe mode lets you clearly see and select the pivot points.
3 Click the pivot point on the ball of the foot, at the base of the toes.
The new pivot point is displayed in red.

NOTE You don’t have to set a key each time you choose the pivot point.
However, you should use the Set Key buttons if you want to change the Key
parameters.

4 Advance the time slider to frame 5, and click

(Set Key).

5 Right-click the foot and choose Rotate from the quad menu. On the main
toolbar, make sure that Reference Coordinate System is set to Local.

6

Rotate the foot up approximately –15 degrees about the local Z

axis to make the heel raise, and then click
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(Set Planted Key).

The heel lifts off the ground, the foot rotates on the ball, and the toes
stay on the ground.

Now you can animate the pivot point to the toes, as the ball of the foot lifts
off the ground.
Animate the pivot points:

1 Drag the time slider to frame 10, and then click

(Set Key).

2 Click Select Pivot, and then click the pivot on the end of the toe.
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3 Click

(Set Sliding Key) to set a key for the pivot.

4 Click Select Pivot again, to turn it off.
5 In the Perspective viewport, right-click the foot and choose Rotate from
the quad menu.

6

Rotate the right foot about –25 degrees around the Z axis so the
heel continues to raise and roll off the toes.
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7 Click

(Set Sliding Key) to keyframe the foot rotation.

The sliding key does not join to the previous key, but has IK Blend set to
1, which keeps the foot above the ground plane. If you had set a planted
key, the foot would jump to a different location as it attempted to join
to the previous key.
Save your work:

■

Save the scene as walkcycle_beginning.max.

Next
Complete the First Step on page 975

Complete the First Step
In this lesson, you complete the first step by moving the biped body forward
and its right foot to the contact position.
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Set up the scene
■

Continue from the previous lesson.

Lift the foot off the ground:
When the foot lifts off the ground completely, you’ll set a free key.
1 Drag the time slider to frame 15.
2 In the Left viewport, right-click the foot and choose Move from the quad

menu.

Move the foot up off the ground and forward.

By moving the foot, you are seeing an example of Biped’s IK system. You
are creating rotations for the upper and lower leg links as you move the
foot.

3 On the Key Info rollout, click
position of the foot.
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(Set Free Key) to keyframe the lifted

4 Scrub the time slider back and forth to observe the animation so far.
Lock down the opposite foot:

1 Drag the time slider back to frame 0 and

2 On the Key Info rollout, click

3 Click
frame 0.

select Bip01 L Foot.

(Set Key).

(Set Planted Key) to set an initial key for the left foot at

This key locks down the foot for any subsequent movement in upcoming
frames. If you were to grab the center of mass and move it down, both
legs would bend instead of moving below the ground plane.
4 Turn on Select Pivot and pick the pivot point at the ball of the foot.

The left foot with a new pivot point.

5 Click Select Pivot to turn it off.
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Keyframe the center of mass:

1 On the Track Selection rollout, click

(Body Horizontal).

Bip01 is automatically selected.

2 At frame 0, click

(Set Key) for Bip01.

This creates a start key for the center of mass.
3 Drag the time slider to frame 15.

4 In the Left viewport, use the Move Transform gizmo to

the center of mass so the torso shifts forward, and then
key.
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move

set another

NOTE Because the center of mass is the root node, you can use only Set
Key, not the specialized IK keys.

5 Use the Move Transform gizmo to

move the center of mass

down a little, so the left knee bends slightly, then
key.

set another

The left leg bends automatically as the center of mass moves down.

6

Select Bip01 L Foot.

7 On the Key Info rollout,

set a planted key for the ball of the foot.
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8 Right-click the left foot and choose Rotate from the quad menu.

Rotate the foot so the heel is lifting up off the ground, and then
set another planted key.
The heel is rotated off the ground.

9 Drag the time slider to frame 22, and click

(Set Key).

10 Right-click the Perspective viewport, turn on Select Pivot, and then pick
the pivot at the end of the toes of Bip01 L Foot.

11 On the Key Info rollout, click
Select Pivot.

12 In the Left viewport,

(Set Sliding Key), then turn off

rotate the left foot up a little more, and

set another sliding key.
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13 On the Track Selection rollout, click

Move the center of mass forward again, and

(Body Horizontal).

set a key.
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Keyframe the right heel hitting the ground:

1 At frame 22,

then

select Bip01 R Foot and

move it forward,

set a sliding key.

2 Turn on
(Select And Rotate), note the location of the gizmo
intersection, and then turn on Select Pivot (this tuns off Select And
Rotate). Pick the point at the ankle that lay at the gizmo intersection,
and then set a sliding key.
3 Turn off Select Pivot. Rotate the foot so it's parallel to the ground, and

then

set a sliding key.
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4 Turn on Select Pivot, and set the pivot to the heel.
sliding key.

Set another

The pivot point moved to the heel.

5 Turn off Select Pivot. Drag the time slider to frame 27.

6 In the Left viewport,

move the right foot forward a little.

Notice that the foot moves away from the pivot point in the viewport.
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Sliding Key lets foot move away from pivot.

7

Set a sliding key.
The pivot point in the viewport moves to the heel of the foot.

8

Move the right foot down so it touches the ground, and
set another sliding key.
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9 Turn on Select Pivot. Pick the pivot at the ball of the right foot.

The pivot moved to the ball of the right foot.

Walk Cycles | 985

10 Click

(Body Horizontal),

move the center of mass so

that it is over the heel of the right foot, and

11 At frame 27,

select Bip01 L Foot and

set a key.

set a free key.

12 Scrub the time slider and watch the animation of the foot and the pivot
points.
Save your work:

■

Save the scene as walkcycle_1step.max.
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Next
Complete the Walk Cycle on page 987

Complete the Walk Cycle
This lesson moves the biped forward and completes the walk cycle.
Set up the scene:
Continue from the previous lesson.

■

Continue the walk cycle:

1 At frame 27, click
mass.

2

(Body Vertical) so you can move the center of

Lower the body slightly, so the biped sinks a bit as the right foot

flattens onto the floor.

Set a key for the center of mass.

3 Drag the time slider ahead to frame 32.

so it’s over the ball of the right foot.
mass.

Move the center of mass

Set a key for the center of
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4

Move and

the ground.

rotate Bip01 L Foot so the heel swings above

Set a free key.
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Use this procedure throughout this exercise: Lock one foot by setting
planted or sliding keys, move the center of mass, then move the other
foot and set a key.
Complete the walk cycle:

1 Drag the time slider to frame 37, and click

Move the center of mass forward, and

(Body Horizontal).

set a key.
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2

Select Bip01 L Foot and

in front of the biped.

move it so the leg is extended

Set a free key.
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3

Rotate the left foot so the heel is down and the toes point

upward.

Set another free key.

Now the foot looks better.
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4 With the left foot selected, click Select Pivot and select the pivot at the

heel.

Set a planted key for the pivot.

5 Turn off Select Pivot.

6 Go to frame 39, and

rotate the left foot so it is flat on the ground.

7 With the left foot selected, click Select Pivot and select the pivot at the

heel.

8

Set a planted key for the pivot.

Set a planted key for the left foot.
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9 Click
(Body Horizontal) and
so the body moves forward.

10

move the center of mass

Set a key for the center of mass.

11 With the left foot selected, click Select Pivot and select the pivot at the

heel.

Set a planted key for the pivot.

12 At frame 41,

on the ground.

13

rotate the left toes (Bip01 L Toe0) so they are flat

Set a planted key.

Select Bip01 R Foot and drag the time slider back to frame 30.

Set a planted key.

14 At frame 32,
rotate the right toes so they are flat, and
set another planted key.

15 Drag the time slider to frame 37, and

little, then

rotate the right foot up a

set a planted key.

16 Scrub the time slider and review the motion. Add rotations for the toes
as needed.
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Save your work:

Save the scene as walkcycle_completed.max.

■

Next
Correct the Walk and Add Secondary Motion on page 994

Correct the Walk and Add Secondary Motion
Although the walk cycle is now complete, you can make the biped’s motion
more realistic by adding secondary motion such as swinging the arms, as this
lesson shows. This lesson also shows a way to correct biped motion by
examining the biped’s trajectory.
Set up the scene:
■

Continue from the previous lesson.

Display trajectories:
Biped has its own trajectory display. You can use it to observe the movement
of the center of mass in the walk cycle. You can also edit the keys on the
trajectory directly in the viewport.

1 On the Track selection rollout, click

2 On the Key Info rollout, turn on

(Body Horizontal).

Trajectories.

A line appears on the viewports showing the COM's trajectory: the path
it moves along during the animation.
WARNING Don’t use the standard Trajectories functionality (the button near
the top of the Motion panel) with Biped. Use the Trajectories button on the
Biped rollout ➤ Modes And Display expansion bar ➤ Display group or on
the Key Info rollout.
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3 Scrub the time slider, and watch the biped center of mass moving along
its trajectory.

4 On the main toolbar, turn on

(Select And Move) toolbar. At the

top of the
Motion panel, turn on Sub-Object, and then click any
key on the trajectory.

5 Use the Move Transform gizmo to
trajectory.

move the keys to correct the
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Edit keys in biped trajectory.

6 Turn off Sub-Object and Key Info rollout ➤

(Trajectories).

Add arm swings:
The character is starting to look like it’s walking, but it’s still quite stiff. Adding
arm swings will put some life in the animation.
The arms swing opposite to the legs. When the right leg is forward, the left
arm is forward. Arms bend at the elbow on the forward swing, and stretch out
straight on the backward swing.
1 Scrub the time slider to decide where to place the arm swings.
The right leg stretches out at frame 27, and you’ll keyframe the left arm
to swing there.

2 Turn on

(Auto Key).
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3 At frame 0,

move the left hand slightly, to set a key.

4 At frame 0,

move the right hand slightly, to set a key.

5 At frame 27,

move the left hand so it swings forward.

Position the arm so there is a slight bend at the elbow. Since Auto Key is
on, you have keyframed the arm by moving it.

6 On the Track Selection rollout, click

(Opposite).

The right hand is selected.

7

Move the right hand back slightly, so the arm is stretched out.
Now the left arm is forward and bent a little, while the right arm is back
and straight.
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8 In the Front viewport, double-click Bip01 R UpperArm.
The entire right arm is selected.
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9 On the

Motion panel, open the Copy/Paste rollout and click

(Copy Posture).

10 Click

(Create Collection). Name the Collection walkcycle1.

11 Turn on Create Snapshot From Viewport, just above the Paste Options
group.

12 Click

(Copy Posture). Name the Copied Posture RArm back.
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13 At frame 37, click

(Paste Posture Opposite).

The left arm swings behind the biped.
14 At frame 27, double-click Bip01 L UpperArm.
The entire left arm is selected.
15 On the Copy/Paste rollout, activate the Perspective viewport and click

(Copy Posture) again. Name the posture LArm forward.

16 At frame 37, click

(Paste Posture Opposite).

The right arm swings in front of the body.

17 Turn off

(Auto Key).

18 Scrub the time slider back and forth to evaluate the animation.
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Add sway to the shoulders and hips:
You’ve animated the character by moving its hands and feet and center of
mass. But the spine, hips, and head are still stationary. You’ll add some
rotations to the shoulders and hips to complete the walk cycle.

1

Select Bip01 Pelvis and drag the time slider to frame 15.
The left foot is locked at this frame with a planted key.
Be careful where you add the hip rotations. Don’t inadvertently disturb
the work you’ve done on the feet so far.
As the legs extend and swing forward, the hips rotate slightly in the
direction of the movement.

2

Rotate the pelvis about the Y-axis approximately –2 degrees,

and

set a key.

The pelvis will not accept too much rotation. When you set the key, the
pelvis corrects itself to account for the locked foot.
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Rotation added to the hips from
the Front view.

3 Drag the time slider back to frame 0.

degrees about the Y axis, and

4

Rotate the pelvis back 2

set a key.

Rotate the pelvis back about –3 degrees about the X axis, and

set a key.
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5 Drag the time slider to frame 32.

around the Y axis, then
set another key

6 Go to frame 39 and

axis again, then

Rotate the pelvis about 4 degrees

set a key. Repeat for the X axis, and

rotate the pelvis –2 degrees around the Y

set a key.

The procedure is the same for the spine. At frame 27, the arms swing out
in one direction. At frame 37, they swing in the opposite direction.

7

Select the biped spine object, Bip01 Spine.
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8 At frame 27,

rotate the spine in the direction of the arm swing

(about –6 degrees around the X axis), then

9 At frame 37,

the X axis, and

set a key.

rotate the spine approximately 12 degrees about

set a key.

The spine can freely rotate about all three axes. You can make adjustments
on each one. Rotate about the Z axis for a more stooped walk. Increase
rotation about the X axis to make the walk loose and floppy.
NOTE Instead of animating the spine, you can animate the clavicles to raise
or lower the shoulders.

Twist links mode:
The Bend Links rollout includes tools you can use for animation. You can use
either the Bend Links or the Twist Links to animate the bending and/or twisting
of the spine.

1 Turn on

(Figure Mode).

In the Structure Rollout, change Spine Links to 5.
You can have up to 10 spine links, but five is enough to observe the Twist
Links effect.

2 Turn off

(Figure Mode).

3 Turn on

(Auto Key).

4 On the Bend Links rollout, turn on Twist Links Mode.
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5

Select the Bip01 Spine object. This is the lowest spine object in
the biped.

6 Go to frame 0, and
rotate the object slightly about the X axis
to add a key. Do the same about the Y axis.

7 Drag the time slider to frame 27, and
rotate approximately 10
degrees about the X axis so the spine rotates following the swing of the
arms. The blue arm is swinging forward, so rotate the spine to match.

8 You can also

rotate –1 degree about the Y axis.

The slight rotation of the first spine object results in a larger effect further
up the hierarchy.
9 At frame 37, repeat the rotations but in the opposite direction, in order
to match the swinging of the green arm outward.
Save your work:

■

Save the scene as walkcycle_fullmotion.max.

Summary
You have animated a simple walk cycle using freeform animation and IK
constraints.
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You can use the footstep method of animation to create a walk cycle
automatically. To learn about this technique, see Creating a Distinctive Walk
on page 856.

Animating a Quadruped Walk
In these lessons, you'll animate a four-legged character, a dog, to walk in a
continuous way. You’ll use the ForeFeet option to make the fingers of the
biped hands behave like toes on forefeet.

Skill level: Intermediate to Advanced
Time to complete: 1 hour and 50 minutes

The Walk Cycle for Quadrupeds
A quadruped walk is essentially two biped walks on page 964 linked together,
but out of phase with each other. When a biped walks, the shifting weight on
the pelvis causes the up-down motion just described. For a quadruped, the
same weight shifts occur for the pelvis and the shoulders.
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Quadrupeds have different proportions than human bipeds. In particular:
■

The rib cage is elongated downwards, unlike the flatter human rib cage.

■

The shoulder blades lie along the side of the rib cage, not on the back.

■

There are no collarbones.
The lack of collarbones gives the shoulder blades more freedom. This affects
weight distribution on the front legs.
When you use Biped to animate a quadruped, its “clavicle” parts behave
more like shoulder blades.

In spite of these differences, and some others we will mention later, a 3ds Max
Biped can model a quadruped quite well. This tutorial uses a 24-frame cycle,
which comes to one step per second for each pair of feet.

Set Up the Scene
The first steps are to configure animation for the walk cycle, and then to adjust
the biped
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Set up the lesson:

■

On the Quick Access toolbar, click
(Open File), navigate to the
\character_animation\quadruped folder, and open quadruped_walk_1.max.
NOTE If a dialog asks whether you want to use the scene’s Gamma And LUT
settings, accept the scene Gamma settings, and click OK. If a dialog asks
whether to use the scene’s units, accept the scene units, and click OK.
This file contains the biped used for the dog. It is posed on all fours, and
has a tail.

If you prefer to start from scratch, you can duplicate this pose by rotating and
moving the biped’s pelvis, arms, and head.
Configure time and Auto Key behavior:

1 Click

(Time Configuration) to open the Time Configuration dialog.
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This button is located among the animation playback controls.

2 In the Frame Rate group, choose Film. This sets the frame rate to 24 frames
per second.

The rate of 24 fps is easier to work with, given our choice of a 12-frame
cycle for each pair of limbs. If later you want to output to NTSC video,
which has a frame rate of 30 fps, you can change the rate before you
render.
3 In the Animation group, change Start Time to 1 and End Time to 25.

This gives a 24-frame animation, with an extra frame at the end so the
walk cycle loops smoothly when you play it as feedback in 3ds Max
viewports. When you’re done, frame 1 and frame 25 will have the same
pose. If you were using the walk cycle in another context (for example,
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moving the walking dog along a path), you would trim off frame 25 and
use the cycle of frames 1 through 24 in the larger animation.
4 Click OK to close the Time Configuration dialog.
5 Choose Customize ➤ Preferences, and go to the Animation tab. In the
Auto Key Default Frame group, make sure On is turned on, and change
the frame value to 1.

This sets Auto Key to set an original-value key at frame 1, the first of this
animation, when you create a key at a different frame.
Set the biped to use ForeFeet.

1 Click any part of the biped to select it, then go to the
panel.

2 On the Biped rollout, click

Motion

(Figure Mode) to turn it on.

3 Open the Structure rollout, and then click ForeFeet to turn it on.
ForeFeet causes the biped fingers to behave like toes. You can think of
this option as “Four Feet.”
NOTE This biped has just one toe for each foot and one finger for each hand.
For most quadrupeds, the toes move as a group when walking, so the simplest
model works well.

4 Click

(Figure Mode) again to turn it off.
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5 Change the viewport to a Left view, then click

(Zoom Extents).

6 Select the biped’s right finger, and
rotate it so it is parallel with
the ground plane: about –30 degrees in the local Z axis.

7 Use

Finger0), and

(Select By Name) to select the biped’s left finger (Bip01 L

rotate it as you did the right finger.
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TIP Another difference between the anatomy of humans and most quadrupeds
(elephants are a notable exception), is that the hind legs appear to have an extra
joint. Actually, this is because the foot is extended, and the weight rests on the
ball of the foot. In Biped, you can add an extra joint or “link” to the leg, but
increasing Leg Links to 4 causes Biped to generate additional animation keys that
you might not want. It seems easier to leave Leg Links at its default of 3, and
increase the length of the foot link, as has been done in this model.

Elongated hind foot in a familiar quadruped

Save your work:
■

Save the file as my_quadruped_adjusted.max.

Next
Block the Steps for the Forelegs on page 1013
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Block the Steps for the Forelegs
Now that you’ve adjusted time settings and the biped itself, you’re ready to
block the basic walk cycle, working from pose to pose. This involves positioning
the legs in space and time, giving the walk its overall tempo. You will begin
with the quadruped’s forelegs.
Set up the scene:

■

On the Quick Access toolbar, click
(Open File), navigate to the
\character_animation\quadruped folder, and open quadruped_walk_2.max.
This scene is the same as the one you just saved, but a set of reference poses
has been set up on planes in the background.

Configure character studio:

1 Use
(Orbit) to change the viewport so you can see all four of the
quadruped’s feet.
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2

Use Ctrl+click to select both hind feet and both hands (forefeet).

3 On the

Motion panel ➤ Quaternion/Euler rollout, choose Euler.

Euler keys have tangent controls, which can be useful for this walk cycle
exercise.
4 On the 3ds Max status bar, to the right of the Set Key button, choose

(Linear) as the Default In/Out Tangent type.
Sometimes blocking the animation is easier without extra interpolation
(which you can add later).
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5 Also on the
Motion panel, open the Key Info rollout and expand
its IK group (click the plus-sign icon to the left of the IK label).

6 Finally, open the Copy/Paste rollout as well.
TIP To see both the expanded Key Info rollout and the Copy/Paste rollout,
it might help to make the Command panel two columns wide: drag the left
border of the Command panel to the left to make the Command panel wider.
7 Press Shift+Z to undo the viewport change and return to the Left view.
(Depending on how you adjusted the viewport, you might have to click
Shift+Z more than once to return to the Left view.)
Begin posing the front legs:

1 Make sure you are at frame 1, then turn on

(Auto Key).

2 Use both
(Move) and
(Rotate) to position the arms
(forelegs) and hands (forefeet) to match the reference sketch. This is the
Passing pose. (The quadruped’s hind legs are in the Down pose.)
TIP While a single biped (quadruped) part is selected, the PageUp and
PageDown buttons move up and down the hierarchy.
You don’t have to match the sketch accurately: a general idea of the pose
is the goal.

TIP If you find it difficult to select a part of the arms by clicking, use
(Select By Name).
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3

Select the right hand (forefoot), then on the Key Info rollout,

click

(Set Sliding Key). Do the same for the left hand (forefoot).

NOTE Both Set Planted Key and Set Sliding Key set IK Blend equal to 1, but
only Set Planted Key turns on Join To Prev IK Key. Join To Prev IK Key causes
the limb to snap to the pivot set in the previous IK key. Set Sliding Key doesn’t
cause the pivot snap; this contributes to a more natural motion for the
forelegs.
One advantage of the ForeFeet toggle is that it lets you set keys such as
this for “hands” on the ground plane, as you do for feet.
NOTE The track bar shows sliding keys in yellow, planted keys in orange,
and free keys in gray.
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4

Double-click the right clavicle to select the entire arm (foreleg),

then on the Copy/Paste rollout, click

(Copy Posture).

5 In the Copy/Paste rollout ➤ Paste Options group, under Auto-Key TCB
/ IK Values, choose Copied.
When Copied is chosen, IK info is pasted along with the new key. When
Default is chosen, IK info is not pasted and the new key is a free key, FK
rather than IK, which is not what you want for this animation.

6

Go to the last frame (frame 25), and then click
Posture).

7 Go to frame 13, and then click

(Paste

(Paste Posture Opposite).

Frame 13 is the midpoint of the walk cycle animation: frames 13 through
24 are essentially the same poses as frames 1 through 12, but with the
legs in opposite positions. (Frame 25 is the same as frame 1, so that the
animation will play as a seamless loop when you preview it in viewports.)
8 Click the Point Of View (POV) viewport label, and choose Right to change
the viewport to a Right viewport.
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9

Go to frame 1,
the left arm (foreleg).

10 Click

11

double-click the left clavicle to select all

(Copy Posture).

Go to frame 25, then click

12 Go to frame 13, then click

(Paste Posture).

Paste Posture Opposite.

Now the forearms/legs have the same posture in the extreme poses: the
first and last frames of the cycle, and the mid frame.
TIP When you use Paste Posture Opposite, don’t be alarmed that a key
doesn’t appear on the Track Bar: the original limb is still selected, so you
won’t see keys for the opposite limb.
13 Press Shift+Z to undo the viewport change and return to the Left view.
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Add the other three poses:

1 Make sure that

(Auto Key) is still on.

2 As in the previous procedure, use
(Move) and
to set up the transitional poses, as follows:
■

Frame 4, Up

■

Frame 7, Contact

(Rotate)
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NOTE The sketches have a bit of perspective, so the left feet appear a bit
raised from the ground plane, but as you’re working in 3D, at contact
both feet can rest on the ground.
■

Frame 10, Down
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3 Also as earlier, after you create each pose,

and click

select the right forefoot

(Set Sliding Key), then do the same for the left forefoot.

Check your work by looking at trajectories:

1

Double-click the right clavicle to select all of the right foreleg.

2 On the Key Info rollout, click

(Trajectories) to turn int on.

3 Scrub the time slider.
The elbow trajectory describes an arc, and the foot trajectory describes a
rough trapezoid.
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4

Double-click the left clavicle to see the trajectories for that limb,
as well.

Copy poses to the second half of the cycle:

1 Go to frame 4.

Double-click the right clavicle to select the entire

foreleg, then click

(Copy Posture).

2 Go to frame 16, and click

3

(Paste Posture Opposite).

(Copy) then
(Paste Posture Opposite) from the right
foreleg in frame 7 to the left foreleg in frame 19, and from the right foreleg
in frame 10 to the left foreleg in frame 22.

4 Repeat the previous three steps, but copying the left foreleg poses to the
right foreleg at the same three frames.
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Preview your work:

1 Click

(Play) to see the animation.

The quadruped’s forelegs now move in a plausible walk cycle.

2 Click

(Stop).

Save your work:

Save the file as my_quadruped_forelegs.max.

■

Next
Block the Steps for the Hind Legs on page 1023

Block the Steps for the Hind Legs
Creating steps for the hind legs essentially repeats the work you did for the
forelegs.
Set up the scene:
■

Continue from the previous lesson.

Start with the Down frames:

1 Go to frame 1. Use
(Move) and
(Rotate) to pose the
hind legs in the Down pose, using the reference sketch as a guide.
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2

Set a sliding key for each foot.

3

Double-click the right thigh to select the whole hind leg, then

click

(Copy Posture).

4 Go to frame 25, then click

(Paste Posture).

5 Go to frame 13, then click

(Paste Posture Opposite).

6 Repeat steps 3 to 5 for the left leg.
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Add the intermediate poses:

1 Use
(Move) and
intermediate frames, as follows:
■

Frame 4, Passing

■

Frame 7, Up

(Rotate) to pose the legs at the
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■

Frame 10, Contact
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NOTE For now, don’t worry if the front and hind feet overlap in space
at the hind legs’ crossing pose. You will fix this later.

2

Set sliding keys for the feet.

Copy poses to the second half of the walk cycle:

➤

For each hind leg,
copy the intermediate poses and
paste
them to the opposite hind leg in the second half of the walk cycle, as
follows:
■

Frame 4 to frame 16

■

Frame 7 to frame 19

■

Frame 10 to frame 22
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Preview your work:

1

Click Play to see the animation.
Now all the legs move in a plausible walk cycle. The effect is still a bit
stiff and mechanical: you will correct that in the following lesson.
TIP If the animation looks too jerky at points, you can stop playback, adjust
poses (Auto Key should still be on), and scrub the time slider to see how it
appears. The goal is a smooth-looking walk, but it doesn’t have to be perfect.

2

Click Stop.

Save your work:

Save the file as my_quadruped_alllegs.max.

■

Next
Add Weight Shifts and Spine Movement on page 1028

Add Weight Shifts and Spine Movement
For a more realistic walk, the quadruped’s hips and shoulders need to move
up and down as the weight of the animal shifts from leg to leg. You will create
a layer that contains this animation. Using a new layer allows you to compare
the original animation with the newly created keys. When you are satisfied
with the new animation, you can collapse layers to integrate the old and new
animation.
Set up the scene:
■

Continue from the previous lesson, or navigate to the

\character_animation\quadruped folder, and
quadruped_walk_3.max.
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open

Create a layer for the hip and shoulder motion:

1

Select any part of the quadruped, go to the
panel, and open the Layers rollout.

2 On the Layers rollout, click
Center of Mass & Spine.

Motion

(Create Layer). Name the new layer

3 Also on the Layers rollout, in the Retargeting group, turn on the

retargeting buttons for all four legs. Turn on IK
Only as well.

These controls preserve the IK constraints from the animation on the
base layer. Without them, moving the quadruped’s center of mass (COM)
would simply translate the entire quadruped, disregarding the sliding
keys you created earlier to control the feet.
4 Click Update.
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If you select a foot, you can see that the sliding keys now appear in the
Track Bar for this layer.
Create movement for the hips:

1 On the

Motion panel, open the Track Selection rollout. Click

(Body Vertical) to turn it on. This selects the COM, as well.
Because the quadruped is walking in place, you need to adjust only the
vertical position of the COM.

2 Go to frame 1. Turn on
(Auto Key), then
move the
COM down slightly (frame 1, as you might recall, is a Down pose).
NOTE When you work with layers, the viewport feedback isn’t fully interactive:
as you move the COM, the feet descend below the ground plane. After you
release the mouse, 3ds Max recalculates IK and the feet snap into the position
where they should be.
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Lowered COM for the Down pose

As you animate on the Center of Mass & Spine layer, viewports show the
original animation as a red stick figure with a box for a head.
3 On the Track Bar Shift+drag the new COM key to make a copy of it at
frame 13 and frame 25, the other two Down frames in this cycle.

4 Go to frame 7, the Up state, and
is higher than the original animation.

move the COM to a point that
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Raised COM for the Up pose

IMPORTANT When you raise the COM, try to make sure that the limbs are
not extended too far: if they are fully extended, then Biped tends to generate
abrupt motion, which doesn’t look good or natural.
5 Shift+drag the new key from frame 7 to create a copy at frame 19.

6 Go to frame 10, the first Contact pose for the hind legs, and
move the COM to a vertical position midway between its heights for the
Down and Up poses.
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7 Shift+drag the new key from frame 10 to create a copy at frame 22.
If you scrub the time slider or play the animation, you can see that the
hips now bob up and down in a more convincing version of a walk. The
shoulders and spine still seem rigid.
Create movement for the shoulders:

1 Go to frame 1. Make sure

(Auto Key) is still on.

2

Select the lowest spine link, Bip01 Spine, and
up a bit (not too much).

rotate it

3

Select the next spine link, Bip01 Spine 1, and
link down a bit.

rotate this
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The goal is to have the outline of the spine match the contour of the
dog’s body in the reference sketch.

4 Shift+drag to copy the new key from frame 1 to frames 13 and 25.

5 Go to frame 7, the Contact pose for the forelegs, and
repeat
these adjustments to the lower two spine links. Again, you want to have
the spine follow the dog’s body in the sketches. At Contact for the
forelegs, the dog’s weight shifts from the pelvis to the shoulders.
In this step, you might want to adjust the third spine link, Bip01 Spine 2,
down a little bit, as well.
After you adjust the spine, if the forefeet don’t appear to be reaching the
ground plane properly, go to the Layers rollout ➤ Retargeting group,
and click Update.
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6 Shift+drag to copy the new key from frame 7 to frame 19.
If you scrub the Time Slider, you can see that the spine already has a
more fluid movement.

7 Go to frame 4, the Up pose for the forelegs. Again,
rotate the
spine links to follow the dog’s body. For this pose, the spine should be a
bit higher than the pelvis.
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8 Shift+drag to copy the new key from frame 4 to frame 16.
With the spine movement added, the quadruped looks less like a robot and
more like an animal walking.
Add some head movement:

1 Go to frame 1, and

select the head of the quadruped.

2 On the Key Info rollout, click

(Set Key).

This sets a key for the head and the upper neck link, Bip01 Neck1.
3 Shift+drag the new key from frame 1 and copy it to frame 25, then copy
it to frame 11 as well.
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4

Select the lower neck link, Bip01 Neck, then click
Key) to set a key for it as well.

(Set

5 Shift+drag the neck key to copy it to frames 11 and 25, as you did for the
head.
You’ve now set up a reference pose about which other head poses can
move. Head movement is secondary motion. It’s called “secondary” because
the walk doesn’t depend on it, and it doesn’t affect the leg or body
motion. However, secondary motion can add a great deal of life to an
animation.

6 Go to frame 7. Make sure
(Auto Key) is on, then
rotate the neck and head upward slightly.

The idea is that in general, the dog looks where it is going when it’s
forelegs are in the Contact position.
7 Shift+drag the new key to copy it to frame 19.
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8 Go to frame 11.
Rotate the neck links so they are roughly parallel
to the ground, and then rotate the head so it is looking slightly down.

As you probably noticed, frame 11 comes one frame after the Down pose
at frame 10. Secondary motion tends to lag a little behind primary motion.
Also, setting keys slightly out of phase in this way helps keep the
animation from appearing too mechanical.
9 Shift+drag the new key to copy it to frame 22.
Save your work:

■

Save the file as my_quadruped_legs_spine_head.max.

Next
Polish the Walk Cycle on page 1039
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Polish the Walk Cycle
Set up the scene:
Continue from the previous lesson, or navigate to the

■

\character_animation\quadruped folder, and
quadruped_walk_4.max.

open

Collapse the layers:

1

Select any part of the quadruped, then go to the

Motion

panel.

2 On the Layers rollout, click

(Collapse).

Now the scene contains only a single layer of Biped animation: the keys
you created on the Center of Mass & Spine layer are transferred to the main
timeline.
Smooth out the trajectories:

1

Click and Ctrl+click to select all four of the quadruped’s feet.

2 On the main toolbar click

(Curve Editor (Open)).

3 If you need to, pan the Controller window until you can see the tracks
for all four feet. Expand the hierarchy if you need to, and Ctrl+click to
select all four Transform tracks.

4 On the Track View status bar, turn on
Toggle).

(Filter - Selected Tracks
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This simplifies the Controller window display by showing only selected
tracks.
5 Make sure you can see all keys in the Function Curves window.

TIP You might have to click
(Zoom Horizontal Extents) and
(Zoom Value Extents) (on the Track View status bar) to see all the keys.

6 Drag a selection box to select all the keys in the animation.
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7 On the Track View toolbar (the Key Tangents toolbar), click
Tangents To Smooth).

(Set

Smooth tangents give the animation a more organic feel, making it less
abrupt.

8 Close Track View.
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Trajectories of the dog’s right forefoot and knee before
smoothing

Trajectories of the dog’s right forefoot and knee after smoothing

9

Play the animation.
The dog’s walk is now much smoother, and feels more “integrated”: more
a single movement, and less a collection of individual movements.
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Give the shoulder blades more freedom:

1 Turn on

(Auto Key). Go to frame 1, select the dog’s shoulder

blade (Biped01 R Clavicle), then
the local Z axis.

rotate it up about 35 degrees in

2 Make sure only the shoulder blade/clavicle is selected, then on the Copy/Paste

rollout, click

3 Click
13.

(Copy Posture).

(Paste Posture) to paste the shoulder blade posture at frame

4 At frame 25, don’t paste the posture, but rotate the shoulder blade up
about 30 degrees.
Pasting the pose lifts the dog’s foot off the ground, and we don’t want
that to happen.

5 Click
(Paste Posture Opposite) to paste shoulder blade posture
onto the left shoulder blade at frames 1, 13, and 25.

6

Switch to display all four viewports before you preview the
animation.
We have been working mostly in the Left viewport, but this is a
three-dimensional animation, and it helps to look at the motion from
other points of view.
With more movement in the shoulder blades, the quadruped walk has
more of a loping feel to it: a gait that we associate with wolves and larger
dogs.

Walk Cycles | 1043

Add some side-to-side movement to the pelvis:

1

Maximize the Top viewport.

2 Make sure

(Auto Key) is on.

3 On the main toolbar, turn on

frame 1,
local Y axis.

(Angle Snap Toggle). Then at

rotate the pelvis to the dog’s right, 15 degrees in the
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4 Go to frame 13.
in the local Y axis.

Rotate the pelvis to the dog’s left: –30 degrees

5 Finally, go to Frame 25, and
1 position: 30 in the local Y axis.

restore the pelvis back to its frame

You can preview the animation, but the pelvis movement is really a basis
for the spine movement, which you will add next.
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Add side-to-side movement to the spine:

1 Make sure
both on.

(Auto Key) and

(Angle Snap Toggle) are

2 Activate the Top viewport, if it isn’t active already.

3 At frame 1,

4

select the lowest link of the spine, Bip01 Spine.

Rotate Bip01 Spine to the dog’s right, 15 degrees in the local Y
axis.
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Notice that Biped maintains the head facing forward, which is what you
want it to do.

5 Also at frame 1,
rotate Bip01 Spine02 –10 degrees in the local Y
axis, and then rotate Bip01 Spine03 (the shoulders) –15 degrees in the
local Y axis.
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The spine describes an S-curve as the dog walks, with the shoulders
rotating in the opposite direction from the hips.
WARNING Don’t use Page Up or Page Down to select spine links. This select
other biped parts as well, such as arm and leg links, and will generate
unwanted animation.

6 Go to frame 13.
Rotate the three spine links in the opposite
direction: –15 degrees in the local Y axis for Bip01 Spine; 10 degrees for
Bip01 Spine02; and 15 degrees for the shoulders, Bip01 Spine03.
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Because of other Biped keys, the spine returns to a straight posture by
frame 5, so you don’t have to “overcompensate” the rotation value as
you did for the hips.

7 Finally, go to frame 25 and
rotate the spine to its frame 1
position: 15 degrees in the local Y axis for Bip01 Spine; –10 degrees for
Bip01 Spine02; and –15 degrees for the shoulders, Bip01 Spine03
The last bit of movement to add is, appropriately, the tail, which mirrors the
spine movement in a similar S-curve. Like head movement, tail movement is
a secondary motion that doesn’t affect the mechanics of the walk, but does
give it greater realism.
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Add side-to-side movement to the tail:

1 Make sure
both on.

(Auto Key) and

(Angle Snap Toggle) are

2 Activate the Top viewport, if it isn’t active already.

3 At frame 1,

4

select the lowest link of the tail, Bip01 Tail.

Rotate Bip01 Tail to the dog’s left, –15 degrees in the local Y axis.
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5

Rotate the remaining three tail links in the opposite direction,
to counter the side-to-side motion of the spine.

6 Go to frame 13 and as you did for the spine,
to mirror the frame 1 pose.

rotate the tail links
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7 Go to frame 25 and

restore the tail to its frame 1 pose.

TIP To save time, you can

their posture at frame 1, and
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select all the tail links,

copy

paste the posture at frame 25.

8 Turn off

(Auto Key).

Correct the intersecting feet:
The last bit of “polish” to add to the dog’s walk is to remove the intersecting
feet that was a result of simple footstep blocking.

1 Click
viewports.

(Maximize Viewport Toggle) so you can see all four

2 Drag the time slider to frame 10. At this point, the right forefoot intersects
the right hind foot.

3 In the Left viewport,

the hind foot, and then click

move the foot up and out of the way of

(Set Sliding Key).
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Now the forefoot lifts out of the way before the hind foot steps down.
Scrub the time slider to make sure you’ve corrected the intersection: the
forefoot should lift from the ground just before the hind foot descends.
4 Drag the time slider to frame 22.
Here there is the same problem with the left feet intersecting.

5 As you did for the right forefoot,

move the left forefoot up and

away from the descending hind foot, and then click
Key).

(Set Sliding

Now neither the right nor left feet intersect during the walk.
Preview your work:

■

Now you’ve finished animating the dog’s walk.

viewports, and
you’re done.

play the animation.
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Switch to all four

Stop playback when

Save your work:

Save the file as my_quadruped_completedwalk.max.

■

To see a completed version of the animation,
quadruped_walk_completed.max.

open

Summary
In essence, a quadruped walk cycle combines two biped walk cycles. This
tutorial demonstrated the ForeFeet toggle that enables hands to behave as
feet, with sliding keys on the ground plane. It also showed one way to smooth
tangents for a better-integrated animation.

Notes on Looping and Reloading Biped Animation
To loop the quadruped walk (or other Biped animation), 3ds Max doesn’t
allow you to use Parameter Curve Out-Of-Range Types, but you can use the
Motion Mixer to loop a walk cycle.
Also, when you have rotated the COM as you did for the quadruped, if you
save the motion as a BIP file you should save a FIG file as well as a BIP file.
Then the method to use depends on how you are loading the BIP file:
■

If you load the BIP file motion onto a new Biped, then after you click

(Load File) on the Motion panel, in the Open dialog, turn on
Restructure Biped To Match File.
■

If you use the Motion Mixer to add the BIP file to the animation, then first

go into Figure Mode and
load the FIG file onto your Biped.
The FIG file saves the COM rotation data, so you need to load it before
loading the BIP animation: Otherwise, the orientation of the motion will
not match the rest of the scene.
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1056

Materials and Mapping
Tutorials

6

Materials are like paint. With materials, you make apples red and oranges orange. You put
the shine in chrome and the polish on glass. By applying maps, you can add images, patterns,
and even surface texture to objects. Materials are what make your scenes look real.
Mapping is a method of projecting pictorial information (materials) onto surfaces. It is a lot
like wrapping a present with wrapping paper, except the pattern is projected mathematically,
with modifiers, rather than being taped to the surface.
This tutorial introduces the Material Editor, the master design studio for materials and maps.
In the following tutorials, you will learn how to assign materials to objects, how to create
basic materials, and how to apply textures.
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Features Covered in This Section
■

Using the 3ds Max Material Editor to create, edit and apply materials.

■

How mapping coordinates work, and how to manipulate them using 3ds Max modifiers.

■

How to layer multiple texture maps onto a surface to create a composite image.

■

How to map textures onto curved surfaces.

■

How to apply multiple sub-maps similar objects to give each their own unique identity.
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Introduction to Materials and Mapping
To introduce materials, you will work with a scene that shows an army
compound: a field headquarters that has been built around a farmhouse.

A rendering of the field headquarters after you have completed the tutorial

In this tutorial, you will learn how to:
■

Create basic materials.

■

Assign materials to objects in the scene.

■

Create and adjust mapping coordinates.

■

Use texture, opacity, and bump mapping.

■

Use 3D procedural materials.

Skill level: Basic to Intermediate
Time to complete: 1 1/2 hours
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Applying Materials and Textures
You begin with a scene that has only a few materials in it.
Set up the lesson:

■

On the Quick Access toolbar, click
(Open File), navigate to
\scenes\materials_and_mapping\intro_to_materials\ and open
army_compound.max.
NOTE If a dialog asks whether you want to use the scene’s Gamma And LUT
settings, accept the scene Gamma settings, and click OK. If a dialog asks
whether to use the scene’s units, accept the scene units, and click OK.
Except for the vehicles, the jeeps and helicopter, this scene contains no
materials. The buildings and terrain have a featureless, plastic look to them
that is typical of newly created geometry in 3ds Max.

The field headquarters before you apply materials
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You’ll begin by adding textures to the utility containers in the fenced area at
the rear of the compound.
Isolate the utility containers:
1 On the main toolbar, open the Named Selection Sets drop-down list, and
choose the Utilities selection set.

3ds Max selects the various containers.
2 Right-click the viewport to display the quad menu, and choose Isolate
Selection.
This command is in the upper-right, Display quadrant.
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3ds Max displays the utility containers in the center of the viewport, and
hides the other scene geometry.
TIP You might have to move the Warning: Isolated Selection dialog to see
the geometry clearly.

3 Use
clearly.

(Orbit) to adjust the view so you can see all five containers
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The isolated set of containers

Now you’re ready to begin creating materials for these objects.
Apply a basic material to the oil tanks:

1 Turn on

(Select Object).

2 Click an empty area of the viewport to deselect the Utilities set, and then
click OilTank01 (the front cylindrical object on the right) to select it.
3 Ctrl+click OilTank02 and OilTank03 to select them as well.

4 On the main toolbar, click
Material Editor.

(Material Editor) to open the Slate
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TIP If this is the first time you are using the Slate Material Editor, you might
need to resize it so you can easily see all three of the columns in its interface.
Also, to see changes in the viewport, it will help to minimize the Slate Material
Editor while you work, and then restore it when you need to work on materials
some more.
The Material Editor is a sort of workbench for creating, adjusting,
managing, and applying materials to objects. The main portions of its
interface are:
■

On the left, a Material/Map Browser panel where you can choose
material and map types (or ready-made materials) to add to the scene.

■

In the middle a View panel where materials and maps appear as nodes
that you can wire together.

■

On the lower right, a Parameter Editor where you can edit the material
and map controls.
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TIP If the Compact Material Editor opens instead, then on the Material Editor
menu bar, choose Modes ➤ Slate Material Editor. The Compact Material
Editor has a smaller window, with conspicuous sample slots near the top of
its interface.
5 On the Material/Map Browser panel at the left, locate Materials ➤
Standard ➤ Standard, then drag the Standard entry from the Browser
and drop it in the active View (the large panel labeled View1 in the center
of the Editor).
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A node for the Standard material appears in the active View.
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6 Double-click the Standard material node to display parameters for the
material in the Parameter Editor on the right side of the Slate Material
Editor.
7 In the material Name field, near the top of the Parameter Editor, enter
Oil Tanks as the material name.
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Notice that as you enter the name in the Name field, the name in the
title bar of the node also updates.
It is good to get in the habit of naming a material as soon as you create
it. In a complex scene, intelligible material names are useful.
8 On the Blinn Basic Parameters rollout, below the Name field, click the
color swatch that is labeled Diffuse.
3ds Max opens a Color Selector dialog.
Use the Red/Green/Blue controls on the Color Selector to choose a yellow
color. Set Red = 200, Green = 200, and Blue = 0.

The diffuse color of a material is the color that appears under diffuse, or
scattered, light. It is what we usually think of as “the” color of a material,
and what you will set first, when you create a basic material such as this
one.
9 Click OK to close the Color Selector.

10 On the Slate Material Editor toolbar, click
Selection).

(Assign Material To

In the viewport, the oil canisters turn yellow.
11 Look at the material preview in the title bar: it now has angled corners.
Double-click the preview to make it larger so you can get a better look.
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Angled corners on a material preview mean that the material has been
applied to at least one object in the scene. When the angled corners are
solid white, as they are in this case, the material is said to be hot. When
you make changes to a hot material, the scene changes immediately, and
usually the viewport display shows the material changes you have made.
You will take advantage of adjusting a “hot” material in the next set of
steps.
Make the oil tanks shiny:
Make sure that the three oil tanks are still selected, and that the Oil Tanks
material is still active.
1 On the Blinn Basic Parameters rollout, in the Specular Highlights group,
change the value of Specular Level to 90.
Bright highlights appear on both the sphere in the preview, and the oil
tanks in the viewport.
2 Also in the Specular Highlights group, change the Glossiness value to 32.
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Left: Preview with the oil tank material
Right: Specular highlight controls with Glossiness = 32

As you can see the preview and in the graph to the right of the Specular
Highlight and Glossiness controls, the highlight is now narrower. Specular
Level controls how bright highlights are, while Glossiness controls
highlight width. In general, shinier materials have smaller highlights.
You have used basic material controls, Diffuse color, Specular Level, and
Glossiness, to create a simple material that has the appearance of a moderately
shiny paint. This completes the material for the oil tanks.
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The oil tanks with their material

Apply a texture map to the ammunition canister:
For the ammunition canister, you will use a bitmap. Bitmaps are a versatile
way to add visual detail to scenes, and we use them extensively in this scene.
When a bitmap is used to provide an object’s color, it is also known as a texture
map. The texture map you apply to the canister shows a section of metal
plating with a “checkered” pattern.
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Texture map for the ammunition canister

1 In the Slate Material Editor ➤ active View, move the Oil Tanks node to
one side.
2 Drag another Standard material node into the active View. Double-click
the node to display the material parameters, then in the Name field,
change the name of the material to Canister.
3 In the Slate Material Editor ➤ Material/Map Browser panel, at the left,
locate Maps ➤ Standard ➤ Bitmap, and drag this map type into the
active View.
3ds Max opens a file dialog.
4 In the file dialog, click to highlight the file metals.checker.plate.jpg (it is
in the project folder \sceneassets\images\, like all the maps for the
tutorials), and then click Open.
3ds Max adds this Bitmap node to the active view.
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5 Drag from the Bitmap node’s output socket (the circular control at the
right of the node). When you drag, 3ds Max creates a wire.
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Drop the wire on the input socket for the Canister node’s Diffuse Color
component.
The Bitmap is now wired to the material.
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After you wire the Bitmap, 3ds Max also adds a Controller node (you
could use this, if you wanted, to animate the Bitmap’s Amount value).
6 Click the new Bitmap node to highlight it.

7 On the Slate Material Editor toolbar, click
to turn it on.

(Show Map In Viewport)

A red diagonal shape appears in the Bitmap title bar, to indicate that
Show Map is active.
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8 Click the Canister node to highlight it again.
9 Move the Slate Material Editor window so you can see both the objects
in the viewport, and the Canister node in the active View. Make sure that
none of the utility objects is selected, then drag from the output socket
of the Canister node (the output socket is the round control at the right
of the node), drag to the viewport, and then release the mouse over the
blue canister in the middle of the group.

Dragging from the output socket of the Canister material

3ds Max applies the Canister material to the ammunition canister.
Dragging and dropping from the output socket of a material node is an

alternative to using

(Assign Material To Selection).
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Adjust the metal plate mapping:

If you
zoom in, you can see that the mapping is not as good as it could
be. The top and sides of the canister look all right, but there is streaking where
the top of the canister has beveled faces.

Streaks in the texture when using the default mapping

To fix this, you use a modifier called UVW Map.

1

Select the canister object, which is named Ammo, and go to the

Modify panel.
2 Open the drop-down Modifier list, and choose UVW Map from the list.
TIP Once you open the list, you can press U a couple times until the list
highlights UVW Map, and then press Enter.
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3 In the Parameters rollout ➤ Mapping group, choose Box.
The radio buttons at the top of the Mapping group (Planar, Cylindrical,
Spherical, and so on) tell the UVW Map modifier how to project the map
onto the object. Box mapping projects the map from all six sides, so the
texture display is more uniform.
4 Also in the Mapping group, set Length = Width = Height = 2.0m.
Now the mapping is uniform and looks good from any angle.
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The texture corrected using UVW Map

Clean up the Slate Material Editor interface:
1 In the Slate Material Editor ➤ active View, click a node to select it, then
press Ctrl+A to select all nodes in the View.
2 Press Delete.
Deleting nodes from the active View simply cleans up the View for further
work. It does not remove the materials from the scene: You can still see
the materials you created (as well as in the Material/Map Browser ➤
Scene Materials group.
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If you need to edit a material again, you can drag it from this group and
into the View as an instance.
NOTE You also have the option of maintaining multiple Views of the materials
for your scene. See the 3ds Max help for more details.

Apply a 3D material to the generators:
Finally, for the generators, you will use a 3D procedural map. A bitmap is
simply a digital image such as a scan or a photograph. A 3D map, on the other
hand, is generated by 3ds Max.

1

Select Generator01 and Generator02, the large boxy objects to
the left.

2 In the Slate Material Editor, drag another Standard material node into
the active View. Double-click the node, then name the material
Camouflage.
3 Drag a Noise map from the Material/Map Browser panel into the active
view, and wire it to the Camouflage material’s Diffuse Color component.
4 Double-click the Noise node to display its parameters. On the Noise
Parameters rollout, click the color swatch labeled Color #1.
3ds Max opens a Color Selector.
5 Change Color #1 to a dark green: Red = 0, Green = 175, Blue = 0.
6 Click the color swatch labeled Color #2. On the Color Selector, change
Color #2 to a tan: Red = 200, Green = 155, Blue = 0.
7 Click OK to close the Color Selector.

1080 | Chapter 6 Materials and Mapping Tutorials

8 Click the Camouflage material node again to make it active.

9 Click
(Assign Material To Selection), and then click
Map In Viewport) to turn it on.

(Show

The map appears in the viewport, but the camouflage pattern isn’t very
apparent.
10 On the Noise Parameters rollout, change the Noise Threshold values. Set
High = 0.51 and Low = 0.49. In addition, change the Size value to 18.0.
Now the generator casings have a recognizable camouflage pattern. A
bonus of the procedurally generated 3D Noise texture, is that the pattern
is not quite the same on either generator. (This effect is more apparent
when you render the scene: In viewports, both generators look much the
same.)
You now have a reasonably realistic texture for all of the containers in the
utilities area of the compound.

Utility containers with their textures
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View the entire scene again:
■

In the Warning: Isolated Selection dialog, click Exit Isolation Mode.

The viewport shows the entire scene once again.
Apply a texture map to the terrain:
For the last step in this lesson, you will apply a texture to the terrain beneath
and surrounding the compound.

Terrain texture for the army compound

1 In the Slate Material Editor, drag another Standard material node into
the active View. Double-click the node to display the material parameters,
then in the Name field, change the name of the material to Terrain.
2 In the Slate Material Editor ➤ Material/Map Browser panel, at the left,
locate Maps ➤ Standard ➤ Bitmap, and drag this map type into the
active View.
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3ds Max opens a file dialog.
3 In the file dialog, choose terrain.jpg, and then click Open.
4 Wire the new terrain texture to the Terrain material node’s Diffuse Color
component.
5 Click the new Bitmap node to make it active, and on the Slate Material

Editor toolbar, click

(Show Map In Viewport) to turn it on.

6 Drag from the Terrain material node’s output slot, and in a viewport,
release the mouse over the Ground object.
The Ground object turns brown, but it doesn’t show the texture map. This
is a sign that the object doesn’t have mapping coordinates.
Primitive objects such as boxes and spheres have default mapping
coordinates, but editable geometry such as Ground, which is an Editable
Poly, does not. You have to assign mapping coordinates by applying
UVW Map.

7

Select the Ground object, and go to the

Modify panel.

8 Use the Modifier List to apply a UVW Map modifier.
For the terrain, the default Planar projection works fine, and the map
terrain.jpg is already the right size for the scene, so your work in this lesson
is now complete.
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Army compound with textured utility containers and terrain

Save your work:
■

Save the scene as my_fieldhq_containers_and_terrain.max.

Add Detail to Some Outbuildings
Next, you will add materials to the barracks. Materials for the barracks use
texture maps, as the ammunition canister does, but they also use bump mapping
to create a more three-dimensional appearance.
Set up the lesson:

■

Continue from the previous lesson, or
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open army_compound01.max.

Isolate the barracks:
1 On the main toolbar, open the Named Selection Sets drop-down list, and
choose the barracks selection set.

3ds Max selects the barracks buildings.
2 Right-click the viewport to display the quad menu, and choose Isolate
Selection.
3ds Max displays the barracks in the center of the viewport, and hides
the other scene geometry.

3 Use
(Orbit) and
(Field-Of-View) to adjust the view so you
can clearly see the barrack walls.
Texture the barrack walls:

1 Turn on
(Select Object), then click an empty area of the viewport
to deselect the barracks set.

2 If it is not already visible,

display the Material Editor.

TIP Besides the toolbar button, another way to display the Material Editor,
or to restore it if it is minimized, is simply to press M.
3 On the Slate Material Editor menu bar, choose Options ➤ Propagate
Materials To Instances to turn it on. (When this option is turned on, a
check mark appears before its name.)
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Like the oil tanks and generators, the barracks objects, roof, walls, and
floors, are instances of each other. By turning on this option, you can
apply a material to all the objects of one type by dragging and dropping
to only one object.
4 In the Slate Material Editor, drag another Standard material node into
the active View. Double-click the node to display the material parameters,
then in the Name field, change the name of the material to BarracksWalls.
5 In the Slate Material Editor ➤ Material/Map Browser panel, at the left,
locate Maps ➤ Standard ➤ Bitmap, and drag this map type into the
active View.
3ds Max opens a file dialog.
6 On the file dialog, choose planks.jpg, and then click Open.
7 Wire the new planks texture to the BarracksWalls material node’s Diffuse
Color component.
8 Click the new Bitmap node to make it active, and on the Slate Material

Editor toolbar, click

(Show Map In Viewport) to turn it on.

The BarracksWalls material now has an image of the planking.

Planks texture for barracks walls
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9 Drag the BarracksWalls node output socket to the leftmost barrack walls.
All three barracks now show the BarracksWalls material.
The planks texture shows dirt at the bottom of the wall, but with default
mapping coordinates, the dirt appears just above each doorway, instead.

Planks texture appears on the walls, but is not aligned correctly.

Use UVW Map to adjust the planks:

1

Select Barracks01-Walls, and then go to the

Modify panel.

2 Use the Modifier List to apply a UVW Map modifier.
3 In the Parameters rollout ➤ Mapping group, change the projection type
to Box. Also set Length = Width = Height = 4.0m.
Now the planking texture is correctly aligned with the walls.
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After applying UVW Map, the planks on the walls are aligned correctly.

Add a bump map to the planks material to improve realism:
If you take a closer look at the barracks, you can see that the texture looks
good, but it also has a flat appearance, smoother than aged wood typically
appears.

1088 | Chapter 6 Materials and Mapping Tutorials

Barrack walls with a texture alone, and no bump mapping

You can improve the appearance of the plank walls by using bump mapping.
Bump mapping makes an object appear to have a bumpy or irregular surface.
1 In the Slate Material Editor ➤ Material/Map Browser panel, at the left,
locate Maps ➤ Standard ➤ Bitmap, and drag another Bitmap node into
the active View.
3ds Max opens a file dialog.
2 On the file dialog, choose planks.bump.jpg,, and then click Open.
3ds Max adds the node to the active View.
This map is simply a black-and-white version of the planks.bmp map itself.
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Black-and-white planks texture for bump mapping

Bump mapping uses intensities in the map to affect the surface of the
material when you render it: white areas appear higher, and black areas
appear lower. This is why the bitmap you use for bump mapping is often
a black-and-white version of the map you use for texture.
3 Wire the node to the Bump component of the BarracksWalls material.
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As it did for the other Bitmap nodes, 3ds Max adds a Controller node for
the bump map’s Value.
TIP Pressing L tells the Slate Material Editor to lay out nodes in the active
View.

4 Bump mapping isn’t displayed in the viewports, so click
Production) to see the effect of the new map.

(Render
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The barrack walls with bump mapping

To get an even more weathered look, you can increase the bump mapping
Amount.
5 Double-click the main BarracksWalls material node, and then on the Maps
rollout, increase the Bump Amount to 75.
NOTE You might notice a couple of user-interface changes that happened
when you assigned the map for bump mapping: a check box indicates that
bump mapping is turned on, and the Bump button now shows the name of
the map: planks.bump.jpg.

6 Click

(Render Production) again.

Now the planks appear extremely weathered.
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The barrack walls with increased bump mapping

Texture the barrack roofs:
You will use a similar method for the roofs and floors of the barracks.

Left: Texture map for the barrack roofs
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Right: Bump map for the barrack roofs

1 Increase the
roofs.

2

Field-Of-View so you have a good view of the barrack

Select Barracks01-Roof.

3 Clear the Slate Material Editor ➤ active View.
4 In the Slate Material Editor, drag another Standard material node into
the active View. Double-click the node to display the material parameters,
then in the Name field, change the name of the material to BarracksRoof.
5 In the Slate Material Editor ➤ Material/Map Browser panel, at the left,
locate Maps ➤ Standard ➤ Bitmap, and drag this map type into the
active View.
3ds Max opens a file dialog.
6 On the file dialog, and then choose metal_plate.jpg as the texture map.
7 Wire the new Bitmap node to the Diffuse Color component of the
BarracksRoof material.
8 Click the BarracksRoof material node again to make it active.

9 Click
(Assign Material To Selection), and then click
Map In Viewport) to turn it on.

(Show

In the viewport, the map appears on the barrack roofs. However, it is
oriented the wrong way: the corrugated plates should lie along the slope
of each roof instead of lengthwise.
TIP The map should be applied to all three roofs. If it isn’t, Propagate
Materials To Instances was not on. Choose Options ➤ Propagate Materials
To Instances to turn this option back on, and try applying the map again.
10 Double-click the Bitmap node with the metal_plate.jpg texture. On the
Coordinates rollout, change the W Angle to 90.0 degrees.
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11 Go to the
Modify panel, and use the Modifier List to apply a
UVW Map modifier.
At first this appears to lose the W-Angle correction you just made, but
changing the modifier alignment will fix that.
12 In the Parameters rollout ➤ Alignment group, choose Y as the alignment
axis.

Now the metal plates are oriented correctly again.
13 Also on the Alignment rollout, click Fit.
This sets the Width to its correct value of 7.04 meters.
14 In the Parameters rollout ➤ Mapping group, change Length to also equal
7.04m.
(Make sure you leave the UVW Map projection set to Planar, the default.)
The roof texture now has the correct size and orientation.
15 In the Slate Material Editor ➤ Material/Map Browser panel, at the left,
locate Maps ➤ Standard ➤ Bitmap, and drag another Bitmap node into
the active View.
3ds Max opens a file dialog.
16 On the file dialog, choose metal_plate.bump.jpg as the texture.
17 Wire the new Bitmap node to the Bump component of the BarracksRoof
node.
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18 Double-click the new Bitmap node to display its parameters. On the
Coordinates rollout, change the W Angle to 90.0 to match the texture.
19 Double-click the BarracksRoof material node. On the Maps rollout, increase
the Bump Amount to 90.

20 Click

(Render Production) to see the effect.

The barrack roofs with bump mapping

At the eaves of the roofs, the texture “slops over” a bit. In this scene, it isn’t
a problem because usually you will render the barracks from a distance. Of
course, the bump mapping isn’t too apparent at a distance, either. Whenever
you texture a scene, bear in mind how much detail you want to use to make
the scene believable.
Texture the barrack floors:
Texturing the barrack floors should now be a familiar process
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Left: Texture map for the barrack floors
Right: Bump map for the barrack floors

1

Select Barracks01-Floor.

2 Add a new Standard material node to the active View, double-click it,
and name the material BarrackFloors.
3 Add a new Bitmap node, choose wood_batten.jpg as the texture, then wire
it to the Diffuse Color of BarrackFloors.
4 Click the BarrackFloors material node again to make it active.

5 Click
(Assign Material To Selection), and then turn on
(Show Map In Viewport).
6 Add another Bitmap node, choose wood_batten_bump.jpg as the texture,
then wire it to the Bump component of BarrackWalls.
7 Double-click the BarrackFloors material node, and on the Maps rollout,
change the Bump amount to 90.

8

Apply a UVW Map modifier to Barracks01-Floor. Leave the
projection set to Planar. Set Length = Width = 4.0m.
You don’t need to adjust the orientation of the floorboards.
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Now the barracks are completely textured.

Close-up of one barrack with textures for roof, walls, and floor

Use the Barrack Materials for the Sentry Box
Now that you have textured the barracks, you can use the same materials for
the sentry box. The trick is to use the same materials and the same UVW Map
settings.
Change the view:
1 Minimize the Slate Material Editor.
2 In the Warning: Isolated Selection dialog, click Exit Isolation Mode to
return to a general view of the scene.
3 Click the Point Of View (POV) viewport label, and choose Cameras ➤
Camera02.
This gives you a view of the completed barracks, and the unfinished
sentry box.

1098 | Chapter 6 Materials and Mapping Tutorials

The new view lets you see the roofs, walls, and floors of the completed
barracks, and also the roof, walls, and floor of the sentry box, which
doesn’t yet have materials applied.

Camera02 view with finished barracks to the right, unfinished sentry box to the left.

4 Click the Point Of View (POV) viewport label, and choose Perspective.
Changing to a perspective view doesn’t change what appears in the
viewport, but in the perspective view, you can navigate without changing
the camera settings.
Copy the barracks floor material:

1

Click one of the Barracks0X-Floor objects to select it.
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2

Ctrl+drag the UVW Mapping entry in the floor object’s modifier
stack, and drop this modifier instance over the floor of the sentry box.
(Before it has a material, the floor appears blue.)
The sentry box floor now has the correct mapping, but it still needs its
material.

3 Press M to open the Slate Material Editor, then drag from the output
socket of the BarrackFloors material to the sentry box floor.
Now the floor has both the material and the correct mapping.
Copy the roof and wall materials:
■

For the roof and walls of the sentry box, follow the same steps you did for
the sentry box floor: First select a barracks roof or wall, Ctrl+drag UVW
Mapping from the modifier to the corresponding sentry box object, then
wire the appropriate material to the roof or walls.
If the material is no longer visible in the active View of the Material Editor,
then on the Browser panel open the Scene Materials group, drag the
material into the active View, and choose Instance.
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The sentry box with the same materials as the barracks

NOTE The order in which you apply the material and the mapping doesn’t
matter. The important thing is to assign the material and the UVW Mapping,
so that the materials render correctly.

Create a new, 3D material for the sentry bar:
For the sentry bar, which blocks or permits vehicle access to the compound,
you can use a simple material with a procedural map named Gradient Ramp.
1 On the main toolbar, open the Named Selection Sets drop-down list, and
choose the sentrybox selection set.
3ds Max selects the sentry box.
2 Right-click the viewport, and choose Isolate Selection from the quad
menu.

3 Use
(Orbit) and
sentry bar is clearly visible.

(Field-Of-View) to adjust the view so the
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Isolated sentry box with a view of the bar

4

Select the sentry-bar object.

5 In the Slate Material Editor, drag a new Standard material node to the
active View, double-click the node, and name the new material SentryBar.
6 From the Material/Map Browser ➤ Maps ➤ Standard group, drag a
Gradient Ramp node into the active View. Wire this node to the Diffuse
Color component of the SentryBar material.

7 Click the new SentryBar material node to highlight it, then click

(Assign Material To Selection) and

(Show Map In Viewport).

8 Double-click the Gradient Map node to see its parameters.
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Gradient Ramp is a 3D procedural material like the Noise material you
used for the generator casings.

9 In the Gradient Ramp Parameters rollout, change the Interpolation type
to Solid.
The gradient display changes to two solid colors, one of them black.
10 Double-click the arrow-shaped slider at the middle of the gradient display.
This slider controls the color to its right (you could use the first slider on
the left to adjust the black color.)

Gradient Ramp with solid colors
Double-click the middle slider (shown in green) to change the color to
the right of the slider.
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3ds Max opens a Color Selector.
11 On the Color Selector, change the second gradient color to orange: Red
= 255, Green = 150, Blue = 0.
12 Click OK to close the Color Selector.
13 On the Coordinates rollout, change the U Tiling value to 10.0.
The material changes from two color areas to multiple stripes.
14 Also in the Coordinates rollout, change the W Angle value to –2.5.
Now the stripes have an angle to them.

Isolated sentry box with the completed sentry bar

View the entire scene again:
1 In the Warning: Isolated Selection dialog, click Exit Isolation Mode.
2 Click the viewport label and choose Cameras ➤ Camera01.
3 Click the viewport label again and choose Perspective.
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Save your work:
Save the scene as my_fieldhq_barracks.max.

■

Using Opacity Mapping for the Fences
The fences are a bit of a special case, because the chain-link parts of them
should be partially transparent. You accomplish this the way you did bump
mapping: by the use of bitmaps.
Set up the lesson:

Continue from the previous lesson, or

■

open army_compound02.max.

Select the fences:
➤

On the main toolbar, open the Named Selection Sets drop-down list, and
choose the fence selection set.
This step is mainly to show you what and where the fences are. There is
the main fence around the compound and the smaller fence that encloses
the utility containers.
NOTE Incidentally, the main fence includes two gates, left and right. Each
gate can move along its own local X axis to open or close the compound.

Use a basic material for the fence supports:
Each fence component, including the gates, actually includes two objects: a
“structure” component for the fence’s supportive piping, and a “wire”
component for the actual chain link.
1 In the Material Editor, drag a new Standard material node to the active
View, double-click it, and name the material, FenceSupport.
2 In the Blinn Basic Parameters rollout, click the Diffuse color swatch to
display the Color Selector, and then assign the material a light gray color:
Red = Green = Blue = 188.
3 Click OK to close the Color Selector.
4 Click the FenceSupport material node again to make it active.
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5 Press H to display the Select From Scene dialog. Highlight the structure
objects for all the fences: Fence-Structure, Gate-left-structure,
Gate-right-structure, and Fence-sml-Structure. Click OK to select these four
objects.

6 Click

(Assign Material To Selection).

Use a texture map for the chain link:
The chain link itself uses a bitmap with a chain-link pattern.

Chain-link texture for the fence

1 In the Material Editor, drag a new Standard material node to the active
view, double-click it, and name the new material FenceChainLink.
2 On the Shader Basic Parameters rollout, turn on 2-Sided.
3 Drag a new Bitmap to the active View. On the file dialog, assign
sitework.chainlink.jpg as the texture.
4 Wire the new Bitmap node to the FenceChainLink material’s Diffuse Color
component.
5 Click the FenceChainLink material node again to make it active.
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6 Press H to display the Select From Scene dialog. Highlight the wire objects
for all the fences: Fence-Wire, Gate-left-wire, Gate-right-wire, and
Fence-sml-Wire. Click OK to select these four objects.

7 Click
(Assign Material To Selection) and then turn on
(Show Map In Viewport).
The fence texture appears in viewports as a gray pattern on a black
background. It isn’t yet to scale, so you need to adjust it with UVW Map.
NOTE Because the mapping isn’t yet right, some fence surfaces might appear
gray even if you turned on 2-Sided. The UVW Map adjustments will fix this.

8 With all four objects still selected, go to the
apply a UVW Map modifier.

Modify panel and

9 Change the mapping projection type to Box, and then set Length = Width
= Height = 0.5m.
Now the mapping and the scale of the chain link are correct; but of course,
the fences still appear to be solid objects.
Use the chain-link texture to create transparency and opacity:
Just as in bump mapping, where black areas of a map appear recessed and
white areas appear prominent (with gray values having an intermediate effect),
in opacity mapping, black areas appear transparent and white areas appear
opaque (while gray values create some degree of translucency).
Because the chain-link map is already black-and-white, it should work
effectively both as a texture and as an opacity map.
1 In the active View, drag a second wire from the Bitmap node with the
chain link pattern. This time, wire it to the FenceChainLink material’s
Opacity component.
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Bitmap controlling both color and opacity

2 Click the main FenceChainLink material node, then click to turn on
(Show Map In Viewport).
Now, in the viewport, the chain-link portions of the fence appear partially
transparent.
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Viewport display of fence with opacity mapping

The one thing missing from this view is transparency in the fence
shadows. Depending on your graphics card, viewports might not display
opacity mapping just as they don’t display bump mapping. If this is the
case, you must render to see the effect of opacity mapping on shadows.

3 Click

(Render Production).

In the rendering, the shadows convincingly match the transparency of
the fence.
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Rendering of opacity-mapped fence

Save your work:
■

Save the scene as my_fieldhq_fencing.max.

Texturing the House: More Mapping Techniques
The house is of stone, not of wood, but for the most part, the mapping
techniques you use should be familiar from previous lessons. This lesson
introduces a couple new techniques that can be useful.
Set up the lesson:

■

Continue from the previous lesson, or

1110 | Chapter 6 Materials and Mapping Tutorials

open army_compound03.max.

Texture the walls of the house:
The walls of the house present familiar techniques.
1 On the main toolbar, open the Named Selection Sets drop-down list, and
choose the house selection set.
3ds Max selects the farm house.
2 Right-click and choose Isolate Selection from the quad menu.

3

Click an empty area of the viewport to clear the selection, and
then click the House object to select the walls.

4 In the Slate Material Editor, drag a new Standard material node to the
active View, double-click it, and name the new material Masonry.
5 Drag a new Bitmap node to the active View, choose masonry.fieldstone.jpg
as the texture, and wire it to both the Diffuse Color and Bump
components of the Masonry material node.

Texture for the house walls

6 Double-click the Masonry material node to see its parameters. On the
Maps rollout, change the Bump amount to 90.
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7 Click
(Assign Material To Selection), and then turn on
(Show Map In Viewport).

8

Apply a UVW Map modifier to the house walls. Change the map
projection to Box, and set Length = Width = Height = 5.0m.

House walls with a masonry texture

Use a Mapscaler to texture the roof:
The roof, on the other hand, presents a problem. With its two gables, there
is no straightforward way to map the pattern using UVW Map.
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Shingle texture for roof of house

With default mapping (you don’t need to go through these steps, yourself),
the texture doesn’t look right. Even if you were to adjust the scale or change
the projection type, the shingles wouldn’t conform to the direction of the
gables.
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Default texture mapping for the roof

The solution is to use a different modifier, Mapscaler, to handle the texture
mapping.

1

Select the House-Roof object.

2 In the Slate Material Editor, drag a new Standard material node to the
active View, double-click it, and name the new material HouseRoof.
3 Drag a new Bitmap node to the active View, choose shakes.weathered.jpg
as the texture, then wire the new Bitmap to the HouseRoof material node’s
Diffuse Color component.
4 Click the HouseRoof material node to make it active.

5 Click
(Assign Material To Selection), and then turn on
(Show Map In Viewport).
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6 Go to the
MapScaler.

Modify panel. From the Modifier List, choose

NOTE Be sure to choose “MapScaler” from the list, and not “MapScaler
(WSM)”. The world-space (WSM) version of MapScaler has a similar effect,
but is not quite the same.
The MapScaler modifier maintains the map scale relative to the object
(in this case, the roof), and by default it wraps the texture so the shingles
follow the angles of the roof.

Shingle texture mapped using MapScaler

TIP Not all game engines recognize the MapScaler modifier, but if you apply
MapScaler and then collapse the object to an Editable Mesh or Editable Poly,
the texture mapping will be “baked in” to the model, and game engines will
recognize the mapping.
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Texture the windows:
The windows use another small feature to ensure correct mapping.
1 In the Warning: Isolated Selection dialog, click Exit Isolation Mode.

2

Click one of the purple windows to select it. The windows are
a single grouped object named Windows.

3 Right-click the viewport, and choose Isolate Selection from the quad
menu.
4 In the Slate Material Editor, drag a new Standard material node to the
active View, double-click it, and name the new material HouseWindows.
5 In the Shader Basic Parameters rollout, click to turn on Face Map.
When Face Map is on, a texture map is applied to each face of an object
individually.
6 Drag a new Bitmap node to the active View, choose window.jpg as the
texture, then wire the new Bitmap node to the Diffuse Color of the
HouseWindows material node.

Bitmap for the window texture
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7 Click the HouseWindows material node to make it active.

8 Click
(Assign Material To Selection), and then turn on
(Show Map In Viewport).
9 In the Warning: Isolated Selection dialog, click Exit Isolation Mode.
Texture the front door:
Like the walls, the front door of the house is a straightforward texture mapping.

1

Click to select the Door object.

2 In the Slate Material Editor, drag a new Standard material node to the
active View, double-click it, and name the new material WoodBoards
(you will use it elsewhere in the scene).
3 Drag a new Bitmap node to the active view, choose wood.boards.jpg as the
texture, then wire the new Bitmap to the Diffuse Color of the WoodBoards
material node.

Left: Texture for the wood boards that make the house door
Right: Bump map for the wood boards
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4 Drag a second Bitmap node to the active View, choose wood.boards.bump
as the texture, and wire this Bitmap to the Bump component of the
WoodBoards material node.
5 Double-click the WoodBoards node so you can see its parameters, then on
the Maps rollout, increase the Bump Amount to 70.

6 Click
(Assign Material To Selection), and then turn on
(Show Map In Viewport).

7

Apply a UVW Map modifier to the door. Change the map
projection to Box, and set Length = Width = Height = 4.0m.

This completes your texturing of the house.

The house with all its textures

Save your work:
■

Save the scene as my_fieldhq_farmhouse.max.

1118 | Chapter 6 Materials and Mapping Tutorials

Mapping the Barn
The army compound scene is nearly complete. The walls and doors of the
barn use the same material you just created for the door, while the floor of
the barn is the same as the barracks floors. The only difference is the roof of
the barn: This also uses the WoodBoards material, but with a slightly different
mapping.
Set up the lesson:

■

Continue from the previous lesson, or

open army_compound04.max.

Use the front-door texture for the walls and doors of the barn:
1 Click the Perspective viewport label, and choose Cameras ➤ Camera03.
Camera03 shows a view of the barn.
2 Click the viewport label again, and choose Perspective, so any navigation
you do won’t change the camera position or settings.
3 From the Material Editor, drag from the output socket of the WoodBoards
material onto the barn walls and barn doors: the objects Barn,
Barn-Door-right, and Barn-Door-left.
4 Press H to display the Select From Scene dialog. Select the Door object,

then
Ctrl+drag its UVW Mapping from the modifier stack to the
barn walls and doors.
Use the barracks floor material for the floor of the barn:
1 From the Material Editor, drag from the output socket of the BarrackFloors
material onto the barn floor.
2 Press H to display the Select From Scene dialog. Select one of the barracks
floor objects, then Ctrl+drag its UVW Mapping from the modifier stack
to the barn floor.
Texture the roof of the barn:
1 From the Material Editor, drag from the output socket of the WoodBoards
material onto the barn roof.
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2

Select the barn roof and
apply a UVW Map modifier
to it. Leave the map projection set to Planar. In the Alignment group,
change the alignment axis to Y. In the Mapping group, change Length
= Width = 4.0m.

Now the army compound scene is completely textured.
Render the completed scene:
1 Right-click the viewport label and choose Cameras ➤ Camera01.

2 Click

(Render Production) to view the final results.

The fully textured field headquarters
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Save your work:
■

Save the scene as my_fieldhq_finished.max.
You can see a version of the finished scene in
army_compound_completed.max.

Summary
This tutorial has introduced a variety of methods for applying materials to
objects. Among the methods shown were:
■

Applying a basic material to change an object’s color or shininess (the oil
tanks and the fence piping)

■

Applying a 3D procedural map to create a patterned material (the generators
and the sentry bar)

■

Applying a Diffuse or “texture” map to give an object a photorealistic
pattern (the ammunition canister, the terrain, and almost all of the building
surfaces)

■

Using the UVW Map modifier to control the projection, orientation, and
scale of texture mapping
We also showed how to copy UVW Map from one object to another when
the objects share the same material.

■

Using bump mapping to give a 3D appearance to a textured material (most
of the materials on the buildings)

■

Using opacity mapping to make a material partially transparent (the
chain-link fence)

■

Using the object-space Mapscaler modifier to project a map onto a
complicated shape (the roof of the house)

Normal Bump Mapping
Normal bump mapping is a technique that lets you simulate high resolution
surface detail on low resolution polygonal models.
Normal bump mapping is similar in some respects to regular bump mapping,
but it conveys more complex surface detail. Normal bump maps store not
only the depth information used in regular bump mapping, but also
information on the direction normal of the surface, to produce more life-like
results.
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The practical benefits of normal bump mapping were first seen in real-time
gaming platforms. The ability, however, to create more realistic detail with
fewer polygons is desirable in all areas of digital content creation. 3D artists
of every specialty should therefore be familiar with two normal bump mapping
techniques: the planar projection method and the cage projection method.
In this section, each technique is presented in its own tutorial.
IMPORTANT Before you begin these tutorials, you should make sure that 3ds
Max is set to use the Direct3D display driver; otherwise, you will not be able to
see the bump effect in your viewports. From the main menu, choose Customize
➤ Preferences, and in the Viewports tab ➤ Display Drivers group, make sure
Direct 3D is the selected driver. If you need to change the driver, you also need
to restart 3ds Max. If Direct3D hardware shading is not available on your
workstation, then skip these tutorials.

Planar Projection Method
Normal bump mapping involves two objects: a high resolution, polygonally
detailed object as the source for the normal bump map information, and a
low resolution target to receive the map and use it to appear more finely
detailed than it really is.
The objective in this tutorial is to assign the target object, a simple
two-dimensional plane, the complex surface detail of the source: a tile of
mortared stones.
The texture to be baked onto the plane will consist of a normal bump map,
together with a diffuse map. You will then add a height map to give the plane
the appearance of depth, and render it with the mental ray renderer.
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In this tutorial, you will learn how to:
■

Set up the map projection using the render to texture controls.

■

Define diffuse, normal bump, and height maps, and bake the resulting
texture onto a destination object.

■

Preview the baked result in a viewport.

Skill level: Intermediate
Time to complete: 1 hour

Creating a Normal Bump Map
First, you use the Render To Texture feature to create the normal bump map.
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Set up the lesson:

➤

On the Quick Access toolbar, click
(Open File) and from the
\materials_and_mapping\normal_bump_map folder, open pavers.max.
NOTE If a dialog asks whether you want to use the scene’s Gamma And LUT
settings, accept the scene Gamma settings, and click OK. If a dialog asks
whether to use the scene’s units, accept the scene units, and click OK.
The scene consists of a source object, a tile of spheres sculpted to resemble
rocks set in mortar. Directly above is the target object, a simple
two-dimensional plane.

Unwrap the plane object:

1 In any viewport,

go to the

select the target plane object, Proj-Plane, and

Modify panel.

2 From the Modifier List drop-down, choose Unwrap UVW.
This modifier sets out the mapping coordinates of the plane object, so
that the textures of the source object can accurately be projected onto it.
On the Parameters rollout ➤ Channel group, notice that the mapping
coordinates are automatically stored on Map Channel 1.
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Set up the projection:
Here, you will use the Render To Texture tool to define various projection
setup parameters.
1 With the plane object still selected, from the main menu, choose
Rendering ➤ Render To Texture.
TIP The default keyboard shortcut for the Render To Texture dialog is 0.
2 In the Render To Texture dialog ➤ General Settings rollout ➤ Output
group, define the output path where you want to save the diffuse, normal
bump, and height map textures you are about to create.

By default, the output is saved to the \3dsmax\sceneassets\images folder
of your 3ds Max project, but you might want to specify a different storage
location.
3 In the Objects To Bake rollout ➤ Projection Mapping group, turn on
Enabled. Since the plane object you will bake the texture to consists of
only a single flat surface, turn off Sub-Object Levels.

If you wanted to bake textures of objects onto multiple surfaces (for
example, onto each face of a box), you would keep Sub-Object Levels
turned on.
4 Click the Pick button to display the Add Targets dialog.
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Here, you choose which objects you want to bake onto the plane object.
5 Click the first item in the list, then Shift+click the last item in the list to
choose all the rocks and the mortar. Click Add.
The drop-down list in the Projection Mapping group changes from (No
Projection Modifier) to Projection, indicating that a new Projection
modifier, containing the items you just selected for projection, has been
placed on the stack for the plane object.
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6 Click the Options button to display the Projection Options dialog.

The height map defines the stone and mortar topography of the source
object. To generate the map, you must determine both the farthest and
closest points between the source and plane object.

7 Activate the Top viewport, and
the mortar regions clearly.

zoom in slightly until you can see

In the next two steps, be sure that you are directly above the plane. Height
selection will work only if you are above the target object.
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8 In the Height Map group, click the
eyedropper button to the right
of the Min Height field. Click through the plane, above the mortar
between the rocks. The value of Min Height changes to –100.

9 Click the
eyedropper button next to the Max Height field and then
click through the plane, over the highest rock in the scene. This is Rock10,
along the upper-right edge of the plane in the Top viewport. Try to find
a value between –40.0 and –20.0.
10

Close the Projection Options dialog. In the Render To Texture
dialog ➤ Objects To Bake rollout ➤ Mapping Coordinates group, choose
Use Existing Channel, if it is not already chosen.

The Use Existing Channel option indicates that you want to use the
texture-mapping coordinates you created from the UVW Modifier at the
beginning of this lesson, rather than letting 3ds Max create new
texture-mapping coordinates on the fly.
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Define the texture to be baked:
Now that the projection method has been defined, the next step is to add the
diffuse, normal bump, and height maps that, when combined, will form the
texture to be baked onto the plane object.
1 On the Render To Texture dialog, scroll down to the Output rollout, click
Add and from the Add Texture Elements dialog, click to highlight
DiffuseMap, then click Add Elements.

A new Diffuse entry appears in the Output rollout ➤ Selected Element
Common Settings group. The file name of the diffuse map to be created
displays in the File Name and Type field.

2 Make sure that the Target Map Slot has changed to Diffuse Color. If it
hasn’t, choose Diffuse Color from the drop-down list.
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3 Click the 512 x 512 Width/Height button. This sets the output resolution
of the diffuse map to 512 by 512 pixels.

4 On the Output rollout, click Add again and from the Add Texture
Elements dialog, click to highlight NormalsMap, then click Add Elements.

A new Normals entry appears on the Output rollout, below the Diffuse
map entry.
5 Make sure that the Target Map Slot has changed to Bump. If it hasn’t,
choose Bump from the drop-down list.
6 Click the 512 x 512 Width/Height button to set the output resolution of
the normals bump map.
7 In the Selected Element Unique Settings group, turn on Output Into
Normal Bump, so that the result shows up properly both in the viewport
and in the rendered frame.
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8 On the Output rollout, click Add and from the Add Texture Elements
dialog, click to highlight HeightMap, then click Add Elements.

A new Height entry appears on the Output rollout.
9 Leave the Target Map Slot empty. This information is not needed here.
You will assign the map later, using the mental ray renderer.
10 Click the 512 x 512 Width/Height button to set the output resolution of
the height bump map.
At this point, you have defined all the basic elements and settings for
creating diffuse, normals bump, and height maps.
11 Activate the Perspective viewport.
12 With the plane object selected, press Alt+X to exit X-ray (See-Through)
mode. This mode lets you see behind the selected object. With this mode
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now turned off, you will be able to see the results when the plane is
rendered.
13 At the bottom of the Render To Texture dialog, click Render to render
the selected plane.
3ds Max displays a warning.

Click Continue to dismiss the Missing Map Targets message box. We
deliberately left the height map unassigned, because in the next lesson,
you will assign it separately.
If the Files Exists dialog displays, click Overwrite Files.
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The rendering shows only the information from the diffuse map. The
normal bump and height maps have also been baked into the texture of
the plane, but they are not visible. In the next lesson, you will use the
Material Editor to display the complete projected texture in the viewports.
14

Close the rendered frame window.

Save your work:
■

Save the scene as my_paver_elements.max.
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Visualizing the Projection
With DirectX shading, you can view the effect of normal bump mapping in
viewports.
Set up the lesson:
Continue from the previous lesson, or from the

■

\materials_and_mapping\normal_bump_map folder,
pavers_view.max.

open

Preview the normals bump map:

1

Select the plane object. Right-click it, and choose Isolate Selection
from the quad menu.
Next, you will hide the plane’s selection cage, which was generated by
the Projection modifier you added earlier.

2 On the
Modify panel, open the Modifier List and apply a Poly
Select modifier. This adds the modifier to the top of the plane’s modifier
stack and hides the selection cage.
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3 Open the

Slate Material Editor.

4 Click
(Pick Material From Object), and click the plane object to
display its material in the active View.
5 Double-click the Proj-Plane_mtl [Proj-Plane] / Shell material node (the one
at the right) to display the Shell material parameters.

As the rollout shows, the Shell material contains two types of material:
the originally assigned plane material, which displays only when rendered,
and the baked material obtained from the source object, which displays
only in viewports.

6 On the Slate Material Editor, click
material tree.

(Zoom Extents) to see the whole
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TIP You might want to change the size of the Slate Material Editor window,
and use some of the other navigation tools, to get a view you can read easily.
At the right is the top-level node, the Shell material you just inspected.
Next to the left are the two sub-materials: The original, renderable material
is above, and the baked, hardware material is below. The baked material
has a Bitmap node and a Normal Bump map node (each of these has an
associated Controller node). Finally, the Normal Bump node uses the
NormalsMap bitmap you rendered in the previous lesson.
7 Double-click the Bitmap node for the Normal Bump map. This is the
node at the far left.
8 In the Bitmap parameters rollout ➤ Cropping/Placement group, click
View Image.
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3ds Max displays the normal bump map you created earlier, which now
is applied to the plane object.
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The colors in the map are significant. The reason normal bump maps
convey so much more detail than ordinary bump maps is that normal
bump maps use the entire RGB spectrum for surface detail information,
whereas ordinary bump maps only use a single grayscale. The blue channel
conveys vertical depth information, and the red and green channels
enhance this information by providing a direction vector for the
orientation of the surface normal at each point. This results in higher
realism.
9

Close the Rendered Frame Window.

1138 | Chapter 6 Materials and Mapping Tutorials

Use hardware shading to display the map:
1 In the Slate Material Editor, double-click the baked_Proj-Plane_mtl /
Standard material node to display its parameters.
2 On the Slate Material Editor toolbar, open the Show Standard/Hardware
Map In Viewport flyout, and choose Show Hardware Map In Viewport.

3 On the Parameter Editor panel, open the Maps rollout, and increase the
Bump amount to 90.

4 Minimize the Slate Material Editor.

5 In the Perspective viewport,
plane.

zoom in to get a closer view of the

The flat surface of the plane object takes on a greater, three-dimensional
degree of detail.
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Next, you will add a standard Omni light to the scene to see how
effectively the normal bump map, when combined with a standard Omni
light, provides a sense of depth to the object.
Visualize the 3D effect

1 On the
Create panel, turn on
(Lights). Choose Standard
from the drop-down list, then click Omni to turn it on.

2 In the viewport, click anywhere above the plane object to place the light.
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3

Move the light across the stones.
You might need to move the light vertically as well, to position it above
the plane.

Even though this object is a flat plane, notice how the light and shadow
play across the stones as if the geometry was a raised surface.
Try rendering with both renderers:
1 Delete the light object.
2 Restore the Slate Material Editor (press M), and move the window so you
can see all of it, again.
3 Double-click the Proj-Plane_mtl [Proj-Plane] / Shell material node (the one
at the right) to display the Shell material parameters.
4 On the Shell Material Parameters rollout, set the Baked Material to be
visible in the rendered output.
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5 Minimize the Slate Material Editor.

6 In the Perspective viewport,
orbit so the plane is almost horizontal,
then press F9 to render the plane.

Notice how the edges of the plane still appear straight and
two-dimensional.
The 3D relief you’ve achieved so far with the diffuse and normals bump
maps is usually acceptable when you model for games development. For
other uses, such as cinematics, you might need to take things one step
farther.
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To complete the effect, you will use the height map you created earlier
and render it with the mental ray renderer.

7 Click
(Render Setup) to open the Render Setup dialog. On the
Common tab, scroll down to the Assign Renderer rollout, then click
(Choose Renderer) for the Production renderer.

8 In the Choose Renderer dialog, choose “mental ray Renderer,” then click
OK.

9

Render the plane again.

10 In the rendered frame window, click
Window), then minimize the two frames.

(Clone Rendered Frame

Render the height map
Now you will add the Height map to the rendering.

1

Select the plane object.

2 Press M to restore the Slate Material Editor.
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3 Double-click the baked_Proj-Plane_mtl / Standard material node to display
its parameters.
4 In the mental ray Connection rollout ➤ Extended Shaders group, click
the
lock button for Displacement to unlock Displacement and
enable its controls.

5 From the Material/Map Browser panel at the left of the Slate Material
Editor, locate Maps ➤ mental ray ➤ Height Map Displacement, and
drag this map type to the Active View.

6 In the active View,
zoom so you have a good view of both the
baked_Proj-Plane_mtl / Standard material node and the new Height Map
Displacement node.
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7 On the baked_Proj-Plane_mtl / Standard material node, click the plus-sign
icon (+) to open the “mr Connection” group, and then wire the Height
Map Displacement node to the “mr Connection: Displacement”
component of the baked material.
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8 On the Material/Map Browser panel, locate Maps ➤ Standard ➤ Bitmap,
and drag this map type to the active View.
3ds Max opens a file dialog.
On the file dialog, choose proj-planeheightmap.tga.
Like the Diffuse and Normal Bump maps, this file should be located in
\sceneassets\images, or in the folder you specified earlier on the Render
To Texture ➤ General Settings rollout.
9 Wire the new Bitmap node to the Height Map component of the Height
Map Displacement node.

10 Double-click the Height Map Displacement node to display its parameters,
and on the Height Map Displacement rollout, set Minimum Height to
0.0.
TIP An easy way to do this is to right-click the spinner arrows.
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11

Render the Perspective viewport.

12 Restore the view of the rendered frame you cloned earlier, and compare
the renderings.

The geometry has been pushed up based on the displacement map
generated by the mental ray engine and added to the rendering.

Summary
This tutorial showed you how to project complex surface detail from a
source object onto a simple, two-dimensional plane. Detail is derived
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from the source by including normal bump, diffuse, and height maps in
the projection, then rendering them as a texture to the simple plane.

Cage Projection Method
Normal Bump Mapping using cage projection also involves a source and target
object.
In this tutorial, you will create a cage object and form it to fit the contours of
the target, a low-resolution model of a human head. You will then use the
cage to receive the diffuse and normal bump map information from the source,
a high-resolution version of the model.

Model of a warrior with diffuse map only (left) and with normal map applied (right)

In this tutorial, you will learn how to:
■

Use Render To Texture to create a normal bump map.

■

Use the Projection modifier to “steal” detail from a high-resolution mesh.

■

Use the Normal Bump map type to render the effects of a normal bump
map.
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Skill level: Intermediate/Advanced
Time to complete: 1 hour

Creating a Normal Bump Map
You use Render To Texture to create the normal bump map for the warrior
head as well, but you also adjust the cage before you render the map.
Set up the lesson:

■

On the Quick Access toolbar, click
(Open File), navigate to
\scenes\materials_and_mapping\normal_bump_map\ and open
warrior_head_lores.max.
NOTE If a dialog asks whether you want to use the scene’s Gamma And LUT
settings, accept the scene Gamma settings, and click OK. If a dialog asks
whether to use the scene’s units, accept the scene units, and click OK.
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The only visible object is an editable mesh model of the head of a warrior.
This is the low-resolution target object, consisting of roughly 750 polygons,
to which you will apply normal bump maps. Its surface is smooth, and it has
a checkered texture map applied to it. This checker map was used as a visual
guide in setting up the texture mapping of the surface. An Unwrap UVW
modifier has already been applied.
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Inspect the mapping:

1

Select the model, go to the
rollout, and click the Edit button.

Modify panel ➤ Parameters

3ds Max opens the Edit UVWs dialog, which shows how the Unwrap
UVW modifier has already been applied to the target object, and how
the texture coordinates have been mapped to the surfaces of the model.
This layout was designed to facilitate painting, which can be necessary
for “touching up” texture mapping.
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2 In the Selection Modes group, turn on Select Element, then click to turn

on
(Face Sub-Object Mode). In the main window, select geometry
elements to see how they correspond to the model in the Perspective
viewport.

Close the dialog when you are done.

In order to extract the high-resolution information from the source model,
you will now need to merge it with the low-resolution version.
Merge the high-resolution model:

1 From the
Application menu, choose Import ➤ Merge, and
on the file dialog, navigate to the folder that contains your scene files.
Select the scene that contains the high-resolution model
warrior_headhires.max, then click Open.
3ds Max opens a Merge dialog.
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2 On the dialog, click to highlight War_Head_HiRes, then click OK.
The two models are now visible. Both are the same size and are precisely
aligned.

Cage Projection Method | 1153

3 To view the high-resolution model on its own, make sure the

high-resolution model is selected,
select a non-checkered part
of the head, right-click, and from the quad menu choose Isolate Selection.
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This model, at approximately 96,000 polygons, shows a much greater
amount of detail.

4 Click Exit Isolation Mode to return to the merged view and then
click a checkered region of the model to select the low-resolution model.
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To make sure you have the low-resolution model selected, check that the
Name And Color rollout displays War_Head_LoRes.
Now you will proceed to create the normal bump map based on the
high-resolution model.
Set up Render To Texture (RTT):
To generate the normal bump map, you will use the Render To Texture tool.
1 From the main menu, choose Rendering ➤ Render To Texture.
2 In the Render To Texture dialog ➤ General Settings rollout ➤ Output
group, define the output path where you want to save the diffuse and
normal bump map textures you are about to create.

By default, the output is saved in the \sceneassets\images folder of the
current project, but you might want to specify a different storage location.
3 In the Objects To Bake rollout ➤ Projection Mapping group, turn on
Enabled, then turn off Sub-Object Levels, since no sub-selections exist in
this particular model.

4 Click the Pick button to display the Add Targets dialog, choose
War_Head_HiRes, then click Add.
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The drop-down list in the Projection Mapping group has changed from
(No Projection Modifier) to Projection, indicating that a new Projection
modifier has been placed on the stack for War_Head_HiRes.

Cage Projection Method | 1157

Also, a rough wireframe cage appears around the high-resolution head
object in the viewport. The cage shows a considerable amount of irregular
geometry, but this is usual when it is first applied. The problem is easy
to correct.

1158 | Chapter 6 Materials and Mapping Tutorials

5 On the Modify panel ➤ Cage rollout, click Reset.
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The cage resets itself to fit tightly around the target low-resolution model.
The shape of the cage is correct, but it is important that the cage fully
encompass the source high-resolution model. Where the source geometry
lies outside the cage, the result will be ray intersection misses, which in
turn will cause flaws in the normal bump map.
6 On the Cage rollout ➤ Push group, set Amount to 1.1.

After the value is applied, it resets to 0.0 and the cage balloons outward
slightly so that the entire War_Head_HiRes object, with all its bumps and
protrusions, fits within it.
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7 In the Render To Texture dialog ➤ Objects To Bake rollout ➤ Mapping
Coordinates group, choose Use Existing Channel.
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This is where you specify that you want to use the pre-assigned
texture-mapping coordinates you viewed at the beginning of this lesson,
rather than letting 3ds Max create new texture-mapping coordinates on
the fly.
8 Scroll down to the Output rollout, click Add, and in the Add Texture
Elements dialog, click to highlight Normals Map, then click Add Elements.

A new NormalsMap entry appears on the Output rollout of the Render
To Texture dialog.
9 On the Selected Element Common Settings group ➤ Target Map Slot
drop-down list, choose Bump, then click the 512 x 512 Width/Height
button, which sets the output size to 512 by 512 pixels.
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10 On the Selected Element Unique Settings group, turn on Output Into
Normal Bump, so that the result shows up properly both in the viewport
and in renderings.

At this point, you have defined all the basic elements and settings for
generating a normal bump map.
Render and fine-tune the normal bump map:
1 At the bottom of the Render To Texture dialog, click Render to render
your normal bump map.
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The rendered map shows an unwrapped diffuse rendering of the
high-resolution model. Assorted red patches are visible, indicating where
the bump map projection rays did not properly capture the underlying
geometry. This is because the cage created by the Projection modifier did
not completely cover the high-resolution model in these spots.
This would create problems if you applied the normal bump map to the
low-resolution target. You will resolve this problem by applying neutral
normal values to these red patches so they blend with their surrounding
areas.
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2 Make sure the War_Head_LoRes object is selected and on the Render To
Texture dialog ➤ Objects To Bake ➤ Projection Mapping group, click
Options to display the Projection Options dialog.

3 In the Resolve Hit group, turn off Ray Miss Check, then
the dialog.

close

With Ray Miss Check turned off, the red patches in the rendered normal
bump map will be replaced by a neutral blue background with a normal
value of 0, a value that will permit the regions to blend effectively with
the normal map that will be created.
4 At the bottom of the Render To Texture dialog, click Render to render
your normal bump map once again.
Click Overwrite Files when you are prompted to overwrite the previous
rendered file.
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The rendered result shows that the previous ray misses now appear as
black, the neutral element background.

Now you will take a look at the actual normal bump map image file to
see the blending result.
5 From the main menu, choose Rendering ➤ View Image File. In the file
dialog that displays, navigate to the image file location, which by default
is \sceneassets\images.
6 Select the file war_head_loresnormalsmap.tga, then click Open.
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The blue channel conveys vertical depth information, and the red and
green channels enhance this information by providing a direction vector
for the normal orientation of the surface at each point. This conveys
more information than an ordinary grayscale bump map.
7

Close the normal map image.

Save your work:
■

Save the scene as my_warrior_normal_map.max.
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Applying Normal Bump Maps to Objects
In this lesson, you will apply the normal bump map you created in the previous
lesson to the low-resolution model of the warrior.
Set up the lesson:
1 Continue from the previous lesson, or from the

\materials_and_mapping\normal_bump_map folder,
warrior_head_b_map.max.

2

open

Select the low-resolution version of the head by clicking a

checkered portion of the model, then go to the

Modify panel.

3 To hide the projection cage, open the Modifier List and apply a Poly
Select modifier.
Apply a texture to the head:
1 With the low-resolution head selected, right-click and from the quad
menu, choose Isolate Selected. The high-resolution model is now hidden.

2 Open the

Slate Material Editor.

3 From the Material/Map Browser panel on the left, drag a Standard material
to the active View.
4 Double-click the Standard material node to display its parameters. In the
name field, name the material Head.
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5 On the Slate Material Editor toolbar, click
Selection).

(Assign Material To

6 From the Material/Map Browser panel, drag a Bitmap into the active View.
3ds Max opens a file dialog.
On the file dialog, choose head_diffuse.jpg (this file is in the
\sceneassets\images folder).
7 Wire the new Bitmap node to the Diffuse Color component of the Head
material.

When you wire the Bitmap, 3ds Max adds a Controller node for the
bitmap’s Value.
8 Double-click the Bitmap node to display its parameters.
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9 On the Bitmap Parameters rollout, click View Image to display the bitmap
in a larger format.

This image file is a previously created diffuse bitmap of the warrior’s face,
based on the unwrapped model.
10

Close the image window.

11 On the Slate Material Editor toolbar, click
to see the material in viewports.
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(Show Map In Viewport)

The result is fairly flat and lacking in detail. The normal bump map you
will now apply should improve things considerably.
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Use a Normal Bump map to apply the normal map:
1 Drag a Normal Bump map from the Browser into the active View.
2 Wire the Normal Bump map node to the Bump component of the Head
material node.

3 Drag another Bitmap from the Browser into the active View.
3ds Max opens a file dialog.
On the file dialog, choose war_head_loresnormalsmap.tga, (this file is in
the \sceneassets\images folder).
(If you like, you can use the version of this map that you rendered yourself
in the previous lesson.)
4 Wire the new Bitmap node to the Normal component of the Normal
Bump map.

1172 | Chapter 6 Materials and Mapping Tutorials

Now the normal bump map will be visible in renderings. To make the normal
bump map visible in viewports, you need to go through a few more steps.
Use hardware shading to display the normal bump map:
1 Double-click the Head material node to see its parameters.
2 On the Slate Material Editor toolbar, open the Show Standard/Hardware
Map In Viewport flyout, and choose Show Hardware Map In Viewport.

3 On the Parameter Editor panel, open the Maps rollout, and increase the
Bump amount to 90.
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4 Minimize the Slate Material Editor.
5 The model suddenly takes on a new level of detail. The low-resolution
model is now picking up the normal information from the high-resolution
mesh object.
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If you like, try adding an Omni light to the scene and moving the light
object across the face: first with the diffuse map selected, then with the
normal bump map selected. See how much of a difference a normal bump
map can make.
Compared to the head that doesn’t use the normal bump map, the
difference is dramatic.

Save your work:
■

Save the scene as my_warrior_head_normal_map.max.

Summary
This tutorial showed you how to use a projection cage to receive texture from
a high-resolution model, then apply the result to a low-resolution version of
the same model. This technique is an effective way to assign complex surface
detail to low-polygon objects. This can be a useful technique when you prepare
a model for a game engine. It can help improve render time, as well.
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Composite Mapping
A composite map layers two or more texture maps onto one another, in order
to produce a more detailed image.
The end result is determined by the level of transparency defined for each
layer. Transparency can be global (applied to the entire surface of the layer),
derived from the layer’s alpha channel, or based on a mask. To fine-tune the
image, the pixels of each layer can also be blended with one another in a
number of different ways.
In this tutorial, you will create a complex texture map of a steel shutter for a
pawn shop. The map will consist of five layers of images composited together
using various transparency settings and blending techniques.

A render of the steel shutter composite map after completing this tutorial

In this tutorial, you will learn how to:
■

Create a composite layer
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■

Color correct a layer

■

Define layer transparency and contrast

■

Create a layer defined by a mask

■

Rearrange the order of layers

■

Blend layers

■

Add bump information to layers

Skill level: Intermediate
Time to complete: 45 minutes

Creating a Composite Map with Alpha Values
You will create the base layer of the composite map by choosing a bitmap of
a steel shutter, then assigning its diffuse, or color, values to an Arch & Design
material. You will then add two more image layers, using alpha values to
define how each are superimposed over the base layer.
Set up the lesson:

1 On the Quick Access toolbar, click
(Open File), navigate to
\scenes\materials_and_mapping\composite_mapping\ and open
composite_start.max.
NOTE If a dialog asks whether you want to use the scene’s Gamma And LUT
settings, accept the scene Gamma settings, and click OK. If a dialog asks
whether to use the scene’s units, accept the scene units, and click OK.
The scene consists of a pawnshop located in a rough part of town. The
storefront is missing one important element: a steel shutter that protects
a plate-glass window. Your task is to create a convincing composite map
of the shutter.
2 From the main menu, chose Customize ➤ Preferences ➤ General panel
➤ Texture Coordinates group and turn off Use Real-World Texture
Coordinates, if it is not already off. Click OK.
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Create a base layer and color correct it:

1 Open the

Slate Material Editor.

2 In the Material/Map Browser panel on the left, locate the Sample Slots
group.
The first sample slot contains an Arch & Design material called Shop-Door.
This material has already been applied to the roll-up shutter object
(door-sec).
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3 Drag the Shop-Door material from the Browser into the active View. In
the Copy/Instance map dialog, make sure Instance is chosen, then click
OK.

4 On the Slate Material Editor toolbar, click
(Show Map In Viewport)
so that later you will be able to view the Composite map in the viewports.
Now you will add a composite map to the material’s diffuse color
component.
5 Drag a Composite map from the Browser into the active View (in the
default groups, Composite is a Standard map), then wire the Composite
map node to the Diffuse Color component of the Shop-Door material.
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6 Double-click the Composite map node to see its parameters.
Initially, the Composite map contains a single layer.
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Specify the first layer of the Composite map:
1 Drag a Bitmap from the Browser into the active View.
3ds Max opens a file dialog.
On the file dialog, choose shutters.jpg, and then click Open.
2 Wire the new Bitmap node to the Layer 1 component of the Composite
map.
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On the Layers 1 rollout for the Composite map, the Texture button now
shows the shutters.jpg texture. This texture will be the base layer of the
Composite map.

3 Right-click the title bar of the Shop Door material node, and choose Open
Preview Window.

The preview helps you monitor the appearance of the map as you add
more layers and make further adjustments.
NOTE A preview window takes more time to render than the small preview
in the title bar of the material node.
4 Right-click the title bar of the Shop Door material node, and choose Preview
Object Type ➤ Box.
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3ds Max changes the sample sphere to a cube, which is a better preview
of the shutter geometry.
5 Drag a corner of the preview window to make it larger.
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6 Move this preview so you can see all of the Shop Door node and the
controls in the Parameter Editor.
Add a rust tone to the first layer:
The shutter door material is uniformly gray in color. Let’s add a little rust to
give the shutter a more run-down appearance.

1 On the Layer 1 rollout, click
(Color Correct This Texture). This
button is at the left of the rollout.
3ds Max displays Color-Correction controls in the Parameter Editor, and
it inserts a Color Correction map node between the Bitmap and the
Composite map.
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TIP In the active View, press L to rearrange the layout and see this node more
clearly. Use other navigation tools to move among nodes in the View.
2 On the Color rollout, click the Hue Tint color swatch.

3ds Max opens a Color Selector.
3 Enter the following values in the RGB fields:
■

R = 0.25

■

G = 0.15

■

B = 0.075

Click OK to close the Color Selector.
4 On the Color rollout, drag the Saturation slider to about 17.0, then in
the Strength field, enter 100.0.
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Now the Shop Door material shows a brownish tint.

Use alpha values to add a layer of graffiti:
Next, you will add a second layer to your composite map, one that contains
the bold strokes of a graffiti artist (or more than one).
1 Double-click the Composite map node to see its parameters again.

1186 | Chapter 6 Materials and Mapping Tutorials

2 At the top of the Composite Layers rollout, click
Layer).

(Add A New

3ds Max adds a new Layer rollout to the display of the Composite map
parameters.

Also, in the active View, the Composite map node now shows a new
Layer 2 component.

3 Drag a Bitmap from the Browser to the active View, just below the Bitmap
node for Layer 1.
3ds Max opens a file dialog.
On the file dialog, make sure Files Of Type is set to All Formats, choose
graffiti.png, and then click View.
3ds Max opens a file viewer that shows the graffiti.png texture.
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Graffiti bitmap used as the second layer in the composite map

In addition to red, green, and blue (RGB) information, the bitmap includes
alpha channel information in its .png file format. This channel provides
the level of opacity needed to superimpose the graffiti image over the
base image.

4 On the file viewer toolbar, click

(Display Alpha Channel).

The viewer displays a black-and-white version of the image, showing the
file’s alpha information.
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Alpha channel of the graffiti bitmap

Black regions of the bitmap will be completely transparent in the
composite map. White regions, representing the graffiti strokes, will be
completely opaque and fully visible in the composite map. Gray regions
will be semi-transparent and provide partial visibility, giving a blurred
edge to the graffiti.
NOTE Other bitmap formats that can contain alpha channel information
include .tif, .tga, and .exr.
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5

Close the graffiti.png viewer, then on the file dialog, click
Open.
3ds Max adds the Bitmap node to the active View.

6 Wire the new graffiti Bitmap to the Layer 2 component of the Composite
map.

The Layer 2 rollout now shows the graffiti.png texture, and the material
preview shows the composited graffiti.
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Composite map with the graffiti layer composited on the
shutter layer

Adjust the alpha and color levels:
If you look at the Shop Door material in a viewport (you will have to move or
minimize the Slate Material Editor), you can see that the default values for
compositing graffiti.png make the graffiti appear to float above the corrugated
texture of the door.
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You will fix this by adjusting some of the alpha settings for this layer.
1 On the Layer 2 rollout, change the value of Opacity 90.0, then press Enter.

This slightly increases the overall transparency of Layer 2, so that a small
portion of Layer 1 is visible beneath it. The result is a more convincing
blending of the graffiti onto the shutter surface.
The graffiti layer still needs to stand out a little more: you will use the
color correction tools to achieve this effect.
2 Drag a Color Correction map from the Browser to the active View, and
drop it on the wire between the Bitmap and the Composite map, when
the cursor shows you can insert a map.
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3ds Max inserts a Color Correction node between the graffiti bitmap and
the Composite map. This is another way to add a Color Correction map.
3 Double-click the new Color Correction node so you can see its parameters.
4 On the Lightness rollout, drag the Brightness slider to the right until the
Brightness field shows a value of about 15.0.

The graffiti colors are now brighter. On the other hand, the change in
Brightness affects the semitransparent portion of the alpha channel as
well, creating a halo effect around the graffiti strokes, which we don’t
want.
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Halo surrounding graffiti
strokes

You will correct this problem by increasing the contrast level.
5 Drag the Contrast slider to the right until the box displays a value of
about 25.0.

Now the graffiti looks more like it is painted on the door.
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Use a mask to add a sticker:
Now you will add a third layer to your composite map, one that features a
sticker.
1 Double-click the Composite map node to see its parameters once more.

2 At the top of the Composite Layers rollout, click
Layer).

(Add A New

3ds Max adds a new Layer rollout to the Composite map parameters, and
a new Layer 3 component to the Composite map node in the active View.
3 Drag a Bitmap from the Browser to the active View.
3ds Max opens a file dialog.
On the file dialog, choose c-sign.jpg, and then click Open.
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4 Wire the new Bitmap node to the Layer 3 component of the Composite
map.

3ds Max displays the new Bitmap on the Layer 3 rollout and in the
preview window.
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The c-sign bitmap applied as a top layer in the composite
map

Bitmaps saved in .jpg format have no alpha channel information. By
applying the c-sign.jpg image directly as a top layer, you have completely
obscured all layers beneath it. You can correct this by adding a mask.
(You could easily create your mask in a paint program, but a mask image
has already been prepared for you.)
5 Drag a another Bitmap from the Browser to the active View.
3ds Max opens a file dialog.
On the file dialog, choose c-sign-msk.jpg, and then click Open.
6 Wire the new mask Bitmap node to the Layer 3 (Mask) component of
the Composite map.
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The mask is a black-and-white image that acts as a “custom” alpha channel
to the color map.. Black areas of the mask allow the underlying layers to
show through, white areas are opaque, and gray areas are partially
transparent.
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Bitmap used to create a cutout of the poster for layer 3

Now on the Layer 3 rollout, the texture with the sticker appears at the
left, and the mask bitmap appears at the right.

In the preview, the “CAUTION” sticker appears by itself, with the rest of
the door now visible.
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Layer 3 with the mask applied

One small problem remains. You want the graffiti to cover the sticker,
not the other way around.
7 Drag the label of the Layer 2 rollout to a point just above the new Layer
3 rollout. Release the mouse when 3ds Max displays a blue line just above
the Layer 3 rollout label.
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3ds Max reorders and renumbers the layers accordingly. (Layer 3 becomes
Layer 2, and vice versa.)
Now the graffiti appears on top of the sticker about closure.
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NOTE In the active View, 3ds Max rewires the nodes to reflect the change
in the order of the layers, so you might want to press L in the active View to
update the layout of the nodes.

Save your work:
■

Save the scene as my_shop_door_3layers.max.

Blending Layers
In the previous lesson, you added layers to the Composite map while in Normal
mode. In this mode, no blending between layers takes place: Visibility is
determined solely by each layer’s alpha channel.
With the blending modes, you can produce interesting composite effects by
choosing how pixels in the top layer interact with those underneath. In this
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lesson, you will use two blending techniques to add more layers to the
composite map.
Set up the lesson:
■

Continue from the previous scene.

Add dirt to the bottom of the door with Multiply blending:
1 Double-click the Composite map node so you can see its parameters.

2 At the top of the Composite Layers rollout, click
Layer).

(Add A New

3 Drag a Bitmap node from the Browser to the active View.
3ds Max opens a file dialog.
On the file dialog, choose dirt-bottom.jpg, and then click Open.
This file shows dirt at the bottom of the door.
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Bitmap used in the first blend operation

4 Wire the new Bitmap node to the Layer 4 component of the Composite
map.
This file is a .jpg image that has no alpha channel. It completely obscures
all layers beneath it.
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5 On the Layer 4 rollout, open the Blending Mode drop-down list.
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In addition to Normal mode, which we have been using so far, there are
a variety of other methods for blending layers.
6 Experiment with blending techniques by choosing a few options from
the list.
The options resemble those available in such paint programs as PhotoShop
and Combustion. Refer to the 3ds Max Help for a description of what each
blending option does.
7 Choose Multiply from the list.
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First blend operation using Multiply

This option multiplies the color value of all layers in the composite. The
non-white color channels have a value of less than 1.0, so the
multiplication tends to produce darker colors, a condition you will now
correct.
8 On the Layer 4 rollout, change the Opacity value to 80.0, and then press
Enter.

The reduced opacity of the top layer results in a lighter overlay of grime.
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Add dirt to the top of the door with Linear Burn blending:

1 At the top of the Composite Layers rollout, click
Layer).

(Add A New

2 Drag a Bitmap node from the Browser to the active View.
3ds Max opens a file dialog.
On the file dialog, choose dirt-top.jpg, and then click Open.
This file shows dirt at the top of the door.
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Bitmap used in the second blend operation

3 Wire the new Bitmap node to the Layer 5 component of the Composite
map.
This file is also a .jpg image that completely obscures all layers beneath
it.
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4 On the Layer 5 rollout, choose Linear Burn from the Blending Mode
drop-down list.
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Linear Burn blending combines the new dirt map with underlying layers.
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Second blend operation using Linear Burn

Linear Burn combines the color of pixels in the top layer with colors from
the underlying layers. The darker the Layer 5 color, the greater the effect:
As a result, the default blending is too dark.
5 On the Layer 5 rollout, change the Opacity value to 70.0, and then press
Enter.

Now the dirt at the top of the door, like the dirt at the bottom, blends
well with the other textures.
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Add bump information to the composite:
1 Minimize the Slate Material Editor.

2 Activate the Camera01 view, then on the main toolbar, click
(Render Production).
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The shutter shows good detail, but in a rendering with shadows, its
corrugated surface lacks depth. You will correct this by adding bump
information from the shutters.jpg map.

3 On the rendered frame window, click
Window).

(Clone Rendered Frame

4 Restore the Slate Material Editor (press M).

5 In the Slate Material Editor, click
(Zoom Extents) to display the
entire material tree, and press L to arrange the layout.
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6 Wire the original Bitmap node, the one that contains shutters.jpg (it is at
the upper left), to the Bump Map component of the Shop Door material
node.
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7 Double-click the Shop Door material node so you can see its parameters.
8 Expand the Special Purpose Maps rollout. The buttom for Bump mapping
should show that shutters.jpg has been assigned. Change the amount
value (the numeric field just to the right of the Bump toggle) to 3.0.

The effect in the preview is rather exaggerated.
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9

Render the Camera01 viewport again and compare the result
with the cloned rendered frame.
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The fully composited shutter door, rendered with bump mapping

The shutter has lost its flat look and appears more three dimensional.
Save your work:
1 Save the scene as my_pawnshop_composite.max.

If you like, you can
open composite_completed.max and compare
your work with a completed scene file of this tutorial.
2 If you turned off the Use Real-World Texture Coordinates option at the
beginning of this tutorial, then from the main menu, go to the Customize
➤ Preferences ➤ General panel ➤ Texture Coordinates group and
turn the option back on.
Save your work:
■

Save the scene as my_shop_door_completed.max.
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Summary
In this tutorial, you learned how to create a composite map consisting of
multiple layers of images. You used alpha channel information and a mask
to control image transparency, then you used blending modes as an alternate
way to specify how layers are composited.

Spline Mapping
This tutorial shows you how to map a material to a curved surface, such as a
road or a garden hose.
You will start with the same pawnshop model featured in the Composite Map
tutorial, and use a spline to map a brick-like material onto the building’s
arched entrance.

In this tutorial, you will learn how to:
■

Choose a mapping method for an object

■

Create a spline and use it as a guide when mapping a texture to the object

■

Adjust the mapping through manipulation of the object’s UVW coordinates
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Skill level: Intermediate
Time to complete: 1 hour

Prepare the Scene
In this lesson, you choose a brick material to map to the building arch, and
specify the Unwrap UVW modifier as the mapping method. Then you create
a spline object and use it as a guide to the mapping process.
Set up the lesson:

On the Quick Access toolbar, click
(Open File), navigate to
\scenes\materials_and_mapping\spline_mapping\ and open
splinemap_start.max.

■

NOTE If a dialog asks whether you want to use the scene’s Gamma And LUT
settings, accept the scene Gamma settings, and click OK. If a dialog asks
whether to use the scene’s units, accept the scene units, and click OK.

Choose the material and apply the mapping method:

1

Maximize the Orthographic viewport and
Arch-Door object.
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select the

Arch door object with no material applied

2 Open the

Slate Material Editor. Locate the Sample Slots group.

A material called brick-soldier has already been prepared for the arch object.
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3 Drag the brick-soldier material from the Browser ➤ Sample Slots group
into the active View. In the Instance (Copy) Material dialog, make sure
Instance is chosen, and then click OK.

4 In the active View, make sure the brick-soldier node is selected, then on

the Slate Material Editor toolbar, click

Selection). Also click to turn on

(Assign Material To

(Show Map In Viewport).

The arch turns a dark gray. It shows no further detail because no mapping
coordinates have yet been specified for the Arch-Door object.
5

Close the Slate Material Editor.

Assign mapping coordinates (a first approximation):
The common way to assign mapping coordinates is to use a UVW Map
modifier, but if you look at the various options this modifier has for orienting
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a map (Planar, Cylindrical, Spherical, Shrink Wrap, Box, Face, and XYZ To
UVW), you can see that none of them corresponds to the curved shape of the
arch.

1 Go to the
UVW.

Modify panel. From the Modifier List, choose Unwrap

Unwrap UVW is often used to map images onto complex objects. Unwrap
UVW is better equipped to handle mapping of complex geometry, because
it breaks that geometry into sections, and applies planar mapping to each
section.
2 Right-click the arch object in the viewport and from the quad menu,
choose Hide Unselected to isolate the object.
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Arch object with brick material mapped to its surface

3 On the modifier stack, click the plus-sign icon (+) next to the Unwrap
UVW modifier to expand its hierarchy, then click to go to the Face
sub-object level.
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At this level, you can map the brick material onto each selected face of
an object.

4 In the viewport,

select a face on the arch object.

A yellow gizmo displays, representing a planar projection of brick material
onto the selected face.
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Planar projection of brick material onto an arch face

5

Select another face on the arch object.
Notice how the yellow gizmo resets onto the newly selected face.
On the Map Parameters rollout, there are a number of controls available
that can help you use Unwrap UVW to map specific types of objects.
Some of these are similar to the UVW Map options. The Cylinder button,
for example, displays controls used to map materials onto cylindrical
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objects, such as a human arm or a lamp post. Others have more special
purposes: You can use the Pelt button to map a material onto fabric such
as a pair of trousers, or a curtain.
In this scene, you will use the Spline option, which is useful for mapping
curved objects with a cylindrical or square cross-section such as a snake,
or a ventilation duct.
Before you use this option, you will create the spline object itself.
Create the spline shape to use as a map path:
1 On the modifier stack, click Face to exit the Face sub-object level.
The spline you create needs to be centered in the arch object. You could
use the Line tool or the Rectangle tool to draw the spline, but you would
need to enter the precise arch object coordinate values to do so. A more
convenient alternative is to derive the spline from the existing object
geometry.
2 On the stack, click the Editable Poly entry. Click Yes to dismiss the
warning message that 3ds Max displays.

3 On the Selection rollout, click
level.

4

(Edge) to go to the Edge sub-object

Click and Ctrl+click to select all the outer edges of the arch
object.
Be sure to leave the bottom and inside edges unselected.
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Arch object with all outer edges selected

5 On the Edit Edges rollout, click Create Shape From Selection.
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6 On the Create Shape dialog ➤ Curve Name box, name the shape
Arch-Door-Spline, make sure Shape Type is set to Smooth, then click OK.

7 Click
(Edge) again to exit the Edge sub-object level, then press H
to open the Select From Scene dialog.
8 Choose Arch-Door-Spline from the list to select the newly created spline.
Click OK.
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9 Press F3 to switch to wireframe mode.
10 From the Modifier List, expand the Editable Spline modifier, then and
click Spline.

11 On the Geometry rollout, scroll down so you can see the Outline button,
and then click it.
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12 In the viewport, click the original spline and drag inward so the outline
spline is positioned roughly at the midpoint between the outer and inner
edges of the front face of the arch.
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Outline spline centered on the front face of the arch object

The outline spline position does not have to be perfectly centered: You
will align it more precisely in a moment.
13 On the modifier stack, click Segment.
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14

Click and Ctrl+click to select the line segments at the base of
the arch (they connect the original spline to the outline spline), then
press Delete.
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Spline segments at the base of each arch column

15 On the modifier stack, click Spline again, select the outer, original spline,
then press Delete.
16 On the modifier stack, click Spline again to exit the Spline sub-object
level.
Align the spline with the arch:
1 On the main toolbar, choose the Local coordinate system.
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2 Make sure the spline is selected, then on the main toolbar click
(Align), and then click the Arch-Door object.
3 In the Align Selection dialog ➤ Align Position (Local) group, turn off X
Position and Y Position, turn on Z Position, and in both the Current
Object and Target Object subgroups, choose Center. Click OK.

The spline is now properly placed in the center of the Arch-Door object,
ready to be used as a guide to map the brick material.
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Apply the spline as a guide for the mapping:
1 Press F3 to return to a shaded view.

2

Select the Arch-Door object.

3 On the modifier stack, in the Unwrap UVW modifier hierarchy, click
Face to go to the Face sub-object level.
4 On the Selection Parameters rollout, turn off Ignore Backfacing.

If you leave Ignore Backfacing turned on, only the polygons facing you
in the viewport will be included in a selection. Polygons hidden on the
other side of the model will remain unselected.
5 Starting just above the base column to the left, click and drag diagonally
upward across the arch object to region-select all the faces except for
those on the underside of each column base.
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Arch faces selected

6 On the Modify panel, scroll down to the Map Parameters rollout and
click Spline.
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7 On the Spline Map Parameters dialog, click Pick Spline.
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For now, leave the Spline Map Parameters dialog open.
8 Press H and on the Pick Object dialog, choose Arch-Door-Spline from the
list, then click Pick.
The arch object is enveloped by a cage gizmo, which shows the outline
and cross sections of the mapping.

Arch object enveloped by the cage gizmo

Now you need to correct the base of the cage gizmo, which is too narrow for
the arch geometry.
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Adjust the mapping gizmo:

1

Orbit the viewport until you can see the two unselected faces at
the base of the arch.

Bottom of arch, showing that the cage gizmo is too narrow

2 On the main toolbar, click
(Select And Uniform Scale), For each
base of the arch, click to select the base of the gizmo, then drag the Scale
gizmo along its Y axis until the cage is at least as wide as each face at the
base of the arch.
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Cage gizmo after resizing each base

You do not need to be precise at this point: In the next lesson, you will
specify the cage more precisely by using the Unwrap UVW controls.
3 On the Spline Map Parameters dialog, click Commit to accept the changes
made to the spline mapping so far.
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Save your work:
■

Save the scene as my_arch_spline_mapping.max.

Fine-Tune the Mapping
With the introduction of the spline as a guide, now the brick material can
properly follow the contours of the arch object. However, in the present state
of mapping, the bricks are too large and they are mapped vertically up the
arch columns instead of horizontally across them. In this lesson, you use the
Edit UVWs dialog to adjust the mapping visually so that the bricks map
properly.
Set up the lesson:
■

Continue from the previous lesson.
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Set up the Edit UVWs dialog, and inspect the brick map:
1 On the Parameters rollout, click Edit.
3ds Max opens the Edit UVWs dialog.

Arch object displayed as grid of UVW faces and vertices

The window in the Edit UVWs dialog shows a flattened representation
of the arch object. There are four red vertical panels made up of UVW
faces and vertices. The panels represent the inner, outer, left, and right
face of the arch.
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2 Move the Edit UVWs window so you can see the arch object in the
Orthogonal and Perspective viewports. If you need to, adjust the size of
the Edit UVWs dialog so you can see all of the arch faces. Use the Edit

UVWs window

zoom tool to zoom out slightly.

The surface of the arch object is currently mapped to a single tile of the
brick-soldier material.
The square occupied by the flattened arch object corresponds to the dark
square in the next diagram, which shows the coordinate system of the
Edit UVWs window.

The texture you apply to the arch object will be mapped to this area,
whose coordinate system ranges from 0, 0 to 1, 1.
3 On the main menu, choose Rendering ➤ View Image File, and on the
View File dialog, navigate to the folder \sceneassets\images\, click to
highlight brick_soldier-diff.jpg and click Open.
3ds Max opens an image file viewer, showing that brick-soldier-diff.jpg is
a square image. At present, it is mapped on a one-to-one basis using UVW
coordinates that range from 0 to 1. Outside of the square bounded by
the 0 to 1 values, the same image is tiled two more times in each direction.
4

Close the image file viewer.
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5 In the Edit UVWs window, open the texture drop-down list at the right
of the toolbar, and choose the entry for “(brick_soldier-diff.jpg)” to display
the map itself in the window.

6 In the Selection Modes group at the lower right of the Edit UVWs dialog,
click Options.

3ds Max opens a further Bitmap Options group that appears below the
Soft Selection group.
7 In the Bitmap Options group, change the value of Brightness to 0.75,
then press Enter .

The bitmap in the Edit UVWs window becomes brighter and easier to
see.
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Correct vertical distortion:

1 In the Selection Modes group, click

(Vertex Sub-Object Mode).

By switching to the Vertex sub-object mode, you can see how the Unwrap
UVW modifier has slightly warped the contours of the arch object. You
need to straighten out these contours.
NOTE The contours in your unwrapped arch object might be slightly different
to the one shown in the next illustration, depending on how you resized the
cage gizmo in the previous lesson.
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Warped contours of the unwrapped arch object

2 On the Unwrap UVWs toolbar, click
all the vertices of the left outside edge.

(Move), and region-select
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UVW vertices of left outside edge selected

For these vertices to be properly aligned with the image map, they must
all have the same U value of zero.
3 In the U coordinate field (on the toolbar at the lower left of the main
dialog), type 0.0, then press Enter.

This gives the the horizontal map coordinate for each selected vertex a
U value of 0, thereby aligning all the vertices vertically at their origin (0)
as shown in the next diagram.
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4 Region-select all the vertices at the right outside edge of the arch object.
5 In the U coordinate field, type 1.0, then press Enter.
This aligns each selected vertex vertically at a horizontal value of 1.
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6 Select in turn, from left to right, the remaining columns of vertices for
each inside edge. Give each inner edge a U value of 0.25, 0.5, and 0.75
respectively.
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UVW vertices after alignment

The UVW map now covers the surface of the arch object much better.
But as you can see in the window, there remains an obvious problem.
The bricks are mapped vertically, whereas they need to be mapped
horizontally. To make this change, you need to rotate the mapping by
90 degrees.
Correct the orientation of the bricks:
1 Press Ctrl+A to select all the vertices.

2 On the Edit UVWs toolbar, click

(Freeform Mode).
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3 Position your cursor over a vertex at the midpoint of any side, and drag
the whole UVW grid until the rotation indicator displays 90.

UVW grid after rotation

Now the bricks on the arch are oriented horizontally. Notice, however,
that the bricks are still too large for the area they cover.
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Arch object with bricks oriented horizontally

You need to resize the UVW grid over the map so that the bricks are better
distributed.
Align the edges of the bricks and the arch:
Specifically, the current vertical scaling of the bricks means that the edges of
bricks are not aligned with the edges of the arch: The UVW grid spans five
bricks, when it should span only four.
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Edges of bricks not aligned with the vertical edges
of the arch

➤

Hold down the Shift key to constrain scaling to a single axis, then click
on the left or right corner of the UVW grid and drag down until the grid
is resized vertically (along the V axis) to fit over four rows of bricks.
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UVW grid resized vertically to cover four rows of bricks, one row per face

Now the edges of the bricks and the edges of the arch line up.
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Along the U axis, the bricks are still too large.
Increase the number of bricks along the length of the arch:

1 In the Edit UVWs window,
zoom out and
see all of the brick-soldier-diff.jpg image.

pan so you can

2 In the Bitmap Options group, change the value of Tiles to 2.
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Now the brick-soldier-diff.jpg is tiled twice in each direction.
NOTE The Tiling value affects the display of the map in the Edit UVWs
window. It does not affect the mapping of the object, which is managed by
the Bitmap controls. When Tiling=0, the map appears only in the unit square;
when Tiling=1 (the default), the map is tiled 3 times in both U and V; when
Tiling=2 (as you just set it), the map is tiled 5 times in both U and V.

3

Zoom out and
brick-soldier-diff.jpg tiles.

pan again so you can see all of the
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Two image tiles surround the UVW grid in every direction

4

Region zoom in again so you can clearly see the UVW grid and
the right edge of the bricks map.
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5 On the Edit UVWs dialog main toolbar, turn on
(Freeform Mode).
Make sure all the vertices are still selected, then Shift+drag the top-right
corner vertex all the way to the right-most edge of the map.
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Shift+drag the top right corner of the UVW grid to resize it horizontally

Because the UVW guides have been stretched horizontally to cover three
map tiles (from 0 to 3 along the U axis), now three times as many bricks
are mapped along the length of the arch.
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Correct the bulging appearance of bricks at the top of the arch:
If you look closely at the top of the arch, you can see that the bricks appear
to bulge out.
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Bricks in arch show deformation

This deformation is because the number of divisions in the arch object’s
polygon mesh does not match the number of bricks mapped onto them.

1 On the Edit UVWs dialog, click

(Zoom Extents) to zoom in to the

UVW guides, then
select only those vertices in the center that
correspond to the top of the arch.

UVW grid with arch vertices selected

There are 14 divisions in the polygon mesh that define the arch, but there
are 16 bricks in the underlying map. You need to resize the UVW guides
so that the mesh divisions match the number of bricks in the map.
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2 With the
Freeform tool still active, Shift+drag the top-left corner
vertex of the selection to the right by one brick.
3 Shift+drag the top-right corner vertex of the selection to the left by one
brick.

The number of arch polygons now matches the number of bricks in the map.

Bricks at the top of the arch no longer appear to bulge.

Correct the scaling of bricks in the column:
If you look at the whole archway, you can see that the fix you just made to
the top of the arch, makes the bricks at the top appear larger than the bricks
in the two columns.
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Arch bricks are larger than the column bricks.

1 In the Edit UVWs window,
select only the vertices that correspond
to the left-hand column of the arch (which is on the right in the Edit
UVWs window and the viewport).
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Left column vertices

2 Shift+drag the top-right corner vertex of the selection to the left by two
bricks.

Left column after being resized two bricks to the left

3 Repeat the previous two steps for the arch object’s right-hand column,
dragging the UVW guides to the right by two bricks.
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All bricks mapped to the arch object, both on the columns and the arch,
now appear to be equal in size. The result is a properly mapped archway,
with the bitmap convincingly following the contours of the object’s
geometry.
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Arch object with bricks of equal size

Render the arch:
1

2

Close the Edit UVWs dialog and on the modifier stack, click
Vertex to exit the Vertex sub-object level, then click any empty part of
the viewport to deselect the arch.

Minimize the Orthographic viewport.
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3 Right-click the Camera01 viewport and from the quad menu, choose
Unhide All.

4 On the main toolbar, click
work.

(Render Production) to render your

Rendered view of brick material mapped to the pawnshop entrance

Now your brick material is mapped to the archway properly.
Save your work:
■

Save the scene as my_arch_spline_mapping_completed.max.

Summary
In this tutorial, you learned how to use the Unwrap UVW modifier combined
with a spline object to map a material onto a curved object. You also learned
how to manipulate the object’s UVW lattice in the Edit UVWs dialog to specify
how the material’s bitmap image is projected onto the target surface.
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Using the Multi/Sub-Map
You can apply multiple Multi/Sub-Maps to objects in a scene whenever you
need to give similar objects in a group their own unique identity.
In this tutorial, you will assign an assembly of stadium seats a common
material, then use a variety of Multi/Sub-Maps to assign each seat its own set
of stains and discolorations.

You can distribute Multi/Sub-Maps among objects randomly, by object, or by
material ID. Each sub-map can be based on a color, a bump map, or an image,
among other components. You can distribute sub-maps individually, or
composited with other maps to produce a more nuanced effect.
Multiple sub-mapping differs from mapping at a sub-object level, where you
apply a material on a one a one-to-one basis to individual components of a
single object.
The next illustration provides an example of sub-object mapping where five
materials have been mapped to a door consisting of five sub-objects. In this
technique, you select the polygon of each component, assign it a material ID,
and apply a unique material to each ID.
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The next illustration provides an example of multi/sub-mapping where
multiple sub-maps have been applied to a material. The jeep surfaces are a
composite of two layers: a layer of army green material and a layer of three
sub-maps. Each sub-map is a bitmap image of a serial number, and is assigned
to a jeep according to the vehicle’s object ID number.
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You can use any map channel in a sub-map. The next illustration shows three
objects whose materials share the same diffuse color and specular highlights,
but a sub-map with a slight variation of the bump channel has been assigned
to each material to give each urn a unique surface texture.
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In this tutorial, you will learn how to:
■

Assign ID numbers to objects in a scene

■

Create sub-maps based on multiple diffuse values

■

Create sub-maps based on multiple bitmap images

■

Create a material from two composited layers of sub-maps

NOTE In this tutorial, you will be creating composite maps. If you are not familiar
with this technique, it is recommended that you complete the Composite Mapping
tutorial on page 1176 first.
Skill level: Intermediate
Time to complete: 30 minutes
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Create the Multi/Sub-Map Material
In this lesson, your objective is to divide the seating in the stadium scene into
four distinct groups, and use multi/sub-mapping to assign each group its own
color, with red representing the most expensive seats and green the cheapest.
Set up the lesson:

On the Quick Access toolbar, click
(Open File), navigate to
\scenes\materials_and_mapping\multi_maps\ and open multi_maps_start.max.

■

NOTE If a dialog asks whether you want to use the scene’s Gamma And LUT
settings, accept the scene Gamma settings, and click OK. If a dialog asks
whether to use the scene’s units, accept the scene units, and click OK. If a
Missing External Files dialog opens, click Continue.

Choose mental ray and group objects by ID number:

1 On the main toolbar, click

(Render Setup).

2 On the Render Setup dialog ➤ Common tab ➤ Assign Renderer rollout,
make sure the Production field is set to mental ray Renderer.

The Multi/Sub-Map is a mental ray feature. It is available only when you
choose mental ray or the Quicksilver Hardware renderer as your renderer.
3

Close the Render Setup dialog.
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4 Right-click an empty area of the main toolbar and from the pop-up menu,
choose Layers.

3ds Max opens the Layers toolbar.

5 On the Layers toolbar, open the layers list and click to hide all layers
except Seats.
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Now only the seats objects are visible, making their selection much easier.

6 Close the Layers toolbar and

7

maximize the Top viewport.

Select any seat object, right-click and from the quad menu,
choose Object Properties.
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Notice that in the Object Properties dialog ➤ General tab ➤ G-Buffer
group, the Object ID displays as 0. All objects when they are first created
are assigned an ID of 0. Later on, you will change this number in order
to assign certain groups of seat objects their own material variations.
8 Click Cancel to close the dialog, then on the main toolbar, choose the
Lasso tool from the Select Object flyout.

9 Use the Lasso tool to select the seats shown in white in the next
illustration.
Be sure to hold down the Ctrl key when you select additional seats.
TIP If you select unwanted seats, use the Alt key to deselect them.
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10 Right-click, choose Object Properties from the quad menu, and in the
Object Properties dialog ➤ General tab ➤ G-Buffer group, change the
Object ID to 1. Click OK.
11 Use the Lasso tool to select the seats shown in the next illustration.
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Be sure to hold down the Ctrl key when you select additional seats.
12 Right-click, choose Object Properties from the quad menu, and in the
Object Properties dialog ➤ General tab ➤ G-Buffer group, change the
Object ID to 2. Click OK.
13 Select the seats shown in the next illustration.
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14 Right-click , choose Object Properties, and in the Object Properties dialog
➤ General tab ➤ G-Buffer group, change the Object ID to 3. Click OK.
15 Select the seats shown in the next illustration, and give them an object
ID of 4.
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Now all the stadium seats have an object ID of 1, 2, 3, or 4. With this in
place, each seat is ready to receive its own material variation and
sub-object maps.
Create a material for the seats:
1 Continue from the previous procedure, or open the file
multi_maps_01.max.
2 Press M to open the Slate Material Editor.
TIP If the Compact Material Editor opens instead, then on the Material Editor
menu bar, choose Modes ➤ Slate Material Editor.
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3 From the Material/Map Browser panel on the left, drag an Arch & Design
material into the active View (View1), the empty area in the center of the
Slate Material Editor window.
In the Browser, the Arch & Design material is in the Materials ➤ mental
ray group.
A node for the Arch & Design material appears in the active View.
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4 Double-click the Arch & Design material node to display its parameters
in the Parameter Editor panel on the right.
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5 Change the name of the material to seats.

6 On the Templates rollout, open the drop-down list and choose Matte
Finish.

7 In the Top viewport,

select all the seats, then on the Slate

Material Editor toolbar, click

(Assign Material To Selection).

The matte-finish seats material is assigned to all the seats.
Now you will add multiple sub-object maps to the seat material’s diffuse
color channel.
Define a multi/sub map for the seats:
1 On the Slate Material Editor, drag a Multi/Sub-Map from the Material/Map
Browser panel to the active View.
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You can find the Multi/Sub-Map entry in the Maps ➤ mental ray group.
A node for the Multi/Sub map appears in the active View.

2 Drag from the output socket of the Multi/Sub-Map node (the round
control at the right of the node). 3ds Max creates a wire. Drop the end
of the wire on the input socket for the Diffuse Color Map component of
the seats material node.
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3 Double-click the Multi/Sub map node to display its parameters.
4 On the Multi/Sub-Map Parameters rollout, set the Number Of Colors/Maps
To Use to 4.
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By default, Switch Color/Map Based On is set to Object ID, meaning that
the sub-maps will be distributed among the objects by their ID number.
You have already set up the object IDs.
The Default/Out-Of-Range Color is set to red. This means the material of
any object in the scene with an ID other than 1 to 4 will display in red.
Red is one of the seat colors we are using, so click this color swatch and
use the Color Selector to change this color to a neutral gray.
NOTE If you were to turn on the Repeat option, all objects with IDs higher
than 4 would display the color sequence assigned to objects with IDs 1 to 4.
5 Click the color swatch labeled Color/Map #1.
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6 On the Color Selector, change the color to a bright red: Red = 0.8, Green
= 0.0, Blue = 0.0, then click OK.
7 Click the color swatch labeled Color #2 and change the color to a blue:
Red = 0.275, Green = 0.534, Blue = 0.814, then click OK.
8 Click the color swatch labeled Color #3 and change the color to a yellow:
Red = 0.867, Green = 0.808, Blue = 0.231, then click OK.
9 Click the color swatch labeled Color #4 and change the color to a green:
Red = 0.158, Green = 0.583, Blue = 0.141, then click OK.
These colors will not show up in the viewports, but they will be visible
when you render the image.
10 Make sure the Top viewport is active, then on the main toolbar, click

(Render Production) to render the scene. Keep the rendered
frame window open.
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The rendered image shows seats with their sub-map material clearly
visible. Seats with an object ID of 1 show the red sub-map applied, seats
with an object ID of 2 show the blue sub-map applied, and so on.
11 Activate the Camera-Seats viewport.
12 In the rendered frame window’s Viewport list, make sure Camera-Seats
is chosen, then click Render to render the scene again.
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13

Close the rendered frame window.

Save your work:
■

Save the scene as my_stadium_submaps.max.

Next
Composite Sub-Maps Onto Objects on page 1290

Composite Sub-Maps Onto Objects
The seats you mapped in the previous lesson appear too uniform: They lack
individual signs of wear and tear. Now you will introduce another level of
randomness to the seat material by adding sub-maps that contain blemishes
and other discolorations.
To accomplish this, you will composite two layers of sub-maps onto one
another. One layer will contain the four diffuse colors you specified in the
previous lesson, the other layer will contain sub-maps with a mixture of image
maps of dirt patterns.
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Set up the lesson:

■

Continue from the previous lesson, or

open multi_maps_02.max.

Create the composite layers:
1 If the Material Editor is not already open, press M to open it.

2 In the Slate Material Editor active View, click
(Zoom Extents) so
you can see both the material node and the Multi/Sub map node.
3 Drag a Composite map (Maps ➤ Standard ➤ Composite) from the
Browser. In the active View, drop the map on the wire that connects the
Multi/Sub map and the seats material.
3ds Max displays a cursor that indicates you are inserting the map into
the wire. Release the mouse when this cursor appears.
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4 After you release the mouse, 3ds Max displays a pop-up menu. On the
pop-up menu, click Layer 1.
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This incorporates the Multi/Sub map as the base layer of the composite.
5 On the Slate Material Editor, press L to arrange the layout of the material
tree.
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Add a Multi/Sub map to Layer 2:
1 Double-click the Composite map node to display its parameters.
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2 On the Composite Layers rollout, click

(Add A New Layer).

3 Drag a second Multi/Sub-Map (Maps ➤ mental ray ➤ Multi/Sub-Map)
from the Browser into the active View, then wire the new Multi/Sub map
to the Layer 2 component of the Composite map.
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TIP Pressing L again can help you see all the nodes. So can the other Slate
Material Editor navigation tools. After you’ve used a navigation tool such as
Zoom or Pan, right-click an empty area of the active View so you can select
material and map nodes once again.
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4 Double-click the new Multi/Sub map node to display its parameters.
5 On the Multi/Sub-Map Parameters rollout, set Number Of Colors/Maps
To Use to 6.
This time, rather than change colors, you will add six bitmap images to
the sub-map.
Add the first dirt bitmap to the Multi/Sub map:
1 Drag a Bitmap from the Browser into the active View.
3ds Max opens a file dialog.
2 On the Select Bitmap Image File dialog, highlight dirt1.jpg and turn off
Sequence (otherwise, 3ds Max opens all the dirt files as an animated
sequence!). Click Open.
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The thumbnail at the bottom right of the dialog gives you an idea of
what the dirt1.jpg image looks like.
3 Wire the new Bitmap node to the Color/Map #1 component of the new
Multi/Sub map.

4 Double-click the new Bitmap node so you can see its parameters.
5 On the Coordinates rollout, make sure Use Real-World Scale is turned
off.
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Add the other bitmaps to the Multi/Sub map:
➤

Repeat the previous procedure for the remaining bitmaps, dirt2.jpg through
dirt6.jpg. Wire the Bitmap node for dirt2.jpg to the Color/Map #2
component, dirt3.jpg to the Color/Map #3 component, and so on.

Composite Sub-Maps Onto Objects | 1299

All six bitmaps wired to the second Multi/Sub map

Define how the two layers composite together:
1 Double-click the Composite map node to see its parameters.

The Operations drop-down list for each layer is set to Normal, which
means that the layer with the highest number obscures all layers beneath
it. You need to add an operation that will blend the layers together.
2 On the Layer 2 rollout, click to open the Operations drop-down list, and
choose Multiply.
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Now the Composite map combines the color and dirt map layers.
3 Make sure the Camera-Seats viewport is active, then press F9 to render
the scene (leave the rendered frame window open).

Notice how each group of seats shows the same dirt map. The dirt1.jpg
map is applied to all objects in the scene with an ID of 1. The dirt2.jpg
map is applied to all objects in the scene with an ID of 2, and so on. You
now need to distribute a random mix of all six dirt maps for all seats
groups in the stadium.
Define the sub-map distribution method and fine tune the composite image:
1 Double-click the Multi/Sub map node that contains the dirt bitmaps, so
you can see its parameters. On the Multi/Sub-Map Parameters rollout,
open the Switch Color/Map Based On drop-down list, and choose
Random.
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2 Click Render to render the scene again (still leaving the rendered frame
window open).

Now, all six dirt maps appear at random for all seats groups in the
stadium. The dirt patterns, however, stand out too clearly.
3 Double-click the Composite map node to see its parameters.
4 On the Layer 2 rollout, change the Opacity setting to 35.0.

The dirt layer is reduced in visibility to 35 percent of its full opacity.
5 Click Render to render the scene once more.

1302 | Chapter 6 Materials and Mapping Tutorials

The dirt maps appear more faded, giving the seats a subtle variation that
appear more realistic.
Save your work:
1 Save the scene as my_stadium_submaps_completed.max.
2 If you wish, open the file multi-maps_completed.max and render the
Camera-Seats viewport to see a finished version of the stadium scene.
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Summary
In this tutorial, you learned how to give similar objects individual character
by adding sub-maps to their base material.
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Lighting Tutorials

7

The tutorials in this section show you how to set the mood and create dramatic lighting effects
for scenes built in 3ds Max.

A midday scene of an army camp

Features Covered in This Section
■

Creation of a Daylight system to illuminate a scene with geographic accuracy.

■

Daylight illumination of building interiors using the Sky Portal.

■

Exposure control.

1305

■

Shadow creation and definition.

■

Nighttime illumination using adjustable photometric lights.

Lighting and Rendering a Daylight Scene
In this tutorial, you have a scene of an army compound that requires lighting
conditions for early, mid-day and late-day illumination.
To accomplish this, you will create a Daylight system and customize it to
match a specific scene location and time. Then you’ll set scene exposure and
combine the Daylight system with a mental ray Sky Portal object that will
cast light into building interiors. You will fine-tune the late-day illumination
by adjusting the aperture setting.
After completing these lessons, you will see how easy it is to use mental ray
rendering options to create realistic daylight conditions.

Morning illumination
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Mid-day illumination
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Late-day illumination

In this tutorial, you will learn how to:
■

Use a Daylight system to illuminate scenes set in the daytime.

■

Set up illumination based on the scene’s geographic location, orientation,
and time of day.

■

Use the Sky Portal object to gather skylight and apply it to the interior of
buildings.

■

Adjust scene exposure.

Skill level: Intermediate
Time to complete: 1 hour

Adding Daylight Illumination
Start by switching from the default 3ds Max renderer to the mental ray
renderer.
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Set up the lesson:

■

On the Quick Access toolbar, click
(Open File) and from the
\lighting_and_rendering\army compound folder, open
army_compound_lighting_start.max.
NOTE If a dialog asks whether you want to use the scene’s Gamma And LUT
settings, accept the scene Gamma settings, and click OK. If a dialog asks
whether to use the scene’s units, accept the scene units, and click OK.

Make the mental ray renderer active:

1 On the main toolbar, click
Setup dialog.

(Render Setup) to open the Render

2 On the Common tab ➤ Assign Renderer rollout, click
(Choose
Renderer) for the Production renderer (at present the label says Default
Scanline Renderer).

3ds Max opens a Choose Renderer dialog.
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3 In the Choose Renderer dialog, choose mental ray Renderer, then click
OK.
4

Close the Render Setup dialog.

5 On the main toolbar, click

(Render Production).

TIP You can press F9 as a shortcut for clicking Render Production.
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Rendered scene with no daylight system present

Default lights provide basic illumination in the scene, with textures and
materials applied, but the rendered image appears flat and not very
realistic. You need to add daylight to the scene. This will be generated
by a Daylight system comprising two mental ray photometric light
sources:
■

mr Sun, which simulates direct light from the sun.

■

mr Sky, which simulates indirect light created by the scattering of
sunlight in the atmosphere.

These two light sources will be accompanied by the “mr Physical Sky”
environment shader, which generates the physical appearance of the sun
and sky.
6

Close the Rendered Frame Window.
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Create the Daylight system:

1 On the
Create panel, click
rollout, click Daylight to turn it on.

(Systems). On the Object Type

2 3ds Max opens a Daylight System Creation dialog that prompts you to
add an “mr Photographic Exposure Control” to the scene.

Click Yes to add the mental ray Photographic Exposure Control with the
recommended Exposure value of 15.
3 In the Top viewport, click anywhere over the compound and drag slightly
in any direction to create a compass rose.
4 Release the mouse button.
As soon as the mouse button is released, a Daylight object, or “sun,” is
created.
5 Move the mouse upward to position the daylight object in the sky. You
can watch the object’s position in the Front viewport. The exact height
of the Daylight object in the sky is not important.
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6 Click once to set the Daylight object position, then right-click to end
Daylight creation.
Set the time and location of the light source:
Now you will reposition the Daylight object, or “sun,” so its position in the
sky corresponds to the geographic location of the scene.

1 With the Daylight object selected, go to the
on the Daylight Parameters rollout, click Setup.

Modify panel, and
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3ds Max displays the

Motion panel.

2 In the Motion panel ➤ Control Parameters rollout ➤ Location group,
click Get Location.
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3 On the Geographic Location dialog, open the Map drop-down list, and
choose South America.
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4 On the map, click on Nicaragua, or choose Managua Nicaragua from the
City list displayed to the left.

After you click OK, 3ds Max positions the Daylight sun object to simulate
the real-world latitude and longitude of Managua.
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The Control Parameters ➤ Time group displays controls that let you
modify the date and time of day, which also affects the position of the
sun. The first scene you will illuminate and render is morning at 9 AM.
5 In the Time group ➤ Hours spinner box, set the time to 9.

6 In the Location group, set the North Direction to 110 degrees.

This adjustment reorients the north-south position of the scene so when
you render the late-day version of the scene, the sun disc will appear over
the barracks as it prepares to set in the west.
7 Right-click the Camera01 viewport and press F9 to render the scene.
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Rendered scene with Daylight object positioned at 9am

Now objects are lit well, and they cast shadows, but the sky is still a blank.

8 With the Daylight object selected, go to the

Modify panel.

9 On the Daylight Parameters rollout, open the Sunlight drop-down list
and choose “mr Sun.”
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10 Also on the Daylight Parameters rollout, open the Skylight drop-down
list and choose “mr Sky.”

3ds Max opens a dialog that asks if you want to add the “mr Physical
Sky” environment map to the scene.
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11 Click Yes to add the “mr Physical Sky” shader as an environment map.

12

Render the Camera01 viewport again.

Rendered scene with mr Physical Sky shader added
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Now the scene looks like a sunny morning. Notice, however, that the
regions behind the barracks doorways remain unnaturally dark. One way
to solve this would be to increase the number of ray bounces used for
Indirect Lighting. An alternate way is to add Sky Portal objects to the
scene. The next section describes this method.
Save your work:
■

Save the scene as my_army_compound_daylight.max.

Using Sky Portals and Photographic Exposure Control
A Sky Portal is a light object that gathers the sky light (as opposed to direct
sunlight) generated by the Daylight system, then directs the light flow to the
interior of certain scene objects.
NOTE Sky Portals typically require less rendering time than the Global Illumination
option. They are an effective alternative to quickly visualize a scene.
Set up the lesson:
■

Continue working on your own scene file or in the \lighting_and_rendering

folder,

open army_compound_lighting_daylight.max.

Add the Sky Portal:

1 On the

Create panel, click

(Lights).

Photometric should be chosen on the drop-down list.
On the Object Type rollout, click “mr Sky Portal,” then turn on AutoGrid.
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2 In the Camera01 view, create the Sky Portal by dragging diagonally from
the upper-right corner of the far-right barracks entrance to the lower-left
corner, until the entire opening is covered.

Sky Portal object in front of the barracks door

The Sky Portal should not be much larger than the door.
3 Right-click to complete creating the Sky Portal.

4 Right-click the Top viewport and
zoom into the scene until you
can clearly see the barracks entrance where you created the Sky Portal
object.
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5

Reposition the Sky Portal so it lies just inside the barracks
entrance.

If the Sky Portal is placed outside the entrance, the sides of the door frame
attract unneeded illumination.

6 With the Sky Portal object still selected, go to the
Modify panel.
On the “mr Skylight Portal Parameters” rollout, make sure the Sky Portal
is On, then change the value of Multiplier to 8.0.

Typically you would specify a lower Multiplier value if Sky Portal objects
were added to the other doors and windows of the barracks.
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7

Zoom out and
front of all three barracks.

pan in the Top viewport so you can see the

8

Shift+copy the Sky Portal to the left to create two more instances
of the Sky Portal object, one for each entrance to the two remaining
barracks.

9 Activate the Camera01 viewport, then
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render the scene.

Rendered scene with light channeled into the barracks interior

The result is much improved. The Sky Portal is now channeling sky light
into the barracks.
10 Minimize the Rendered Frame Window.
Set the illumination for mid and late afternoon:

1

Select the Daylight system (click the sun object, not the compass

rose), then go to the
Motion panel. ➤ Time group ➤ Hour
spinner box, set the time to 14 (2 PM).

2 Make sure the Camera01 view is active, then

render the scene.
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Rendered scene with Daylight object positioned at 2 PM
®

The shadow of the suspended light next to the jeep indicates that the
sun is almost directly overhead. However, for this time of day the Sky
Portals are transferring too much light into the barracks.

3

4

Make a clone of the Rendered Frame Window.

Select one of the Sky Portal objects, go to the
Modify
panel, and on the mr Skylight Portal Parameters rollout, change the
Multiplier value to 5.0.
The Sky Portals are instances, so any change you make to one Sky Portal
will be passed on to the others.

5

Render the Camera01 viewport again.
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Rendered scene with Sky Portal multiplier reduced

Compare the latest rendered frame with the one you cloned earlier. The
entrance illumination is subtle but more realistic.
Now you will generate a third rendered version of the scene, this one
showing late-day illumination.

6

7

Select the Daylight system sun object, and in the
panel ➤ Time group, change the Hour to 17 (5 PM).

Motion

Render the Camera01 viewport.
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Rendered scene showing late day illumination before Exposure Control adjustment

The rendering is too dark. You will use exposure control to adjust the
illumination.
8 On the Rendering menu, choose Exposure Control.
3ds Max opens the Environment And Effects dialog.
9 In the “mr Photographic Exposure Control” rollout ➤ Exposure group,
choose Photographic Exposure, then set the value of Aperture (f-Stop) to
5.6.
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10

Render the Camera01 viewport again.

Rendered scene after exposure adjustment

The new f-stop setting compensates for the time of day.
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You have created three distinct moods based on mental ray lighting
techniques.
Save your work:
■

Save the scene as my_army_compound_evening.max.

Summary
You can create a Daylight system to simulate real-world outdoor lighting
conditions at any time of day, at any location on the planet. The mental ray
renderer offers a range of presets that define proper exposure settings, which
you can adjust manually as needed. You can add Sky Portal objects to channel
daylight into structures through their doorways and windows, to improve
interior illumination.

Lighting and Rendering a Nighttime Scene
In this tutorial, you will illuminate the army compound so you can render it
at night.
You will create photometric lights that replicate real-world lighting systems,
then add a touch of realism using the mental ray Glare effect.
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In this tutorial, you will learn how to:
■

Place photometric lights in a scene and adjust light color.

■

Set shadow parameters so lights cast shadows properly.

■

Change the exposure for a nighttime scene.

■

Use a bitmap image as the scene background and adjust its output to
compensate for night lighting conditions.

Skill level: Intermediate
Time to complete: 1 hour

Adding Photometric Lights
You will start by switching from the default renderer to the mental ray renderer,
if you have not already done so. Then you will add photometric lights to
illuminate the nighttime scene.
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Set up the lesson:

■

From the
to reset 3ds Max.

Application menu, choose Reset, and accept the prompt

■

On the Quick Access toolbar, click
(Open File) and in the
\lighting_and_rendering\army compound folder, open
army_compound_lighting_start.max.
NOTE If a dialog asks whether you want to use the scene’s Gamma And LUT
settings, accept the scene Gamma settings, and click OK. If a dialog asks
whether to use the scene’s units, accept the scene units, and click OK.

Make the mental ray renderer active:

1 On the main toolbar, click
Setup dialog.

(Render Setup) to open the Render

2 On the Common tab ➤ Assign Renderer rollout, click
(Choose
Renderer) for the Production renderer (at present the label says Default
Scanline Renderer).

3ds Max opens a Choose Renderer dialog.
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3 Choose mental ray Renderer and click OK.
4

Close the Render Setup dialog.

5 Activate the Camera01 viewport, and on the main toolbar, click
(Render Production).
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Rendered scene with default lighting

This is the same starting point as the previous tutorial, with default lights
providing basic illumination. Now you will add photometric light objects
to illuminate the scene.
6

Close the Rendered Frame Window.

Set up the photometric lights:

1 Activate the Top viewport and
next to the jeep01 object.
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zoom in to the overhead lamp

2 On the
Create panel, click
(Lights). If AutoGrid is on,
turn it off. On the Object Type rollout, click Free Light to turn it on.

3ds Max opens a dialog that asks whether to add an “mr Photographic
Exposure Control” to the scene.
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3 Click Yes to add the exposure control.
4 In the Top viewport, click once at the center of the lamp shade to create
the light object.
5 Look at the Camera01 viewport. By default, the light object is created on
surface plane of the scene.
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6 Activate the Front viewport and
the new light.

zoom in to see the area around

7 Use
(Select And Move) to move the light object on its Y axis
until it is just below the lamp light bulb.
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Do not position the light object inside the bulb itself. If you do, the bulb
object will cast unwanted shadows.

8 Go to the
Modify panel. On the Templates rollout, open the
drop-down list and choose Street 400W Lamp (Web).
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Next, you will adjust the color of the light to be cast. You have two ways
to do this: You can specify color by the type of object that emits the light,
such as an incandescent bulb or a fluorescent tube. Or you can specify
light color by its temperature, in degrees Kelvin.
9 In the Intensity/Color/Attenuation rollout ➤ Color group, open the
drop-down list and choose Incandescent Filament Lamp.
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The color swatch just below this list updates to match the color
temperature of your light selection. The rollout also displays its
corresponding value in degrees Kelvin.

10 Activate the Camera01 viewport and
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render the scene.

Scene exposure set too high for the light object

Even though 3ds Max added an exposure control to the scene, its default
settings don’t work with this light object.
Set scene exposure:
1 On the Rendering menu, choose Exposure Control to open the
Environment And Effects dialog.
2 In the “mr Photographic Exposure Control” rollout ➤ Exposure group,
choose Photographic Exposure, then specify a Shutter Speed of 1.0 (1/1.0

= 1 Sec.), then

render the scene again.
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Rendered scene after adjustment to exposure

The rendering is much improved, but light is falling only on the central
part of the compound. You need to add another overhead light.
3

Close the Environment And Effects dialog.

Add another overhead light:

1 Activate the Top viewport and
zoom out until you can see the
other overhead light fixture, to the lower right.
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2

Shift+move the light object until it is just below the other light
fixture.

3ds Max opens a Clone Options dialog.
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3 In the Object group, choose Instance to create an instance of the Free
Light object, then click OK.

4 Activate the Camera01 viewport and
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render the scene again.

Scene illumination after second light added

The rear area of the compound is now illuminated, but objects in the
scene cast no shadows.
Add shadows to the rendering:

1 With either light selected, go to the
Modify panel. In the ➤
General Parameters rollout ➤ Shadows group, turn on Shadows.
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2 Open the Shadow Map Params rollout (you might have to scroll down
to see it). Reduce Bias to 0.0 to set shadows closer to the shadow-casting
object, and change Sample Range to 12.0.
Setting Sample Range to a value greater than zero generates soft-edged
shadows.

3

Render the Camera01 viewport again.
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Objects in the scene now cast shadows

Notice the improvement that shadow casting has on the rendering of
the jeep.
Next, you will add light objects to the light fixtures above each barracks
doorway.
Add lights over the barracks doors:
1

Close the Rendered Frame Window, activate the Top viewport,

and
barracks.

zoom in to the light fixture above the entrance to the far left
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2 On the
Create panel, click
rollout, click Free Light to turn it on.

(Lights). On the Object Type

3 Click once on the center of the light fixture to create the light object.

4 Activate the Front viewport and use
(Select And Move) to move
the light object on its Y axis until it is level with the light fixture.
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5 In the Top viewport,

zoom out until you can see all three

doorways, then
Shift + drag the light to the right, creating two
instances of the light, each positioned above one of the remaining two
barracks entrances.
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6 With any of the barracks doorway lights selected, go to the
Modify panel. On the Templates Rollout, open the drop-down list and
choose 100W Bulb.
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Keep in mind that the light you choose in this list possesses the same
properties as real-world lights do. In terms of light attenuation, for
example, for every 10 meters distance travelled, light intensity from this
bulb will drop off to 1/100th of its initial strength.
7 In the Intensity/Color/Attenuation rollout ➤ Color group, use light
temperature to change the light color. You want the bulb to project a
light blue color, so choose Kelvin, and then enter a value of 8000.0.
In the range of degrees Kelvin, light color varies from 1000 (pink) to
20,000 (blue).
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8 Activate the Camera01 viewport and

render the scene.

Rendered scene with all light systems in place

All objects in the scene foreground look properly lit.
Save your work:
■

Save the scene as my_army_compound_nighttime.max.
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Next
Adding a Background Image and Lighting Effects on page 1353

Adding a Background Image and Lighting Effects
In this lesson, you take a daylight image of a desert landscape, adjust its output
to resemble nighttime lighting conditions, then incorporate the result into
the scene as a background. You’ll add a Glare effect to enhance the appearance
of the lights, then introduce a few more photometric lights to illuminate the
interior of one barracks.
Set up the lesson:
■

Continue working on your own scene file or in the

\lighting_and_rendering\army_compound folder,
army_compound_lighting_no_bkrnd.max.

open

Add a background image:
1 Open the Rendering menu and choose Environment to open the
Environment And Effects dialog. On the Common Parameters rollout,
click the Environment Map button (at present, the text on the button
says (“None”).

3ds Max opens the Material/Map Browser.
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2 On the Material/Map Browser, double-click the Bitmap map type. (Bitmap
is in the Maps ➤ Standard group.)
3ds Max opens a file dialog.

1354 | Chapter 7 Lighting Tutorials

3 In the file dialog, navigate to the \sceneassets\images folder, click desert.jpg
to highlight it, then click Open.
The image is a desert landscape, taken during the day.
4 On the Exposure Control rollout make sure Process Background And
Environment Maps is off.

When this option is turned on, 3ds Max applies the exposure control to
the background map itself. For most bitmaps (those that don’t save a
high dynamic range), in effect this makes the background and other
environment maps invisible.
5 Make sure no object is selected, right-click a viewport, and from the quad
menu, choose Hide Unselected.

6

Render the Camera01 viewport.
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With all objects hidden, 3ds Max has rendered only the background
image. It is apparent that you will need to make the image darker so it
suits the nighttime scene.
Leave the Environment And Effects dialog open for now.
Adjust the background image:

1 Open the

Slate Material Editor.

2 In the Material/Map Browser panel on the left, navigate to the Sample
Slots group.
3 Drag the Environment Map button from the Environment And Effects
dialog and drop it onto an unused sample slot. The sample slot shows a
red bar across it when you are able to drop the map.
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3ds Max asks if this should be an instance or a copy. Make sure Instance
is selected, and then click OK.
4

Close the Environment And Effects dialog.

5 Drag the sample slot with the environment map into the active View.
Once again, 3ds Max asks if this should be an instance or a copy. Make
sure Instance is selected, and then click OK.
6 In the active View, double-click the Bitmap node so you can see its
parameters in the Parameter Editor panel to the right.
7 On the Output rollout, decrease the Output Amount to 0.033.

8

Render the Camera01 viewport again.
The result is a heavily underexposed image, resembling a night sky: a
digital version of filming “day for night.”

Adding a Background Image and Lighting Effects | 1357

Background bitmap heavily underexposed to suit night scene

9 Right-click any viewport, select Unhide All from the quad menu, then

render the scene again.
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Bitmap image added to scene background

The background adds depth and interest to the scene.
10

Close the Slate Material Editor.

Add a Glare effect:
mental ray provides a number of special effects designed to give light objects
added realism. Here, you will add a Glare effect to the army compound lights,
to simulate their interaction with dust particles and ambient humidity.

1 Click
(Render Setup). On the Render Setup dialog, go to the
Renderer tab. In the Camera Effects rollout ➤ Camera Shaders group,
turn on the Output shader toggle.
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As the shader button shows, mental ray provides a Glare shader as a
default shader for camera output, but by default this shader is turned off,
so you have to enable it “by hand.”

2 Open the
dialogs.

Slate Material Editor, and move it so you can see both

3 In the Material/Map Browser panel on the left, navigate to the Sample
Slots group.
4 Drag the Camera Shaders ➤ Output button from the Render Setup dialog
and drop it onto an unused sample slot. The sample slot shows a red bar
across it when you are able to drop the map.

3ds Max asks if this should be an instance or a copy. Make sure Instance
is selected, and then click OK.
5

Close the Render Setup dialog.

6 Drag the sample slot with the Glare shader into the active View.
Once again, 3ds Max asks if this should be an instance or a copy. Make
sure Instance is selected, and then click OK.
7 In the active View, double-click the Glare node so you can see its
parameters in the Parameter Editor panel to the right.
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8 On the Glare Parameters rollout, change the value of Spread from 2.0 to
0.5.

9

10 Make a
the scene.

Close the Slate Material Editor.

clone of the existing rendered frame, then

render

Adding a Background Image and Lighting Effects | 1361

Rendered scene with Glare effect added to light sources

Compare the two images to see the Glare effect. This effect is most
pronounced on the suspended lamp over the jeep.
11

Close the Rendered Frame Windows.

Add lights to the interior of the barracks on the right:

1 Activate the Top viewport, then
far-right barracks comes into view.
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zoom and

pan until the

2 On the
Create panel, click
rollout, click Free Light to turn it on.

(Lights). On the Object Type

3 Place the new light by clicking the apex of the barracks roof, near the
entrance.
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4 Activate the Front viewport,

zoom to see the front of the

right-hand barracks, then use
(Select And Move) to raise the
light object on its Y axis until it is above the floor but below the roof, as
shown in the illustration.
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The interior barracks lights are fluorescent, so the new light object should
be suspended about two feet (about 0.6m) from the ceiling.

5 Go to the
Modify panel. On the Templates rollout, open the
drop-down list and choose 4ft Pendant Fluorescent (Web).
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Now you will set the color the light will cast.
6 On the Intensity/Color/Attenuation rollout, make sure the preset Light
radio button is chosen (as opposed to color temperature: “Kelvin”), then
choose Fluorescent (White) from the Light drop-down list.
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The scene calls for a standard fluorescent fixture consisting of four tubes.
Rather than physically re-creating each tube, you can simply bump up
the intensity of the single light object by a factor of four.
7 In the Intensity/Color/Attenuation rollout ➤ Dimming group, change
the value of Resulting Intensity to 400% (percent).

8 In the Top viewport, make two instances of the fluorescent light.
Distribute them evenly along the length of the barracks.
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9 On the Shadows rollout, turn shadows On so the ceiling lights will cast
shadows.
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10 Activate the Camera01 viewport and

render the scene again.

Rendered scene with interior lights added to the barracks on the right
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The inside of the right-hand barracks is now illuminated, with light
spilling out of the entrance.
Save your work:
■

Save the scene as my_army_compound_nighttime_completed.max.

Summary
In this tutorial, you learned how to use photometric lights to illuminate a
night scene. You specified the color of the light source and defined how
shadows were cast. You also learned how to take a background image, adjust
its output, and apply it as a background to the night scene. Finally, you saw
how a mental ray Glare shader can be applied to a light object to produce
added realism.
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Rendering Tutorials

8

The lighting tutorials showed you ways in which to render your scene. The tutorials in this
section cover additional aspects of rendering: Rendering large numbers of low-poly objects
and proxies to reduce scene calculation time.

Features Covered in This Section
■

Use a particle system to simulate large numbers of similar objects in a scene

■

Create mental ray proxy objects and use the Scatter utility to instance, then distribute
them across a scene

1371

Reducing Complexity in Your Renderings
When you render a scene, the number of faces in the scene model directly
affects rendering time: The greater the number of faces, the longer the
rendering takes.
The tutorials in this section use trees as an example of objects with a high face
count. They show you to ways to reduce that count: By turning trees into
particles, a method you can use with either renderer; and by turning trees into
mr Proxy objects, a method that applies to the mental ray renderer.

Trees set up as “particles” to render a wooded area in a short amount of time

Particle Trees
In this tutorial, you learn how to use particles behaving as “billboards”: Each
particle shows a bitmap tree image that can render quickly, while a twinned
particle casts the shadow of the tree.
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Trees modeled using conventional 3D techniques can produce authentic
results, but a single tree typically can include 20,000 polygon faces or more.
If you need to duplicate the tree many times, to create a forest for example,
you can be faced with a lengthy render involving millions of polygons.
However, there is a way to populate your scene with many life-like trees
without sacrificing render speed. You can do this by using a particle system
to generate a number of particles in the shape of two-dimensional planes, or
“billboards.” A map of a tree is then projected onto each billboard.
This particle method permits the mapping of different sizes and shapes of
trees and is very economical to render. But it also raises several important
issues.
Because the tree image is two-dimensional, it can be seen properly only when
it directly faces the camera. If seen from an angle, it loses its realism.
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Left: Particle tree facing camera
Right: Particle tree at oblique camera angle

For this reason, the flat plane on which the image is mapped must be
continuously re-oriented toward the camera as the camera moves around the
scene.

Particle tree continuously faces the camera

Another consideration is how your two-dimensional particle trees cast shadows.
If the light source (usually the sun) does not directly face the billboard plane,
the tree will cast an unrealistic oblique shadow, as shown in the next
illustration.
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Light source causes the particle tree to cast a shadow at an oblique angle

Therefore, you must generate a second set of particle tree planes. The first set
should show the tree and no shadow, while the second set should show a
shadow and no tree.

Left: Second particle tree oriented toward the light source, with its shadow visible
Right: Second particle tree hidden, with only its shadow visible
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The visible tree planes are oriented to continually face the camera, while the
shadow-only tree planes continually face the light source. You define the tree
and shadow orientation in the particle system parameter settings.
You should also introduce a degree of self illumination to the particle-based
trees you generate. Otherwise, if the light source is behind the object in camera
view, as shown in the next illustration, the object can appear darker that it
should.

Left: Camera view of backlit particle tree with no self-illumination
Right: Camera view of particle tree illuminated directly by light source

In this tutorial, you will learn how to:
■

Create tree objects and modify their material

■

Create a particle system

■

Use operators to shape particle system events

■

Map images to generated particles

■

Set particle visibility

■

Assign sub-materials to generated particles

■

Rearrange particle placement in a scene

■

Use polygon selection to define the area in which to render the particles.

Skill level: Intermediate
Time to complete: 1 1/2 hours

Creating Billboard Tree Maps
In this lesson, you will choose a tree from the 3ds Max library of ready-made
plant objects and edit its material to resemble an elm in spring. You will save
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this object as a .tif image, ready to be projected onto the billboards of your
particle system.
NOTE In addition to the tree objects available in 3ds Max, there are a number of
commercially available plug-ins, such as Forest from Itoo Software, or RPC from
ArchVision, that offer a wide range of alternative tree species.
Create a tree:

1 On the main toolbar, click

(Render Setup).

2 In the Render Setup dialog ➤ Common panel ➤ Common Parameters
rollout ➤ Output Size group, set Width and Height to 512.
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Each particle, or billboard, you generate from the particle system will be
perfectly square, so the resolution of the map you want to use for the
tree must be square as well.
A value of 1024 x 1024 or even higher is permissible, but the higher the
resolution, the longer it will take to render the particle trees.
3

Close the Render Setup dialog.

4 On the
Create panel, click
(Geometry). Open the Objects
drop-down list, and choose AEC Extended.

5 On the Object Type rollout, click Foliage and on the Favorite Plants rollout
click American Elm.
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6 Click anywhere in the Perspective viewport to place the tree.
7 Right-click to exit object creation mode.
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Position the tree so it will render as a well-behaved billboard:
1 Activate the Front viewport and press P to switch to a Perspective view.

2 Click

(Zoom Extents).

3 Click the Point-of-View (POV) viewport label and choose Show Safe
Frames. Change the viewport shading mode to Smooth + Highlights (you
can press F3).
The safe frame displays as a yellow square, indicating the extent of the
rendering area.

Perspective view with the safe frame displayed
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4 Use
(Pan) and
occupies the safe area.

(Zoom) to reposition the tree until it fully

Tree repositioned to fill the safe area

Now you need to make sure the base of the tree trunk is centered precisely
at the bottom midpoint of the frame. In doing so, you ensure that the
trunk of this tree will be aligned with the tree shadow that you’ll derive
from this image.
5 Click the Perspective viewport’s General label (“[+]”) and choose
Configure.
6 In the Viewport Configuration dialog ➤ Safe Frames panel ➤ Setup
group, turn off User Safe Lock, then turn on User Safe.
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7 Set the User Safe Horizontal spinner to 100.0, the Vertical spinner to 0.0,
then click OK.
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A purple vertical guide line displays in the viewport safe area. (This guide
line is actually a rectangular safe-frame area that has no width.)

User safe area that acts as a guideline for centering the tree in the frame

8

Move the tree along its X axis until the center of the trunk base
is aligned with the purple line.
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The next procedure shows how to replace the tree with another one that
might be more to your liking.
Find a tree configuration that you like:

1 Go to the
Modify panel. On the Parameters rollout, click the
New button to the left of Seed until you see a tree you prefer.
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2 If 3ds Max displaces the tree trunk,
move the base of the tree
along its X axis until it is aligned with the center line of the safe frame
again.
This time, also make sure the tree base extends slightly below the bottom
edge of the safe area. This will cause the particle tree to slightly sink in
to the emitter object and form a solid connection with the ground. Also,
make sure no leaves or tree branches extend beyond the safe area.
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Base of the tree repositioned so it extends slightly into the safe area

Render the tree:
1 On the main menu, choose Rendering ➤ Gamma/LUT Setup.
2 3ds Max opens the Preferences dialog to the Gamma And LUT tab. Turn
on Enable Gamma/LUT correction. Make sure that Gamma is chosen,
and that the gamma value is set to 2.2.
Turn on both options in the Materials and Colors group as well: Affect
Color Selectors and Affect Material Editor.
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Adding gamma correction improves the appearance of renderings.

3 On the main toolbar, click

(Render Production).
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3ds Max renders the tree using the default render settings. The trunk
color is not realistic, and the leaves are too uniform in color. To correct
this problem, you will change their material diffuse values.
4 Minimize the Rendered Frame Window.
Change the material of the trunk:

1 Open the

Slate Material Editor.
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2 On the Slate Material Editor toolbar, click
(Pick Material From
Object), then in a viewport, click any part of the tree.
3ds Max displays the BasicElm material in the Slate Material Editor active
View.

3 In the Slate Material Editor, click

(Zoom Extents).
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The material tree looks complicated because BasicElm is a Multi/Sub-Object
material, but it really is not as complicated as it looks.
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4 Double-click the main BasicElm material node, the node at the right of
the tree, so you can see the material parameters in the Parameter Editor
panel at the right of the Slate Material Editor.

The Multi/Sub-Object Basic Parameters rollout shows how the BasicElm
material contains five sub-materials, assigned separately to the trunk,
branches, and leaves.
NOTE The Canopy sub-material is the material shown in viewports when the
tree object is not selected.
Now you will change the Diffuse values of the Trunk sub-material to
improve the appearance of the tree trunk.
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5 In the active View, click to select the first sub-material at the top of the
View, which is the node for the Trunk sub-material.

6 Click
(Zoom Extents Selected), and then
pan out in the
View a bit so you can see the Trunk material node and the map and
controller already assigned to it. When you’re done, right-click an empty
area of the View to return to selection mode.

7 In the Material/Map Browser panel at the left, locate the Noise map (it
is in the Maps ➤ Standard group), drag this entry into the active View,
and then wire it to the Trunk sub-materials Diffuse Color socket.
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8 Double-click the Noise map node so you can see its parameters.
9 On the Noise Parameters rollout, choose Fractal for the noise type, and
set the Size spinner to 5.0.
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10 Click the Color #1 color swatch and choose a medium-dark brown color,
(such as R=77, G=41, B=5), then click the Color #2 color swatch and
choose a light tan or beige color (such as R=146, G=124, B=102).

Render the tree to see the result:
1 Minimize the Slate Material Editor.
2 Render the Perspective viewport to see the new diffuse values you set for
the Trunk sub-material. If you are not satisfied with the result, feel free to
make further changes to the material color.

1394 | Chapter 8 Rendering Tutorials

With lighter, noise-mapped colors, the trunk looks more convincing and
also more elm-like.
Next, you will copy the diffuse values of the trunk to the branches.
Use the new Trunk submaterial for the branches:
1 Restore the Slate Material Editor window.

2 In the active View,
Pan downward in the View so you can see the
Branch0 and Branch1 nodes. When you have finished panning, right-click
an empty area of the View to return to selection mode.
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3 Click the Branch0 sub-material node, then press Delete.
4 Delete the Branch1 sub-material node as well.
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5 Wire the Trunk sub-material node to the main BasicElm (2) and (3)
sub-material sockets that used to contain the Branch0 and Branch1
sub-materials.
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6 With your cursor in the active View, press L to rearrange the layout of
the material tree.

1398 | Chapter 8 Rendering Tutorials

With only three sub-materials, the material tree is simpler than it was.
Now all the branches match the trunk, as you can see if you render the
Perspective viewport again.
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Change the material of the leaves:
1 Double-click the Leaves sub-material node (now the second sub-material
from the top) so you can see its parameters.
2 Drag another Noise map from the Browser into the active View, and wire
the Noise map node to the Diffuse Color socket of the Leaves sub-material.
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TIP After you add and wire the new Noise node, press L again to clean up
the layout of the active View.
3 Double-click the new Noise map node so you can see its parameters.
4 On the Noise Parameters rollout, choose Fractal for the noise type, and
set the Size spinner to 3.0.
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5 Also on the Noise Parameters rollout, set the Noise Threshold ➤ High
value to 0.7 and the Low value to 0.3.

These values will increase the level of sharpness between the two colors
you are about to choose.
6 Click the Color #1 color swatch and choose a medium-dark green color,
(such as R=0, G=73, B=0), then click the Color #2 color swatch and choose
a light green color (such as R= 175, G=189, B=171).

7 Minimize the Slate Material Editor.
8 Render the tree to see the new diffuse values for the leaf material.
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Notice how the two-color combination makes for more realistic leaves.
Check the alpha channel:

1 On the Rendered Frame Window, click
(Display Alpha Channel)
to view the alpha channel of the tree object in the rendering.
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Alpha channel of the tree object rendering

The alpha information provides the shape of the cutout for the particle
trees you will generate later.
Now you now need to save the tree to an image file format that includes
alpha information.

2 Turn off

(Display Alpha Channel).
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Save the “billboard” image of the tree in spring foliage:

1 On the Rendered Frame Window, click

(Save Image).

2 In the Save Image dialog File Name field, type my_elm_spring.tif, then
click Save.
3ds Max opens the TIF Image Control dialog. In the Image Type group,
make sure that 8-Bit Color is chosen, and Store Alpha Channel is on.

NOTE You can save your file in a format other than .tif, but be sure to choose
a format that stores alpha information. Formats such as .png and .tga can
include alpha, whereas .jpg and .bmp cannot.
The particle system you create in the next lesson can use this tree image
to populate a forest. To introduce some variation to the scene, you will
create a second tree image to be referenced by the particle system as well.
Create fall foliage for the tree, and save that image:

1 In the Perspective viewport, select the tree object and on the
Modify panel ➤ Parameters rollout, click the New button to the left of
Seed.
2 Continue clicking the button until you obtain a tree you like.
3 Set the Density spinner to 0.75 and press Enter.
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This value reduces the number of leaves on the tree.

4 If you need to,
move the tree trunk along its X axis again so it
is properly centered on the vertical midpoint of the safe area.
5 Restore the Slate Material Editor window.
6 On the Noise Parameters rollout, change Color #1 and Color #2 for the
Leaves sub-material to red and orange respectively.

7 Render the Perspective viewport.
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Tree object with fall-like parameters

By reducing the number of leaves and adjusting the leaf colors, you have
created a tree that is suited to a fall scene.
8 On the Rendered Frame Window, click Save Image, then on the Save
Image dialog File Name field, type my_elm_fall.tif and click Save. Be sure
to specify the 8-bit and alpha channel options.
At this point, you could create as many different sizes, leaf density,
pruning level, colors, and species of trees as you like to be referenced by
the particle system. In this tutorial, however, you already have a dozen
tree types made for you, sufficient to create a convincing-looking forest.
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Save the scene:
■

For future reference and adjustments, save the scene as my_elmtree.max.

Creating a Particle System
Now that you have set up the images you want to manage using a particle
system, it is time to create the particle system itself.
Set up the lesson:

■

On the Quick Access toolbar, click
(Open File), navigate to the
\scenes\rendering\particle_trees folder, then open ptrees_basics.max.
NOTE If a dialog asks whether you want to use the scene’s Gamma And LUT
settings, accept the scene Gamma settings, and click OK. If a dialog asks
whether to use the scene’s units, accept the scene units, and click OK.

The scene consists of a simple plane on which you will place the
particle-based trees. It also includes a Daylight system for outdoor
illumination, and a camera.
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Create a particle system:

1 On the
Create panel, click
(Geometry). Open the Objects
drop-down list, and choose Particle Systems.

2 On the Object Type rollout, click PF Source to turn it on. In the Top
viewport, drag anywhere outside the plane to place the Particle Flow
source icon.
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The size and location of the source icon is not important, since the
particles will be generated from the plane object.
3 Right-click to end object creation.

4 Go to the
Modify panel. In the Emission rollout ➤ Quantity
Multiplier group set the Viewport % spinner to 100.0.
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When the Viewport Quantity is 100 percent, the viewports display every
particle in the system. For an effect such as smoke or fluid, this could
slow down 3ds Max performance, but for the particle-tree forest, there
are not that many particles, and you want to be able to see all of them.
5 On the Setup rollout, click Particle View.
TIP You can also display Particle View by pressing 6 on your keyboard.

Particle View manages a particle system and helps you visualize the
particle source and parameters, as well as events that influence a particle’s
appearance and behavior during its life span.
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Initially, the system contains two events: the source that you just created,
and a default Event 001.
6 In Event 001, click the Birth 001 operator to highlight it.

On the right of Particle View, the Birth 001 rollout displays parameters
that relate to particle creation. The Emit Start and Emit Stop spinners
indicate that particle generation will start at frame 0 and end at frame
30. The Amount spinner indicates that 200 particles will be generated by
the system.
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7 Drag the time slider to see how the default particles are generated.

Particles emanating from the emitter object

By default, there are a large number of particles that fall downward from
the Particle Source icon. You need to modify the Birth 001 parameters so
that the system generates only six particles that remain stationary at all
times.
Change the particle settings so particles are stationary, with visible geometry:
1 On the Birth 001 rollout, set Emit Stop to 0 (this ensures that the particles
do not pop up over time) and set the Amount spinner to 6, so that only
six particle trees are created.
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2 In Particle View, click the Speed 001 operator to highlight it, then
right-click and choose Delete, since you do not want the particle trees to
move.
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3 Delete the Rotation 001 operator as well, since the orientation of the
particles will be driven by the camera position.
4 The “depot” is the list of operators and tests that appears at the bottom
of the Particle View window. Drag a Position Object operator from the
depot and in Event 001, drop it directly over the Position Icon 001 operator.
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3ds Max displays a red line to indicate you are replacing the original
operator with the new one.
5 Click the new Position Object 001 operator to highlight it. In the Position
Object 001 rollout ➤ Emitter Objects group, click Add. In any viewport,
click the Plane01object.
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Before, particles were emitted from the particle source icon. Now, particles
are emitted from the Plane01 object: You can see them scattered about
the plane’s surface.
6 Click the Display 001 operator to highlight it. On the Display 001 rollout,
open the Type drop-down list, and choose Geometry.

It is now easier to visualize the particles, although soon you will be
replacing these shapes with tree images.
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7 Click the Position Object 001 operator again and on the Parameters panel,
scroll down to the Uniqueness group. Click New to change the positioning
of the particles. Continue clicking the button until you get a grouping
you like.

Change the particles to shapes that face the camera:
1 From the depot, drag a Shape Facing operator directly over the Shape 001
operator to replace it.
2 Click the Shape Facing 001 operator to highlight it. In the Size/Width
group, make sure In World Space is chosen, then change the value of
Units to 40.0, and press Enter.
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This value increases the size of the particles.
3 In the Look At Camera/Object group, click the button labeled “None”
and in any viewport, click the Camera01 object.
The particles, which previously lay flat on the plane emitter, now face
the direction of the Camera01 object.
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NOTE To refresh the scene properly, you might need to adjust your view in
the Camera01 viewport, using any viewport navigation control.
4 On the Shape Facing rollout, open the Pivot At list, and choose Bottom.

5 At the bottom of the Size/Width group, change the value of Variation %
to 25.0.

This creates a range of particle sizes. The tree images mapped onto each
particle will also vary in size.
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Next, you will map the tree images onto the particles. You will do so
using the Material Static operator, the best choice for a material that is
not animated.
Map tree images to the particles:
1 From the depot, drag a Material Static operator to the PF Source 001 event.
Drop it just below the Render 001 operator. A blue line indicates the point
of insertion.

NOTE You are defining the material at the PF Source 001 level because you
want all the trees to share the same material throughout the particle life span.
If you wanted to assign the trees different materials based on a specific particle
event, you would have dragged the Material Static operator to the appropriate
event box.
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2 Open the

Slate Material Editor.

3 Drag an Arch & Design entry from the Material/Map Browser into the
active View.
4 Double-click the Arch & Design material node to display its parameters.
5 Name the new material Trees.
6 On the Templates rollout, open the drop-down list and choose Matte
Finish.
With Matte Finish, the trees will not pick up any reflection from
neighboring objects.
7 Drag a Bitmap entry from the Browser into the active View.
3ds Max opens a file dialog. Navigate to \sceneassets\images and choose
elm_summer.tif.
8 Wire the new Bitmap node to the Diffuse Color socket of the Trees
material.

9 Double-click the Bitmap node so you can see its parameters.
10 On the Coordinates rollout, turn off Use Real-World Scale if it is on, and
make sure Tiling is set to 1.0 for U and V.
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This step ensures that the image area matches the size of the particle.
11 Click the Trees material node to make it active, then on the Slate Material

Editor toolbar, click

(Show Map In Viewport) to turn it on.

12 Move Particle View and the Slate Material Editor so you can see both
windows. In Particle View, highlight the Material Static 001 operator, then
drag from the output socket of the Trees material node, and in Particle
View, drop the material on the Assign Material button (initially labeled
“None”). When 3ds Max asks whether to use a copy or an instance, make
sure Instance is chosen, then click OK.
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TIP If the tree maps don’t appear in the shaded viewport right away, turn
off Assign Material and then turn it back on.
Now the tree map is now applied to all particles in the scene. Their
background remains visible: You still need to make them cutouts by using
the alpha-channel information.

Tree map applied to all particles in the scene
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Use cutout mapping for the tree particles:
1 In the Slate Material Editor, Shift+drag the Bitmap node to make a copy
of it.

2 Wire the new Bitmap copy to the Cutout Map socket of the Trees material
node.
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3 Double-click the new Bitmap node so you can see its parameters.
4 On the Bitmap Parameters rollout, in the Mono Channel Output group,
choose Alpha, and then in the RGB Channel Output group, choose Alpha
As Gray.
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Now the background of the tree bitmap no longer appears.

Next, you will boost the amount of self-illumination so that all parts of
the tree can still be visible even when the leaves and branches are not in
direct sunlight.
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Set particle tree self-illumination:
1 In the Slate Material Editor, wire the original Bitmap node (the one you
are using for colors, not for the alpha channel) to the Self-Illumination
Map socket of the Trees material node.
2 Double-click the Trees material node so you can see its parameters.
3 On the Self Illumination (Glow) rollout, turn on Self Illumination.

At this point, the self-illumination has no real effect, because the default
Luminance values are overpowered by the Daylight system exposure
value set for your exterior scene.
4 In the Luminance group, leave Unitless chosen, and enter a value of
5000.0.

1428 | Chapter 8 Rendering Tutorials

5

Close the Slate Material Editor.

6 Render the Camera01 viewport.
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Particle trees with self illumination added

Now the self-illumination of the trees is apparent.
Save your work:
■

Save the scene as mytrees.max.

Defining Tree Shadows
In this lesson, you will instruct the particle system to generate a second set of
trees, with only its shadows visible. You will then orient the shadows so they
continually face the light source in the scene. As a result, the shadows will
appear to belong to the first set of visible trees.

1430 | Chapter 8 Rendering Tutorials

Set up the lesson:
■

Continue working on the scene file you saved in the previous lesson, or

open ptrees.max.
Generate a second set of tree particles:
1 Press 6 to display Particle View, drag a Spawn operator from the depot
to Event 001, and drop it at the bottom of the event, below the Display
001 operator.

The Spawn operator will generate a new set of particles from the ones
you defined in Event 001.
2 Highlight the Spawn 001 operator to display its parameters.
In the Spawn 001 rollout ➤ Spawn Rate And Amount group, the Once
option should be chosen, indicating that only one set of particles will be
created.
Set the particles to follow the sun:
1 In Event 001, click to highlight the Shape Facing 001 operator, then
right-click it and from the pop-up menu, choose Copy.
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2 Right-click an empty area of the event-display area below Event 001, and
from the pop-up menu, choose Paste.

3ds Max creates a new event, called Event 002, with an operator that also
instructs the particles to face the camera. Now you will modify this
operator so that the particles will face the scene light source instead of
the camera.
3 Click the new Shape Facing 002 operator so you can see its parameters. In
the Shape Facing 002 rollout ➤ Look At Camera/Object group, click the
Pick button (which at first is labeled Camera01), then in any viewport,
click the [Daylight01] Sun01 object.
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4 In Event 002, click the Display 002 operator. On the Display 002 rollout,
click the color swatch and use the Color Selector controls to choose a red
color.

This color is used to display the shapes of the second set of particles in
wireframe views. It will not be visible in renderings. The red color will
help you better identify the second set of particles.
5 Open the Type drop-down list and choose Geometry.
6 In Event 001, click the Display 01 operator and choose a dark blue color,
to better see the first set of particles in wireframe view.
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7 Click the blue handle to the left of the Spawn operator and drag it to the
Event 002 input (the empty circle that protrudes from the top of Event
002).

With this connection, Event 001 spawns a set of particles once and sends
them to Event 002, where they are instructed to face the sun.
8 In the Front viewport, select the camera. On the main toolbar, click

(Select And Move). In the Top viewport, move the camera about
the scene.
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Top: Camera position 1
Bottom: Camera position 2
Billboard trees (shown in blue) follow the camera position, while the shadow
particles (shown in red) do not

9 Press Ctrl+Z to undo the camera movement.
Do a test rendering:

■

Render the Camera01 viewport.
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Rendered scene showing two sets of particle tree shadows

There are now two sets of particle trees, each of which cast shadows. You
need to hide the shadows of the particle trees that face the camera, then
hide the particle trees that face the sun but keep their shadows visible.
Fix the visibility of shadows:
1 Highlight the header of Event 001, then right-click it and from the pop-up
menu, choose Properties.
Remember that in Particle View, Event 001 represents the particle trees
that face the camera, while Event 002 represents the particle trees that
face the sun.
2 In the Object Properties dialog ➤ General panel ➤ Rendering Control
group, click By Layer (if By Object is not already active) and turn off
Receive Shadows, Cast Shadows and Apply Atmospherics. Click OK.
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3 Highlight the header of Event 002, then right-click it and from the pop-up
menu, choose Properties.
4 In the Object Properties dialog ➤ General panel ➤ Rendering Control
group, click By Layer (if By Object is not already active) and turn off
Inherit Visibility, Visible to Camera, Visible to Reflection/Refraction,
Receive Shadows and Apply Atmospherics. Click OK.
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5

Render the Camera01 viewport again.

Particle trees with only one set of shadows visible

The rendering shows one visible set of particle trees, and shadows cast
by the second set of trees, which are otherwise hidden.
Save your work:
■

Save the scene as my_ptrees_shadows.max.

Introducing Variety
The trees in your scene are casting shadows properly, but while they vary in
size, they are all identical in shape and color. To make a convincing forest,
you need to add a few more tree varieties into the mix.
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Set up the lesson:
■

Continue working on the scene file you saved in the previous lesson, or

open ptrees_shadows.max.
Adjust the camera view:

1 On the main toolbar, click
(Select And Move). In the Front
viewport, move the Camera01 object until it is closer to the ground.

2 Activate the Camera01 viewport, and
are in full view.
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dolly forward until the trees

Increase the number of tree particles:
1 In Particle View, in Event 01, click the Birth 01 operator to highlight it.
2 On the Birth 01 rollout, change the Amount value to 25.

3

Close the Particle View window.
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Now the particle system generates 25 trees. Each particle uses the same
image of the elm tree you selected earlier. Next, you will change the
particles to reference three different types of trees.
Create a Multi/Sub-Object material to contain multiple tree maps:

1 Open the

2

Slate Material Editor.

Zoom out in the active View, then drag a Multi/Sub-Object from
the Browser into the active View, and drop it to the right of the Trees
material.
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By default, the Multi/Sub-Object material contains 10 entries, each of
which allows you to specify a sub-material. Fortunately, you don’t need
all of these.
3 Drag box to select all of the submaterial nodes, then press Delete.
4 In the Slate Material Editor, click (Zoom Extents), then move the
Multi/Sub-Object material node closer to the main Trees material node.
5 Double-click the Multi/Sub-Object material node so you can see its
parameters.
6 Name this material Elm Trees.
7 On the Multi/Sub-Object Basic Parametrers rollout, click Set Number. On
the Set Number Of Materials dialog, change the value to 3.
You will specify three different tree types to use on the particles.
8 Wire the Trees material node to the (1) sub-material socket of the Elm Trees
node.

Now you need to create the other two sub-materials.
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Create a fall sub-material, and then another for winter:
1 Click the minus-sign (-) icon on the title bar of the Trees material node
to collapse this node display, then hold down the Shift key and drag the
Trees node to make a copy of it.

2 Click the plus-sign (+) icon on the title bar of the new material node to
open the node display again, then drag away from the input sockets to
disconnect the wired bitmaps.
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3 Click the minus-sign (-) icon to collapse the new material node again,
then Shift+drag to make another copy.
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4 Double-click the Trees material node so you can see its parameters. Change
the name of this sub-material to Elm - Summer.
5 Double-click the second material node, and change its name to Elm - Fall.

On the Slate Material Editor toolbar, turn on
In Viewport).

(Show Standard Map

6 Double-click the third material node, and change its name to Elm - Winter.

On the Slate Material Editor toolbar, turn on
In Viewport).

(Show Standard Map

7 Wire the second and third material nodes to the (2) and (3) sockets of
the Elm Trees material node to make them sub-materials as well.

Add the bitmaps for the new sub-materials:
1 Click the plus-sign (+) icon of the Elm - Fall sub-material node to open the
node, then press L so you can see all of the material tree.
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2 Drag a wire from the Diffuse Color Map socket of the Elm - Fall sub-material
node, then release the mouse. From the pop-up menu, choose Standard
➤ Bitmap.
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3ds Max opens a file dialog. Choose the elm tree with autumn foliage
you rendered in the previous lesson, or navigate to \sceneassets\images
and choose elm_fall.tif.
3 Wire the new Bitmap node to the Self Illumination Map socket as well.
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4 Shift+drag the new Bitmap node to make a copy of it, then wire the copy
to the Cutout Map socket of the Elm - Fall sub-material.
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5 Double-click the Bitmap node that is wired to the Cutout Map socket.
On the Bitmap Parameters rollout, change Mono Channel Output to
Alpha, and RGB Channel Output to Alpha As Gray.
6 Repeat steps 1 through 5 for the third sub-material node, this time using
\sceneassets\images\elm_winter as the bitmap.
Change the particle system to use randomly chosen trees:
1 Press 6 to display the Particle View window. Arrange the windows so you
can see both the Material Static 001 rollout on Particle View, and the
output socket of the Elm Trees material in the Slate Material Editor.
2 In Particle View ➤ PF Source 001, click Material Static 001 to highlight it.
Drag a wire from the output socket of the new Elm Trees Multi/Sub-Object
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material node, and drop it on the Material Static 001 rollout ➤ Assign
Material button.
3 On the Material Static 001 rollout, turn on Assign Material ID and Show
In Viewport.

4 Change the Material ID value from 1 to 2 and 3 to display one of the
three different tree sub-materials you set up earlier.

Particle Trees | 1451

Elm trees with fall colors: Material ID=2

Elm trees in winter: Material ID=3

5 To get a mix of all three tree types, choose Random.
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The Camera01 viewport updates to show a random selection of all three
tree types.

Random assortment of particle trees

6 In the Material Static 001 rollout ➤ Uniqueness group, click New
repeatedly until you obtain a mix of tree types that you like.
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7

Render the Camera01 viewport to see the result.

Save your work:
■

Save the scene as my_ptrees_various.max.

Placing the Particle Trees
In this lesson you use polygon selection to define the area in which tree
particles appear.
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Set up the lesson:

Open ptrees_placement.max.
The scene consists of an undulating terrain bisected by a riverbed and
populated by a number of particle-based trees.

■

Use polygon selection to define where trees will appear:

1

2

Maximize the Top viewport and set viewport shading mode to
Smooth + Highlights (you can press F3).

Zoom in to the river.

Notice how a few particle trees stand in or on the very edge of the river
bed.
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3

Zoom out again and select the Camera01 object.
The light blue guidelines show the camera’s field of view. Assume for the
moment that you want only a static shot, or plan to have the camera
move toward the upper-left corner of the terrain. This means there are
many particle trees elsewhere on the plane that will never be seen and
consequently do not need to be generated.

Camera field of view

Now you will use polygon selection to indicate where to place the particle
trees (within the field of view and not in or near the river).
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4

Switch back to a four-viewport layout,

object, then go to the

5 On the Selection rollout, click

6

select the Plane01

Modify panel.

(Polygon).

Click just outside the top left corner of the Plane01 object and
drag toward its center.
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7 On the main toolbar, choose

(Paint Selection Region) from the

Selection Region flyout (initially it shows
Region)).

(Rectangular Selection

8 In the Camera01 viewport, hold down Ctrl and start painting over the
polygons adjacent to the riverbank.
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Selected polygons near riverbank
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Top view, showing selection of polygons near the riverbank.

9 In the Top view, hold down the Alt key and deselect polygons at the
periphery of the camera’s field of view, as shown in the next illustration.
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Top view, with polygons beyond periphery of camera view deselected

10 On the Selection rollout, click
sub-object level.

(Polygon) again to exit the polygon

Set the particle system to use the sub-object selection:

1

Click an empty area of the Top viewport to deselect the Plane01
terrain object, then press 6 to open the Particle View window.
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2 In Event 01, click the Position Object 01 operator to highlight it (if it is not
highlighted already).
3 In the Position Object rollout ➤ Location group, open the Location
drop-down list and choose Selected Faces.

Previously, particles were generated across the entire plane. Now, the
same number of particles are generated only on the polygon faces you
just selected.
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Particle generation restricted to top left region of plane object

Because the generation area is reduced, you can reduce the total number
of particles generated.
4 Click the Birth 01 operator to highlight it. On the Birth 01 rollout, set the
Amount spinner to 50 and press Enter.
5 If you like, adjust tree placement in the Position Object 01 rollout ➤
Uniqueness group by clicking New until you see a grouping you prefer.
6 In PF Source 01, click the Material Static 01 operator to highlight it. In the
Material Static rollout ➤ Uniqueness group click New until the Camera01
viewport displays a mix of trees that looks good to you.
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7

Render your scene.

Rendered 50-tree view of the particle forest

The 50 particle trees should take just a minute or two to render. If, on
the other hand, the scene were made up of 3D trees at 30,000 polygons
each, 3ds Max would need to process over a million polygons: This would
require a great deal more time to render.
There is one aspect to watch out for when using particle systems to create
trees with shadows. As the next illustration demonstrates, the base of the
tree on the left does not quite match the base of its shadow.
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Tree trunk not aligned with particle
tree shadow

Recall that you created two sets of particle trees: One set oriented to face
the camera and another, hidden set that faces the sun. Depending on
the respective positions of the light source and the camera, a hidden tree
might cast a shadow that is out of alignment with the visible tree.
To solve this problem, you can rearrange tree placement by changing the
particle trees’ Seed value, or you can add objects such as rocks to obscure
unwanted detail.
Save your work:
■

Save the scene as my_ptrees_forest.max.
You can find a completed version of this scene in the
\scenes\dynamics_and_effects\particle_trees folder, called ptrees_completed.max.

Summary
Particle systems offer a fast, effective way to populate scenes with multiple
objects.
In this tutorial you used images of trees and mapped them onto billboard-sized
particles. But you could just as easily have mapped other types of images; for
example, you could use photographs of people to create a crowd scene.
When using this particle-creation technique, make sure your particles are set
to face the camera. If you need to cast shadows, generate a second set of
particles and make sure their shadows continually face the light source.
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mr Proxies
In this tutorial, you will learn how to use mr Proxy objects to create a scene
of a forest that, despite its large size, can render quickly.
You will convert trees to mr Proxy format, then give each proxy a material
you saved in a material library. Finally, you will use the Object Paint feature
to instance the proxies multiple times and distribute them across the scene.

In this tutorial, you will learn how to:
■

Save materials to a material library

■

Save objects in mr Proxy file format

■

Create mr Proxies and associate them with imported proxy files

■

Add materials to mr Proxies

■

Use Object Paint to instance and distribute mr Proxies in a scene

Skill level: Intermediate
Time to complete: 1 hour
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Creating mr Proxy Objects
mr Proxies are useful when you want to fill a scene with instances of objects
that have a high polygon count, such as 3D trees. Proxy objects save you time
and free up memory because they do not need to be converted to mental ray
format and their source objects do not need to be present during render time.
In this lesson, you convert trees to .mib format so they can be used as mr Proxy
objects.
Set up the lesson:

Click
(Open File), navigate to the \scenes\rendering\mr_proxies folder,
and open trees.max.

■

NOTE If a dialog asks whether you want to use the scene’s Gamma And LUT
settings, accept the scene Gamma settings, and click OK. If a dialog asks
whether to use the scene’s units, accept the scene units, and click OK.

Render the scene:

1

2

Zoom and

pan so the tree objects fill the viewport.

Render the scene.
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The eight trees in the scene show foliage from four different seasons:
winter, spring, summer, and fall. The trees in the front row are oaks, and
the trees in the back row are elms.
These trees were created and textured using the methods described in
the lesson Creating Billboard Tree Maps on page 1376. The only difference
is that there was no need to center each trees in a viewport and render
it: The mr Proxy method works with referenced geometry instead of with
rendered bitmaps.
3

Close the Rendered Frame Window.

Save the materials to a library:
The tree materials that you saw in the rendering will need to be reused for the
mr Proxy objects. The best way to do this is to save the materials in a library,
so you can access them for use in various scenes and situations.

1

Open the Slate Material Editor.
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2 On the Material/Map Browser panel at the left, scroll down so you can
see the Scene Materials group. (It helps to drag the edge of the Browser
panel to make the Browser wider, too.)

The four Tree materials are the ones you want to save.
3 Right-click the Tree-Fall entry and from the pop-up menu, choose Copy
To ➤ Temporary Library.

3ds Max creates a Temporary Library group that appears at the bottom
of the Browser panel. The Temporary Library has a copy of the Tree-Fall
material in it.

IMPORTANT A Temporary Library such as this one lasts only as long as the
current 3ds Max session.
4 Right-click the Temporary Library label, and from the pop-up menu,
choose Save As.
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3ds Max opens a file dialog. On the file dialog, navigate if you need to
to the \materiallibraries subfolder of your Project Folder, then enter
mytrees as the library name (the file name extension for a material library
is MAT), and then click Save.

5 At the top of the Browser panel, click
(Material/Map Browser
Options). This opens a pop-up menu. On the pop-up menu, choose Open
Material Library.
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3ds Max opens another file dialog. In the \materiallibraries subfolder,
choose the library you just created, mytrees.mat, and then click Open.
3ds Max opens a group for mytrees.mat at the very top of the Browser
panel. (The Temporary Library remains visible at the bottom of the panel.)

6 In the mytrees.mat group, right-click the Material #0 entry and from the
pop-up menu, choose Rename.

mr Proxies | 1471

3ds Max opens a Rename dialog. Change the material name back to
Tree-Fall, then click OK.

7 In the Scene Materials group, right-click the Tree-Spring material entry.
On the pop-up menu, choose Copy To ➤ mytrees.mat.

8 In the mytrees.mat group, use Rename to name this material Tree-Spring
once again.
9 Copy Tree-Summer and Tree-Winter to mytrees.mat as well. Each time, change
the name of the material back to its original name.
10 Right-click the mytrees.mat label, and on the pop-up menu, choose the
first entry, C:\Users\...\mytrees.mat ➤ Save.
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11

Close the Slate Material Editor.
Now you have a library of materials to use for the proxy objects. The next
task is to create those proxies.

Save source objects in mr Proxy file format:

1 On the
Create panel, click
(Geometry), then open the
Objects drop-down list and choose “mental ray.”
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2 On the Object Type rollout, click “mr Proxy” to turn it on.

3 Drag in the viewport to create an mr Proxy object.
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4 Go to the
Modify panel. On the Parameters rollout, in the Source
Object group, click the Source Object button (initially labeled “None”).

In the viewport, click the Elm-Winter tree object.
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5 In the Parameters rollout ➤ Source Object group, click Write Object To
File.

3ds Max opens a file dialog. If you need to, navigate to the
\sceneassets\renderassets folder. Name the file My_Elm_Winter (it has a
file name extension of MIB), and then click Save.
3ds Max opens an “mr Proxy Creation” dialog. On this dialog, click OK
to accept the default values.

NOTE If your tree object were animated, you would use the “mr Proxy
Creation” dialog to save the object as a sequence of frames, with one .mib
file created per frame. You specify the time segment to save in the Geometry
To Write group.
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3ds Max briefly displays a small Rendered Frame Window while it renders
the proxy geometry.

In the viewport, 3ds Max displays the mr Proxy object as a point cloud.
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6 In the Parameters rollout ➤ Display group, change the Viewport Verts
value from 128 to 512, and press Enter.
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The object outline becomes more apparent as more points are displayed,
but a denser point cloud can affect viewport performance.
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7 Change the Viewport Verts value back to 128, then turn on Show
Bounding Box to display the extents of the tree proxy.
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3ds Max displays the proxy surrounded by a complete bounding box.
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8 With the proxy object selected, repeat steps 4 through 7 for the Elm-Spring
tree object.
When you’re done, you should have an .mib file for Elm-Spring.
If you were working from scratch, you would repeat the steps for every
tree in the scene, but to speed things up a little, we have created .mib files
for all the tree types. These are saved in the \sceneassets\renderassets folder.
You will use these proxies in the next lesson.
9 Do not save the current scene file.
The work you needed to save is contained in the MIB files and their
associated bitmaps.
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Loading Proxy Files Into a Scene
In this lesson, you create a group of mr Proxy objects, and associate each proxy
with an .mib file such as the ones you saved in the previous lesson. Then you
assign each proxy a material from your mytrees material library.
Set up the lesson:
1 If you have a scene open from the previous lesson, do not save it.

2

Open proxy_trees_start.max.
The new scene features a rolling terrain intersected by a riverbed.

Create an mr Proxy object and associate it with an .mib file:

1 Go to the
Create panel and click
(Geometry). Open the
Objects drop-down list, and choose “mental ray.” On the Object Type
rollout, click “mr Proxy.”
2 In the Top viewport, click and drag anywhere to the right of the plane
object.
The proxy object you create can be of any size.
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3 Go to the

Modify panel and rename the object Elm-Winter.

4 Inthe Display group, turn on Show Bounding Box.

5 In the Parameters rollout ➤ Proxy File group, click the
button.
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browse

3ds Max opens a file dialog. Go to the \sceneassets\renderassets folder,
choose elm1_winter.mib, then click Open.

The scale of the imported proxy file is too large.
6 In the Parameters rollout ➤ Proxy File group, set the Scale spinner to
0.1 to reduce the proxy to one-tenth its default size.
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Copy the original proxy and change the tree types:

1 In the Top viewport,
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Shift +move the proxy to the right.

2 In the Clone Options dialog ➤ Object group, make sure Copy is chosen,
then set Number of Copies to 3. Click OK.
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3

Select a copied proxy and on the
it Elm-Spring.

Modify panel, name

4 In the Parameters rollout ➤ Proxy File group, click the
button and use the file dialog to choose elm2_spring.mib.

browse

5 Repeat steps 3 and 4 for each of the two remaining proxies, rename them
Elm-Summer and Elm-Fall, and associate them with their corresponding
.mib files.

6

Select all four proxy objects and Shift+move them once,
downward. In the Clone Options dialog, make sure Copy is chosen, then
click OK.

7 Repeat steps 3 and 4 for each of the new proxies. Rename them
Oak-Winter, Oak-Spring, Oak-Summer, and Oak-Fall, and associate them
with their corresponding .mib files.
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Render the result:
1 Activate the Camera01 viewport. Press P to make it a Perspective view.

Zoom,

pan, and

all eight tree proxies, then

orbit so you have a good view of

render the Perspective viewport.

Tree proxies with the same material

The tree proxies have different shapes and leaf densities, but their leaves
and trunks are all the same color. In the next procedure, you will associate
each proxy with a material you saved earlier in the material library.
2 Minimize the Rendered Frame Window.
Assign materials to the tree proxies:
1 From the main menu, choose Rendering ➤ Material/Map Browser.
2 In the Top viewport, Click and Ctrl+click to select Elm-Winter and
Oak-Winter, then drag the Tree-Winter material from the Material/Map
Browser ➤ mytrees.mat group, and drop this material on your selection.
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3ds Max opens an Assign material dialog. On the dialog, make sure Assign
To Selection is chosen, then click OK.

3 Repeat the previous step for each of the spring, summer, and fall pairs of
tree proxies, using the appropriate library material.
4

5

Close the Material/Map Browser.

Render the Perspective viewport once again.
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Tree proxies after receiving materials from the material library

Now you have eight different types of trees that are ready to be multiplied
and distributed across your scene.
6

Close the Rendered Frame Window.

7 Change the Perspective viewport back to the Camera01 view.
Save your work:
■

Save your file as my8_trees.max.

Next
Using Object Paint to Distribute the Trees on page 1491

Using Object Paint to Distribute the Trees
Now that you have your tree proxies properly defined, you need a way to
instance them multiple times and distribute them across your terrain. You
can do this by using the Object Paint feature, which is new to Autodesk 3ds
Max 2011. Object Paint lets you paint objects onto other objects: In this lesson,
you will paint proxy trees onto the terrain object, Plane01.
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Set up the lesson:

■

Continue from the previous lesson or

open 8_trees.max.

Choose the trees with which you will paint:

1 If the ribbon isn’t already open, then on the main toolbar click
(Graphite Modeling Tools). Click the
you can see the full height of the ribbon.

expand/collapse icon until

2 On the ribbon, click the Object Paint tab.

3 On the Paint Objects panel, click

3ds Max opens a Paint Objects dialog.
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(Edit Object List).

4 On the dialog, click Add.
3ds Max opens a Select Objects dialog.
5 Click and Shift+click to select all eight tree objects, and then click Add.
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The grove you paint in this lesson will be an eclectic one. Another time,
you might want to choose only spring trees, for example, or fall ones.
6

Close the Paint Objects dialog.
Now you are able to paint the trees onto the terrain. By default, the Paint
Objects tool uses the first object in the set you selected.
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Set up the Object Paint tool:
1 On the Paint Objects panel, choose All, Randomly from the drop-down
list.

When you paint, the trees will appear in random order.
2 Also on the Paint Objects panel, open the Paint On drop-down list and
choose Selected Objects.

3 On the Brush Settings panel, set Spacing to 40.00 units.

4 Also on the Brush Settings panel, open the Align drop-down list, and
turn off Align To Normal.
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We want the trees to grow vertically, not to lean wherever the terrain is
not flat.
5 The right-hand side of the Brush Settings panel has three groups of
controls: Scatter, Rotate, and Scale. In this tutorial, we don’t use the
Scatter tools, but do make adjustments to the other two groups.
In the Brush Settings panel ➤ Rotate group, click the drop-down arrow
next to the Z coordinate field, and in the drop-down list, turn on Random
Z.

When you paint, the trees will have a random amount of rotation about
their vertical (Z) axis.

6 In the Brush Settings panel ➤ Scale group, make sure
(Uniform Scale)) is turned on, then open the
drop-down list, and choose Random.
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axis Lock
Scale Type

After you choose Random, the Scale group shows a range of values for
the axes; because Axis Lock is on, you can change only the X axis values.
7 Also in the Scale group, set the minimum X value (on the left) to 60 and
the maximum X value (on the right) to 160.

The trees will vary in height and girth from 60 units to 160.
Now you are ready to begin painting trees.
Paint the proxy trees:

1

Select the terrain object, Plane01.
Remember that Object Paint is set to paint onto the currently selected
object.

2

Maximize the Top viewport, and click
Selected).

3 On the Paint Objects panel, click to turn on

(Zoom Extents

(Paint).
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4 Hold down the mouse button as you drag over the terrain object. 3ds
Max adds copies of trees to the scene. The trees are at least 40 units apart.

You can paint the trees densely together, but on the near bank of the
stream, avoid painting directly in front of the camera’s line of sight.
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5

Minimize the Top viewport, then activate the Camera01 viewport,

and

render the scene.
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TIP If any of the trees appear to be floating above ground level, then on the
Paint Objects panel, set the Offset value to a negative value; for example,
–3.0.
6 One good feature of Object Paint, is that you can preview the scene with
renderings before you commit.

■

If you are not happy with the results, click
(Cancel).
3ds Max removes the trees you painted, allowing you to start over.

■

When you are happy with the results, click
(Commit).
3ds Max adds the trees to the scene, as copies of the original tree proxy
objects.
If you like, experiment with other options, such as painting with only
trees from a certain season, as we suggested earlier, or changing the
range of Scale X to paint a greater (or lesser) range of variation in size.

Save your work:
■

Save the scene as my_forest_painted.max.
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You can compare your work with a finished version of this scene,
proxy_trees_final.max.

Summary
When you render with the mental ray renderer, mr Proxies are a useful way
to create a large scene with many instances of a similar object. While mr Proxy
objects cannot be edited directly, they offer the advantage of freeing up
memory and speeding up render time.
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1502

Effects Tutorials

9

3ds Max provides a variety of tools for improving the visual richness and realism of a scene.
This section introduces a few special-purpose techniques:
■

Using the Garment Maker and Cloth modifiers to create a costume

■

Using the Hair And Fur modifier to give a character hair

■

Using a Particle Flow system to model smoke

Creating a Costume out of Cloth
The Garment Maker and Cloth modifiers work together to create clothing for
your characters, human or not human.

1503

In this tutorial, you will remain in the human realm, and create the clothing
for a fashion model. Aside from her shoes, which are already supplied, the
model wears two outer garments:
■

A pullover made of a clinging stretch fabric

■

A skirt made of a loose and flowing fabric, with pleats

With Garment Maker, you specify the construction of clothing, based on
pattern shapes. The Cloth modifier then fits those clothes to the character
who wears them; later, Cloth also generates realistic animation for the clothing.
Skill level: Intermediate
Time to complete: 2 1/2 hours

Preparation for This Tutorial

■

On the Quick Access toolbar, click
(Project Folder) and set your
current project to Autodesk 3ds Max 2011 Tutorials.

Draw the Patterns for the Clothes
For the most part, clothes are made of flat pieces of fabric that are then sewn
together. A pattern is often printed on paper, so cloth can be cut to match
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the pattern. The Garment Maker modifier is based on this work model: It
constructs a garment out of outlines drawn with 3ds Max splines.
Set up the scene:

➤

Click
(Open File), navigate to the \scenes\effects\cloth folder, and
open fashion_model_start.max.
NOTE If a dialog asks whether you want to use the scene’s Gamma And LUT
settings, accept the scene Gamma settings, and click OK. If a dialog asks
whether to use the scene’s units, accept the scene units, and click OK.
The scene contains a model who is wearing shoes but no clothes.
The scene is also animated: In frames 0 through 12, the model stands in
a reference pose, but starting from frame 13, she walks forward as if on
a runway in a fashion show.

Draw the Outline of the Pullover
The model’s upper garment is a pullover with a collar. Its pattern has simple
straight line segments.

Draw the Patterns for the Clothes | 1505

Pattern for the front of the pullover

NOTE If you plan to use the Garment Maker modifier’s Panel Position controls,
then you must create the pattern in the Top viewport. This tutorial does not use
those controls, so you will create the pattern in the Front viewport, which is a
more intuitive way to work.
Draw the outline of the pullover:

1 On the
Create panel, click
in the Object Type rollout, turn on Line.
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(Shapes) to turn it on, then

2 In the Creation Method rollout, make sure that Initial Type is set to
Corner, and set Drag Type to Corner as well.

When you create a pattern for Garment Maker, it is best to use Corner
vertices. Later, the modifier provides any smoothing that the garment
requires.
3 Begin by drawing the top of the shoulder seam, and the neckline.
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4 Continue down along the side of the model, roughly following the
contour of the figure, and adding a bit of flare for the bust. Extend the
outline to the level of the model’s hips.
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5 Hold down the Shift key while you drag across the model’s hips. This
ensures that the spline segment will be level.
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6 Continue up the model’s right side, keeping the vertices as symmetrical
as you can.
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7 End the last segment of the outline by clicking over the first vertex, and
when 3ds Max prompts you to close the spline, click Yes.
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8 At this point, if you want to adjust the vertices, go to the

panel, turn on

Modify

(Vertex) to go to the Vertex sub-object level, and

move vertices until you have a symmetrical pattern with which
you are comfortable.
TIP If the spline you drew is hard to see in the viewport, click the color swatch
for the spline, and choose a color that is easier to read. When you do this, you
might want to turn off Assign Random Colors: This gives you greater control over
object color.
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Draw the outline of the collar:

1 On the
Create panel, turn on
on, and then turn on Rectangle.

(Shapes) if it isn’t already

2 In the viewport, draw a rectangle that will be the pattern for the collar.
The rectangle should be above the neckline, in front of the model’s
mouth.
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3 Right-click the collar, and from the Transform (lower-right) quadrant of
the quad menu, choose Convert To ➤ Convert to Editable Spline.

4 Go to the
Modify panel, and turn on
the Vertex sub-object level.

5 Drag a box to

(Vertex) to go to

select all the vertices in the collar outline.

By default, 3ds Max creates a Rectangle shape with Bezier Corner vertices.

6 Right-click to display the quad menu, then in the Tools 1 (upper-left)
quadrant of the quad menu, choose Corner.
This converts the vertices to Corner vertices like those in the main part
of the pullover pattern.
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7 In the modifier stack, click Editable Spline to exit the Vertex sub-object
level.

Attach the collar to the main pattern:

1 Click to

select the main spline of the pullover pattern, Line01.

2 On the
Modify panel ➤ Geometry rollout, click to turn on
Attach, and then click the collar outline, Rectangle01.
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3 Click Attach again to turn it off.
4 Change the name of the pattern shape to Pullover Pattern

Break the vertices for seams:
The Garment Make modifier recognizes seams by breaks in the outline of the
pattern: A broken pair of coincident vertices indicates the end of a seam, while
an unbroken vertex is part of a continuous seam. Because of this, you have
to break vertices selectively before you apply Garment Maker.

1 On the

2

Modify panel, turn on

(Vertex).

Drag a box to select all the vertices in the collar outline.
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3 On the Geometry rollout, click Break.

4

Drag a box again to select the vertices at the top of the shoulder
straps, but not the midpoint of the neckline, or the midpoint of the
armholes.
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5 Click Break once more.
6 Drag a box to select the vertices at the bottom of the armholes, but not
the vertices at the waistline.
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7 Click Break.
8 Finally, drag a box to select the hip vertices at the bottom of the pattern.
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9 Click Break a final time for the pullover pattern.
Copy the pullover outline to create the back panel:

1 Turn on
(Spline) to go to the Spline sub-object level, and drag to
select the entire pattern.

2 Turn on
(Select And Move), then Shift+move the pullover pattern
to the right to make a clone of the original splines.
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Adjust the neckline of the back panel:

1 On the

Modify panel, turn on

(Vertex) to go to the Vertex

sub-object level, then
move the center vertex of the back panel’s
neckline vertically, so the neckline at the back of the pullover doesn’t
plunge as the front neckline does.

2 In the modifier stack, click the Line entry to exit the Vertex sub-object
level.
The pattern is now ready for you to apply Garment Maker to it. Before doing
that, you will create a comparable pattern for the skirt.
Save your work:
■

Save the scene as fashion_pullover_pattern.max.

Draw the Outline of the Skirt
The skirt is also a simple pattern, but it includes lines to control where the
pleats will be.
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Pattern for the skirt

Draw the outline of the skirt:

1

Zoom out in the viewport a bit, to see more of the model’s figure.

2 On the
Create panel, turn on
on, and click to turn on Rectangle.
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(Shapes) if it is not already

3 Begin the skirt outline by drawing a rectangle. The skirt should begin at
the model’s waist, above the navel, and end at the model’s knees.

4 Change the name of the rectangle to Skirt Pattern.
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5 Right-click, and from the Transform (lower right) quadrant of the quad
menu, choose Convert To ➤ Convert To Editable Spline.

6 Go to the

7

Modify panel, and turn on

(Segments).

Select the two vertical sides of the rectangle.

8 On the Geometry rollout, scroll down to find the Divide button, then
click Divide to add a vertex to the side segments.
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9 Turn on
(Vertex). Drag a box to
select all the vertices in
the skirt, then right-click, and from the Tools 1 (upper left) quadrant of
the quad menu, choose Corner.

10

Drag a box to select the new, middle vertices along the side of
the skirt pattern.
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11

Move the vertices vertically so they are just below the top vertices
of the rectangle. They should form a waistband for the skirt.

Change the hem line to a rounded hem:

1 On the main toolbar, choose

(Select And Non-Uniform Scale),

then from the Pivot Point flyout, choose
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(Use Selection Center).

2 Still at the
Vertex sub-object level, select the two lower vertices
of the skirt pattern. These are the vertices that define the hem line.

3 Drag the vertices outward along the X axis to create a flare for the skirt.
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4 Right-click, and choose from the Tools 1 (upper left) quadrant of the
quad menu, choose Bezier Corner.
This is a temporary measure so you can shape the hem.

5

Move the lower tangent handles, along the hemline, downward
to create a rounded hem for the skirt.

6 Turn on

(Segment), then click to
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select the hemline.

7 On the Geometry rollout, change the Divide value to 10, and then click
Divide.
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The new vertices will become the basis of the pleats of the skirt.
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8 Turn on
(Vertex). Drag a box to
select all the vertices in
the hemline, including the outer ones. Then right-click, and from the
Tools 1 (upper left) quadrant of the quad menu, choose Corner.
Now you are ready to create the pleats of the skirt.
Add the segments that will become pleats:
The Garment Maker and Cloth modifiers provide a number of different ways
to create pleats, darts, and so on. The method we use in this tutorial is one of
the easier and more efficient ways. For more details about modeling clothes,
see the 3ds Max help.

1 On the main toolbar, right-click
(Snaps Toggle) to display the
Grid And Snap Settings dialog. In the dialog, click Clear All, and then
click to turn on Vertex.

Close the Grid And Snap Settings dialog.

Draw the Patterns for the Clothes | 1531

2 On the main toolbar, click to turn on

(3D Snaps Toggle).

3 Make sure you are still at the
Vertex sub-object level, then on the
Geometry rollout, click to turn on Create Line.

4 Start creating a line by snapping to the vertex that is just before the right
edge of the hem. Then press S to toggle snaps off temporarily, and click
to place the end of the line just below the waistline, in front of the model’s
torso. Right-click to end line creation.
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5 Press S to turn on snaps once again, and draw a similar line beginning
at the next hem vertex to the left.
6 Continue to add a line to each of the vertices along the hem, snapping
to the hem vertex, but leaving the top vertex free (don’t worry too much
about the placement of the top vertices). When you finish, the skirt
should have 10 seam lines in all.

7 Turn on
(Select And Uniform Scale), then drag a box to select
all the top vertices of the seam lines.
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8

Scale downward along the Y axis until the vertices are level with
each other.

9

Move individual vertices horizontally along the X axis so the
tops of the pleats are more or less equidistant.
You don’t have to be too accurate in this step: As the skirt drapes and
moves, the pleats will be more noticeable at the hemline than at the
waist.
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10 Drag to
select all the vertices in the skirt pattern, then on the
Geometry rollout, click Break.

Now the pattern for the skirt is nearly complete.
Copy the pattern to create the back of the skirt:

1 Turn on
(Spline), and drag a box to
in the pattern.

select all the splines
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2

Shift+move the skirt to the right, to create a duplicate panel that
will become the back of the skirt.

3 In the modifier stack, click the Editable Spline entry to exit sub-object
mode.
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Save your work:
■

Save the scene as fashion_both_patterns.max.

Now you are ready to use Garment Maker to build the costume.

Next
Use the Garment Maker and Cloth Modifiers to Prepare the Pullover on page
1537

Use the Garment Maker and Cloth Modifiers to Prepare
the Pullover
The Garment Maker modifier works on spline patterns. It does two main
things:
■

Subdivides the panels into a mesh that the Cloth modifier can use

■

Specifies how the panels are stitched together

Use the Garment Maker Modifier to Prepare the Pullover
Set up the scene:

■

Continue working from the previous lesson, or
fashion_model01.max.

open the file
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Apply Garment Maker to make the pullover pattern into a cloth-style mesh:

1 Click
viewports.

2 Click to

(Maximize Viewport Toggle) so you can see all four

select the pullover pattern.

3 On the
Modify panel, open the Modifier List, and choose
Garment Maker.
In shaded viewports, you can see that the pullover pattern now has a
mesh.
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4 Activate the Perspective viewport if it isn’t active already, and then press
F4 to display edged faces.
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Garment Maker creates an irregular mesh. The mesh looks a bit odd, but
it is good at deforming the way cloth deforms.
Move the pullover panels into position:

1 In the modifier stack, click
(the plus-sign icon) to expand the
Garment Maker modifier hierarchy, and then click the Panels level to
make it active.
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2 Turn on
Snap Toggle).

(Select And Rotate), and then turn on

(Angle

3 Change the transform coordinate system to Local.

4 Click and Ctrl+click to
pullover.

select the right-hand portion of the
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These panels will become the back of the pullover.

5

Rotate the panels 180 degrees about their Y axis.
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Garment Maker creates single-sided meshes, so you have to make sure
that panels are oriented correctly.

6

Move the back panels along the X axis until the front and back
are in the same X location, and them move them back along the Y axis
so the back panels are behind the model.
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For this step, having all four viewports visible is a help.
Improve the initial position of the collar:
The main panels of the pullover are parallel to each other, but we want the
front of the collar to be lower than the back. Because of this, it helps to adjust
the initial shape and position of the collar.

1 Still at the Panels sub-object level,
the collar.

select just the front panel of

2 In the Deformation group, click to choose Curved, and then set the
Curvature value to –4.0.

To see this effect, it might help to
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orbit the active viewport.

3

Select the back panel of the collar, and set its deformation to
Curved, with a value of –4.0 as well.
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(The same value works for both panels, because of the one-sided
orientation that panels have.)

4

Rotate the front panel of the collar up about 30 degrees in its
Local X axis, and then rotate the back panel of the collar down about
–30 degrees, also in the X axis.

5 In the Left viewport,
move the two collar panels so they are
closer to the model, and so their edges line up.
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With this setup, it will be easier for the Cloth modifier to join the two
halves of the collar.
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Create the seams:
1 In the modifier stack, click to highlight the Garment Maker sub-object
level Seams.

To the Garment Maker modifier, a seam is a set of edges connected by
unbroken vertices.
2 In the Perspective viewport, click to select the main seam at the left side
of the back panel.
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TIP It is hard to see selected seams unless the viewport is displaying Edged
Faces. Press F4 to turn on face edges, if they are not already on.
3 Ctrl+click to select the matching seam at the front of the pullover.
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4 On the seams rollout, click Create Seam.

Garment Maker displays the seam as a set of lines connecting the two
edges. The Garment Maker modifier does not change the position of the
panels: You will use Cloth to accomplish that soon.
5 Using the technique of the previous three steps, create additional seams
between the tops of the shoulder straps and the two right ends of the
collar.
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NOTE While you create seams, you might see this warning:

If this happens, increase the Seam Tolerance value (this field is near the bottom
of the Seams rollout); for example, to 0.2 or 0.3, and then try to create the
seam again.
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6

Orbit the Perspective view, and create the corresponding three
seams for the left side of the pullover.

TIP You can use Shift+Z to undo viewport changes after you have finished
creating the seams.
7 Finally, create seams between the two collar panels and their
corresponding neckline.
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Now the pullover is ready for the Cloth modifier.

Use the Cloth Modifier to Fit the Pullover
Apply the Cloth modifier to the pullover:
1 In the modifier stack, click the Garment Maker entry to exit the Seams
sub-object level.
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2 From the Modifier List, choose Cloth.
3 On the Object rollout, click Object Properties to display the Object
Properties dialog.

For the Cloth simulation to run correctly, you have to set some conditions
in the Object Properties dialog.
4 In the Object Properties dialog, click Pullover Pattern to highlight it, and
then click Cloth.
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This tells Cloth to treat the (Garment-modified) Pullover Pattern as cloth.
When you choose Cloth, 3ds Max enables a variety of options. These
settings are described in the 3ds Max help. Using them can be a matter
of trial and error, but Cloth includes some useful presets: For the pullover,
we will use a preset and adjust only one Cloth Properties setting.
5 From the Presets drop-down list, choose Spandex.

6 Change the Damping value to 0.02.
7 Under Objects In Simulation, click Add Objects.
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3ds Max opens a Scene Explorer dialog. In the Scene Explorer, click to
highlight the body object, and then click Add.
8 Make sure that body is highlighted in the Objects In Simulation list, and
then choose Collision Object.

This tells Cloth to treat the body of the model as a solid object.
9 In the Collision Properties group, change the value of Offset to 0.15.

The lower the Offset value, the closer the simulated cloth will come to
the collision object (in this case, the model herself). The new value ensures
that the pullover will be form fitting.
10 Click OK to exit the Object Properties dialog.
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Fit the pullover to the model’s torso:
1 Go to the Simulation Parameters rollout.
TIP Drag the left edge of the Command Panel area to the left, to expand it
to two columns so you can see both the Object and Simulation Parameters
rollouts at once.
2 On the Simulation Parameters rollout, turn off Gravity.

3 On the Object rollout, click Simulate Local (Damped).

The Cloth modifier runs a simulation that animates over time. When the
cloth is tightly fitted to the body, click Simulate Local (Damped) again
to turn it off.
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NOTE If you click Simulate Local instead of Simulate Local (Damped), the
pullover will have an ill-fitting seam and some protrusions that shouldn’t be
there. If this happens,
(Damped).

undo the simulation and use Simulate Local

4 If you look closely, you will notice that the seams did not close all the
way.
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To fix this problem, go to the Simulation Parameters rollout. Turn off
Use Sewing Springs.
5 On the Object rollout, click Simulate Local (Damped) once again.
The Cloth modifier runs further simulation, and closes the gap between
panels.
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6 When the panels have come together, click Simulate Local (Damped) to
turn it off once again.
NOTE There are a few different Simulate buttons on the Object rollout.
Simulate Local and Simulate Local (Damped) are for fitting garments to
characters: They don’t create animation, and if you were to play the
anmimation now, the model would simply walk out of the pullover.
Simulate Local (Damped) runs more slowly than Simulate Local: This can be
an advantage when you are fitting garments. Sometimes the speed of Simulate
Local can cause crumpled areas that don’t look good.
The Simulate button does generate animation: You will use this in a later
section.

Change the color of the pullover:
1 In the Name And Color area, click the color swatch for the pullover.
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2 In the Object Color dialog, click the black color swatch, and then click
OK.

Save your work:
■

Save the scene as fashion_pullover_completed.max.

Next
Use the Garment Maker and Cloth Modifiers to Prepare the Skirt on page 1561

Use the Garment Maker and Cloth Modifiers to Prepare
the Skirt
Turning the skirt pattern into a skirt is even simpler than doing so for the
pullover, except for the additional steps to prepare the pleats.
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Set up the scene:

Continue working from the previous lesson, or
fashion_model02.max.

■

open the file

Isolate the pleat lines from the main outline of the pattern:
At this point, if you were to apply the Garment Maker modifier to the skirt
pattern, 3ds Max would display the following warning:

The reason is the segments for the pleats, which Garment Maker does not
know how to handle. The workaround is to assign a different Material ID to
the pleat lines,

1

Select the skirt and on the
(Segments).

Modify panel, turn on

2 Drag and Ctrl+drag selection boxes to
select all the pleat
segments, but none of the segments in the skirt outline.
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3 Scroll down to the Surface Properties rollout, and change the Set ID field
to 2.

Now you are ready to apply Garment Maker.
Apply Garment Maker to the skirt pattern:
1 In the modifier stack, click the Editable Spline entry to exit the Segments
sub-object level.
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2 From the Modifier List, choose the Garment Maker modifier.
Garment Maker turns the skirt panels into subdivided surfaces. (If the
viewport is not displaying Edged Faces, press F4.)

Set up the pleats or creases:
The pleats of the skirt should have an alternating pattern, like that in the
following illustration.
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To accomplish this, you’ll set the values for alternating pairs of pleats.

1 In the modifier stack, click
(the plus-sign (+) icon) to open the
Garment Maker hierarchy, if it isn’t visible already. Then click the Seams
sub-object level to make it active.
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2 Click and Ctrl+click to
the left side of the viewport.

select the first pair of seam segments, at

TIP The pleat segments are hard to see, because of all the face edges (but
you can’t select the edges). Look for the straight lines that end at the hem

of the skirt. It helps to
in the Front viewport.

zoom in a little. It can also help to do this work

3 On the Seams rollout, change the Crease Angle value to 150.0. Change
the Crease Strength value to 5.0.
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4

Select the next pair of seams, moving to the right.

5 On the Seams rollout, change the Crease Angle value to –150.0 this time.
Change the Crease Strength value to 5.0 again.
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6 Repeat the previous four steps for the remainder of the pleat segments,
always assigning a Crease Strength of 5.0, but alternating the Crease Angle
between 150.0 and its opposite, –150.0. Continue the alternation as you
continue onto the back panel of the skirt.

These pleats have a positive crease angle.

These pleats have a negative crease angle.

Increase the density of the skirt mesh:
1 In the modifier stack, click the Garment Maker entry to exit the Seams
sub-object level.
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2 On the Main Parameters rollout for Garment Maker, change the value of
Density to 1.5.

The result is a much denser mesh. This will help give the skirt its flowing
quality.
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(You can see why we chose to set up the pleats before increasing the
Density.)
Move the skirt panels into position, and create the seams:
1 In the modifier stack, click the Panels sub-object level to make it active.
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2 Turn on
(Select And Rotate). Make sure
(Angle Snap
Toggle) is turned on, then as you did for the back of the pullover, rotate
the back panel of the skirt 180 degrees about its Y axis (using Local
coordinates).

3

Move the back panel along the X axis so it has the same X
position as the front panel, and then move it back along the Y axis so it
is behind the body of the model.

4 On the modifier stack, click the Seams sub-object level to make it active.

5 For each side of the skirt, there are just two seams to create: the one
defined by the short segments at the sides of the waistband, and the one
that defines the length of the skirt.
Click and Ctrl+click to select each pair, and then on the Seams panel,
click Create Seam.
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Waistband seam created
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Side seam created

6

Orbit the view, and repeat the previous step to create the two
seams on the opposite side of the skirt.
(You can use Shift+Z to undo the orbit, later.)

Use Cloth to Shape the Skirt
You use cloth for the skirt essentially in the same way you did for the pullover.
The difference is that you also need to attach the waistband to the torso of
the model. Because of this, local simulation proceeds in two steps.
Apply the Cloth modifier to the skirt:

1 In the
modifier stack, click the Garment Maker entry to exit the
Seams sub-object level.
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2 From the Modifier List, choose Cloth.
3 On the Object rollout, click Object Properties to open the Object Properties
dialog.

4 In the Object Properties dialog ➤ Objects In Simulation list, click Skirt
Pattern to highlight it, and then choose Cloth.
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5 With Skirt Pattern still highlighted, choose Cotton from the Presets
drop-down list.
6 In the Cloth Properties group, change the value of U Stretch to 50.0 (this
changes the V Stretch value as well). Change the value of Shear to 180.0.
Leave the other cloth settings unchanged.
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7 Click the Add Objects button. 3ds Max displays a Scene Explorer. In the
Scene Explorer, click to highlight the body object, and then click Add.
8 In the Object Properties dialog, make sure body is still highlighted, and
then choose Collision Object.
9 In the Collision Properties group, change the Offset value to 0.5.

The Offset value is a bit larger than the Offset used for the pullover (0.15),
because the skirt does not need to be form fitting, and because the waist
of the skirt should be outside the pullover.
10 Click OK to close the Object Properties dialog.
Fit the skirt to the model’s waist:
1 On the Simulation Parameters rollout, click to turn off Gravity, and turn
off Use Sewing Springs as well.
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Eventually, we do want gravity to affect the skirt, but at this point, the
skirt would simply slide right off the model!
2 On the Object rollout, click Simulate Local (Damped).
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3 Watch in the viewport, and when the seams of the skirt have closed, click
Simulate Local (Damped) againt to turn it off.
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Attach the waistband to the body:
1 Activate the Front viewport.

2 In the modifier stack, click
(the plus-sign (+) icon) to expand the
Cloth hierarchy, then click the Group sub-object level to make it active.

3 In the Front viewport, drag a selection box to select the vertices in the
waistband. You don’t have to be accurate about this, but make sure the
top row of vertices is selected.

4 On the Group rollout, click Make Group.
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3ds Max opens a Make Group dialog. Name the vertex selection
Waistband, and then click OK.

5 On the Group rollout, click Surface.
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6 In the viewport, click the body object.
The waistband is now attached to the body.
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NOTE You can pick the body because it is part of the Cloth simulation. You
could not pick the Pullover Pattern, for example, because it has not been
added to the skirt simulation.
7 In the modifier stack, click the Cloth entry to exit the Group sub-object
level.

Now you are ready to use gravity.
Use gravity to finish shaping the skirt:
1 On the Simulation Parameters rollout, click Gravity to turn it back on.
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2 On the Object rollout, click Simulate Local to begin simulating the effect
of gravity.

Because you have already joined the seams of the skirt, you can afford
to run the simulation a bit faster, this time.
3 Watch the viewport while the simulation runs. When the skirt looks
good, and does not appear to be changing any longer, click Simulate
Local again to turn it off.
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Save your work:
■

Save the scene as fashion_costume_completed.max.
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Next
Finish the Clothing and Animate It on page 1586

Finish the Clothing and Animate It
Before you animate the clothing, there are a couple of steps to improve the
general appearance of the clothes.
Set up the scene:
■

Continue from the previous lesson.

Use the Relax modifier to improve the appearance of the skirt:
If you render the skirt at this point, you will see that the skirt drapes well and
the pleats look fairly good, but there is bunching along the pleats that it would
be nice to remove.
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Rather than twiddling Cloth parameters, you simply can apply a Relax
modifier.

1

Select the skirt.

2 From the

Modifier List, choose Relax.

3 On the Parameters rollout, change the Relax Value to 0.75.

Now the pleats look smoother when you render the model.
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Change the color of the skirt:
1 In the Name And Color area, click the color swatch for the skirt.

2 In the Object Color dialog, click the dark red color swatch, and then click
OK.

Use the Shell modifier to give the clothes some thickness:
At present, the pullover and the skirt are extremely thin: In fact, technically
they have no thickness. This can become a problem when you animate the
cloth, especially the pullover: Patches of skin might appear through the fabric.
To avoid this “wardrobe malfunction,” use the Shell modifier to give the
garments some thickness.

1

Select the pullover.

2 From the Modifier List, choose Shell.
3 On the Parameters rollout, change the value of Outer Amount to 0.002m.
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Two millimeters is a realistic thickness for a piece of cloth.
4 Right-click the modifier stack, and choose Copy from the pop-up menu.

5

Select the skirt.

6 Right-click the modifier stack, and choose Paste Instanced from the pop-up
menu.
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Now the pullover and skirt both have an equal thickness.
Animate the clothing:

1

Select the pullover.

2 On the modifier stack, click the Cloth modifier to make it active.
3 On the Object rollout, click Simulate. Let the simulation run for all 200
frames. This will take a few minutes.
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4

Go back to frame 0, then

select the skirt.

5 On the Object rollout, click Simulate. Let the simulation run for all 200
frames. This will take several minutes, because the skirt is a dense mesh.

6

Go back to frame 0, then

play the animation.

The pullover clings to the model’s body, while the skirt sways according
to gravity and the movement of the model; it also moves from colliding
with the model’s knees.
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Stop playback when you are done watching the animation.
Save your work:
■

Save the scene as fashion_costume_animated.max.

To see a completed version of the model with cloth, you can
open
fashion_model_completed.max. You can also see a completed movie of the
model’s walk by choosing Rendering ➤ View Image File, and then opening
fashion_model.avi.

Summary
The Garment Maker and Cloth modifiers work together to create clothing
that animates in a realistic manner. Garment Maker operates on patterns
constructed from splines, similar in form to the paper patterns used by clothing
makers. It adds a mesh to the pattern, and lets you specify other details such
as seams and pleats. Cloth takes panels set up using Garment Maker, joins
seams, and deforms the modeled fabric. Cloth can fit fabric to a character
mesh, provide the effect of gravity, and animate garments.

Adding Hair to a Human Head
The Hair And Fur modifier adds hair to a model.
In this tutorial, you add both facial hair and head hair to the head of a Viking
character. The work proceeds in three steps of increasing complexity:
1 Beard The beard has very little styling,
2 Mustache The mustache requires some styling and brushing.
3 Head hair The hair on top of the Viking’s head is shaped by a spline cage.
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Skill level: Intermediate to Advanced
Time to complete: 1 hour and 40 minutes

Preparation for This Tutorial

■

On the Quick Access toolbar, click
(Project Folder) and set your
current project to Autodesk 3ds Max 2011 Tutorials.

Create the Beard
Creating the beard demonstrates the basic controls for Hair And Fur.
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Set up the scene:

■

Click
(Open File), navigate to the \scenes\effects\hair folder, and
open viking_start.max.
NOTE If a dialog asks whether you want to use the scene’s Gamma And LUT
settings, accept the scene Gamma settings, and click OK. If a dialog asks
whether to use the scene’s units, accept the scene units, and click OK.
The scene contains the head of a warrior character.
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NOTE You might notice that the texture on the crown of the skull doesn’t
quite match the skin on the face. This is because the model was created from
an earlier model wearing a cap. The discrepancy doesn’t matter for this tutorial,
because you are going to cover the crown area with hair, anyway.
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Create the faces for the beard:
You can grow hair directly from the Head object, or from a subset of its faces,
but creating a separate set of nonrendering faces gives you more flexibility,
as the following steps will show.
1 Make the Left viewport active.

2

Select the Head object.

3 In the Graphite Modeling Tools Ribbon ➤ Polygon Modeling group,
click to turn on Modify Mode.

3ds Max opens the

Modify panel.

TIP If you can’t see the ribbon in the 3ds Max window, then on the main

toolbar, click

(Graphite Modeling Tools (Open)).

4 Also in the Polygon Modeling group, click
the Polygon sub-object level.
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(Polygon) to go to

5 Use selection tools to
select the polygons in the area where the
beard will grow. Use the following illustration as a reference.
If the viewport doesn’t show face edges, press F4 to turn on Edged Faces
display.

TIP
(Lasso Selection Region) can be a convenient way to select
faces in such an irregular shape.
6 Switch to the Right and then to the Front viewport to make sure the
selection is symmetrical. Use Ctrl+click to add faces or Alt+click to remove
faces, as necessary.
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7 In the Graphite Modeling Tools ribbon ➤ Geometry (All) group, click
(Detach).

3ds Max opens a Detach dialog.
8 On the Detach dialog, turn on Detach As Clone. Name the detached faces
Beard, and then click OK.
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9 Click

(Polygon) again to exit the Polygon sub-object level.

Make the beard faces nonrendering:

1

Select the Beard object. Right-click, and from the Tools (lower
right) quadrant of the quad menu, choose Object Properties.

3ds Max opens the Object Properties dialog.
2 In the Object Properties dialog ➤ Rendering Properties group, click to
turn off Visible To Camera, and then click OK.
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The Beard faces are for growing the hair of the beard, but they don’t need
to appear in renderings.
Adjust the shape of the beard:
1 With the Beard object still selected, in the Ribbon ➤ Polygon Modeling
group, turn on

(Vertex).

2 Click the Shading viewport label menu (the one on the right, which now
reads “Smooth + Highlights + Edged Faces”), and change the Left viewport
to Wireframe display.
3 Use region selection (drag a small selection box) to select pairs of vertices,

on both the left and right sides of the face, then
move the
vertices along the cheek so the beard has a smoother outline. Also move
the vertex for the area of the sideburn that extends behind the ear. Use
the following illustration for reference.
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4 Also in the Left viewport,

lip.

region-select the vertices along the

Move them slightly downward and a little to the left.
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NOTE After moving vertices, some of the Beard faces might be behind some
of the Head faces. This is why you worked in wireframe mode, but it is not a
problem: When you apply hair, it will just grow through the Head faces.
5 Double-check your work in the Right and Front viewports.
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6 Click

(Vertex) again to exit the Vertex sub-object level.

Apply the Hair And Fur modifier:
1 Activate the Perspective viewport.
IMPORTANT Hair appears in orthographic viewports (Front, Left, Top, and
so on), but it does not render in orthographic viewports. You can render hair
only in Perspective and Camera viewports.

2 From the
Modifier List, choose WORLD-SPACE MODIFIERS ➤
Hair And Fur (WSM).
Hair now grows from the faces of the beard.
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3 On the Modify panel, scroll down to the Display rollout.
TIP Drag the left edge of the Command Panel area to the left, to expand it
to two columns. Like the Cloth modifier, Hair And Fur has a multitude of
rollouts and settings.
4 On the Display rollout, turn on Display Guides.
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In the viewport, hair guides display as yellow lines.

The Hair And Fur modifier generates guide hairs at the corners of
polygons. When you style hair, you are styling only the guides: The hairs
between the guides are interpolated from the guide hairs.
5 Also on the Display rollout, change the Display Hairs ➤ Percentage value
to 10.0.
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3ds Max increases the number of hairs shown in the viewport.

Increasing the percentage of displayed hairs helps you visualize how the
beard will look.
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Set the hair color:
The Viking should have reddish-brown hair. He is middle aged, so the hair
should also be starting to turn gray.
1 Open the Material Parameters rollout. Click the Root Color color swatch.

3ds Max opens a Color Selector.
2 Change the Root color of the hair to R=30, G=20, and B=15, and then
click OK.

This is a very dark brown with a hint of red.
3 On the Material Parameters rollout, click the Tip Color color swatch.
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4 In the Color Selector, change the Tip color of the hair to R=130, G=120,
and B=120, and then click OK.
The color at the tip of the hairs is a brownish gray.
The Hair And Fur modifier shades hairs from the Root color, where they
begin, to the Tip color, where they end. But actual hairs usually vary, and
you can use the Mutant Color controls to model this variation.
5 Drag the Root Color color swatch, and drop it on the Mutant Color color
swatch.
3ds Max opens a Copy Or Swap Colors dialog. Click Copy.

6 Change the Mutant % value to 15.
Now Hair will randomly choose 15 percent of the hairs to maintain the
Root color: That is, they will be dark instead of graying.
Trim the beard a little:
1 Open the Styling rollout, and click Style Hair to turn it on.
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2 Make the Front viewport active.

3 In the Styling rollout ➤ Styling group, click
it on.

(Hair Cut) to turn

In the active viewport, the Hair Cut cursor appears as a green circle. If
you look at other viewports, you can see that the cursor is actually a
cylinder: Its effect goes deep into the scene.
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The cursor has falloff: Its effect is greatest at the center, and less at the
edges.
TIP You can use the slider in the Styling group to change the diameter of
the brush.

4 With single clicks, use the Hair Cut cursor to trim the left side of the
beard (on the right of the viewport), making the sideburns and cheek
hairs less lengthy than the chin hairs.

NOTE Dragging the Hair Cut cursor has no effect.
5 Do the same for the right side of the beard (on the left of the viewport).
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Don’t worry about being perfectly symmetrical. We can imagine that the
Viking didn’t care.
6 On the Styling rollout, click Finish Styling to turn off hair styling.
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7 Close the Styling rollout.
8 Make the Perspective viewport active again.
Adjust some more Hair And Fur settings:
1 Scroll down to the Display rollout, and turn off Display Guides.
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2 Scroll up so you can see the General Parameters rollout. Change the Hair
Count value from the default of 15,000 to 6000.

You can improve Hair And Fur render time by reducing the Hair Count
value, and setting hairs to have multiple strands.
3 Scroll down and open the Multi Strand Parameters rollout. Change these
values:
■

Count = 2

■

Root Splay = 0.6

■

Tip Splay = 1.3

The beard is now bushier and a little more wild.
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4 Open the Frizz Parameters rollout. Change Frizz Root to 50.0.

NOTE When Frizz Root and Frizz Tip both equal 0.0, the hair is perfectly
straight, and follows the normal of the face that it grows from.
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5 Close the Frizz Parameters rollout and open the Kink Parameters rollout.
Change these settings:
■

Kink Root = 3.0

■

Kink Tip = 5.0

The Frizz and Kink setting changes make the beard even more bushy.
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Render the beard:

➤

On the main toolbar, click

(Render Production).

3ds Max renders the head of the Viking quickly. It takes a more little time
to render the beard.

TIP If you want to reduce the length of the beard, there are two ways to do
so, both of them on the General Parameters rollout. Scale keeps the shape
of all the hairs, and scales them as a percentage. Cut Length also retains hair
shape, but trims hairs from the tip toward the root.

Save your work:
■

Save the file as viking_beard.max.

Next
Create the Mustache on page 1617
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Create the Mustache
You use a similar method to create the mustache, and the mustache has similar
settings, but it requires a bit more styling than the beard does.
Set up the scene:

➤

Continue from the previous lesson or

open viking_01.max.

Create the faces for the mustache:

1

2

Select the Beard object. Right-click, and from the Display (upper
right) quadrant of the quad menu, choose Hide Selection.

Orbit the view so you can see the front of the Viking’s face.
If Edged Faces aren’t visible, press F4.
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3 In the Ribbon ➤ Polygon Modeling group, click to turn on Modify Mode.

3ds Max opens the

Modify panel.

4 Also in the Polygon Modeling group, click to turn on
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(Polygon).

5 Click and Ctrl+click to
grow.

select the faces where the mustache will

6 In the Ribbon ➤ Geometry (All) group, click

(Detach).

3ds Max opens a Detach dialog.
7 On the Detach dialog, turn on Detach As Clone. Name the detached faces
Mustache, and then click OK.
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8 Click

9

(Polygon) again to exit the Polygon sub-object level.

Select the Mustache object. Right-click, and from the Tools (lower
right) quadrant of the quad menu, choose Object Properties.

3ds Max opens the Object Properties dialog.
10 In the Object Properties dialog ➤ Rendering Properties group, click to
turn off Visible To Camera, and then click OK.
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Like the Beard faces, the Mustache faces are for growing hair, but don’t
need to appear in renderings.
Adjust the size of the mustache faces:
1 With the Mustache object still selected, open the Graphite Modeling Tools
➤ Polygon Modeling drop-down menu, and turn on

2

( Vertex).

Move vertices along the upper edge of the Mustache object to
give the mustache a larger area.
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NOTE If the mustache were to be a short one, you might want to raise the
vertices along the line of the upper lip as well. But since the Viking’s mustache
will droop over the lip, for this lesson you can leave these vertices as they are.
Check your work in side views to make sure the mustache polygons don’t
stray far from the original face of the model.
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3 Make the Perspective view active again.

4 Click

(Vertex) again to exit the Vertex sub-object level.

Apply Hair And Fur:

1 From the
Modifier List, choose WORLD-SPACE MODIFIERS ➤
Hair And Fur (WSM).
2 On the Frizz Parameters rollout, set Frizz Tip to 0.0.
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3 On the Kink Parameters rollout, make sure Kink Root equals the default
value of 0.0.

Setting Frizz Root and Kink Root to zero is a temporary measure that
makes it easier for you to see the effect of styling the mustache.
4 On the Material Parameters rollout, give the mustache the same colors
as the beard:
■

Tip Color: RGB = 130, 120, 120

■

Root Color: RGB = 30, 20, 15

■

Mutant Color = Root Color: RGB = 30, 20, 15

■

Mutant % = 15.0
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5 On the General Parameters rollout, change the Hair Count to 3000.

6 On the Display Parameters rollout, change Display Hairs ➤ Percentage
to 15.0.
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7 On the Multi Strand Parameters rollout, change the values as follows:
■

Count = 2

■

Root Splay = 0.15

■

Tip Splay = 0.1

Now the mustache is ready to style.
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Style the mustache:
1 Open the Styling rollout, and click Style Hair to turn it on.

NOTE When you turn on Style Hair, 3ds Max displays the hair guides in
viewports.
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2 Activate the Front viewport.

3 In the Styling rollout ➤ Styling group, click
on.

Select to turn it

4 In the viewport, drag to select the portion of the mustache to the left of
the Viking’s nose (at the right of the viewport).

While you are styling hair, active guides appear orange, while inactive
guides are yellow.

5 In the Styling rollout ➤ Styling group, click
turn it on.

(Hair Brush) to

The Hair Brush cursor is like the Hair Cut cursor: It appears circular in
the active viewport, cylindrical in others, and it has a falloff such that its
action is strongest at the center axis of the cylinder.

6 Make sure
(Translate) is active, then
downward to make it droop.
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brush the mustache

Notice that while you use the Hair Brush, only the guides are affected:
After you release the mouse, other hairs deform to follow the guides.
7 Activate the Top viewport.

8

Brush the left side of the mustache (right side of the viewport)
so it stands away from the skull.
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TIP You might want to
to see the mustache better.

orbit the viewport a bit, as in this illustration,

9 Click
(Scale) to make it active, then
outward to make it longer.
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brush the mustache

10 Activate the Front viewport again.

11 Turn on
(Translate) once more, then
to make it less chaotic.

brush the mustach

12 Repeat steps 3 through 11 for the right side of the mustache (to the left
of the viewport).
As when you trimmed the beard, don’t worry too much about making
the mustache symmetrical: Faces and facial hair rarely are.

13

Select all the
guides in the mustache, and then
brush the hairs below the nose so they also hang downward.
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14 On the Styling rollout, click Finish Styling to turn off hair styling.

15 Close the Styling rollout.
16 Activate the Perspective viewport again.
Adjust some more Hair And Fur settings:
1 On the Frizz Parameters rollout, set Frizz Root to 15.0.
2 On the Kink Parameters rollout, set Kink Root to 0.5, and Kink Tip to 3.0.
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Render the mustache:
1 Right-click the viewport, and from the Display (upper right) quadrant of
the quad menu, choose Unhide All.
Now the beard is visible again.

2 On the main toolbar, click

(Render Production).

Once you create the hair for the Viking, the model will be complete.
Save your work:
■

Save the file as viking_beard_and_mustache.max.

Next
Create the Head Hair on page 1634

Create the Mustache | 1633

Create the Head Hair
To create the hair for the top of the head, you will use a spline cage; this
method helps to style a large amount of hair, especially long hair, all at once.

Spline cage for growing a head of hair

The spline cage method is somewhat different from the polygon method you
used for the beard and mustache:
■

Hair grows from the splines, instead of from the Head surface.

■

There are no guide hairs: The splines themselves are the guides.

■

When you grow hair from splines, the default values are different from
when you grow hair from polygons.

Set up the scene:

➤

Continue from the previous lesson or
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open viking_02.max.

Hide the beard and mustache:

➤

Click and Ctrl+click to
select the Beard and Mustache objects (or
use Select By Name). Then right-click, and from the Display (upper right)
quadrant of the quad menu, choose Hide Selection.

Draw the spline cage:
NOTE The tutorial files include a spline cage that has already been drawn. If you
have trouble completing this procedure and the two that follow, or if you don’t
want to spend the time it takes to construct the splines, you can skip ahead to the
procedure Apply Hair And Fur on page 1645.

1 On the
Create panel, click
(Shapes) to make it active,
then on the Object Type rollout, click to turn on Line.

2 On the Creation Method rollout, change both the Initial Type and the
Drag Type to Smooth.
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3 On the main toolbar, right-click
(Snaps Toggle) to open the Grid
And Snap Settings dialog. In the dialog, click Clear All, and then click to
turn on Face.

Close the Grid And Snap Settings dialog.
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4 Click

(3D Snaps Toggle) to turn it on.

5 Open the Rendering rollout, and turn on Enable In Viewport.

This simply helps you see the splines better while you create them.
6 Draw the first spline, on the left side of the head, from the crown down
to the right shoulder. Right-click to end spline creation.
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Because you are snapping to faces, some portions of the spline might
sink below the skin. Don’t worry about this: You will move the splines
away from the head before you generate the hair.
7 Using the illustrations as a guide, draw the remaining splines.
On each side of the head, there are three splines in front of the ear, and
three behind the ear.
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There are also two additional splines at the very back of the head.
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Orbit the viewport while you draw the splines (you can use Shift+Z
later to undo the view changes).
Assemble the splines into the cage:

1 When you have drawn the splines to your satisfaction,
select
the first spline you created (at the front left temple). Right-click it, and
from the Transform (lower right) quadrant of the quad menu, choose
Convert To: ➤ Convert To Editable Spline.
2 Make the Top viewport active.
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3 Go to the
Modify panel. With the first spline
still
selected, turn on the Geometry rollout ➤ Attach button and proceeding
in a counterclockwise direction, click to attach each of the additional
splines in the cage.
The order is important: If splines are out of order, the hair will be tangled
or scrambled. Because of this, you can’t use the Attach Multiple button,
either.
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TIP If it is hard to see the splines, you can select the head, right-click and
choose Hide Selection, and then do the attaching as described earlier in this
step.
4 When you have added all the splines to the cage, turn off Attach.
Move the cage away from the scalp:
1 Turn off Rendering ➤ Enable In Viewport.

2 Turn off

3 Turn on

(Snaps Toggle), if it is still on.

(Vertex) to go to the Vertex sub-object level.

4 Click and Ctrl+click to
select all the first vertices of the hair
splines (the ones that display in yellow, when they aren’t selected).
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TIP At this point, if the root vertices seem to be a bit far apart, you might

want to use
(Select And Uniform Scale) to bring them closer together
so the viking doesn’t have a bald spot.
5 Press Ctrl+I to invert the selection.
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6 Turn on
(Select And Scale), choose
(Use Selection
Center), and then scale the vertices up a bit, so that all but the first, scalp
vertices are at a distance from the skin of the head.
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7 Click

(Vertex) to exit this sub-object level.
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Apply Hair And Fur:
1 Do one of the following:
■

If you followed the preceding procedures to create the spline cage,
and are happy with how it looks, then skip ahead to step 2.

■

If you prefer to use the prepared spline cage, or you didn’t create your

own, then from the
Application menu choose Import ➤
Merge. Open hair_spline_cage.max. In the Merge dialog, click the
Hair_Cage object to highlight it, and then click OK.
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2

Select the spline cage.

3 On the
Modify panel, from the Modifier list, choose
WORLD-SPACE MODIFIERS ➤ Hair And Fur (WSM).

4 On the Material Parameters rollout, give the head hair the same colors
as the beard and mustache:
■

Tip Color: RGB = 130, 120, 120
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■

Root Color: RGB = 30, 20, 15

■

Mutant Color = Root Color: RGB = 30, 20, 15

■

Mutant % = 15.0

5 On the General Parameters rollout, change the Hair Count to 3000.

Notice that the default Hair Count is 450: This is far lower than the default
for hair grown from polygons, and it is too low a value.
6 Also on the General Parameters rollout, change Hair Segments to 100
and Hair Passes to 2.
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Hair Segments specifies how many segment subdivisions Hair And Fur
uses for each hair. We increased this value because the Viking’s hair is
long.
Hair Passes is a quality control: Increasing its value increases rendering
time, but also improves the appearance of the hair.
7 Also on the General Parameters rollout, change Random Scale to 20.0.

This specifies that 20 percent of the hairs will have a random variation
in their length.
8 On the Frizz parameters rollout, change Frizz Root to 3.0 and Frizz Tip
to 2.0.

9 On the Kink Parameters rollout, change Kink Root to 0.1 and Kink Tip
to 2.0.
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10 On the Multi Strand Parameters rollout, change the settings as follows:
■

Count = 3

■

Root Splay = 1.2

■

Tip Splay = 1.15

Now you are ready to try rendering the hair.
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Render the hair:

1 On the main toolbar, click

(Render Production).

Because the hair is longer, the head takes longer to render than the beard
or mustache.
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The result is not good: The hair looks matted and oily. In part, this is
because the defaults for hair grown from splines differ from those for hair
grown from polygons.
2 On the General Parameters rollout, change the value of Root Thick to
2.5 and the value of Tip Thick to 0.25.

The default Root Thick(ness) for polygon hair is 5.0, while for spline hair
it is 10.0!
3 On the Material Parameters rollout, change the values of Specular and
Glossy to both equal 15.0.

1652 | Chapter 9 Effects Tutorials

In this case, the defaults are the same as for the beard and mustache, but
the greater area of the head hair makes highlights more apparent.
4 Right-click a viewport, and from the Display (upper right) quadrant of
the quad menu, choose Unhide All.

5

Render the head once more.

This time, the appearance of the head hair is more in keeping with the
beard and mustache.
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Save your work:
■

Save the scene as viking_hairy.max.

Summary
In this tutorial, you grew hair from polygons, and also from a spline cage. You
used several of the numerous Hair And Fur settings to change the hair color
and appearance and obtain a realistic result.

Using Particle Flow to Generate Smoke
Particle systems can model snow and rain, flowing water, smoke, explosions,
and so on. Typically they give you animated effects.
In this tutorial, you use the Particle Flow particle system to model smoke on
a bombing range or battlefield.

NOTE 3ds Max provides a number of particle system types. Particle Flow is the
most versatile and general purpose of these.
Skill level: Intermediate
Time to complete: 2 1/2 hours
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Preparation for This Tutorial

■

On the Quick Access toolbar, click
(Project Folder) and set your
current project to Autodesk 3ds Max 2011 Tutorials.

Create a Particle Flow that Behaves like Smoke
The first step is to set up a particle system that behaves like smoke. Once the
behavior is established, then you can adjust the appearance of the particles.
Set up the scene:

➤

Click
(Open File), navigate to the \scenes\effects\smoke folder,
and open pflow_start.max.
NOTE If a dialog asks whether you want to use the scene’s Gamma And LUT
settings, accept the scene Gamma settings, and click OK. If a dialog asks
whether to use the scene’s units, accept the scene units, and click OK.
The scene is of a desert landscape. There are scorched areas on the ground,
and the wreckage of a jeep®.
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Create the particle system:

1 In the Top viewport,
jeep.

zoom in on the area around the wrecked

The jeep is in the road, toward the right-hand side of the landscape.
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2 Go to the
already on.

Create panel. Turn on

(Geometry) if it is not

3 From the drop-down list, choose Particle Systems.

4 On the Object Type rollout, click PF Source to turn it on.

5 In the Top viewport, drag across the jeep to create a Particle Flow source
icon.
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6 Go to the
Modify panel. On the Emission rollout, change the
Icon Type from Rectangle to Circle.

7 Also on the Emission rollout, set the circle Diameter to 3.0.

Particles will be emitted from the area of the circle, which is a bit smaller
than the size of the jeep itself.
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NOTE The Logo Size value has no effect on particle generation: It just adjusts
the size of the Particle Flow icon, which gives you an object to select in
viewports. But the emitter icon and its dimensions (in this case, the circle and
its diameter) do affect where particles will appear.
8 In the Emission rollout ➤ Quantity Multiplier group, change Viewport
% to 100.0.

For large particle systems, using a Viewport % value less than 100.0 can
improve 3ds Max performance, but displaying 100 percent of the particles
gives you a better idea of what the result of your adjustments will be.
9 If you drag the time slider, you can see in the Orthographic viewport,
and only in the Orthographic viewport, that particles are being emitted
downward. This is the default orientation when you create the icon in
the Top view.
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10 Activate the Perspective viewport. Turn on

(Select And Rotate)

and
(Angle Snap Toggle), then rotate the Particle Flow icon 180
degrees about its Y axis, so the arrow points straight up.

11 Drag the time slider again.
Now the particles move upward instead of downward, and you can see
them in all four viewports.
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At present, the particles appear in a single burst, between frame 0 and frame
30, then no more particles appear. You will correct this, and also set up some
other particle behavior, in the procedure that follows.
Adjust the Particle Flow settings:

1 Go to the

Modify panel. On the Setup rollout, click Particle View.

3ds Max opens a Particle View window.
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Particle View is the main interface to Particle Flow systems. This is where
you add and adjust the particle behavior. In the window, the main areas
are the event display at upper left, which shows events you’ve already
created, and the “depot” at lower left, which contains operators that you
can add to the event display.
At present, the event display shows the PF Source 01 operator you added
to the scene, and Event 01, which so far contains default settings.
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2 In Event 01, click the Birth 01 operator to highlight it.

On the right side of Particle View, 3ds Max displays a parameters rollout
for the Birth operator. As the fields show, the Birth operator generates
200 particles in all. It starts emitting particles at frame 0, and stops
emitting them at frame 30.
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3 Change the value of Emit Start to –100 and the value of Emit Stop to 300.

Starting emission at an imaginary frame –100 means tells 3ds Max to
generate particles before the animation begins, so there will already be
some smoke in the scene at frame 0. Stopping particle emission at frame
300, the last frame of the animation, means that smoke will continue to
appear throughout the animation.
4 Drag the time slider to see the animation.

1664 | Chapter 9 Effects Tutorials

Particles are present at frame 0, and they continue throughout the
animation, but so far, they aren’t exactly billowing.
5 On the Birth rollout, change the value of Amount to 2000.

6 Drag the time slider again.
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Now the particles are more numerous and beginning to look a little more
like smoke, but they are still moving too quickly.
7 In the event display, click the Speed 01 operator to highlight it.

In the parameters panel on the right side of Particle View, 3ds Max
replaces the Birth rollout with a Speed operator rollout.
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8 On the Speed rollout, change the value of Speed to 6.0, and the value of
Variation to 1.0.

9 Drag the time slider.

Create a Particle Flow that Behaves like Smoke | 1667

Now the smoke rises more slowly, in a dense column. This is a better
effect, but its path is unnaturally straight and vertical.
Before you add effects to make the smoke behave naturally, you will
adjust its viewport display to see the effect a little better.
10 In the event display, click the Display 01 operator to highlight it.

Now the parameters panel shows a Display operator rollout.
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11 On the Display rollout, change the Type from Ticks to Geometry.

TIP If you don’t care for the color of the particles, click either the color swatch
on the Display rollout, or the color dot on the Display operator entry in Event
01.

Clicking either the swatch or the dot displays a Color Selector that lets you
change the display color.

12 In the event display, click the Shape 01 operator to highlight it.
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13 In the Shape rollout that 3ds Max now displays, change the value of Size
to 0.2.

Now the particles appear as a mass of tiny cubes, as you can see in the
Perspective viewport.
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This is not meant to be the final form of the particles: It is just a temporary
setting to help you visualize the effects you are about to add.
Add a space warp for the updraft:
To give the column of smoke more realistic motion, you will add a couple of
Wind space warps to the scene.
1 Minimize Particle View.
TIP While a Particle Flow system is in the scene, the keyboard shortcut 6

hides or displays Particle View. On the main toolbar, turn on
(Keyboard Shortcut Override Toggle) for this shortcut to work. You don’t
have to select the Particle Flow icon before you press 6.

2 On the

Create panel, turn on

(Space Warps).

3 On the Object Type rollout, turn on Wind.
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4 In the Top viewport, click the Shading viewport label menu (at present,
it says “Smooth + Highlights”), and change the Top viewport to a
wireframe view.
5 In the Top viewport, drag to create a Wind space warp just to the left and
below (“southwest” of) the Particle Flow source icon.
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The Wind space warp icon is a square with an arrow coming out of it. In
shaded viewports, the square is hidden by terrain, but in the Perspective
viewport, it is easier to see the arrow.

6 Change the name of the Wind space warp to Updraft.

This space warp will model the updraft caused by the heat of the fire,
itself.
Add a space warp for wind:

1 With the Top viewport still active, click

(Zoom Extents).
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2 Turn on Wind again, if the button is not still on.

3 In the Top viewport, drag just to the right (“east” of) the terrain to create
a second Wind space warp.
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4 Turn on
(Select And Rotate), makes sure
(Angle Snap
Toggle) is on, then activate the Camera01 viewport, and rotate the Wind
icon –90 degrees on its Y axis, so the arrow is pointing to the left.
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5 Change the name of this second Wind space warp to East Wind.

This space warp will model an actual wind coming from the east.
Include the space warps in the particle animation:
1 Restore Particle View (6).
2 In the “depot” at the lower left of Particle View, click to highlight the
Force operator, then drag it to the event display, and drop it on Event 01,
just above the Shape operator.
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Force operator in the depot

Dropping the Force operator on the event

3 Click the new Force operator entry to highlight it.
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3ds Max displays the Force operator parameters in a rollout on the
parameters panel to the right.

4 On the Force 01 rollout, click By List.
3ds Max opens a Select Force Space Warps dialog.
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5 Click and Ctrl+click to highlight both the East Wind and Updraft space
warps, and then click Select.
6 Hide Particle View (6).
7 Drag the time slider.
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The particles move upward and toward the west, as we want them to,
but now they are so widely dispersed that the smoke is hardly visible.
This is because the default Wind settings are too strong. You will correct
that in the next procedure.
Adjust the space warp settings:

1

Select the East Wind object, and go to the

Modify panel.

2 In the Parameters ➤ Force group, set Strength to 0.01 and Decay to
0.025.
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3 In the Parameters ➤ Wind group, change the settings as follows:
■

Turbulence = 0.01

■

Frequency = 3.0

■

Scale = 0.1

These settings were arrived at by trial and error.

4

Select the Updraft object.
NOTE You might notice that, now that the Wind space warps are part of the
Particle Flow system, selecting the space warp also selects the Particle Flow.

5 Change the Updraft settings as follows:
■

Strength = 0.0

■

Turbulence = 0.05

■

Frequency = 6.8

■

Scale = 0.2
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6 Drag the time slider again.

The particles seem to be a little denser and to move more slowly, but it
is still hard to see the system in the Camera01 viewport.
7 Restore Particle View (6). Click the Birth 01 operator to highlight it, then
change the Amount value to 10000 (ten thousand).
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8 Click
(Time Configuration), and in the Time Configuration dialog
➤ Playback group, turn off Active Viewport only, then click OK.

9

Play the animation.

Create a Particle Flow that Behaves like Smoke | 1683

Now the smoke is a thick stream that is visible in the Camera01 viewport.
Its motion is controlled by the two Wind space warps, and it shows some
turbulence as it rises and drifts to the west.

To render smoke effectively using small particles like this, you would need
even more than 10,000 of them. Using this many particles is not a good idea:
The large number of particles will slow down 3ds Max, and rendering the
animation will take a long time. The next lesson shows a way to display smoke
using the Wind settings you just created, but with fewer particles in the system.
Save your work:
■

Save the scene as smoke_particles.max.

Next
Set up Particle Geometry that Changes over Time on page 1684

Set up Particle Geometry that Changes over Time
In this lesson, you set up the particle geometry to change over time as the
smoke disperses. You also set up the Particle Flow system so it uses fewer
particles.
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Set up the scene:

➤

Continue from the previous lesson or

open pflow_01.max.

Change the particle geomery:
1 Restore Particle View (6).
2 Click the Birth 01 operator to highlight it, then change the Amount of
particles emitted to 250.

3 From the depot, drag a Shape Facing operator, and drop it on top of the
Shape operator, to replace the Shape operator with Shape Facing.
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Unlike the blue line that appears when you add an operator by dropping
the operator between two others, the line for replacing an operator appears
red.

In viewports, the particles change to square shapes that are larger than
the small cubes you generated before. However, their orientation is
random: This is because the particles aren’t yet oriented to anything.
4 Move Particle View so you can see a viewport with the camera visible in
it. (The lower-left Orthographic view is good for this.)
5 Click the Shape Facing operator to highlight it.
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6 On the Shape Facing operator rollout, click to turn on the Look At
Camera/Object button (at present it is labeled “None”), then in the
viewport, click Camera01.

Click the Look At button to turn it on.

Look At button after you pick the
camera

7 Hide Particle View (6).
8 Drag the time slider.
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Now particles face in a uniform direction, and always face the camera,
as you can see most easily in the Perspective viewport.

Shape facing particles always face another object. Usually this is a camera:
The idea is to assign the particles a material that makes the scene geometry
appear to be more complicated than it actually is. (The tutorial Particle
Trees on page 1372 is another example of this technique.)
9 Restore Particle View (6).
10 In the Shape Facing parameters rollout ➤ Size/Width group, make sure
In World Space is chosen, and then change the value of Units to 5.0.
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Now when you drag the time slider, smoke particles are easily visible
even in the Camera01 viewport.
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Set the particles to grow over time:
The smoke particles should grow over time: As the smoke rises, it also disperses.
To model this, you use a Scale operator.
1 Drag a Scale operator from the depot to Event 01, and drop it between
the Shape Facing and Force operators.

2 Click the Scale operator to highlight it.
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3 In the Scale parameters, choose Relative Successive from the Type
drop-down list.

4 Make sure Constrain Proportions is turned on, then change the value of
Scale Factor ➤ X % to 100.2.

Because Constrain Proportions is on, the Y % and Z % factors update to
100.2 as well.
The factor by which the particles grow doesn’t need to be great. Even
two-tenths of a percent increase at each frame adds up quickly.
5 Hide Particle View (6) and drag the time slider.
The particles increase in size as they rise.
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Create a dynamic material for the particles:
The next step is to create a material that changes over time while the particles
change in size.

1 On the main toolbar, click
Material Editor.

(Material Editor) to display the Slate

TIP If this is the first time you have used the Slate Material Editor, you might
have to resize it to make it larger so you can easily see all the panels.
2 In the Material/Map Browser panel on the left, locate Materials ➤
Standard ➤ Standard, and drag the Standard material entry into the
active View.
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3 In the active View, double-click the Standard node so you can see its
parameters on the Parameter Editor panel to the right.
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4 Name the new material Smoke.
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5 On the Material/Map Browser panel, locate Maps ➤ Standard ➤ Particle
Age, and drag the Particle Age entry into the active View.

6 In the active View, wire the Particle Age map output to the Standard
map’s Diffuse Color input.
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NOTE When you wire the Particle Age map, 3ds Max also adds a Bezier Float
controller node. You won’t be using that in this tutorial.
7 Double-click the Particle Age map node to display its parameters.
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The Particle Age map specifies three colors: By default, Color #1 is the
color at a particle’s birth (0 percent), Color #2 is the color when the
particle is halfway through its life (50 percent), and Color #3 is the color
at the particle’s death (100 percent). You can change the ages, but we
won’t do so in this tutorial.
8 Change Color #1 to yellow, Color #2 to green, and Color #3 to blue.

Don’t worry about the precise values: These are just arbitrary colors to
test the Particle Age effect. Once Particle Age is working as we want it to,
you will replace the colors with more realistic patterns.
9 In the Material/Map Browser panel, scroll so you can see the Sample Slots
group. Drag from the output socket of the Smoke material node (at the
right), and drop it on an unused sample slot. In the Instance/Copy dialog,
choose Instance, then click OK.

Add the new material to the particle system:
1 Minimize the Slate Material Editor and restore Particle View (6).
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2 Drag a Material Dynamic operator from the depot, and drop it on Event
01 between the Force and Display operators.

3 Click the Material Dynamic operator to highlight it.
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4 In the Material Dynamic parameters, click the Assign Material button.

3ds Max opens a modal version of the Material/Map Browser.
5 Scroll to the Sample Slots group, and double-click the Smoke material.

6 Hide Particle View (6).

7 Activate the Camera01 viewport, click

click

(Go To End), and then

(Render Production).

NOTE The Particle Age effect doesn’t appear in viewports, so when you use
this map, you have to render to see the result.
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The particles still have a uniform yellow (birth) color.
The reason for this is that the particles don’t yet have a defined life span.
The Birth operator controls particle creation, but not particle death.
Define the life span of particles:
1 Restore Particle View (6).
2 In Particle View, drag a Delete operator from the depot, and drop it on
Event 01 between the Birth and Position Icon operators.
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3 Click the Delete operator to highlight it.
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4 In the Delete parameters, choose Remove ➤ By Particle Age.

Choosing By Particle Age enables the Life Span and Variation parameters.

5 Change the value of Life Span to 350 and the value of Variation to 50.
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The Variation setting introduces a random variation in the life span of
particles, so the system doesn’t appear too uniform.
6 Hide Particle View (6).

7

Render frame 300 once again.

The particles begin with a yellow color, which shades to green at their
half-life, and then to blue as they near the end of their existence.
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Now you are ready to change the particle colors from the test colors to a
pattern that simulates smoke. This is the subject of the next lesson.
Save your work:
Save the scene as smoke_dispersing.max.

■

Next
Create a Material to Model Smoke on page 1704

Create a Material to Model Smoke
The material that models smoke uses maps with computer-generated patterns
that have a naturalistic appearance.
Set up the scene:

➤

Continue from the previous lesson or

open pflow_02.max.

Use a Noise map to create a smoke-like pattern:

1 On the main toolbar, click
Material Editor.

(Material Editor) to open the Slate

(If you’re continuing from the previous scene, you can just restore the
Material Editor window: Press M.)
2 If the Smoke material isn’t already in the active View, drag it into the
View from the Scene Materials group as an instance.
3 Double-click the Particle Age map node to display its parameters.
4 Drag a Noise map from the Browser into the Active View.
5 Wire the Noise map to the Color 1 component of the Particle Age map.
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In the parameters for the Particle Age map, you can see that the Color
#1 map button now shows the Noise map.
6 Double-click the preview in the title bar of the Noise node, to get a better
view of the map.

The Noise map is a mix of black and white, and this is a good first
approximation to a smoke pattern.
7 Double-click the Noise node (in an area other than the preview) so you
can see its parameters.
8 On the Noise Parameters rollout, choose Fractal as the Noise Type.
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The Fractal pattern is more sharply defined than the Regular pattern.

9 Also on the Noise Parameters rollout, change the value of Levels to 10.0.

Increasing the number of levels increases the complexity of the Noise
pattern.
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10 Change the value of Noise Threshold ➤ High to 0.65 and Noise
Threshold ➤ Low to 0.35.

This increases the contrast of the Noise pattern.

11 Click the Color #1 color swatch. In the Color Selector, set V=29.0 (a very
dark gray; the RGB values change to equal 29.0 as well), and then click
OK.
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12 Click the Color #2 color swatch. In the Color Selector, set V=86.0 (a
moderately dark gray), and then click OK.

The smoke in its initial stages will be very dark, nearly black.
13 Change the value of Size to 4.0.

The material preview now shows a very fine-grained Noise pattern, but
this Size value matches the scale of the scene: Remember that when
particles are born, they are 5.0 units square.
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Vary the map as particles age:
1 Hold down the Shift key, and in the active View drag the Noise map node
to create a clone of the node.
2 Wire the second Noise map to the Color 2 component of the Particle Age
map.

The second, mid-life color now has a map assigned to it.
3 Double-click the new Noise map node to see its parameters.
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4 By the Noise color swatches, click the Swap button.

The idea is that, for each succeeding Noise map, the lighter Color #2
becomes the darker Color #1.
5 Click the Color #2 color swatch. In the Color Selector, set V=161, and
then click OK.

6 Also on the Noise Parameters rollout, change these settings:
■

Noise Threshold ➤ High = 0.8

■

Noise Threshold ➤ Low = 0.2

■

Size = 5.0

7 Double-click the previews of the two Noise map nodes, to make the
previews small again.
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8 Hold down the Shift key and drag the second Noise node to make a clone
of it.
9 Wire the new, third noise node to the Color 3 component of the Particle
Age map.

10 Double-click the third Noise map node to see its parameters.
11 By the Noise color swatches, click the Swap button.
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12 Click the Color #2 color swatch. In the Color Selector, set V=220, and
then click OK.

13 Also on the Noise Parameters rollout, change the value of Size to 4.0.

TIP When you are done adjusting the Noise map nodes, you can click the
minus-sign (–) icon in the title bar of each to minimize the size of these nodes.
14 Minimize the Slate Material Editor, activate the Camera01 viewport,

go to the last frame, and
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render the scene.

The particles now have a good smoke pattern that begins very dark and
grows lighter over time.
The next step is to make the particle edges transparent, so they blend together
more naturally, and don’t have sharp edges against the terrain or the sky.
Add an Opacity map to hide particle edges:
1 Drag a new Particle Age map from the Browser to the active View.
2 Wire the new Particle Age map to the Opacity component of the Smoke
material.
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If the Controller node that 3ds Max creates for the new Particle Age map
obscures the new Particle Age node, move it out of the way.
TIP You can update the layout of the active View by pressing L.
You will animate the opacity to decrease over time, as the smoke disperses.
3 Drag a Gradient map from the Browser to the active View, and wire it to
the Color 1 component of the new Particle Age map.
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4 Double-click the new Gradient map node to see its parameters.
5 On the Gradient Parameters rollout, change the Gradient Type to Radial.

6 Double-click the preview in the title bar of the Gradient map node to
enlarge the preview.
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The center of the map, where it is white, will be completely opaque, while
the black areas at the edges will be completely transparent.
You will use the Gradient map’s Noise controls to make this pattern more
irregular, to obtain a more natural appearance.
7 In the Noise group, change the type to Fractal.

8 Also in the Noise group, change these settings:
■

Amount = 0.3

■

Levels = 10.0

■

Size = 5.0

Now the opacity pattern appears more natural, but retains the opaque
center and transparent edges.
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9 Drag a Noise map from the Browser to the active View, and wire the new
Noise node to the Color 2 component of the Gradient map node.

By now, you will have to use some of the Slate Material Editor navigation
tools to move around the tree of the Smoke map, which is becoming fairly
elaborate.
10 Double-click the Noise map node so you can see its parameters.
11 Change the Noise map settings as follows:
■

Noise Type = Fractal

■

Levels = 10.0

■

Noise Threshold ➤ High = 0.7

■

Noise Threshold ➤ Low = 0.3

(Do not change the colors or the Size value.)
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12 Look at the preview for the Gradient map.

Now the opacity map is even more irregular.
13 Drag a second wire from the same Noise map, and wire it to the Color 3
component of the Gradient map.
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Now Color #2 and Color #3 of the Gradient map both use the same Noise
map.

Decrease opacity as the particles age:
1 Click and Ctrl+click to select both the Noise map and the Gradient map,
then Shift+drag to clone both nodes.
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(You need to select both nodes; otherwise, the Gradient is copied but the
Noise map remains an instance, or vice versa.)
2 Wire the new Gradient node to the Color 2 component of the Particle
Age map.

3 Clone the Noise/Gradient node pair again, and wire this new combination
to the Color 3 component of the Particle Age map.
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4 Double-click the Particle Age map node (for Opacity) to see its parameters.
Now all three particle ages have a Gradient map with Noise.

5 Double-click the Noise map node connected to the Gradient map that is
connected to Color 2.
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6 In the Noise Parameters rollout, click the Color #2 color swatch. In the
Color Selector, change V=161, and then click OK.

The darker color makes particles more transparent in midlife.
7 Double-click the Noise map node connected to the Gradient map that is
connected to Color 3.
8 In the Noise Parameters rollout, click the Color #2 color swatch. In the
Color Selector, change V=64, and then click OK.

The new Color #2 value makes the particles even more transparent as
they near the end of their life.
9

Close the Slate Material Editor.

10 Activate the Camera01 viewport,

animation, and
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go to the last frame of the

render the scene.

You now have good, realistic smoke.
Add shadows to the scene:

1 On the main toolbar, click

(Select By Name).

2 In the Select From Scene dialog, click to highlight the light Direct01, and
then click OK.
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3 On the
Modify panel, ➤ General Parameters rollout ➤ Shadows
group, turn on shadows for the Directional light.
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4

Render frame 300 once more.

Now the smoke particles cast shadows onto the landscape and also onto
each other, making the smoke effect even more convincing.
Now you have used Particle Flow to create a realistic smoke simulation. In the
next lesson, you will add the smoke to other areas of the terrain,.
Save your work:
■

Save the scene as smoke_material.max.

Next
Apply the Smoke to Other Parts of the Scene on page 1725

Apply the Smoke to Other Parts of the Scene
It would be possible to copy the original Particle Flow icon to other locations
in the scene; Instead of this, we will use a special operator, Placement Paint,
to generate additional sources of smoke from the single Particle Flow system.
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Set up the scene:

➤

Continue from the previous lesson or

open pflow_03.max.

Use Particle Paint to emit smoke from other areas of the terrain:

1 In the Top viewport,
wrecked jeep.

zoom in once again on the area near the

2 Change the Top viewport to a Wireframe view.
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3 On the
Create panel, turn on
(Helpers). Choose Particle
Flow from the drop-down list, then on the Object Type rollout, click to
turn on Particle Paint.
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4 In the Top viewport, drag near the jeep to create a Particle Paint helper.

5 On the Setup rollout, change the Brush Radius value to 2.0.
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6 Change the shading of the Top viewport back to Smooth + Highlights.

Select the Plane01 object, choose
and then click this navigation button.

7

(Zoom Extents Selected),

Zoom in a little more closely so you have a good view of the
scorch marks.
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8 Click

9

(Maximize Viewport Toggle) to maximize the Top viewport.

Select the Particle Paint helper again, then go to the
Modify panel.

10 On the Setup rollout, click to turn on Freehand Paint.
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Now you are ready to paint particle seeds in the viewport.
IMPORTANT Before you go to the next step, make sure you are at frame 0.

Click
frame.

(Go To Start) if the time slider is still at frame 300 or some other

11 While Freehand Paint is active, click and drag a single stroke to paint a
rough circle around the wreck of the jeep.

After you release the mouse, 3ds Max displays a number of ticks along
the path you painted.
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Each tick is a particle seed that eventually will generate particles for the
Particle Flow system.
12 Paint a similar circular stroke on the two other scorched areas, one at the
lower right (southeast) area of the terrain, and the other at the upper
right (northeast) area.
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13 For the lengthwise scorched area in the road, at the left (west) area of the
terrain, paint a single back-and-forth stroke (in other words, go over the
lengthwise area twice, but in a single motion of the Freehand Paint cursor).

14 Right-click to turn off Freehand Paint.
Your scene should now have four areas with particle seeds: the three
circular scorched areas on the right (east), and the long scorched area in
the road on the left (west).
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15 Click
(Maximize Viewport Toggle) once again to return to a
four-viewport layout.
Now that you have placed the particle seeds, you need to add a Particle Flow
operator that allows the Smoke system to use these seeds.
Add a Placement Paint operator:
1 Restore Particle View (6).
2 From the depot, drag a Placement Paint operator, and in Event 01, drop
it on top of the Position Icon operator to replace Position Icon.
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3 Click the Placement Paint operator to highlight it.
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The Placement Paint entry is followed by “( ??? )”. This indicates that
you haven’t yet assigned a Particle Paint helper.
4 Move the Particle View window so you can see the Particle Paint helper
icon in a viewport.
5 On the Placement Paint rollout, click the Particle Paint Helper button
(initially, it is labeled “None”).

6 In a viewport, click the Particle Paint helper icon.
Particle Flow now uses the Particle Paint helper as the geometric source
for particle generation.
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However, at this stage, particles are generated from a point that is the
average center of all the paint seeds taken together.

7 In the Particle Paint rollout ➤ Acquire Paint Data group, choose Paint
Position To ➤ Position.

Now Particle Flow generates particles wherever there are seeds in the
scene.
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8 In the Index Order group, turn on Stop If Count Overflow.

This option tells Particle Flow to stop creating particles when the number
of particles in the system exceeds the number of seeds you painted. It
prevents the particle system from becoming “overcrowded.”
9 Hide Particle View (6).

10 Click
(Go To End) to go to frame 300, then click
Production).

(Render
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Now smoke issues from all four scorched areas. It looks good, but a bit
sparse: The same number of particles is now shared among the four areas.
Add a Spawn operator to increase the number of particles:
One way to increase the number of smoke particles is simply to increase the
Amount value in the Birth operator. But in this lesson, we will adjust the
number of particles by using a Spawn test. This is a useful alternate technique,
and using Spawn will also be a help when you create embers in the lesson
that follows.
The actions in the depot that have yellow, diamond-shaped icons, are known
as tests.
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Test entries in the Particle View depot

1 Drag a Spawn test from the depot, and drop it on Event 01 between the
Material Dynamic and Placement Paint operators.

2 Click the Spawn test to highlight it.
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3 On the Spawn rollout, change the Offspring # to 2, and change the
Spawnable % to 60.0.

This tells Particle Flow to take 60 percent of the original particles, and
spawn two child particles from each of the originals.
4 Hide Particle View (6).

5

Go to frame 300 and
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render the scene.

Now the smoke is much denser.
You have now completed the smoke itself. The remaining exercise is to generate
embers from the burning jeep.
Save your work:
Save the scene as smoke_multiplied.max.

■

Next
Generate Embers from the Burning Jeep on page 1743

Generate Embers from the Burning Jeep
You will use a subset of particles to simulate not smoke, but embers (burning
debris) from the jeep.
Set up the scene:

➤

Continue from the previous lesson, or

open pflow_04.max.

Set aside some particles to behave as embers:
1 Restore Particle View (6).
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2 Drag a Split Amount test from the depot, and drop it on Event 01 just
above the Spawn test (and below the Material Dynamic operator).

3 Click the Split Amount test to highlight it.
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4 On the Split Amount rollout, make sure Test True For ➤ Fraction Of
Particles is chosen, then change the value of Test True For ➤ Fraction
Of Particles ➤ Ratio % to 15.0.

This “siphons off” 15 percent of the original 250 particles (because the
Split Amount test precedes the Spawn test). These particles will become
embers.
5 Drag the Material Dynamic operator and drop it below the Spawn test.
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Moving the Material Dynamic operater enables you to assign the ember
particles a different material from the smoke particles.
Add a new Particle Paint helper:
1 In Event 01, click the icon of the Display operator to turn the Display
operator off.

This disables particle display in viewpors (though not in renderings). This
is a temporary measure to make it easier for you to paint new particle
seeds.
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2 Hide Particle View (6).

3 Activate the Top viewport, and

4

zoom in on the jeep.

Go to frame 0.

5 On the
Create panel, turn on
(Helpers). Choose Particle
Flow from the drop-down list, then on the Object Type rollout, click to
turn on Particle Paint.
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6 In the Top viewport, drag near the jeep to create a second Particle Paint
helper.
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7 On the Setup rollout, change the Brush Radius value to 0.4.

Now you are ready to paint the seeds for the ember particles.
Paint where and when the embers will appear
For the smoke, you painted all seed particles at frame 0. For the embers, you
will add them at particular frames, to distribute them in time as well as in
space.

1 Make sure Particle Paint 002 is still selected, then go to the
panel.

Modify
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2 In the Top viewport,
the geometry of the jeep.

3 On the
Paint.

zoom in even more closely, so you can see

Modify panel ➤ Setup rollout, click to turn on Freehand

4 At frame 0, paint two short strokes on the body of the jeep.
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5 Drag the time slide to frame 80, and paint two more strokes.
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6 Add an additional two short strokes at the following frames:
■

Frame 160

■

Frame 240

■

Frame 280

When you are done, the jeep will be fairly well covered with particle
seeds.

7 Right-click to turn off Freehand Paint.
Add the embers to the particle system:
1 Restore Particle View (6).
2 Drag a Placement Paint operator from the depot to the gray area of the
event display.
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When you drop an event (an operator, test, and so on) the empty part
of the event display, Particle Flow creates a new event. Initially, the new
event contains the operator you dropped, and a Display operator.
TIP To rearrange events and the root PF Source entry in the event display,
simply drag the entry by its title bar.
3 In Event 02, click the Placement Paint operator to highlight it.
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4 Move Particle View so you can see a viewport that shows the Particle Paint
002 helper icon.
5 On the Placement Paint rollout, click the Particle Paint Helper button
(initially, it is labeled “None”).

6 In a viewport, click the Particle Paint 002 helper icon.
Event 002 will use Particle Paint 002 as the source for generating ember
particles.

7 In the Particle Paint rollout ➤ Acquire Paint Data group, choose Paint
Position To ➤ Position.
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8 In the Index Order group, turn on Stop If Count Overflow.

9 In the event display, the round blue sockets that protrude from test actions
are known as test outputs. When you move the cursor over a test output,
it changes to indicate the test is available for wiring.

Connect the Split Amount test to Event 02 by dragging a wire from the
Split Amount test output to the input socket of Event 002.
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Particle Flow wires the test to the new event.
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Now Event 002 can use the particles that Split Amount sends to it.
10 Hide Particle View (6).
11 Drag the time slider.

Some embers fly upward and outward, while others hover near the jeep.
TIP If the ember particles are hard to see in viewports, click either the color
swatch on the Display rollout, or the color dot on the Display operator entry
in Event 02.

Clicking either the swatch or the dot displays a Color Selector that lets you
change the display color.

Adjust the ember particle behavior:
1 Drag a Speed operator from the depot, and drop it on Event 02.
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2 Click the new Speed operator to highlight it.

3 On the Speed rollout, change the value of Speed to 20.0, and the value
of Variation to 10.0.

Now the particles move more slowly, and they all move vertically upward
as the smoke particles initially did.
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You will add space warps so the particles come back down to earth. But
first, you will adjust how the particles appear in viewports and renderings.
4 Drag a Shape operator from the depot, and drop it on Event 002.

5 Click the new Shape operator to highlight it.
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6 On the Shape rollout, leave 3D chosen, and choose Sphere 20-Sides from
the 3D drop-down list.

7 Change the Size value to 1.5.
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8 Click to turn on Scale %. Leave its value at the default of 100.0.
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9 In Event 002, click the Display operator to highlight it.

10 On the Display rollout, choose Geometry from the Type drop-down list.

Now the ember particle geometry is visible in viewports.
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Add a Wind space warp to propel the embers:
1 Hide Particle View (6).

2 On the

Create panel, click to turn on

(Space Warps).

3 On the Object Type rollout, turn on Wind.
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4 In the Top viewport, drag to create a Wind space warp centered on the
jeep.

The new space warp is a little easier to see in the Perspective viewport.
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5 Name the new Wind space warp Explosion.

6 In the Parameters rollout ➤ Force group, change the wind direction to
Spherical.

7 Also in the Force group, change the value of Strength to 0.02.

Generate Embers from the Burning Jeep | 1765

8 In the Parameters rollout ➤ Display group, change the Icon Size value
to 0.6.

The Explosion space warp will propel the embers in circular paths.
Add a Gravity space warp so the embers will fall back to earth:
1 On the Create panel ➤ Object Type rollout, turn on Gravity.

2 In the Perspective viewport, drag near the jeep to create a Gravity space
warp.
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3 In the Parameters rollout ➤ Display group, change the Icon Size value
to 1.2.

4 In the Parameters rollout ➤ Force group, change the Strength value to
0.04.

The force of gravity is slightly greater than the force of the wind.
Now you can use the space warps to control the ember particles.
Include the space warps in the particle system:
1 Restore Particle View (6).
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2 Drag from the depot to add a Force operator to Event 02.

3 Click the new Force operator to highlight it.

4 On the Force rollout, click By List.
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5 In the Select Force Space Warps dialog, click and Ctrl+click to select the
space warps Explosion and Gravity001, then click Select.
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Now the combination of a (spherical) wind and gravity will control the
ember particles.
6 Hide Particle View (6).

7 Drag the time slider or
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play the animation.

The embers fly out of the jeep, then fall back to the earth. They are easiest
to see in the Perspective viewport. They look rather large: But as with the
smoke particles, the material you apply will help fix their appearance.
Creating that material is the subject of the next procedure.

NOTE If you were modeling more solid particles (for example, solid chunks
of the jeep), you might want to add a Collision test that would detect when
the particles fell to the ground (Plane01). For this tutorial, that isn’t necessary.

Create a material for the glowing embers:

1 On the main toolbar, click
Material Editor.

(Material Editor). to display the Slate

2 Right-click the blank area above the active View, and from the pop-up
menu, choose Create New View.
3 In the Create New View dialog, name the new view Embers.

Generate Embers from the Burning Jeep | 1771

4 Drag a Standard material entry from the Materials ➤ Standard group
into the Embers view, and double-click the new Standard node to display
its parameters.
5 Name the material Embers.
6 Click the Diffuse color swatch, and in the Color Selector, change the
Diffuse color to RGB = 255, 156, 0. Click OK to close the Color Selector.

7 Click to turn off the
button that locks the Ambient component
to the Diffuse component.
8 Click the Ambient color swatch, and in the Color Selector, change the
Ambient color to RGB = 186, 0, 0. Click OK to close the Color Selector.
9 In the Self Illumination group, change the self-illumination value to 50
(percent).
Increasing the self-illumination value makes a material appear to glow.

10 In the Specular Highlights group, change the Specular Level value to 171,
and the Glossiness value to 34.
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The highlights make the material appear brighter.

11 Drag a Falloff map from the Browser to the Embers view, and wire it to
the Opacity component of the Embers material.
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By default, the falloff map makes the edges opaque and the center
transparent: This is the opposite of the effect we want.
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12 Double-click the Falloff node so you can see its parameters.

13 On the Falloff Parameters rollout, click

(Swap Colors/Maps).

Now the center is opaque, and the edges are transparent.

TIP The Falloff map is good alternative for making the edges of particles
transparent, when the particles are three-dimensional.
14 Drag the Standard material node’s output socket to an unused sample
slot in the Material/Map Browser ➤ Sample Slots group. Choose Instance,
and then click OK.
15

Close the Slate Material Editor.

Add the embers material to the particle system:
1 Restore Particle View (6).

Generate Embers from the Burning Jeep | 1775

2 Drag from the depot to add a Material Static operator to Event 02.

You can use a Material Static operator for the embers event, because the
material doesn’t change over time.
3 Click the new Material Static operator to highlight it.

4 On the Material Static rollout, click the Assign Material button (initially
it is labeled, “None”).
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5 In the Material/Map Browser ➤ Sample Slots group, double-click the
Embers material.

You can see the embers effect most clearly by renering the Perspective
viewport. (For this illustration, we turned off rendering for the smoke
particles.)

Up close, the embers still don’t look too realistic. But they will look all
right when you render the Camera01 viewport, and you will enhance
the effect by adding motion blur to the embers. That is the subject of the
next procedure.
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Add motion blur to the embers:
1 In Particle View, click the title bar of Event 02 to select the entire event.

2 Right-click, and from the pop-up menu, choose Properties.
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3ds Max opens an Object Properties dialog for Event 02.
3 In the General panel ➤ Motion Blur group, make sure Enabled is turned
on, then click to choose Image.

4 Also in the Motion Blur group, change the Multiplier value to 10.0.
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5 Click OK to close the Object Properties dialog.
6 Activate the Perspective viewport, drag the time slider until you have a

frame with embers in it, then

render the scene.

3ds Max renders the frame, and then in a second pass, adds motion blur
to the ember particles. (For this illustration, we turned off rendering for
the smoke particles, once again.)
In the Camera01 viewport, the effect is subtle because the embers are at
a distance. The motion blur effect is most apparent when you play the
animation.
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(Optional) Render the animation:

1 On the main toolbar, click

(Render Setup).

3ds Max opens the Render Setup dialog.
2 In the Time Output group, choose Active Time Segment.
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TIP Rendering at the full resolution of 1024 x 554 can take a lot of time.
Before you render, you might want to reduce the size of frames in the movie;
for example, to 500 x 271. Smaller frames render more quickly.

3 Scroll down to the Render Output group, and click Files.

3ds Max opens a file dialog. Enter a name for the file, choose a movie
file type (AVI or MOV), and then click Save. 3ds Max opens a compression
setup dialog for the movie format you chose. Adjust the settings or accept
the defaults, and then click OK.
4 In Render Output group, make sure Save File is turned on. (By default, it
turns on when you specify an output file.)
5 At the bottom of the Render Setup dialog, make sure Camera01 is chosen
in the View drop-down list, and then click Render.
Save your work:
■

Save the scene as smoke_completed.max.

To see a completed version of the smoking desert, you can
open
pflow_completed.max. You can also see a completed movie of the smoke
animation by choosing Rendering ➤ View Image File. Navigate to
\sceneassets\renderassets\, and then open either smoke.avi or smoke.mov.
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Summary
This tutorial demonstrated some aspects of particle systems; in particular:
■

Particle Flow is a powerful, general-purpose particle system that you can
use to model smoke and explosions, among other dynamic phenomena
(rain, snow, and flowing water are other possibilities).

■

Particle Flow can work with space warps such as Wind and Gravity, to
model real-world behavior.

■

The Particle Flow Shape Facing operator is good for creating particles whose
appearance is controlled by their material. You can design materials (for
example, with a Noise map) to simulate more complex geometry.

■

The Particle Age map lets you create materials that change over time as
particles can.

■

For flat particles, using a radial Gradient map for opacity can disguise the
edges of the particles. For three-dimensional particles, using a Falloff map
for opacity can accomplish the same thing.

■

The Particle Paint helper in combination with the Placement Paint operator
lets you set particle location by freehand strokes, and apply the same
Particle Flow system to multiple locations in a scene.

■

Particle Paint also lets you set particle generation at different frames in an
animation.

■

The Split Amount test is one way to treat a set of particles differently from
the original set.

■

Applying Image Motion Blur to fast-moving particles can improve their
appearance in animations.
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1784

Interoperability Tutorials

10

One of the strengths of 3ds Max is its ability to share data with other Autodesk products. The
FBX data format is one of these solutions. In this chapter, you learn how to rig and animate
a character with the MotionBuilder character-animation tool, and then use the animation
you created in 3ds Max.

1785

MotionBuilder animation mapped onto a 3ds Max charater

MotionBuilder Interoperability
Part of your development pipeline might take you to MotionBuilder, a powerful
3D character-animation suite.
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With MotionBuilder, you can quickly and easily rig characters, then set up
their animation using a full-body FK/IK manipulation rig. You can also retarget
animation data between characters, as well as blend, edit, and sequence tracks
in a timeline editor, combining animation with cameras, digital video, and
audio.
As you build your animation, MotionBuilder provides real-time playback of
character performance. There is no need to preview or render your work.
This tutorial shows you how to import a character to MotionBuilder, add
animation using both the FK/IK manipulation rig as well as data from a
motion-capture file, then export your work back to 3ds Max as a fully editable
animated character.
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In this tutorial, you will learn how to:
■

Label 3ds Max biped skeletons for easy conversion to MotionBuilder

■

Export a 3ds Max biped as an FBX file, then import to MotionBuilder

■

Characterize a skeleton in MotionBuilder for animation as a full FK/IK rig

■

Animate a character in MotionBuilder based on motion-capture data

■

Use keyframes to fine-tune character movement
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■

Export character animation as an FBX file from MotionBuilder, then import
to 3ds Max

■

Fine-tune character animation in 3ds Max.

Skill level: Intermediate
Time to complete: 1 1/2 hours

Preparation for This Tutorial

■

On the Quick Access toolbar, click
Project Folder and set your
current project to Autodesk 3ds Max 2011 Tutorials.

Preparing 3ds Max Scenes for Export
This lesson shows you how to take characters created in 3ds Max and prepare
them for import to MotionBuilder.
Set up the lesson:

■

On the Quick Access toolbar, click
(Open File), navigate to
\scenes\interoperability\motionbuilder and open basics.max.
NOTE If your system units are set to anything other than Centimeters, a File
Load: Units Mismatch dialog opens, prompting you to choose which unit scale
to use. Turn on Adopt the File’s Unit Scale and click OK.
The scene contains, from left to right, a mesh character and three skeletons
that can be used to drive the mesh.
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Mesh and three skeletons
Left: Mesh
Second from left: Skeleton A
Third from left: Skeleton B
Fourth from left: Skeleton C

Skeleton A is made up of a conventional Bones system. Skeletons B and C
are 3ds Max Biped systems.
Before MotionBuilder can recognize a model as a character that can be
animated, its skeleton bones must be characterized. A model can be
characterized only if its bones are labeled in a specific way. You can rename
character bones in MotionBuilder, but it is a good idea to rename them
properly in 3ds Max whenever you can.
View skeleton bone hierarchy and naming conventions:

1

Region-select Skeleton A, then right-click and from the quad
menu, choose Isolate Selection.
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Skeleton created from a conventional bone system

2 On the main toolbar, click

(Select By Name).

3 On the Select From Scene dialog, choose Display ➤ Display Children
and then Display ➤ Expand All. Scroll the list to view the skeleton
hierarchy and see how each bone is named.
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This is the naming convention recognized by MotionBuilder. If you name
the skeleton bones this way, you can later characterize them in
MotionBuilder with a simple click of the mouse.
4 Click Cancel to close the Select From Scene dialog, and then click Exit
Isolation Mode to display the whole scene again.
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5

Region-select Skeleton B, then right-click and from the quad
menu, choose Isolate Selection.

6 On the main toolbar, click

(Select By Name).
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The Select From Scene dialog opens, showing the bone hierarchy of the
Skeleton B and its identifying names. This naming convention is the
default for Biped. While it is different from the convention used by
Skeleton A, MotionBuilder also recognizes it, and it can be used to quickly
convert skeletons for animation.
7 Repeat steps 4 through 6 to isolate Skeleton C and view its skeleton
hierarchy.
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Even though the suffix of each bone name in Skeleton C is identical to
the name suffixes in Skeleton B, the prefix to each bone name, “MIA,”
is different. MotionBuilder recognizes prefix changes for biped skeletons.
8 Click Cancel to close the Select From Scene dialog, and then click Exit
Isolation Mode to display the whole scene again.

Exporting Scenes to MotionBuilder
This lesson shows you how to export 3ds Max scene data in .fbx format to
MotionBuilder. You can export an entire scene, or only a portion of the scene
containing selected elements.
Set up the lesson:

If you are continuing from the previous lesson, from the

■

Application menu choose Reset, do not save any changes, then
reopen basics.max.
Export skeleton A in FBX format:

1

Region-select all of skeleton A.
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Notice that the skeleton has been positioned in a “T” pose, the stance
commonly used by animators for skinning. You should always place your
characters in this position before you export them to MotionBuilder.
Also, skeletons must be oriented in the minus Y axis direction. (All 3ds
Max Biped systems are oriented this way when you create them.)
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Skeleton A oriented in a minus Y direction

2 From the

Application menu, choose Export ➤ Export Selected.

3 In the Select File To Export dialog ➤ File Name field, type
mybone-skeleton and click Save.
NOTE The default location for the exported FBX file is the \export folder in
the current project.
3ds Max opens the FBX Export dialog. Here, you specify how to convert
the 3ds Max scene information.
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NOTE For conversion to take place properly, you must have the latest FBX
driver installed. If this is the first time you have used FBX export, the dialog
will prompt you to check for updates. You can also check if you are not sure
whether you have the latest version: Click the Web Updates button in the
Information group.

4 On the FBX Export dialog, expand the Include ➤ Animation group, and
turn off the Animation check box.
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This option should be turned on only when the scene you want to export
has animation.
5 Close the Animation group, expand the Embed Media group, and Make
sure Embed Media is also turned off (it should be off by default).

If you were exporting a mesh with a character, the Embed Media option
would embed in the FBX file any texture maps associated with the
character. But since you are exporting a skeleton only, this option is not
needed.
6 Expand the Advanced Options ➤ Axis Conversion group, and make sure
Up Axis displays the Y-Up option (once again, this should be the default).

This setting assigns the exported character a Y-up axis, the orientation
used by objects in MotionBuilder. This setting is required because objects
created in 3ds Max use a Z-up orientation.
7 Expand the Advanced Options ➤ FBX File Format group, and choose
the FBX version that is compatible with the version of MotionBuilder
installed on your system.
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In this case, we have MotionBuilder 2010 installed, so we chose FBX 2010
as the version to export.
8 Click OK to export Skeleton A as an FBX file.
Typically, you would also export a mesh, properly skinned onto a skeleton.
This is what you do in the next procedure.
Export the Pepe character:

1 On the Quick Access toolbar, click

(Open File).

2 Do not save your scene file when prompted, and from the Open File
dialog, choose pepe_biped.max.
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Scene consists of a biped skeleton inside a mesh

3 On the main toolbar, click

(Select By Name).
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The Select From Scene dialog opens, showing both the mesh and the
biped. The biped hierarchy uses a naming convention recognized by
MotionBuilder.

4 Click Cancel to close the dialog. On the main menu, turn on
(Select And Move).
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5 Move Pepe’s right foot bone in any direction to see how the skinning
controls the character behavior.

6 Right-click or click

(Undo) to undo the foot motion.

7 From the
Application menu, choose Export, and in the File
Name field, type my_pepe_biped01.
8 In the FBX Export dialog ➤ Embed Media group, turn on Embed Media.
Make sure the other export settings are the same as you used for the Bones
skeleton, then click OK.

The FBX Exporter displays a warning message. This is because Pepe has
a Multi/Sub-Object material that FBX and MotionBuilder don’t recognize.
We don’t plan to render Pepe in MotionBuilder (after animating in
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MotionBuilder, you import the Pepe model back into 3ds Max), so the
warning is not important: Click OK to dismiss it.
You might see an additional warning that says “Unsupported controller
(1) / Turned edges (1)”: This is because the Pepe mesh is an Editable Poly
object, rather than an Editable Mesh. This doesn’t affect the workflow,
so dismiss this warning, too.
The Pepe character is exported as an FBX file to the same folder as the
biped skeleton you saved earlier.
Rename the biped:

1 In the viewport,

select any bone in the biped skeleton.

2 Go to the
Motion panel ➤ Biped rollout, expand the Modes
And Display group, and in the Name field, type PEPE.

3 On the main toolbar, click

(Select By Name).

The Select From Scene dialog displays the modified names of the character
parts. Each bone is now identified by the PEPE prefix.
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4 Click Cancel to close the Select From Scene dialog.
5 Export this modified scene as you did in steps 6 and 7 of the previous
procedure, but name the exported file my_pepe_named.
In the next lesson, you will use this FBX file to learn how to import
custom-named characters into MotionBuilder.
Save your work:
1 Save your 3ds Max scene as my_pepe.max.
2 Exit 3ds Max.
In the next few lessons, you will be working in MotionBuilder.

Importing Scenes to MotionBuilder
This lesson shows you how to import an FBX file to MotionBuilder and
characterize the bones of the skeleton you need to animate. You will then
assign the skeleton a control rig.
Import a skeleton:

1 Start

MotionBuilder.

2 Choose Layout ➤ Editing so the MotionBuilder layout will correspond
to that shown in these lessons.
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3 In MotionBuilder, on the Asset Browser explorer panel, right-click a blank
area of the folder list and choose Add Favorite Path.

4 On the Open Directory dialog, navigate to the \3ds Max 2010
tutorials\export folder. Highlight the folder and click OK.
The folder displays as a shortcut in the Asset Browser
NOTE An \export folder is also provided with MotionBuilder: By default, this
one contains only a couple of files.
5 Click the folder name so you can view its contents.
The folder contents display in the right-hand pane of the Asset Browser.
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Now you have fast access to the FBX files you want to import into
MotionBuilder.
If you had saved your FBX files from MotionBuilder instead of from 3ds
Max, you could open them simply by dragging their file icon from the
Asset Browser into the Viewer. However, dragging the icons of FBX files
created in external applications launches a series of dialogs that prompt
you for more information. Because of this, it is easier to import files
created in 3ds Max through an FBX Plug-in Import dialog.
6 From the main menu, choose File ➤ FBX Plug-In Import.
7 On the Open File dialog, navigate to the \3ds Max 2010 tutorials\export
folder, highlight mybone-skeleton.fbx, and click Open.
If you like, you can import the presaved file _bone_skeleton.fbx, instead.
8 On the FBX Plug-In Import Options dialog, leave the default settings
unchanged, and click Open.
The MotionBuilder Viewer window displays the MotionBuilder equivalent
of the Bones skeleton you exported from 3ds Max.
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Familiarize yourself with Viewer navigation in MotionBuilder:
Pause now and take a moment to try a few MotionBuilder navigation
techniques.
1 Press Ctrl+Shift+drag to orbit around the scene.
2 Ctrl+drag to zoom in and out of the scene.
3 Shift+drag to pan the scene.
TIP You can also use the ViewCube to navigate the scene. The ViewCube in
the MotionBuilder Viewer behaves the same as it does in 3ds Max viewports.
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Characterize the skeleton:
Now you need to characterize the skeleton bones before you can animate
them. Characterization is the way you rig a skeleton in MotionBuilder.
1 On the Asset Browser, click Templates ➤ Characters.
2 Drag the Character tool from the Asset Browser, and drop it on the
skeleton’s center of mass.

When you release the mouse, a pop-up menu shows the Characterize
option.
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3 Click Characterize.
4 On the Character dialog, click Biped to indicate the type of rigging to
apply to the character (the other choice is Quadruped).

NOTE As the dialog mentions, the character must be in a “stance” (“T”)
pose and be facing in the positive Z axis (the equivalent of the negative Y
axis that you converted when exporting the .max file into .fbx format).
5 On the Character Controls window, choose Edit ➤ Control Rig Input.
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You must choose this setting if you intend to keyframe your character.
6 On the Create Control Rig dialog, click FK/IK.

FK/IK is the method commonly used to animate characters.
7 In the Character Controls window ➤ Active group, turn on Ctrl Rig In.
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This setting activates the Character Controls ➤ Character Representation
to the left. The Character Representation is an image of a biped, with all
the effectors you need to animate the control rig.
Your character is now rigged and ready to receive animation.
Because your character bones were properly labeled, it took just seven
steps to successfully rig your character. In 3ds Max, rigging a character
using regular FK/IK constraints would have taken a great deal more effort.
Animate the skeleton:
1 On the Character Controls pane ➤ Character Representation, click to
select the right hand effector.
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2 With your mouse over the Viewer, press T (for Translate), and move the
hand down. As you continue to move the hand, the arm extends, and
the rest of the body reacts in a natural movement.
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Characterize a Biped skeleton:
1 From the main menu, choose File ➤ New. Do not save the skeleton
animation.
2 Choose File ➤ FBX Plug-In Import.
3 On the Open File dialog, navigate to the \3ds max tutorials\export\ folder,
highlight mypepe_biped01.fbx and click Open.
If you like, you can import the presaved file _pepe_biped_bip01.fbx, instead.
On the FBX Plug-in Import dialog, leave the default settings unchanged
and click Open.
The Pepe character mesh displays in the Viewer.

4 Place the cursor anywhere inside the Viewer and press A.
Pressing A is the equivalent of using Zoom Extents in 3ds Max. It zooms
in to all visible objects in the Viewer.
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5 With your cursor still in the Viewer, press Ctrl+A to obtain a skin-only
view. Press Ctrl+A again to switch to X-ray mode.

Pepe character in X-ray mode

In this mode, you can view and select both the character mesh as well
as the bones, either individually or by region selection.
6 Drag the Character icon from the Asset Browser into the Viewer, then
release the icon over the skeleton’s center of mass, as shown in the next
illustration.
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Pepe character center of mass

7 On the pop-up menu, click Characterize.
An error message displays, indicating that the characterization of the
bones could not be completed. This is because MotionBuilder could not
recognize the names that identify the Pepe character bone system.

8 Click OK.
A list displays all the bones MotionBuilder could not find.
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9 Click Close, then go to the Navigator window, expand the Characters
list, then double-click the Character entry.
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10 If the Character Definition pane is not already active, click the Character
Definition tab.
11 In the left-hand column, expand the Base (Required) list.

The Mapping List in the Character Definition pane shows all the skeleton
components whose mapping conversion was not recognized by
MotionBuilder. The Base (Required) list shows the most crucial of these.

1818 | Chapter 10 Interoperability Tutorials

The standard MotionBuilder character template works well for 3ds Max
Bones systems, but it is not set up for Biped skeletons. You will try again
with the Biped template.
Change the template to a Biped template:
1 In the Navigator list, click the Character entry to highlight it, then
right-click and choose Delete.
2 Drag the 3ds Max Biped Template from the Asset Browser to the Viewer,
and drop it on the Pepe character’s center of mass.
This tool is similar to the Character tool you used earlier, but it is designed
to recognize the bones of a biped object created in 3ds Max (bones that
use the Biped link-naming convention for their suffixes).
3 On the pop-up menu, choose Characterize.
4 On the Character Controls window, choose Edit ➤ Control Rig Input.
5 On the Create Control Rig dialog, click FK/IK.
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6 In the Character Controls window ➤ Active group, turn on Ctrl Rig In.
7 On the Character Control pane ➤ Character Representation, click to
select the right hand effector, then with your mouse over the Viewer,
press T for Translate, and move the hand.
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The Pepe skeleton is fully rigged.
8 Go to the Navigator window, double-click the Bip01 entry, and on the
Character Definition pane, expand the Base (Required) list.
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The Mapping List column shows how the 3ds Max Biped Template tool
has characterized the bones by mapping their conventional Biped names
onto the default MotionBuilder naming convention, shown in the Base
(Required) list. No Naming Template was used.
You can characterize any Biped skeleton this way, regardless of
the prefix given to the bones of the biped. If you want to, try it with the
file you saved earlier called my_pepe_named.fbx (or use the presaved file
_pepe_biped_pepe.fbx).
Save your work:
■

Choose File ➤ Save As, and save the file as mypepe_rigged.fbx. In the
Save Options dialog, accept the defaults, then click Save.
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Animating Characters In MotionBuilder
In MotionBuilder, you can animate characters by setting keyframes manually
or by using motion-capture data. This lesson shows you how to do both.
NOTE If you already know how to animate characters in MotionBuilder, you can
skip this lesson and go to the next lesson on page 1835.
Load Pepe with characterization:

1 In
New.

MotionBuilder, from the main menu, choose File ➤

2 In the Asset Browser ➤ Export folder, click to highlight
pepe_biped_characterized.fbx.
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This file contains the Pepe character you worked on in the last few lessons.
To speed things up, he has already been characterized and saved in
MotionBuilder, so he is ready to receive animation.
3 Drag pepe_biped_characterized.fbx to the Viewer.
4 On the pop-up menu that appears, choose FBX Open ➤ <All Takes>.

MotionBuilder has the ability to store multiple animation “takes” or
sequences within the same project, and this option would open all of
them if they existed. Alternatively, you could choose <No Animation>
or Take 001.
5 With the cursor in the Viewer, press A to zoom in to the Pepe character.
6 Press Ctrl+Shift and drag to orbit until the Pepe’s right side is in view.
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Pepe is ready to accept keyframe animation using control-rig input from
the Character Controls window. But in this case, you will retarget
animation to Pepe from one of the motion-capture files that ship with
MotionBuilder.
Animate the Pepe character using motion-capture data
1 From the Asset Browser ➤ Export folder, choose iceslip and drag it to the
Viewer.
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2 A pop-up menu appears. Choose FBX Merge ➤ IceSlip.

3 Zoom out until the yellow skeleton that represents the motion-capture
animation is visible.
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Pepe with skeleton containing motion-capture information

NOTE If you do not see the yellow skeleton, place your cursor in the Viewer
and press Ctrl+A to exit Models Only mode.

4 On the Transport Controls, click

(Play) to view the animation.

You will now assign this movement to the Pepe character. In
MotionBuilder, this task is easy to accomplish.
Apply the animation to the Pepe character:
1 On the Character Controls window ➤ Character Controls pane, make
sure PEPE is displayed in the character list.
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2 Choose Edit ➤ Input ➤ Skeleton2, which is the yellow skeleton
containing the motion-capture animation.

3 Scrub the animation either by dragging the animation slider bar, or by
holding down the J key and dragging left or right in the viewport.
The skeleton’s animation now drives the Pepe character.
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Identify a problem area:
The skeleton is a good deal larger than Pepe, and when scales are mismatched
in this way, you can expect that some motion doesn’t translate correctly.
1 Press Ctrl+A until only Pepe is visible.
2 Drag the timeline indicator (equivalent to the 3ds Max time slider) to
frame 92. You can also use the Play Controls to find the right frame.
3 Zoom in on the Pepe character.
If you look carefully, you will see how one of Pepe’s hands passes into
his face. You might need to orbit the Viewer and scrub the animation a
few times to see the problem.

Unwanted hand movement inherited from motion capture

This behavior occurred because the animation driving Pepe’s bone
movement is based on the skeleton, which has a very different physiology.
(Pepe’s head, hands, and feet, for example, are much larger than the
skeleton’s, while his shoulders are much narrower.)
In the next procedure, you will correct Pepe’s hand movement.
Correct the hand-in-the-face problem:
1 On the Character Representation, click the right hand effector, then press
T and try to move Pepe’s hand in the viewport.
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Nothing happens because Pepe’s animation is controlled by the skeleton,
not the control rig. Before you can go any farther, you need to bake the
skeleton animation onto the Pepe character’s control rig.
2 On the Character Control window ➤ Character Controls pane ➤ Edit
menu, choose Plot Character.

3 On the Character dialog, click Control Rig.
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On the second Character dialog, leave the default values unchanged, and
click Plot.

Now you can edit the Pepe character using his control rig.
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NOTE The Plot command creates a key at every frame at the base layer of
the animation track, which makes edits difficult. Because of this, you will edit
the keyframing on a different layer.
4 On the Key Controls window, click the Base Layer list and choose Layer
1.

The keyframes are hidden on the timeline, clearing your workspace.
5 Go to frame 80, which is the start of the problem hand movement. On
the Character Representation, click the right wrist effector, then on the
Key Controls panel, click Key.

TIP You can also create a key by placing your cursor anywhere in the Viewer
and pressing K.
6 Go to frame 105, the end of the problem hand movement, and click Key
again.
All character movement before the first key and after the second will
remain unchanged. Only the character movement between frames 80 to
105 will be modified.
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7 Go to frame 94, the midpoint between the two new keyframes you set.
8 Make sure the right hand effector is still active. In the Viewer, press T,
move the hand away from Pepe’s face on its X and Z axes, and create
another key.

Left hand repositioned away from character’s face

9 Hold down J, then drag back and forth to see how the hand reacts to the
keys you just created.
Pepe’s hand no longer intersects with his face while he is falling.
Correct the hand position after Pepe has fallen:
1 Advance to the last frame of the animation and adjust the Viewer until
you can see the right side of Pepe’s body.
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Right hand too close to the character’s head

2 Move the hand away from the body and create a key.
3 Press R and use the rotate gizmo to modify the hand’s position until it
rests flat on the ground, then create another key.
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Rotate gizmo used to reposition right hand

4 Go to frame 114 and position the right hand farther away from the head
and create another key.

5

Play back the animation to see the result.
When you are satisfied with the animation, proceed to the next lesson.
There, you will save your work and prepare it for import back to 3ds Max.

Preparing Animation for Export to 3ds Max
3ds Max cannot read the control rig information that defines character
animation in MotionBuilder. For 3ds Max to recognize this animation, you
need to plot, or “bake,” the keyframe data into the character’s skeleton.
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Set up the lesson:

■

In
MotionBuilder, continue from the previous lesson, or
from the main menu, choose File ➤ New and then from the Asset Browser
➤ Export folder, open the file pepe_biped_unplotted.fbx.

Bake animation onto the Pepe character skeleton:
1 On the Character Controls window ➤ Character Controls pane ➤ Edit
menu, choose Plot Character.

2 On the Character dialog, click Skeleton.
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On the second Character dialog, leave the default values unchanged and
click Plot.

The character control rig is deactivated, but the Pepe character retains
all animation information.
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TIP If you need to edit the character’s movement after its animation has been
plotted, simply go back to the Character Control panel ➤ Character Controls
tab ➤ Edit menu, and choose Plot Character ➤ Control Rig again. When
you are done, repeat steps 1 to 2 to bake the animation back onto the
character skeleton.
When you save your file, you will have not only the animated character
Pepe in your scene, but the reference skeleton as well. You could delete
the skeleton from the scene or select the Pepe character and save it to
another file for import to 3ds Max, but this is not mandatory. As you will
see, you can just as easily strip out the skeleton during the import process
to 3ds Max.
3 From the main menu, choose File ➤ Save As, then in the Save File dialog,
enter mypepe_biped_plotted and click Save. In the Save Options dialog,
accept the defaults, then click Save.
4 Exit MotionBuilder.

Importing Animation to 3ds Max
You can choose to import the entire contents of scenes saved in MotionBuilder,
or only those elements whose names match elements in your 3ds Max scene.
The animation you import from MotionBuilder is fully editable in 3ds Max.
Set up the lesson:

■

Start
3ds Max. On the Quick Access toolbar, click
(Open File). Open pepe_biped_pepe.max.
The skeleton bones in this scene file have the same PEPE prefix as the
character you exported to MotionBuilder.

Import the animated character to 3ds Max:

1 On the

Application menu, choose Import.
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2 On the Select File To Import dialog, navigate to the \3ds max 2011
tutorials\export\ folder, and open mypepe_biped_plotted.fbx (or use the
presaved file \import\_pepe_biped_plotted.fbx).
NOTE The presaved file is in the \import folder of the tutorial project, not
the \export folder.
3 On the FBX Import dialog, expand the Include group.
The File Content list displays Add And Update Scene Elements by default.
If left as is, this setting would import not only the Pepe character, but
the yellow reference skeleton as well.
4 From the File Content list, choose Update Scene Elements.

This option updates only the scene elements in 3ds Max that share the
same name as those in the imported file. No new elements are imported.
If you were importing animation from MotionBuilder to a new 3ds Max
scene, you would instead choose the Add To Scene option.
5 Click OK.
3ds Max displays a warning about skeleton elements: The warning applies
to the large MotionBuilder skeleton. You aren’t using this in the 3ds Max
scene, so click OK.
6 Scrub the time slider to see how the MotionBuilder animation has been
baked into the bones of the Pepe character.

TIP It helps first to
the animation.

zoom out in the viewport, so you can see all of
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Fine-tune the animation in 3ds Max:

1 Go to frame 0 and

zoom in and
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orbit around Pepe’s hands.

The character’s fingers are too close to the thighs

2

Select a part of the PEPE skeleton and go to the

Motion

panel.

3 Expand the Layers rollout and click
layer of animation.

(Create Layer) to create a new
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4 On the main toolbar, click
R Hand bone.

(Select By Name) and select the PEPE

5 Right-click the viewport, and from the quad menu, choose Move.
6 Drag the hand away from Pepe’s body on its X and Z axes.

7 Expand the Key Info rollout and click

8 Expand the Track Selection rollout and click
Pepe’s left hand.
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(Set Key).

(Opposite) to select

9 Repeat steps 6 and 7 for the left hand, then
to see the result of your edits.

replay the animation

10 When you are satisfied with the new animation, on the Layers rollout,

click

(Collapse).

Save your work:
■

Save the scene as my_pepe_iceslip.max.

Summary
In this series of lessons, you took a character called Pepe (consisting of a mesh
and a Biped skeleton), and exported it to MotionBuilder as an FBX file. There,
you characterized the biped bones, and animated the Pepe skeleton by plotting
it to another skeleton whose movements were derived from motion capture.
Then you baked the animation back to Pepe’s control rig, made a few
adjustments so that the motion better fit his cartoon-like dimensions, and
baked the animation back into Pepe’s skeleton for export to 3ds Max. Finally,
you fine-tuned Pepe’s body motion using the fully preserved Biped edit
functionality.
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